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Konfiguracija sustava

Paket s 
bežičnim 
mikrofonom 
UWP-D21 
UWP-D22 
UWP-D26

Prijemnik 
bežičnog 
mikrofona 
URX-P03D

Adapter za 
nosač 
za više sučelja 
SMAD-P3D

Adapter za 
nosač za više 
sučelja 
SMAD-P5

Adapter A-mount 
LA-EA3 
LA-EA4

Objektiv 
E-mount

Mikrofon 
ECM-VG1 
ECM-MS2

Jedinica daljinskog 
upravljača 
RM-30BP

MCX-500 
Uređaj Multi 
Camera Live 
Producer

Daljinski upravljač 
na drški (priložen)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

Komplet 
adaptera XLR 
XLR-K2M 
XLR-K3M

Svjetlo za 
videozapis 
HVL-LBPC

CFexpress Type A  
memorijske 
kartice

SDXC  
memorijske kartice

BC-CU1  
Punjač za baterije 
(isporučuje se)

BP-U35, BP-U60, 
BP‑U60T, BP-U70, 
BP‑U90, BP-U100 
Komplet baterija

Adapter za 
izmjeničnu struju 
(priložen)

Čitač CFexpress Type A kartice /  
čitač SD kartice

Punjač baterije 
BC-U1A, BC-U2A

1. Pregled
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Položaj i funkcija dijelova

Lijeva strana i prednja strana
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1.	 Kuka za mjernu traku
Kuka za mjernu traku je u ravnini slikovnog 
senzora. Za točno mjerenje udaljenosti 
između videokamere i objekta upotrijebite 
ovu kuku kao referentnu točku. Kraj mjerne 
trake pričvrstite za kuku kako biste izmjerili 
udaljenost od objekta.

2.	 Priključnica za tražilo (stranica 19)

3.	 Izlazni otvor za zrak

[Napomena]
Nemojte prekriti izlazni otvor za zrak.

4.	 Sklopka za odabir TC IN/OUT 
(stranica 34, 107)

5.	 Priključnica za daljinski upravljač s 
drškom (stranica 20)

6.	  (N-oznaka) (stranica 56)
ˎˎ Pametnim telefonom s funkcijom 
NFC dodirnite jedinicu kako biste 
uspostavili bežičnu vezu.  
Neki pametni telefoni s podrškom 
za sustave bežičnog plaćanja možda 
ne podržavaju NFC. Pojedinosti potražite 
u uputama za upotrebu pametnog telefona.
ˎˎ Komunikacija bliskog polja NFC (Near Field 
Communication) unutarnji je komunikacijski 
protokol za bežičnu komunikaciju bliskih 
objekata.

7.	 Postavljanje daljinskog upravljača 
na drški (stranica 20)

8.	 Gumb za otpuštanje daljinskog upravljača 
na drški (stranica 20)

9.	 Antena za Wi-Fi

10.	Lampica snimanja/signalizacije (sprijeda) 
(stranica 34)

Treperi kada je preostali kapacitet medija 
za snimanje ili baterije nizak.

11.	Sklopka FOCUS (stranica 37)

12.	Slikovni senzor

13.	Gumb PUSH AUTO FOCUS (stranica 40)

14.	Signalni kontakti objektiva

[Napomena]
Nemojte izravno dirati rukama.

15.	Gumb WB SET (postavljanje balansa bijele 
boje) (stranica 45)

16.	Gumb za otpuštanje objektiva 
(stranica 22)
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Desna strana (sprijeda/odozgo/odozdo)
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1.	 Gumb Clip Flag (stranica 50, 65)

2.	 Sklopka HOLD (stranica 93)

3.	 Gumb za snimanje START/STOP 
(stranica 34)

Pritisnite gumb za snimanje START/STOP za 
početak snimanja. LED lampica svijetli crveno 
tijekom snimanja.

4.	 Kotačić ND VARIABLE (stranica 43)

5.	 Sklopka ND PRESET/VARIABLE 
(stranica 43)

6.	 Gumbi gore/dolje ND FILTER POSITION 
(stranica 43)

7.	 Indikator ND CLEAR (stranica 43)

8.	 Gumb ND VARIABLE AUTO (stranica 43)
Pritisnite gumb ND VARIABLE AUTO za početak 
namještanja automatske gustoće ND filtra. LED 
lampica svijetli zeleno kada je uključeno.

9.	 Višenamjenski kotačić (stranica 48)
Pritisnite tijekom pregleda slike na tražilu za 
prikaz i upravljanje izravnim izbornikom.
Kada se na tražilu prikazuje izbornik, okrećite 
kotačić kako biste pokazivač pomicali gore/
dolje za odabir stavki izbornika i postavki. 
Pritisnite za primjenu odabrane stavke.
Kada se izbornik ne prikazuje, kotačić također 
može služiti kao dodjeljivi kotačić.

10.	Gumb funkcije IRIS (stranica 42)

11.	Gumb CANCEL/BACK (stranica 64)

12.	Gumb THUMBNAIL (stranica 63)

13.	Gumb MENU (stranica 13, 68)
Pritisnite gumb MENU da bi se prikazao zaslon 
statusa. Pritisnite i držite gumb MENU da bi 
se prikazao zaslon cijelog izbornika. Pritisnite 
gumb tijekom zaslona statusa ili prikaza 
zaslona cijelog izbornika za povratak na 
prethodni prikaz zaslona.

14.	Gumb funkcije ISO/GAIN (stranica 42)

15.	Sklopka ISO/GAIN (odabir pojačanja 
signala) (stranica 42)

16.	Gumb funkcije WHT BAL (balans 
bijele boje) (stranica 45)

17.	Sklopka WHT BAL (odabir memorije 
za balans bijele boje) (stranica 45)

18.	Gumb funkcije SHUTTER (stranica 43)

19.	Priključnica za slušalice (stranica 34)

20.	Sklopka POWER (stranica 34)

Desna strana (straga) 
(stranica 6)
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Desna stražnja strana i utor za karticu
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1.	 Antena za Wi-Fi

2.	 Kotačić AUDIO LEVEL (CH1) (stranica 46)

3.	 Sklopka CH1 (AUTO/MAN) (stranica 46)

4.	 Gumbi ASSIGN (dodjeljiv) od 1 do 3 
(stranica 48)

5.	 Unutarnji mikrofon (stranica 46)
Mikrofon za pričanje za snimanje zvukova iz 
okoline. 

[Savjet]
Ovaj mikrofon onemogućen je kada je ručka postavljena 
i kada je ručka unutarnjeg mikrofona aktivna 
(stranica 7).

6.	 Gumb DISPLAY (stranica 11)

7.	 Ugrađeni zvučnik (stranica 34)

8.	 Indikator POWER (stranica 34)

9.	 Gumb SLOT SELECT (odabir utora za 
memorijsku karticu (A)/(B)) (stranica 34)

10.	Sklopka CH2 (AUTO/MAN) (stranica 46)

11.	Kotačić AUDIO LEVEL (CH2) (stranica 46)

12.	Indikator pristupa A (stranica 26)

13.	Utor za CFexpress Type A karticu / SD 
karticu (A) (stranica 26)

14.	Utor za CFexpress Type A karticu / SD 
karticu (B) (stranica 26)

15.	Indikator pristupa B (stranica 26)
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Ručka, stražnja strana i blok priključnice
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1.	 Prekidač HOLD za ručku
Upotrebljava se za onemogućavanje rada 
upravljačkih elemenata ručke.

2.	 Gumb za snimanje na ručki START/STOP

3.	 Ručka unutarnjeg mikrofona

4.	 Nosač za više sučelja

Za detalje o dodatnoj opremi koju podržava 
nosač za više sučelja obratite se prodajnom 
predstavniku tvrtke Sony.

5.	 Dodjeljivi kotačić na ručki (stranica 48)

6.	 Poluga s ručkom za zumiranje 
(stranica 93)

7.	 Gumbi ASSIGN (dodjeljivi) od 7 do 8 
(stranica 48)

8.	 Višestruki birač (osmosmjerni D-upravljač 
i gumbi za primjenu)

9.	 Nosač dodatne opreme (stranica 7)

10.	Otvori za vijak (1/4 inča) za postavljanje 
dodatne opreme

Kompatibilni s vijcima 1/4-20 UNC (duljine 
6 mm ili kraći).

[Napomena]
Upotreba vijaka dužih od 6 mm može oštetiti vanjsku 
površinu.

11.	Lampica snimanja/signalizacije (straga) 
(stranica 34)

12.	Gumb BATT RELEASE (stranica 17)

13.	Ulaz za zrak

[Napomena]
Nemojte prekriti ulaz za zrak.

14.	Priključak za komplet baterija 
(stranica 17)

15.	Priključnica USB-C (stranica 60)

16.	Priključnica INPUT2 (ulaz zvuka 2) 
(stranica 46)

17.	Priključnica INPUT1 (ulaz zvuka 1) 
(stranica 46)

18.	Sklopka INPUT2 (LINE/MIC/MIC+48V) 
(stranica 46)

19.	Sklopka INPUT1 (LINE/MIC/MIC+48V) 
(stranica 46)

20.	Otvori za vijak za vanjske uređaje
Kompatibilni s vijcima M3 (duljine 4 mm ili 
kraći).

[Napomena]
Upotreba vijaka dužih od 4 mm može oštetiti vanjsku 
površinu.

21.	Priključnica HDMI OUT (stranica 106)

22.	Priključnica SDI OUT (stranica 106)

23.	Priključnica TC IN/TC OUT (ulaz/izlaz 
vremenskog koda) (stranica 107)

24.	Priključnica REMOTE
Za priključenje dodatne opreme opće namjene 
s priključnicom LANC.

25.	Priključnica USB/multi (stranica 108)

26.	Priključnica DC-IN (standardni DC 
priključak) (stranica 18)

Postavljanje nosača za više sučelja

1	 Podignite prednji rub opruge nosača 
i povucite oprugu u smjeru suprotnom 
od strelice urezane na opruzi.

Opruga nosača

Nosač dodatne opreme

1

2	 Postavite nosač dodatne opreme na 
nosač za više sučelja, poravnajte utore na 
nosaču s odgovarajućim točkama na 
držaču te zategnite četiri vijka.
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3	 Umetnite oprugu nosača u smjeru strelice 
tako da dio oblikovan kao slovo postavite 
na rub nosača za više sučelja.

Opruga 
nosača

Nosač dodatne opreme

2 32 3

Uklanjanje nosača za više sučelja

Uklonite oprugu nosača kako je opisano 
u 1. koraku pod „Postavljanje nosača za više 
sučelja", odvijte četiri vijka i uklonite nosač 
za više sučelja.

Postavljanje ručke

Stavite ručku tako da su priključnica ručke 
i otvori za vijke poravnati, gurnite unutra 
i okrenite vijke za postavljanje ručke 
u smjeru kazaljke na satu za postavljanje 
ručke na jedinicu.
Možete i zategnuti vijke za postavljanje ručke 
okretanjem u smjeru suprotnom od kazaljke 
na satu s pomoću imbus ključa.

[Napomena]
Provjerite jesu li dva vijka za postavljanje ručke dobro 
zategnuta prije upotrebe ručke. Ručka može ispasti s 
videokamere ako vijci nisu dobro zategnuti.

Uklanjanje ručke

Uklonite je tako da postupak postavljanja 
napravite obrnutim redoslijedom.

Postavljanje poklopca za zaštitu 
priključka za ručku (isporučen)

Tijekom upotrebe videokamere bez ručke 
zaštitite priključak isporučenim zaštitnim 
poklopcem.

[Savjet]
Pri postavljanju ručke stavite zaštitni poklopac na dno 
ručke.

Zaštita stezaljki priključnica

Na nekorištene priključnice postavite poklopac 
kako biste zaštitili stezaljke priključnice.

Gornja strana

1

2 2

2

2

1.	 Priključak za ručku

2.	 Otvori za vijak (1/4 inča) za postavljanje 
dodatne opreme

Kompatibilni s vijcima 1/4-20 UNC (duljine 
6 mm ili kraći).

[Napomena]
Upotreba vijaka dužih od 6 mm može oštetiti vanjske 
dijelove.
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Donja strana

1 2
1.	 Otvori za vijke stativa (1/4'', 3/8'')
Kompatibilni s vijcima 1/4-20 UNC i 3/8-16 
UNC. Postavite stalak (nije obavezno, duljina 
vijka 5,5 mm ili manja).

2.	 Izlaz za zrak

[Napomena]
Nemojte prekriti izlaz za zrak.

Tražilo

Pojedinosti o postavljanju tražila (priloženo) 
potražite na (stranica 19).

1
2
3

4 5

1.	 Gumb PEAKING

2.	 Gumb ZEBRA

3.	 Gumb ASSIGN 9 (dodjeljiv) (stranica 48)

4.	 Zaslon osjetljiv na dodir
Rad dodirom može se onemogućiti 
s pomoću dodjeljivog gumba ili izbornika 
(stranica 10).

5.	 Sklopka MIRROR

Daljinski upravljač na drški

Pojedinosti o postavljanju daljinskog 
upravljača na drški (priložen) potražite 
na (stranica 20).

4

3
2

1

7
8

6
5

1.	 Poluga zuma

2.	 Gumb ASSIGN 4 (dodjeljiv) (stranica 48)

3.	 Dodjeljivi kotačić na drški (stranica 48)

4.	 Gumb ASSIGN 6 (dodjeljiv) (stranica 48)

5.	 Poluga za okretanje drške (stranica 21)

6.	 Gumb za snimanje START/STOP

7.	 Višestruki birač (osmosmjerni D-upravljač 
i gumbi za primjenu)

8.	 Gumb ASSIGN 5 (dodjeljiv) (stranica 48)
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Upotreba zaslona osjetljivog na dodir

Mjere opreza za upotrebu zaslona 
osjetljivog na dodir

Tražilo jedinice je zaslon osjetljiv na dodir 
kojim možete upravljati izravno dodirom prsta.
ˎˎ Zaslon osjetljiv na dodir dizajniran je da se 
može lagano dodirnuti prstom. Nemojte 
snažno pritiskati zaslon ili ga dodirivati 
oštrim predmetima (čavao, kemijska 
olovka, igla itd).
ˎˎ Zaslon osjetljiv na dodir možda neće 
reagirati ako se dodiruje u sljedećim 
okolnostima. Imajte na umu da one mogu 
dovesti do kvara.
ˎˎ 	Upravljanje vrškom prstiju
ˎˎ 	Rad dok drugi predmeti dodiruju 
površinu
ˎˎ 	Rad sa zaštitnom folijom ili naljepnicom
ˎˎ 	Rad kada su na zaslonu prisutne kapi 
vode ili je na zaslonu došlo do pojave 
kondenzacije
ˎˎ 	Rad mokrim ili znojnim prstima

Geste dodirnog zaslona

Dodir
Lagano prstom dodirnite stavku poput ikone ili 
stavke izbornika i zatim odmah maknite prst.

Povlačenje
Dodirnite zaslon i prstom povucite do željenog 
položaja zaslona te zatim maknite prst.

Pomicanje
Dodirnite zaslon i brzo pomaknite prstom 
prema gore, dolje, lijevo ili desno.

[Savjet]
Ako se sadržaj zaslona prikazuje i preko rubova zaslona, 
možete povući ili pomaknuti sadržaj zaslona.

Konfiguracija zaslona osjetljivog 
na dodir

Rad zaslona osjetljivog na dodir može se 
omogućiti/onemogućiti s pomoću funkcije 
Touch Operation (stranica 93) u izborniku 
Technical.
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Zaslonski prikaz
Tijekom snimanja (snimanje/pripravnost) i reprodukcije status i postavke videokamere polažu se 
na sliku prikazanu na tražilu.
Informacije možete prikazati/sakriti gumbom DISPLAY. Čak i kada je skriven, prikazat će se 
tijekom rada izravnog izbornika (stranica 48).
Također možete odabrati pojedinačno prikazivanje/sakrivanje svake stavke (stranica 87).

Informacije koje se prikazuju na zaslonu tijekom snimanja

3 42

6
8

9 1075

11
12

13
14

15
16
17

18 19 20 21 22 23 24 25 26 27 28

29

30
31
32
33
34
35
36

1

1.	 Indikator statusa mreže (stranica 13)
Prikaz statusa povezanosti s mrežom u obliku 
ikone.

2.	 Indikator prijenosa/indikator preostalih 
datoteka (stranica 61)

3.	 Indikator područja fokusiranja (stranica 37)
Prikaz područja fokusa za automatsko fokusiranje.

4.	 Način snimanja, utor A/B, indikator 
intervala snimanja Interval Rec 
(stranica 49)

Display Značenje

Rec Recording (Način 
snimanja u 5 sekundi)

Stby Pripravnost za 
snimanje

5.	 Indikator dubine polja

6.	 Indikator načina skeniranja pretražnika 
(stranica 24)

Ako postoji nepodudaranje veličine kruga 
slike objektiva i postavke načina skeniranja 
pretražnika za efektivnu veličinu slike, 
prikazuje se oznaka .
Kada je funkcija Imager Scan Mode 
postavljena na FF, oznaka „C” prikazuje se u 
načinima s užim kutom gledanja (izrezano).
Do rezanja dolazi u sljedećim načinima.
ˎˎ Kada je format snimanja 3840×2160 i broj 
sličica u sekundi za snimanje u načinu S&Q 
Motion 100 fps ili 120 fps
ˎˎ Kada je funkcija Codec postavljena na RAW ili 
RAW & XAVC-I i izlazni RAW format je 3840×2160.

7.	 Indikator statusa izlaza za RAW 
(stranica 55)

Prikaz statusa izlaza RAW signala.

8.	 Indikator statusa serije UWP-D 
(stranica 13)

Prikaz jačine signala razine RF ikonom kada 
je uređaj serije UWP-D povezan s nosačem 
za više sučelja konfiguriranim za digitalni 
prijenos zvuka.

9.	 Indikator broja sličica u sekundi za 
snimanje za Slow & Quick Motion 
(stranica 49)

10.	Indikator preostalog kapaciteta baterije/
napona na DC IN (stranica 17)

11.	 Indikator načina izoštravanja 
(stranica 41)

Značenje Display
Način Focus Hold Focus Hold

Način MF MF

Način AF AF

Način Face/eye detection AF (AF/ /Only/ / )

Ikona otkrivanja 
lica/oka

Ikona otkrivanja lica/
oka pri automatskom 
fokusiranju

Only

Ikona registriranog 
lica

 

Ikona pauziranja 
automatskog 
fokusiranja tijekom 
otkrivanja lica/oka 
pri automatskom 
fokusiranju1)

1)	 Prikazuje se kada nema registriranog lica i ne 
pronalazi se lice, ili kada postoji registrirano lice koje 
se ne pronalazi.

12.	Indikator položaja zuma (stranica 36)
Prikazuje položaj zuma u rasponu od 0 (široki 
kut) do 99 (telefoto) (ako je postavljen objektiv 
koji podržava prikaz postavke zuma).
Prikaz je moguće promijeniti u indikator 
s trakama ili indikator udaljenosti fokusa 
(stranica 94).

Sljedeće stavke dodane su na prikaz kada je 
omogućena funkcija zuma za jasnu sliku.

Display Značenje
Omogućena je funkcija zuma 
za jasnu sliku

Vrijednost 
povećavanja

Tijekom primjene funkcije 
zuma za jasnu sliku

13.	Indikator načina stabilizacije slike

14.	Indikator statusa funkcije Rec Control na 
izlazu (stranica 106)

Prikaz statusa izlaza kontrolnog signala REC.

15.	Indikator fokusiranja (stranica 40)

16.	Indikator preostalog kapaciteta medija

17.	 Indikator načina za balans bijele boje

Display Značenje
Automatski način

 Hold Automatski način je pauziran

W:P Unaprijed postavljeni način

W:A Način Memory A

W:B Način za Memory B

18.	Prikaz podataka o indikatoru/vremenu 
vanjskog zaključavanja vremenskog koda 
(stranica 34)

Prikaz "EXT-LK" kada je zaključano na 
vremenski kod vanjskog uređaja.

19.	Indikator filtra ND (stranica 43)

20.	Indikator datoteke kadra (stranica 105)

21.	Indikator irisa
Prikaz položaja irisa (F vrijednost) (ako je 
postavljen objektiv koji podržava funkciju 
prikaza irisa).

22.	Indikator upozorenja na razinu 
videozapisa

23.	Indikator pojačanja signala (stranica 42)
Prikazuje EI vrijednost kada je u načinu Cine EI 
(stranica 24).
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Display Značenje
Automatski način

H Način Preset H

M Način Preset M

L Način Preset L

Način za privremeno 
podešavanje

24.	Prikaz naziva isječka (stranica 63)

25.	Indikator zatvarača (stranica 43)

26.	Indikator načina AE /razine AE 
(stranica 42)

27.	Indikator libele
Prikaz vodoravne razine do ±15° u koracima 
od ±1°.

28.	Mjerač razine zvuka
Prikaz razine zvuka na CH1 i CH2.
CH3 i CH4 mogu se pratiti na zaslonu statusa.

29.	Nadzor videosignala (stranica 50)
Prikaz valnog oblika, vektroskopa i histograma.
Narančasta linija prikazuje postavljenu 
vrijednost funkcije zebra.
U načinu Cine EI (stranica 24) prikazuje vrstu 
LUT signala koji se prati.

30.	Indikator osnovne osjetljivosti/indikator 
osnovnog ISO (stranica 42)

U načinu Custom (stranica 24) prikazuje 
postavljenu temeljnu osjetljivost s pomoću 
funkcije ISO/Gain/EI na zaslonu Main Status 
ili ISO/Gain/EI>Base Sensitivity u izborniku 
Shooting cijelog izbornika.
U načinu Cine EI (stranica 24) prikazuje 
postavljenu temeljnu ISO osjetljivost s pomoću 
funkcije ISO/Gain/EI na zaslonu Main Status 
ili ISO/Gain/EI>Base ISO u izborniku Shooting 
cijelog izbornika.

31.	Indikator pomoćnog prikaza game/LUT 
monitora

Prikaz statusa pomoćne funkcije prikaza 
game. Pomoćnu funkciju prikaza game 
moguće je uključiti/isključiti dodjelom funkcije 
Gamma Display Assist dodjeljivom gumbu 
(stranica 48).
U načinu Cine EI (stranica 24) prikazuje 
postavku LUT monitor(stranica 76).

32.	Indikator osnovnog izgleda 
(stranica 52)

Prikazuje postavku temeljnog izgleda.
U načinu Cine EI (stranica 24) prikazuje 
LUT postavku za snimanje videozapisa na 
memorijske kartice (stranica 76).

33.	Indikator statusa videozapisa proxy

34.	Indikator formata snimanja (kodek) 
(stranica 77)

Prikaz naziva formata za snimanje na 
memorijske kartice.

35.	Indikator formata snimanja (broj sličica u 
sekundi i metoda skeniranja)

36.	Indikator formata snimanja (veličina slike) 
(stranica 77)

Prikaz veličine slike za snimanje na 
memorijske kartice.

Informacije koje se prikazuju na zaslonu tijekom reprodukcije

Sljedeće informacije polažu se na sliku reprodukcije.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1.	 Indikator statusa mreže

2.	 Indikator prijenosa/indikator preostalih 
datoteka

3.	 Broj isječka/ukupan broj isječaka

4.	 Indikator stanja reprodukcije

5.	 Indikator formata reprodukcije (broj 
sličica u sekundi i metoda skeniranja)

6.	 Indikator formata reprodukcije 
(veličina slike)

7.	 Indikator preostalog kapaciteta baterije/
napona na DC IN

8.	 Indikator formata reprodukcije (kodek)

9.	 Indikator medija
Ako je memorijska kartica zaštićena od 
prepisivanja pojavljuje se ikona .

10.	Prikaz podataka o vremenu

11.	Prikaz naziva isječka

12.	Indikator pomoćnog prikaza game

13.	Mjerač razine zvuka
Prikaz razine zvuka reprodukcije.

14.	Indikator temeljnog izgleda
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Prikaz ikona

Prikaz ikona za mrežnu vezu

Mrežni način rada Status veze Icon
Način za pristupnu točku Radi kao pristupna točka

Pogreška rada pristupne točke

Način za stanicu Wi-Fi veza
Ikona se mijenja ovisno o jačini signala 
(četiri koraka)

   

Wi-Fi je odspojen (uključujući i tijekom 
uspostavljanja veze)

Pogreška veze Wi-Fi

Dijeljenje putem USB-a Spojeno dijeljenje putem USB-a

Odspojeno dijeljenje putem USB-a

Pogreška kod dijeljenja putem USB-a

Prikaz ikone za seriju UWP-D

Status odašiljača Status primanja Icon
Isključeno Nema primanja

Status normalnog odašiljanja Receiving

 –   
(razina prijema (četiri koraka))

Status prigušenja Prijem (prigušen)

Status upozorenja za preostali kapacitet 
baterije

Receiving
 (ikona treperi)

Status upozorenja za prigušenje i 
preostali kapacitet baterije

Receiving

 (ikona treperi)

Zaslon statusa

Postavke i status videokamere možete 
provjeriti na zaslonu statusa. Postavke stavki 
označenih zvjezdicom (*) mogu se promijeniti.
Zaslon statusa podržava rad dodirom.

Prikaz zaslona statusa
ˎˎ Pritisnite tipku MENU.

Za prebacivanje zaslona statusa
ˎˎ Okrečite višenamjenski kotačić.
ˎˎ Pritisnite višestruki birač prema gore/dolje.
ˎˎ Povucite zaslon statusa prema gore/dolje.

Sakrivanje zaslona statusa
ˎˎ Pritisnite tipku MENU.

Za promjenu postavke
Kada se prikazuje zaslon statusa, pritisnite 
višenamjenski kotačić ili višestruki birač za 
omogućavanje odabira stavke za postavljanje 
na stranici. Odaberite broj stranice i zatim 
pritisnite za prebacivanje stranica.
Možete odabrati stavke i izravno 
s pomoću rada dodirom.

[Napomena]
Možete onemogućiti promjene na zaslonu statusa 
postavljanjem funkcije Menu Settings >User Menu Only 
(stranica 93) u izborniku Technical cijelog izbornika 
na On.

Zaslon Main Status

Prikaz glavnih funkcija kamere i slobodnog 
prostora na mediju.

Stavka prikaza Opis
S&Q Frame Rate Postavka broja sličica 

u sekundi za snimanje 
Slow & Quick Motion

Frequency/Scan* Frekvencija sustava i 
postavke metode skeniranja

Imager Scan* Način skeniranja slikovnog 
senzora

Media Remain 
(A)

Preostali slobodan prostor 
na mediju u utoru A

ND Filter Postavka filtra ND

ISO/Gain/EI Postavke za ISO/Gain/
Exposure Index

Base ISO/
Sensitivity*

Postavka za Base ISO/Base 
Sensitivity

Codec* Postavka kodeka za 
snimanje

Media Remain (B) Preostali slobodan prostor 
na mediju u utoru B

Scene File* Datoteka kadra koja se 
primjenjuje i njene postavke 
za File ID

Base Look/LUT* Postavka za Monitor LUT

Shutter Postavka brzine zatvarača ili 
kut zatvarača

Blenda Postavka irisa

Video Format* Veličina slike za snimanje na 
memorijske kartice

RAW Output 
Format*

Veličina slike za RAW izlaz

White Balance Postavka balansa bijele boje
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Zaslon Camera Status

Prikazuje status različitih unaprijed 
postavljenih postavki kamere.

Stavka prikaza Opis
White Switch<B> Postavka B memorije 

balansa bijele boje

White Switch<A> Postavka A memorije 
balansa bijele boje

White Switch<P> Postavka Preset White

ND<Preset> Postavke Preset1 do 3 za 
filtar ND

ISO / Gain<L>* Postavka za ISO/Gain<L>

ISO / Gain<M>* Postavka za ISO/Gain<M>

ISO / Gain<H>* Postavka za ISO/Gain<H>

Base ISO/
Sensitivity*

Postavka za Base ISO/Base 
Sensitivity

Zebra1 Postavka On/Off i razina 
funkcije Zebra1

Zebra2 Postavka On/Off i razina 
funkcije Zebra2

VF Gamma/
Gamma

Kategorija i krivulja game

Scene File* Datoteka kadra koja se 
primjenjuje i njene postavke 
za File ID

Zaslon Audio Status

Prikaz ulazne postavke, mjerača razine zvuka i 
postavke monitora glasnoće za svaki kanal.

Stavka prikaza Opis
CH1 Level 

Control
Automatsko namještanje 
statusa uključeno/isključeno

Level Meter Mjerač razine zvuka

Source* Ulazni izvor

Ref./Sens.* Referentna razina unosa

Wind 
Filter*

Postavka filtra za smanjenje 
šuma zbog vjetra na mikrofonu

CH2 Level 
Control

Automatsko namještanje 
statusa uključeno/isključeno

Level Meter Mjerač razine zvuka

Source* Ulazni izvor

Ref./Sens.* Referentna razina unosa

Wind 
Filter*

Postavka filtra za smanjenje 
šuma zbog vjetra na mikrofonu

CH3 Level 
Control*

Automatsko namještanje 
statusa uključeno/isključeno

Level Meter* Mjerač razine zvuka

Source* Ulazni izvor

Ref./Sens.* Referentna razina unosa

Wind 
Filter*

Postavka filtra za smanjenje 
šuma zbog vjetra na mikrofonu

CH4 Level 
Control*

Automatsko namještanje 
statusa uključeno/isključeno

Level Meter* Mjerač razine zvuka

Source* Ulazni izvor

Ref./Sens.* Referentna razina unosa

Wind 
Filter*

Postavka filtra za smanjenje 
šuma zbog vjetra na mikrofonu

Audio Input 
Level*

Postavka razine ulaza zvuka 
(glavna jačina zvuka)

HDMI Output CH* Postavka kanala za izlaz 
zvuka za HDMI

Jačina zvuka* Postavka glasnoće slušalica 
/ ugrađenog zvučnika

Monitor CH* Postavka kanala za monitor

Zaslon Project status

Prikaz osnovnih postavki povezanih 
s projektom snimanja.

Stavka prikaza Opis

Frequency/Scan* Frekvencija sustava i 
postavke metode skeniranja

Codec* Postavka kodeka za 
snimanje

Rec Function Format i postavke 
omogućenog posebnog 
formata snimanja

Simul Rec* Status On/Off funkcije 
istovremenog snimanja 
u dva utora

Title Prefix Naslovni dio naziva isječka

Imager Scan* Način skeniranja slikovnog 
senzora

Format 
videozapisa*

Veličina slike za snimanje 
na memorijske kartice

Number Brojčani sufiks naziva isječka

Režim snimanja* Postavka načina za snimanje

RAW Output 
Format*

Veličina slike za RAW izlaz

Proxy Rec* Status On/Off i postavka 
funkcije snimanja 
videozapisa proxy

Zaslon Monitoring Status

Prikaz postavki izlaza za SDI i HDMI.

Stavka prikaza Opis
SDI Signal* Veličina izlazne slike

Info. 
Disp.*

Postavka uključivanja/
isključivanja zaslona 
Output Display

Color 
Gamut*

Postavka prostora boje/
status LUT monitora

HDMI Signal* Veličina izlazne slike

Info. 
Disp.*

Postavka uključivanja/
isključivanja zaslona 
Output Display

Color 
Gamut*

Postavka prostora boje/
status LUT monitora

Emitira-
nje

Signal Veličina izlazne slike

Info. 
Zaslon

Zaslon Output display 
(Isključeno (fiksno))

Color 
Gamut*

Postavka prostora boje/
status LUT monitora

VF Color 
Gamut*

Postavka funkcije Gamma 
Display Assist / Postavka 
prostora boja / Status LUT 
monitora

Base Look/LUT* Postavka Base Look/LUT

Gamma Display 
Assist*

Postavka uključivanja/
isključivanja funkcije 
Gamma Display Assist
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Zaslon Assignable Button Status

Prikaz funkcija dodijeljenih svakome od 
dodjeljivih gumba.

Stavka prikaza Opis
1 Funkcija dodijeljena gumbu 

ASSIGN 1

2 Funkcija dodijeljena gumbu 
ASSIGN 2

3 Funkcija dodijeljena gumbu 
ASSIGN 3

4 Funkcija dodijeljena gumbu 
ASSIGN 4

5 Funkcija dodijeljena gumbu 
ASSIGN 5

6 Funkcija dodijeljena gumbu 
ASSIGN 6

7 Funkcija dodijeljena gumbu 
ASSIGN 7

8 Funkcija dodijeljena gumbu 
ASSIGN 8

9 Funkcija dodijeljena gumbu 
ASSIGN 9

Gumb Zadrž. 
izošt.

Funkcija dodijeljena gumbu 
Focus Hold na objektivu

Multi Function 
Dial

Funkcija dodijeljena 
višenamjenskom kotačiću

Kotačić na drški Funkcija dodijeljena 
dodjeljivom kotačiću 
na drški

Kotačić na ručki Funkcija dodijeljena 
dodjeljivom kotačiću 
na ručki

Zaslon Battery Status

Prikaz informacija o bateriji i izvoru na DC IN.

Stavka prikaza Opis
Detected Battery Vrsta baterije

Remaining Preostali kapacitet (%)

Charge Count Broj ponovnih punjenja

Kapacitet Preostali kapacitet (Ah)

Napon Napon baterije (V)

Manufacture 
Date

Datum proizvodnje baterije

Video Light 
Remaining

Prikaz preostalog kapaciteta 
baterije svjetla za 
videozapis.

Power Source Izvor električnog napajanja

Supplied Voltage Napon izvora napajanja

Zaslon Media Status

Prikaz preostalog kapaciteta i preostalog 
vremena snimanja na mediju za snimanje.

Stavka prikaza Opis
Informacije o 
mediju A

Prikaz ikone medija kada je 
medij za snimanje umetnut 
u utor A.

Mjerač 
preostalog 
kapaciteta na 
mediju A

Prikaz preostalog kapaciteta 
medija za snimanje umetnutog 
u utor A u obliku postotka ili 
stupčastog grafikona.

Preostalo vrijeme 
snimanja na 
mediju A

Prikaz procjene preostalog 
vremena snimanja, pod 
trenutačnim uvjetima, 
na mediju za snimanje 
umetnutom u utor 
A u minutama.

Informacije o 
mediju B

Prikaz ikone medija kada je 
medij za snimanje umetnut 
u utor B.

Mjerač 
preostalog 
kapaciteta na 
mediju B

Prikaz preostalog kapaciteta 
medija za snimanje 
umetnutog u utor B u obliku 
postotka ili stupčastog 
grafikona.

Preostalo vrijeme 
snimanja na 
mediju B

Prikaz procjene preostalog 
vremena snimanja, pod 
trenutačnim uvjetima, 
na mediju za snimanje 
umetnutom u utor 
B u minutama.

Zaslon Network Status

Prikaz statusa mrežne veze.

Stavka prikaza Opis
Bežični LAN Postavke i status veze 

s bežičnom mrežom

Wired LAN Postavke i status veze 
sa žičnom mrežom LAN

Modem Postavke bežične mreže 
i status veze dijeljenja 
putem USB-a

Zaslon File Transfer Status

Prikaz informacija o prijenosu datoteka.

Stavka prikaza Opis
Auto Upload 
(Proxy)

Status On/Off funkcije Auto 
Upload (Proxy)

Job Status 
(Remain / Total)

Broj preostalih zadataka 
i ukupan broj zadataka

Total Transfer 
Progress

Napredak prijenosa svih 
zadataka

Default Upload 
Server

Naziv odredišnog poslužitelja 
za Auto Upload (Proxy)

Current File 
Transfer Progress

Napredak prijenosa 
trenutačne datoteke

Current 
Transferring 
File Name

Naziv trenutačno prenošene 
datoteke

Server Address Adresa odredišnog 
poslužitelja za prijenos 
datoteke

Destination 
Directory

Odredišna mapa na 
odredišnom poslužitelju 
za prijenos datoteke
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Upotreba zaslona s postavkama na dodir

Raspored na zaslonu

Stavka

Oznaka koja označava 
trenutačnu postavku

Gumb Set (primjena)

Pokazivač za odabir postavke 
(narančasti okvir)

Naziv stavke

Opcije za odabir

Operation

1	 Dodirnite stavku za postavljanje.

Dodir

Pojavljuju se opcije odabira za vrijednost.

2	 Dodirnite ili povucite postavku za odabir 
vrijednosti.

Pomicanje

3	 Dodirnite gumb Set ili pokazivač za odabir 
vrijednosti.
Vrijednost je primijenjena i prikaz se vraća 
na prethodni zaslon.

[Savjeti]
ˎˎ Pritisnite gumb CANCEL/BACK  za povratak na 

prethodnu vrijednost.
ˎˎ Možete upotrijebiti višenamjenski kotačić ili 

višestruki birač.
ˎˎ Može se onemogućiti i rad dodirom (stranica 93).
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Izvor napajanja
Možete upotrebljavati komplet baterija 
ili izmjenično napajanje adapterom 
za izmjeničnu struju.
Iz sigurnosnih razloga upotrebljavajte samo 
komplete baterija i adaptere izmjeničnu struju 
tvrtke Sony navedene u nastavku.

Litij-ionski kompleti baterija
BP-U35 (priloženo)
BP-U60
BP-U60T
BP-U70
BP-U90
BP-U100

Punjači baterija
BC-CU1 (priloženo)
BC-U1A
BC-U2A

Adapter za izmjeničnu struju (priložen)
[OPREZ]

Komplete baterija nemojte pohranjivati 
na lokacijama izloženima izravnoj sunčevoj 
svjetlosti, plamenu ili visokoj temperaturi.

[Napomene]
ˎˎ Za napajanje iz izmjeničnog izvora upotrebljavajte 

priloženi adapter za izmjeničnu struju.
ˎˎ Prije priključenja baterije ili adaptera za izmjeničnu 

struju sklopku POWER obavezno postavite na Off. 
Ako priključite sa sklopkom POWER u položaju On, 
u nekim slučajevima moguće je da se videokamera 
ne može pokrenuti. Ako videokameru nije moguće 
pokrenuti, sklopku POWER postavite u položaj 
Off i privremeno odspojite bateriju ili adapter za 
izmjeničnu struju te pričekajte oko 30 sekundi prije 
ponovnog priključenja. (Ako je adapter za izmjeničnu 
struju priključen dok se videokamera pogoni 
kompletom baterija, bez problema se priključuje 
sa sklopkom POWER u položaju On).

Upotreba kompleta baterija

Za postavljanje kompleta baterija umetnite 
ga do kraja u nastavak (stranica 7), a zatim 
povucite dolje kako bi se pričvrstio.

Za uklanjanje kompleta baterija pritisnite 
i zadržite gumb BATT RELEASE (stranica 7), 
pomaknite ga prema gore i zatim izvucite 
iz nastavka.

Gumb BATT 
RELEASE

[Napomene]
ˎˎ Prije postavljanja kompleta baterija napunite bateriju 

s pomoću odgovarajućeg punjača za baterije BC‑CU1, 
BC-U1A ili BC‑U2A.
ˎˎ Ako komplet baterija punite dok je topao (primjerice 

odmah nakon upotrebe) možda nećete u potpunosti 
moći napuniti bateriju.

Provjera preostalog kapaciteta

Pri snimanju/reprodukciji s kompletom 
baterija preostali kapacitet baterije prikazuje 
se u tražilu (stranica 11).

Icon Značenje
od 91 % do 100 %

od 71 % do 90 %

od 51 % do 70 %

od 31 % do 50 %

od 11 % do 30 %

od 0 % do 10 %

Videokamera prikazuje preostali kapacitet 
izračunavajući vrijeme dostupno s kompletom 
baterija za nastavak rada s trenutačnom 
potrošnjom energije.

Ako je napunjenost kompleta baterija 
niska

Ako preostala napunjenost baterije padne 
ispod određene razine tijekom rada (stanje 
Low Battery), prikazuje se poruka o niskoj 
razini napunjenosti baterije i lampica 
snimanja/signalizacije počinje treperiti kao 
upozorenje.
Ako preostala napunjenost baterije padne 
ispod razine na kojoj je moguć nastavak rada 
(stanje Battery Empty), prikazuje se poruka o 
praznoj bateriji.
Zamijenite napunjenim kompletom baterija.

Promjena razina upozorenja

Tvornički je razina Low Battery postavljena je 
10 %, a razina Battery Empty na 3 % napunjene 
baterije. Postavke razine upozorenja moguće 
je promijeniti s pomoću funkcije Camera 
Battery Alarm (stranica 94) u izborniku 
Technical cijelog izbornika.

Za promjenu kompleta baterija s pomoću 
priloženog punjača za baterije (BC-CU1)

1	 Adapter za izmjeničnu struju (priložen) priključite 
na punjač za baterije, a kabel napajanja 
(priložen) na izvor izmjeničnog napajanja.

2	 Gurnite bateriju unutra i povucite je u 
smjeru strelice.
Žaruljica punjenja CHARGE svijetli 
narančasto i punjenje započinje.

Žaruljica punjenja CHARGE

Adapter za izmjeničnu struju

Kabel za napajanje

Žaruljica punjenja CHARGE (narančasto)
Svijetli:�Punjenje
Treperi:�greška s punjenjem ili temperatura 

premašuje raspon radne temperature 
i punjenje je pauzirano

ˎˎ Kada je u potpunosti napunjena, žaruljica 
punjenja CHARGE punjača za baterije 
isključuje se.
ˎˎ Uvijek upotrebljavajte originalne baterije 
tvrtke Sony.
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Vrijeme punjenja
Približno vrijeme (minute) potrebne kada 
punite u potpunosti ispražnjen komplet 
baterija.

Baterija Potpuno vrijeme 
punjenja

BP-U35 120 minuta

[Napomena]
Ako je adapter za izmjeničnu struju odspojen od punjača 
za baterije, a baterija je i dalje spojena na punjač za 
baterije, baterija će se početi prazniti.

Upotreba izmjeničnog napajanja

Priključenje videokamere na izvor izmjeničnog 
napajanja omogućuje upotrebu bez brige 
o ponovnom punjenju kompleta baterija.

Priključnica DC IN

Adapter za izmjeničnu struju

Kabel za 
napajanje

Adapter za izmjeničnu struju priključite na 
priključnicu DC IN na videokameri, a kabel 
napajanja (priložen) na izvor izmjeničnog napajanja.

Ako izlazni napon adaptera za 
izmjeničnu struju postane prenizak

Ako izlazni napon adaptera za izmjeničnu 
struju padne ispod određene razine tijekom 
rada (stanje DC Low Voltage1), prikazuje se 
poruka koja vas obavještava o padu izlaznog 
napona adaptera za izmjeničnu struju i 
lampica snimanja/signalizacije počinje 
treperiti kao upozorenje.
Ako izlazni napon adaptera za izmjeničnu 
struju padne na razinu na kojoj nastavak rada 
nije moguć (stanje DC Low Voltage2), prikazuje 
se poruka koja vas obavještava o preniskom 
izlaznom naponu adaptera za izmjeničnu struju.
Ako se to dogodi, adapter za izmjeničnu struju 
možda je neispravan. Po potrebi pregledajte 
adapter za izmjeničnu struju.

Promjena napona upozorenja

Tvornički je razina DC Low Voltage1 
postavljena na 16,5 V, a razina DC Low 
Voltage2 na 15,5 V. Postavke razine upozorenja 
moguće je promijeniti sa Camera DC IN Alarm 
(stranica 94) u izborniku Technical.

Adapter za izmjeničnu struju

ˎˎ Adapter za izmjeničnu struju nemojte 
upotrebljavati u skučenom prostoru, 
primjerice između zida i namještaja.
ˎˎ Adapter za izmjeničnu struju priključite 
na najbliži izvor izmjeničnog napajanja. 
Ako se tijekom rada pojavi problem. kabel 
napajanja odmah odspojite od izvora 
izmjeničnog napajanja.
ˎˎ Metalne dijelove priključka adaptera za 
izmjeničnu struju nemojte kratko spajati. 
U protivnom će doći do kvara.
ˎˎ Bateriju nije moguće puniti dok se nalazi na 
videokameri, čak i ako je priključen adapter 
za izmjeničnu struju.
ˎˎ Kada odspajate adapter za izmjeničnu struju 
iz jedinice, primite priključak i izvucite ga. 
Povlačenje kabela može dovesti do kvara.
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Postavljanje uređaja

Postavljanje mikrofona (prodaje se 
zasebno)

1	 Stavite mikrofon na stalak za mikrofon.

2	 Spojite kabel mikrofona na priključnicu 
INPUT1 ili INPUT2.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Microphone

Stalak za 
mikrofon

INPUT1 INPUT2

3	 Stavite kabel mikrofona i držač kabela 
kako je prikazano na dijagramu.

Držač kabela

[Savjeti]
ˎˎ Ako ne možete sigurno spojiti mikrofon, upotrijebite 

fiksator koji ste dobili s mikrofonom.
ˎˎ Ovisno o vrsti postavljenog objektiva, vrh mikrofona 

može biti vidljiv na slici videokamere. Namjestite 
položaj mikrofona.

Postavljanje tražila

[Napomena]
Tražilo postavite/uklonite dok je videokamera isključena.

Postavljanje tražila na prednju stranu 
držača

1	 Umetnite adapter stezaljke za montiranje 
tražila na mjesto za postavljanje tražila na 
držač () i okrenite vijak (priložen) 
u smjeru kazaljke na satu kako biste 
ga pričvrstili na mjesto ().
Adapter stezaljke za montiranje može 
se slobodno postaviti u jedinicama pod 
kutom od 45°, ali preporučuje se položaj 
u kojemu je točka postavljanja odmah 
iznad vijka.

Vijak
Adapter stezaljke za 
montiranje tražila

2	 Postavite stezaljku tražila na adapter 
stezaljke za montiranje tražila () i 
okrenite ručicu za zaključavanje u smjeru 
kazaljke na satu kako biste je pričvrstili na 
mjesto ().

[Napomena]
Obavezno dobro zategnite ručicu za zaključavanje 
tijekom upotrebe tražila. Tražilo može pasti ako ručica 
za zaključavanje nije dobro zategnuta.

3	 Poravnajte oznaku  na videokameri 
s oznakom  na priključnici za tražilo 
i umetnite kabel.
Provjerite je li oznaka  na vanjskoj strani 
prije umetanja priključnice.

4	 Stavite kabel i držač kabela kako je 
prikazano na dijagramu.

Držač kabela
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Postavljanje tražila na stražnju stranu 
držača

Na stražnjoj strani držača () i stražnjoj strani 
videokamere () za postoje dvije točke za 
postavljanje tražila. Postavite tražilo na isti 
način koji je opisan u odjeljku „Postavljanje 
tražila na prednju stranu držača”.

Podešavanje položaja tražila

Nagnite tražilo prema gore/dolje/naprijed/
natrag za namještanje kuta tražila.
Sklopku MIRROR možete upotrijebiti da, 
primjerice, okrenete sliku kada je gledate 
s prednje strane videokamere.

[Savjet]
Kada se jedinica ne upotrebljava ili se prenosi, 
preporučuje se da se tražilo pomakne na položaj 
prikazan na sljedećem dijagramu kako biste ga zaštitili.

Uklanjanje tražila

Olabavite ručicu za zaključavanje tražila 
i obrnuto ponovite postupak postavljanja 
tražila.

Postavljanje poklopca tražila

Otvorite metalne kopče na poklopcu tražila. 

5	 Postavite metalnu kopču na vrhu 
poklopca tražila na kuku na vrhu tražila 
i postavite metalnu kopču na dnu 
poklopca tražila na dno tražila.

Pričvrsne kuke

6	 Gurnite ploču za zaključavanje poklopca 
tražila u smjeru strelice kako biste 
zaključali poklopac tražila u položaj.

Ploča za 
blokiranje

Otvaranje poklopca tražila

Povucite donju sredinu poklopca tražila prema 
sebi i povucite kako biste otvorili poklopac.

[Napomena]
Kada pomičete tražilo, držite tijelo tražila i zatim 
ga pomaknite. Nemojte držati poklopac tražila.

Skidanje poklopca tražila

Otvorite poklopca tražila i skinite poklopac 
tražila s tražila.

Postavljanje daljinskog upravljača 
na drški

[Napomena]
Daljinski upravljač na drški postavite/uklonite 
dok je videokamera isključena.

1	 Spojite kabel na priključnicu daljinskog 
upravljača na drški.
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2	 Poravnajte daljinski upravljač na drški 
videokamere i montirajte oznaku za 
postavljanje na dršku (), postavite dršku 
na videokameru i polako je okrenite u 
smjeru suprotnom od kazaljke na satu ().
Čut ćete škljocaj kada sjedne na mjesto.
Oznaka za postavljanje

[Napomena]
Ako ga ne možete ispravno postaviti, ponovno ga 
postavite bez primjene velike sile na daljinski upravljač 
na drški ili videokameru.

3	 Umetnite kabel spojen u 2. koraku ispod 
proreza daljinskog upravljača na drški 
kako je prikazano na dijagramu.

[Napomena]
Ako kabel nije stavljen ispod proreza, promjena kuta 
postavljanja drške može dovesti do toga da je na 
kabel primijenjena prevelika sila ili kabel može zapeti u 
mehanizmu okretanja.

Namještanje kuta daljinskog upravljača 
na ručki

Možete namjestiti kut daljinskog upravljača 
na drški u rasponu prikazanom na sljedećem 
dijagramu kako bi odgovarao vašem stilu 
snimanja.

Standardni položaj

Okrenut prema objektivu (najviše 90°)

Okrenut prema stražnjoj strani (najviše 83°)

1	 Pomaknite polugu za okretanje drške 
u položaj prikazan na dijagramu i okrenite 
dršku dok pritišćete polugu.

2	 Maknite prst s poluge za okretanje drške 
pokraj željenog položaja.

3	 Malo pomaknite dršku sve dok ne čujete 
škljocaj koji označava da je drška sjela na 
mjesto.
Kada drška sjedne na mjesto, poluga za 
okretanje drške vraća se u izvorni položaj.

[Napomene]
ˎˎ Nakon promjene položaja uvijek provjerite 

je li drška sjela na mjesto.
ˎˎ Ne možete namjestiti kut izvan raspona za 

namještanje. Nemojte primjenjivati preveliku 
silu tijekom okretanja drške.

Držanje drške (preporučena metoda)

Ne postoje pravila o tome kako držati dršku, 
ali sljedeći primjer prikazuje kako lako rukovati 
drškom.

Kada upotrebljavate gumb ASSIGN 5 ili 
višestruki birač

A: Upravljajte dodjeljivim kotačićem 
na drški s pomoću kažiprsta.
B: Upravljajte višestrukim biračem 
i gumbom ASSIGN 5 s pomoću palca.
C: Čvrsto držite dršku s pomoću srednjeg 
prsta, prstenjaka i malog prsta.
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Kada rukujete zumom

A: Upravljajte polugom zuma s pomoću 
kažiprsta i srednjeg prsta.
B: Čvrsto držite dršku s pomoću palca.
C: Čvrsto držite dršku s pomoću prstenjaka 
i malog prsta.

Skidanje drške

[Napomena]
Kada skidate dršku, stavite videokameru na ravnu 
površinu poput stola.

1	 Odspojite kabel s priključnice za daljinski 
upravljač na drški.

2	 Pritisnite i držite gumb za otpuštanje 
daljinskog upravljača na drški 
videokamere i okrećite dršku u smjeru 
kazaljke na satu sve dok se ne odspoji.

Gumb za otpuštanje daljinskog 
upravljača na drški

[Savjet]
Moguće je postaviti rozetu i na točku za postavljanje 
drške na jedinici i na odgovarajuću točku za postavljanje 
na drški.
Obratite se dobavljaču tvrtke Sony u pogledu pojedinosti 
o nabavi rozete.
–– Na videokameri: 4-546-932- (nije obavezno)
–– Na drški: 4-547-089- (nije obavezno)
–– Vijci za pričvršćivanje* 

Na videokameri: 7-627-556- (nije obavezno) 
Na drški: 7-627-556- (nije obavezno)

*	 Za svaku rozetu potrebna su četiri vijka (otvori za vijak 
označeni su krugovima na sljedećem dijagramu). 
Upotreba drugih vijaka osim onih koji su navedeni 
može dovesti do oštećenja vanjske površine.

Na 
videokameri

Na drški

Pričvršćivanje objektiva

[OPREZ]

Leću nemojte ostaviti usmjerenu prema suncu. 
Izravna sunčeva svjetlost može prodrijeti 
kroz leću, fokusirati se u videokameri te 
uzrokovati požar.

[Napomene]
ˎˎ Objektiv postavite/uklonite dok je videokamera 

isključena.
ˎˎ Objektiv je precizna komponenta. Objektiv nemojte 

odlagati na površinu s elementom za montažu 
objektiva okrenutim prema dolje. Postavite isporučeni 
poklopac za element za montažu objektiva.

[Savjet]
Za detalje o objektivima koje podržava videokamera 
obratite se prodajnom predstavniku tvrtke Sony.

Postavljanje objektiva E-mount

1	 Skinite poklopac objektiva s videokamere 
i objektiva.

2	 Poravnajte oznaku za montiranje objektiva 
(bijelo) s videokamerom, pažljivo umetnite 
objektiv i zatim objektiv okrenite u smjeru 
kazaljke na satu.
Čut ćete škljocaj kada sjedne na mjesto.

Oznake za montažu (bijele)

[Napomena]
Nemojte pritiskati tipku za otpuštanje objektiva prilikom 
postavljanja objektiva.

Postavljanje objektiva A-mount

Za primjenu objektiva A-mount postavite 
adapter za postavljanje objektiva (u opciji) 
i zatim postavite objektiv A-mount.

[Napomena]
Kada upotrebljavate objektiv A-mount, iris se postavlja 
ručno, a fokusiranje je postavljeno na MF.

Uklanjanje objektiva

Objektiv uklonite prateći sljedeći postupak.

1	 Pritisnite i držite gumb za otpuštanje 
objektiva i okrenite objektiv u smjeru 
suprotnom od kazaljke na satu dok 
držite objektiv.

2	 Ravnom kretnjom izvucite objektiv.

[Napomene]
ˎˎ Pri uklanjanju objektiva oznaku za postavljanje 

na zabravnom prstenu na objektivu poravnajte 
s oznakom za postavljanje na videokameri.
ˎˎ Rukom čvrsto prihvatite objektiv kako ne bi ispao.
ˎˎ Ako odmah nećete postaviti drugi objektiv, obavezno 

postavite poklopac kućišta.

Podešavanje irisa na objektivima sa 
sklopkom Auto Iris

ˎˎ Kada je funkcija Auto Iris objektiva 
postavljena na AUTO, iris se podešava 
automatski, a moguće je i ručno 
podešavanje na videokameri.
ˎˎ Kada je funkcija Auto Iris objektiva 
postavljena na MANUAL, iris je moguće 
podešavati isključivo prstenom na objektivu. 
Upravljanje irisom na videokameri ne radi.
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Podešavanje fokusa na objektivima 
sa sklopkom za fokusiranje

ˎˎ Kada je prekidač fokusa na objektivu 
postavljen na AF/MF ili AF, fokus se 
podešava automatski, a moguće je 
i ručno podešavanje jedinicom za daljinsko 
upravljanje.
ˎˎ Kada je prekidač fokusa na objektivu 
postavljen na MF, fokus se podešava 
prstenom na objektivu, a moguće 
je i ručno podešavanje jedinicom 
za daljinsko upravljanje.

	 [Napomena]
Kada upotrebljavate objektiva A-mount, ručno 
podešavanje jedinicom za daljinsko upravljanje može 
biti nedostupno.

ˎˎ Kada je prekidač fokusa na objektivu 
postavljen na Full MF, fokus je moguće 
podešavati isključivo prstenom na objektivu. 
Upravljanje fokusom na videokameri ne radi.

Postavljanje na stativ

Za pričvršćenje a stativ iskoristite otvore 
za stativ na videokameri. Postavljanje 
nosača za stativ na objektiv može 
uzrokovati oštećenje.
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Konfiguriranje osnovnih radnji videokamere
Pri prvom uključenju videokamere ili nakon 
potpunog pražnjenja rezervne baterije 
na tražilu se prikazuje zaslon s početnim 
postavkama.
Na tom zaslonu postavite datum i vrijeme 
unutarnjeg sata.

Time Zone
Funkcijom Time Zone postavlja se vremenska 
razlika u odnosu na UTC (koordinirano svjetsko 
vrijeme). Promijenite postavku po potrebi.

Postavljanje datuma i vremena

S pomoću višestrukog birača (stranica 7) 
ili višenamjenskog kotačića (stranica 5) 
odaberite stavke i postavke, zatim pritisnite 
gumb za primjenu višestrukog birača 
ili višenamjenski kotačić za primjenu 
postavki i početak rada sata.
Postavke datuma, vremena i vremenske 
zone nakon zatvaranja zaslona s postavkama 
možete mijenjati sa Clock Set (stranica 99) 
u izborniku Maintenance.

[Napomene]
ˎˎ Ako zbog dugotrajnog nedostatka napajanja (bez 

kompleta baterija i napajanja DC IN) dođe do 
potpunog pražnjenja rezervne baterije i gubitka 
postavki sata, pri sljedećem pokretanju videokamere 
prikazuje se zaslon s početnim postavkama.
ˎˎ Tijekom prikaza zaslona s početnim postavkama 

nijedna druga radnja, osim isključenja napajanja, nije 
dopuštena do dovršetka postavki na ovom zaslonu.
ˎˎ Videokamera ima ugrađenu punjivu bateriju za 

spremanje datuma, vremena i drugih postavki čak i 
kada je videokamera isključena.

Prije snimanja konfigurirajte osnovne radnje 
videokamere na zaslonu Project status kako bi 
odgovarale primjeni.

4/12
Frequency/Scan

59.94P
Imager Scan

FF
Shooting Mode

Custom (709)
Codec

XAVC-I
Video Format

2160P3840
RAW Output Format

- - -
Rec Function

O�
Simul Rec

O�
Proxy Rec

O�
Title Prefix

000_
Number

0001

Project

Način snimanja

Način snimanja možete mijenjati između 
"Custom mode" za prilagodljivo stvaranje 
slika na lokaciji "Cine EI mode" (kada se 
videokamera upotrebljava slično kao filmska 
kamera i materijal se razvija u postprodukciji).
Postavite način snimanja s pomoću funkcije 
Shooting Mode (stranica 14) na zaslonu 
Project status.

[Savjet]
Također možete postaviti način snimanja s pomoću 
funkcije Base Setting >Shooting Mode (stranica 77) na 
izborniku Project cijelog izbornika.

Način Custom

U načinu snimanja Custom možete odabrati 
standard videozapisa.
Standard videozapisa možete postaviti 
s pomoću funkcije Base Setting >Target 
Display (stranica 77) u izborniku Project 
cijelog izbornika.
ˎˎ SDR(BT.709): Snimanje u skladu sa 
standardom za HD emitiranje
ˎˎ HDR(HLG): Snimanje u skladu sa standardom 
sljedeće generacije 4K emitiranja

Pojedinosti potražite u poglavlju 
stranica 52.

Način Cine EI

Kada je način snimanja postavljen na način Cine 
EI, odaberite osnovni prostor boje za signal 
snimanja i izlazni signal. Ovdje odabrani prostor 
boje je prostor boje za videoizlaz kada je 
funkcija MLUT isključena postavljanjem na Off.
Prostor boje možete postaviti s pomoću funkcije 
Cine EI Setting >Color Gamut (stranica 78) u 
izborniku Project cijelog izbornika.
ˎˎ S-Gamut3.Cine/SLog3: Jednostavno 
namještanje skale boje za digitalnu 
kinematografiju (DCI-P3).
ˎˎ S-Gamut3/SLog3: Široka skala boja tvrtke Sony 
koja obuhvaća prostor boje ITU-R BT.2020.

Pojedinosti potražite u poglavlju 
stranica 54.

[Napomene]
ˎˎ Način Cine EI ima sljedeća ograničenja.

ˎˎ Funkcije koje je nemoguće automatski podešavati 
(praćenje)
–– White balance (Podešavanje bijele boje)
–– Razina signala
–– Shutter

ˎˎ Funkcije koje nije moguće konfigurirati
–– ISO sensitivity/gain (postavlja se na temeljnu 

ISO osjetljivost (nepromjenjivo))
–– Postavke izbornika Paint/Look (bez funkcije 

Base Look)
–– Scene File (onemogućeno)

ˎˎ Sljedeće funkcije dostupne su samo u načinu Cine EI 
(stranica 54).

ˎˎ Exposure Index
ˎˎ Monitor LUT

Frekvencija sustava

Postavite frekvenciju sustava s pomoću 
funkcije Frequency/Scan (stranica 14) na 
zaslonu Project status. Ovisno o odabranoj 
vrijednosti, videokamera se nakon promjene 
može automatski ponovno pokrenuti.

[Savjet]
Frekvenciju sustava možete postaviti i s pomoću funkcije 
Rec Format >Frequency (stranica 77) u izborniku 
Project cijelog izbornika.

[Napomena]
Tijekom snimanja ili reprodukcije nije moguće 
promijeniti frekvenciju sustava.

Imager Scan Mode

Moguće je postaviti efektivnu veličinu 
slike i razlučivost slikovnog senzora.
Postavite način skeniranja s pomoću funkcije 
Frequency/Scan (stranica 14) na zaslonu 
Project status.
ˎˎ FF: Veličina punog kadra.
ˎˎ S35: Veličina Super 35mm.

[Savjet]
Način skeniranja možete postaviti i s pomoću funkcije 
Rec Format >Imager Scan Mode (stranica 77) u 
izborniku Project cijelog izbornika.

[Napomene]
ˎˎ Tijekom snimanja ili reprodukcije nije moguće 

promijeniti način skeniranja pretražnika.
ˎˎ Kada je postavljen na S35, format videozapisa 

ograničen je na 1920 x 1080.

Kodek

Postavite kodek s pomoću funkcije Codec 
(stranica 14) na zaslonu Project status.

[Savjet]
Kodek možete postaviti i s pomoću funkcije Rec Format 
>Codec (stranica 77) u izborniku Project cijelog 
izbornika.

[Napomena]
Tijekom snimanja ili reprodukcije nije moguće 
promijeniti kodek.
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Format videozapisa

Moguće je postaviti format videozapisa 
za snimanje. Postavite format videozapisa 
s pomoću funkcije Video Format 
(stranica 14) na zaslonu Project status.

[Savjet]
Format videozapisa možete postaviti i s pomoću funkcije 
Rec Format >Video Format (stranica 77) u izborniku 
Project cijelog izbornika.

[Napomene]
ˎˎ Tijekom snimanja ili reprodukcije nije moguće 

promijeniti format videozapisa.
ˎˎ Ovisno o postavci formata videozapisa, moguća su 

ograničenja signala s priključnica SDI OUT i HDMI OUT.
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Videokamera snima zvuk i videozapise na memorijske kartice CFexpress Type A (dostupne 
zasebno) ili SDXC memorijske kartice (dostupne zasebno) koje su umetnute u utore za kartice. 
Memorijske kartice upotrebljavaju se i za snimanje proxyja i pohranu/učitavanje postavki, kao 
i tijekom ažuriranja (ažuriranje softvera).

O memorijskim karticama CFexpress Type A

U videokameri upotrebljavajte memorijske kartice Sony CFexpress Type A* “Preporučeni mediji” 
(stranica 27).
Detalje o radu s medijima drugih proizvođača potražite u uputama za rad s medijem ili se 
obratite proizvođaču za informacije.
* �Navedene kao „CFexpress kartice” u ovom dokumentu.

O memorijskim karticama SDXC

U videokameri upotrebljavajte memorijske kartice SDXC* “Preporučeni mediji” (stranica 27).
* �Navedene kao „SD kartice” u ovom dokumentu.

Upotreba memorijskih kartica
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Preporučeni mediji

Zajamčeni radni uvjeti razlikuju se ovisno o postavkama za Rec Format i Recording.
Da: radnja je podržana
Ne: normalan rad nije zajamčen

Format snimanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096 × 2160
Class300

Normalan način 59.94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

24P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

3840 × 2160
Class300

Normalan način 59.94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (60 fps ili manje) 59.94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da



2. Priprema: Upotreba memorijskih kartica28HR

Format snimanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Normalan način 59.94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

24P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (60 fps ili manje) 59.94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

24P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

3840 × 2160
Class300 

Normalan način 59.94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (60 fps ili manje) 59.94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Ne Ne Ne Ne Ne

50P Da Ne Ne Ne Ne Ne Ne Ne

29,97P Da Ne Ne Ne Ne Ne Ne Ne

25P Da Ne Ne Ne Ne Ne Ne Ne

23,98P Da Ne Ne Ne Ne Ne Ne Ne



2. Priprema: Upotreba memorijskih kartica29HR

Format snimanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Normalan način 59.94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (60 fps ili manje) 59.94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (150 fps, 180 fps) 59.94P Da Ne Ne Ne Ne Ne Ne Ne

50P Da Ne Ne Ne Ne Ne Ne Ne

29,97P Da Ne Ne Ne Ne Ne Ne Ne

25P Da Ne Ne Ne Ne Ne Ne Ne

23,98P Da Ne Ne Ne Ne Ne Ne Ne

S&Q (200 fps, 240 fps) 59.94P Da Ne Ne Ne Ne Ne Ne Ne

50P Da Ne Ne Ne Ne Ne Ne Ne

29,97P Da Ne Ne Ne Ne Ne Ne Ne

25P Da Ne Ne Ne Ne Ne Ne Ne

23,98P Da Ne Ne Ne Ne Ne Ne Ne
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Format snimanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840 × 2160
420 

Normalan način 59.94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (60 fps ili manje) 59.94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Ne

1920×1080
HD50

Normalan način 59.94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (60 fps ili manje) 59.94P Da Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da
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Format snimanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150 fps, 180 fps) 59.94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (200 fps, 240 fps) 59.94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

1920×1080
HD35

Normalan način 59.94P Da Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da Da

29,97P Da Da Da Da Da Da Da Da

25P Da Da Da Da Da Da Da Da

23,98P Da Da Da Da Da Da Da Da

S&Q (60 fps ili manje) 59.94P Da Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (150 fps, 180 fps) 59.94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (200 fps, 240 fps) 59.94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Ne Da
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Umetanje memorijske kartice

1	 Otvorite poklopac za medije na dijelu s 
utorima za kartice.

2	 Umetnite memorijsku karticu.
ˎˎ Kod CFexpress kartica naljepnica je 
okrenuta na lijevu stranu.

Oznaka

ˎˎ Kod SD kartica naljepnica je okrenuta 
na desnu stranu s nakošenim rubom 
na dnu.

Nakošeni rub

Indikator pristupa (stranica 6) svijetli 
crveno, a potom postaje zelen kada je 
kartica upotrebljiva.

	 [Napomena]
Ako indikator pristupa neprestano treperi crveno i 
ne postaje zelen, privremeno isključite videokameru 
te skinite i ponovno umetnite memorijsku karticu.

3	 Zatvorite poklopac za medije.

[Napomene]
ˎˎ Memorijska kartica, utor za memorijsku karticu i 

slikovne datoteke na memorijskoj kartici mogu se 
oštetiti ako se kartica pogrešno okrenuta prisilno 
umetne u utor.
ˎˎ Kada snimate na medij umetnut u oba utora A i B za 

CFexpress Type A kartice / SD kartice, umetnite medij 
u oba utora koja se preporučuju za rad s formatom 
snimanja.

Izbacivanje memorijske kartice

Otvorite poklopac za medije na dijelu s 
utorima za kartice i lagano utisnite memorijsku 
karticu kako biste je izbacili.

[Napomene]
ˎˎ Ako se tijekom pristupa memorijskoj kartici isključi 

videokamera ili ukloni memorijska kartica, nije 
moguće zajamčiti cjelovitost podataka na kartici. Svi 
podaci snimljeni na karticu mogu biti odbačeni. Prije 
isključenja videokamere ili uklanjanja memorijske 
kartice obavezno provjerite je li indikator pristupa 
zelen ili isključen.
ˎˎ Kada uklanjate memorijsku karticu odmah nakon 

završetka snimanja, memorijska će kartica možda biti 
vruća, ali to ne znači da je došlo do problema.

Formatiranje (inicijalizacija) 
memorijskih kartica

Ako se umetne neformatirana memorijska 
kartica ili memorijska kartica formatirana 
s različitim specifikacijama, na tražilu se 
prikazuje poruka za formatiranje kartice 
„Media Needs to be Formatted”.

Karticu formatirajte sljedećim postupkom.

1	 Odaberite funkciju Format Media 
(stranica 86) u izborniku TC/Media 
cijelog izbornika.

2	 Odaberite Media(A) (utor A) ili Media(B) 
(utor B), a zatim odaberite metodu 
formatiranja (Full Format ili Quick Format).
Prikazuje se potvrdna poruka.
ˎˎ Full Format: U potpunosti inicijalizira 
medij, uključujući regiju podataka i 
informacije o upravljanju podacima.
ˎˎ Quick Format: Inicijalizira samo podatke 
o upravljanju podacima medija.

3	 Odaberite Execute.
Tijekom postupka formatiranja prikazuje 
se poruka, a indikator pristupa svijetli 
crveno.
Po dovršetku formatiranja prikazuje se 
poruka o dovršetku. Za odbacivanje 
poruke pritisnite višenamjenski kotačić.

[Napomene]
ˎˎ Formatiranjem memorijske kartice brišu se svi podaci, 

uključujući snimljene podatke videozapisa i datoteke 
za postavljanje.
ˎˎ Tijekom izvođenja mogu se pojaviti poruke ovisno 

o trajanju procesa formatiranja.

Ako je formatiranje neuspješno

Memorijske kartice koje videokamera 
ne podržava nije moguće formatirati.
Prikazuje se poruka upozorenja. Pratite upute 
kako biste karticu zamijenili podržanom 
memorijskom karticom.

Upotreba kartice SD formatirane 
u videokameri u utoru drugog uređaja

Prvo napravite rezervnu kopiju kartice, a zatim 
ponovno formatirajte karticu uređaju u kojem 
je želite upotrebljavati.

Provjera preostalog vremena za 
snimanje

Tijekom snimanja (snimanje/pripravnost) 
možete pratiti preostali kapacitet memorijske 
kartice u svakom utoru s pomoću indikatora 
preostalog medija u utoru A/B na tražilu 
(stranica 11).
Preostalo vrijeme za snimanje izračunava 
se iz preostalog kapaciteta medija u svakom 
utoru i trenutačnog formata videozapisa 
(brzina snimanja u bitovima), a prikazuje 
se u minutama.

Vrijeme zamjene memorijske kartice

ˎˎ Kada ukupno preostalo vrijeme za snimanje 
na obje memorijske kartice postane kraće 
od 5 minuta, prikazuje se poruka „Media 
Near Full”, lampica snimanja/signalizacije 
počinje treperiti i oglašava se zvučni signal 
(izlaz za slušalice) za upozorenje.  
Zamijenite s medijem na kojem je dostupan 
slobodan prostor.
ˎˎ Ako nastavite snimati dok se ukupno 
preostalo vrijeme za snimanje ne smanji 
na nulu, poruka se zamjenjuje s "Media Full" 
i snimanje se zaustavlja.

[Napomena]
Na jednu memorijsku karticu moguće je snimiti do oko 
600 isječaka.
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Oporavljanje memorijskih kartica

Ako zbog bilo kojeg razloga dođe do pogreške 
na memorijskoj kartici, kartica se prije 
upotrebe mora oporaviti.
Kada učitate memorijsku karticu koju treba 
oporaviti, na zaslonu tražila prikazuje se 
poruka s upitom o oporavku.

Oporavljanje kartice

Okrećite višenamjenski kotačić (stranica 5) 
za odabir funkcije Execute, a potom ga 
pritisnite.
Tijekom postupka formatiranja prikazuje 
se poruka i status napretka (%), a indikator 
pristupa svijetli crveno.
Po dovršetku oporavka prikazuje se poruka 
o dovršetku.

Ako je oporavak neuspješan

ˎˎ Memorijske kartice na kojima je došlo do 
pogrešaka u memoriji nije moguće oporaviti. 
Prikazuje se poruka upozorenja. Pratite 
upute za zamjenu memorijske kartice.
ˎˎ Memorijske kartice na kojima je došlo do 
pogrešaka u memoriji možda se mogu 
ponovno upotrijebiti nakon ponovnog 
formatiranja.
ˎˎ U nekim slučajevima neke je isječke moguće 
oporaviti, a neke ne. Oporavljene isječke 
moguće je normalno reproducirati.

[Napomene]
ˎˎ Medije snimljene ovom videokamerom obavezno 

oporavite ovom videokamerom.
ˎˎ Medije snimljene drugim uređajem ili drugom 

verzijom videokamere (čak i istog modela) možda se 
neće moći oporaviti ovom videokamerom.
ˎˎ Isječke kraće od 2 sekunde nije moguće oporaviti.
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Osnovni radni postupak
Osnovno snimanje provodi se po sljedećem 
postupku.

1	 Postavite potrebne uređaje i provjerite 
imate li napajanje.

2	 Umetnite memorijske kartice.

3	 Sklopku POWER postavite u položaj za 
uključivanje.
Uključuje se indikator POWER, a u tražilu 
se prikazuje slika kamere.

4	 Pritisnite gumb za snimanje START/STOP 
(stranica 5).
Uključuje se lampica snimanja/
signalizacije i započinje snimanje.

5	 Za prekid snimanja ponovno pritisnite 
gumb za snimanje START/STOP.
Snimanje se zaustavlja, a videokamera 
prelazi u način STBY (stanje pripravnosti).

[Napomena]
Ako se gumb za snimanje START/STOP pritisne nekoliko 
sekundi nakon uključenja videokamere, lampica 
snimanja/signalizacije uključuje se i prikazuje kako je 
jedinica u stanju za snimanje, no snimanje na medij 
možda se neće provoditi tijekom prvih nekoliko sekundi, 
ovisno o odabranom formatu snimanja.

Prebacivanje između memorijskih 
kartica

Kada su umetnute dvije memorijske kartice, 
pritisnite gumb SLOT SELECT (stranica 6) 
za zamjenu kartica.
Snimanje automatski prelazi na drugu 
memorijsku karticu netom prije smanjenja 
preostalog kapaciteta snimanja prve kartice na 
nulu (prijenosno snimanje). Kada zamijenite 
memorijske kartice, kontinuirano snimanje 
možete nastaviti zamjenom pune memorijske 
kartice s novom memorijskom karticom.

[Napomena]
Memorijske kartice ne možete zamijeniti u načinu za 
reprodukciju. Također, kontinuirana reprodukcija isječka 
koji se nalazi na medijima u utoru A i utoru B nije 
podržana.

Isječci (snimljeni podaci)
Kada zaustavite snimanje, videozapis, 
zvučni zapis i popratni podaci od početka do 
završetka snimanja spremaju se kao jedan 
„isječak” na memorijsku karticu.

Nazivi isječaka
Naziv svakog snimljenog isječka 
videokamerom automatski se dodjeljuje s 
pomoću formata postavljenog u funkciji Clip 
Name Format (stranica 86) izbornika TC/
Media cijelog izbornika.

Maksimalno trajanje isječka
Do šest sati po isječku.
Maksimalno trajanje kontinuiranog snimanje 
jednako je maksimalnom trajanju isječka. 
Ako vrijeme snimanja prekorači maksimalno 
trajanje isječka, automatski se stvara novi 
isječak i snimanje se nastavlja. Novi isječak 
na zaslonu s minijaturama prikazuje se kao 
zasebni isječak.

Tijekom prijenosnog snimanja uzastopno se 
snima više isječaka, no snimanje se zaustavlja 
automatski nakon približno 24 sata.

[Napomene]
ˎˎ Nemojte vaditi memorijsku karticu dok je snimanje 

na nju u tijeku. Pri snimanju možete zamijeniti samo 
memorijsku karticu u utoru s isključenim indikatorom 
pristupa.
ˎˎ Kada se preostali kapacitet memorijske kartice na koju 

se snima smanji na manje od minute, a u drugom 
utoru nalazi se memorijska kartica na koju je moguće 
snimati, prikazuje se poruka o skoroj zamjeni utora 
"Will Switch Slots Soon". Poruka se uklanja nakon 
zamjene utora za memorijsku karticu.
ˎˎ Prijenosno snimanje možda neće raditi ako je 

preostali kapacitet memorijske kartice manji od 
minute. Za ispravno prijenosno snimanje prije 
početka snimanja provjerite je li preostali kapacitet 
memorijske kartice veći od minute.
ˎˎ Videozapise izrađene funkcijom prijenosnog snimanja 

videokamere nije moguće besprijekorno reproducirati 
na videokameri.
ˎˎ Za spajanje videozapisa izrađenog funkcijom 

prijenosnog snimanja videokamere upotrijebite 
softver "Catalyst Browse".

Praćenje zvučnog zapisa

Snimani zvučni zapis možete pratiti 
slušalicama.
Priključite slušalice na priključnicu za slušalice 
(stranica 5) kako biste pratili snimani 
zvučni zapis. Zvučni zapis reprodukcije 
(stranica 64) možete pratiti na ugrađenom 
zvučniku (stranica 6) ili sa slušalicama.
Jačinu zvuka koji pratite možete namjestiti 
s pomoću funkcije Volume (stranica 14) 
na zaslonu Audio Status ili putem funkcije 
Audio Output >Volume (stranica 91) 
u izborniku Audio cijelog izbornika.
Možete odabrati kanal za praćenje putem 
funkcije Monitor CH (stranica 14) na zaslonu 
Audio Status ili putem funkcije Audio Output 
>Monitor CH (stranica 91) u izborniku Audio 
cijelog izbornika.

Određivanje podataka o vremenu

Postavljanje vremenskog koda

Postavite vremenski kod za snimanje 
s pomoću funkcije Timecode (stranica 85) 
u izborniku TC/Media cijelog izbornika.

Postavljanje korisničkih informacija

Snimljenoj slici možete dodati 
osmeroznamenkasti heksadecimalni broj 
kao korisničke informacije. Korisničke 
informacije također možete postaviti na 
trenutačno vrijeme. Postavite pod Users Bit 
(stranica 85) u izborniku TC/Media.

Prikaz podataka o vremenu

Vremenski kod za prikaz postavite pod 
TC Display (stranica 85) >Display Select 
u izborniku TC/Media.
Pritiskom jednog dodjeljivog gumba 
(stranica 48) s dodijeljenom funkcijom 
DURATION/TC/U-BIT zamjenjuje se prikaz 
vremenskog koda, korisničkih informacija 
i trajanja u nizu.

Zamjena uvoza/izvoza vremenskog 
koda

Unos/izvoz vremenskog koda možete 
zamijeniti sa sklopkom za odabir TC IN/OUT 
(stranica 4).
Pojedinosti potražite u poglavlju 
stranica 107.
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Pregled snimke (Rec Review)

Posljednji snimljeni isječak moguće je 
pregledati na zaslonu (pregled snimke).

[Napomena]
Funkcija Rec Review nije podržana ako se format 
videozapisa promijeni nakon snimanja isječka.

Metoda pregleda snimke

Funkciju Rec Review unaprijed dodijelite 
jednom dodjeljivom gumbu.
Po zaustavljanju snimanja pritisnite dodjeljivi 
gumb (stranica 48) kojem je dodijeljena 
funkcija Rec Review. Započinje reprodukcija 
posljednjeg snimljenog isječka.
Isječak se reproducira do završetka, funkcija 
Rec Review se zaustavlja, a videokamera vraća 
se u način STBY (stanje pripravnosti).

Zaustavljanje funkcije Rec Review

Pritisnite dodjeljivi gumb kojem je dodijeljena 
funkcija Rec Review ili pritisnite gumb 
CANCEL/BACK.

Postavke pregleda snimke

Početni položaj reprodukcije postavkom 
za Rec Review (stranica 93) u izborniku 
Technical možete postaviti na jedan od 
sljedećih.
ˎˎ Posljednje tri sekunde isječka
ˎˎ Posljednjih 10 sekundi isječka
ˎˎ Početak isječka

[Savjet]
Ako nakon snimanja više isječaka želite pregledati 
određeni isječak, pritisnite gumb THUMBNAIL kako biste 
prikazali zaslon s minijaturama, a zatim odaberite isječak 
za pokretanje reprodukcije.
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Zum možete namjestiti u skladu s uvjetima 
snimanja.

Kada je postavljen objektiv s električnim 
zumom, zum možete namjestiti s pomoću 
poluge zuma na svakoj strani daljinskog 
upravljača na drški ili ručki. Brzina zuma 
razlikuje se ovisno o pritisku na polugu.
Videokamera je opremljena funkcijom zuma 
koja upotrebljava funkciju obrade signala 
slike pod nazivom Clear Image Zoom. 
Kada je omogućena funkcija Clear Image 
Zoom, zum je podržan čak i kod objektiva 
s fiksnom fokalnom duljinom (glavni). 
Može se upotrebljavati i za proširenje raspona 
izvan optičkog raspona na objektivu s 
električnim zumom.
Maksimalan omjer zuma s pomoću funkcije 
Clear Image Zoom varira ovisno o rezoluciji 
snimanja.
ˎˎ Za rezoluciju snimanja QFHD/4K: 1,5×
ˎˎ Za rezoluciju snimanja HD: 2×

Odabir vrste zuma

Postavite vrstu zumiranja s pomoću funkcije 
Zoom >Zoom Type (stranica 93) u izborniku 
Technical cijelog izbornika.
Vrsta zumiranja varirat će ovisno 
o postavljenom objektivu.

Postavljeni 
objektiv

Postavka vrste zumiranja
Samo 
optički zum

On(Clear 
Image Zoom)

Glavni objektiv / 
objektiv s 
ručnim 
zumiranjem

Nije podržan 
rad zuma 
s pomoću 
poluge.

Funkcija zuma 
za jasnu sliku 
nije podržana.

Objektiv s 
električnim 
zumom

Samo optički 
zum

Podržane su 
funkcije optički 
zum i zum za 
jasnu sliku.

[Napomene]
ˎˎ Funkcija zum za jasnu sliku nije podržana u sljedećim 

slučajevima.
–– Kada je funkcija S&Q Motion >Frame Rate 

(stranica 76) u izborniku Shooting cijelog 
izbornika viša od 60 fps

–– Kada je funkcija Rec Format >Codec (stranica 77) 
u izborniku Project cijelog izbornika postavljena 
na RAW ili na opciju koja uključuje RAW

ˎˎ Rad sklopke za odabir SERVO/MANUAL na objektivu 
ponovno postavlja povećanje funkcije Clear Image 
Zoom na 1×.
ˎˎ Tijekom rada funkcije Clear Image Zoom područje 

izoštravanja postavljeno je na Wide i funkcija Face/
Eye Detection AF je onemogućena.

Postavljanje zumiranja s pomoću ručke

Postavite postavku zumiranja ručkom 
s pomoću funkcije Handle Zoom 
(stranica 93) u izborniku Technical 
cijelog izbornika.

Postavljanje smjera prstena za zum

Na nekim E-mount objektivima smjer rotacije 
prstena za zum može biti obrnut.
Postavite smjer rotacije s pomoću funkcije 
Lens >Zoom Ring Direction (stranica 94) 
u izborniku Technical cijelog izbornika.

Namještanje zuma
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Prilagodba fokusa
Uvjetima snimanja fokus je moguće prilagoditi 
automatski ili ručno.

Ručna prilagodba fokusa 
(Manual Focus)

Za ručno prilagođavanje fokusa sklopku 
FOCUS (stranica 4) postavite u položaj 
"MAN".
To omogućuje ručno prilagođavanje fokusa 
uvjetima snimanja.
Ručno fokusiranje korisno je za sljedeće vrste 
objekata.
ˎˎ Objekti na udaljenoj strani prozora 
prekrivenog kapljicama vode
ˎˎ Objekti sa slabim kontrastom u odnosu 
na pozadinu
ˎˎ Objekti udaljeniji od bliskih objekata

[Savjet]
U sljedećim slučajevima možete upotrebljavati 
i automatsko fokusiranje kada je ručno namještanje 
u glavnom načinu rada.
ˎˎ Kada je osjetljivost na zamjenu objekta pri 

automatskom fokusiranju postavljena na 1 
(Zaključano)
ˎˎ Kada je sklopka FOCUS postavljena na položaj „AF”
ˎˎ Pri radu prstena za fokusiranje (AF Assist, 

stranica 39)

Automatska prilagodba fokusa 
(Auto Focus)

Videokamera primjenjuje AF otkrivanje 
otklona za vrlo brzo fokusiranje te AF kontrast 
za fokusiranje velike točnosti.
Kombinacija ove dvije metode za AF osigurava 
veliku brzinu i visoku točnost automatskog 
fokusiranja.
Za automatsko prilagođavanje fokusa sklopku 
FOCUS (stranica 4) na videokameri 
postavite u položaj „AUTO”. Ako je objektiv 
opremljen sklopkom za odabir fokusiranja, 
postavite je u položaj "AF/MF" ili "AF". Ako 
je sklopka postavljena u položaj "Full MF" ili 
"MF", fokusiranjem objektivom nije moguće 
upravljati na videokameri (stranica 23).

[Savjet]
Kada je funkcija Focus >AF Assist (stranica 75) 
u izborniku Shooting cijelog izbornika uključena s 
On, tijekom automatskog fokusiranja i dalje je moguće 
namještati fokus prstenom za fokusiranje na objektivu.

[Napomene]
ˎˎ Potreban je objektiv koji podržava automatsko 

fokusiranje.
ˎˎ Ovisno o uvjetima snimanja, možda nije moguće 

postići točnost.
ˎˎ Na objektivu A-mount fokus je nemoguće podešavati 

automatski.

Postavljanje područja/položaj 
automatskog fokusiranja (Focus Area)

Možete postaviti ciljno područje za 
automatsko fokusiranje s pomoću funkcije 
Focus >Focus Area (stranica 75) u izborniku 
Shooting cijelog izbornika.

Fleksibilni spot:
fokusiranje u određenu točku na slici.
Kada je odabrana, odredite položaj s pomoću 
višestrukog birača (stranica 7).
Možete se vratiti u središnji položaj pritiskom 
i držanjem višestrukog birača.

Zone:
automatski pretražuje položaj za fokusiranje 
unutar određene zone.
Kada je odabrana, odredite položaj s pomoću 
višestrukog birača (stranica 7).
Možete se vratiti u središnji položaj pritiskom 
i držanjem višestrukog birača.

Široko:
pri fokusiranju traži objekt kroz široki kut slike. 
Okvir se ne prikazuje.

[Savjet]
Istu radnju podržava dodjeljivi gumb (stranica 48) 
kojem je dodijeljena funkcija Focus Area.
Možete prikazati/sakriti okvir područja fokusiranja s 
pomoću funkcije Display On/Off >Focus Area Indicator 
(stranica 87) u izborniku Monitoring cijelog izbornika.

[Napomene]
ˎˎ Okvir područja fokusiranja nije sakriven kada 

primjenjujete gumb DISPLAY.
ˎˎ Područje fokusiranja postavljeno je na Wide tijekom 

rada funkcije zuma za jasnu sliku.

Brza promjena područja fokusiranja 
(Focus Setting)

Položaj i veličinu područja automatskog 
fokusiranja tijekom snimanja moguće je brzo 
promijeniti dodjelom funkcije Focus Setting 
jednom od dodjeljivih gumba (stranica 48).
Radnja se razlikuje ovisno o postavci područja 
fokusiranja.

Kada je funkcija Focus >Focus Area 
(stranica 75) u izborniku Shooting cijelog 
izbornika postavljena na Flexible Spot ili Zone
Položaj područja fokusiranja mijenja 
se pritiskom dodjeljivog gumba kojemu 
je dodijeljena funkcija Focus Setting 
i namještanjem s pomoću višestrukog 
birača (stranica 7).
Možete vratiti položaj područja fokusiranja 
u središnji položaj namještanjem položaja 
pritiskom višestrukog birača.
Veličina područja fokusiranja mijenja se 
pritiskanjem i zadržavanjem dodjeljivog 
gumba kojem je dodijeljena funkcija Focus 
Setting.
Nakon promjene veličine postavite područje 
fokusiranja pritiskom višestrukog birača.
Nakon dovršetka pritisnite dodjeljivi gumb 
s funkcijom Focus Setting kako biste se vratili 
na početni zaslon.
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Kada je funkcija Focus >Focus Area 
(stranica 75) u izborniku Shooting cijelog 
izbornika postavljena na Wide
Veličinu područja fokusiranja moguće 
promijeniti samo pritiskanjem i zadržavanjem 
dodjeljivog gumba kojem je dodijeljena 
funkcija Focus Setting. Položaj je također 
moguće promijeniti tako da najprije vrstu 
promijenite iz Flexible Spot u Zone.

[Savjeti]
ˎˎ Kada je funkcija Focus >Push AF Mode (stranica 75) 

u izborniku Shooting cijelog izbornika postavljena 
na Single-shot AF(AF-S) i sklopka FOCUS 
(stranica 4) je u položaju MF, možete promijeniti 
položaj područja fokusiranja Focus Area(AF-S) 
(stranica 75).
ˎˎ Kada upotrebljavate funkciju zuma za jasnu sliku, 

postavka veličine područja fokusiranja onemogućena 
je i aktivira se rad funkcije automatskog fokusiranja 
s prioritetom na središnji položaj.
ˎˎ Okvir područja fokusiranja prikazan je narančastom 

bojom kada se područje fokusiranja može promijeniti.

Pomicanje okvira područja fokusiranja 
s pomoću rada dodirom (dodir područja 
fokusiranja)

Položaj područja fokusiranja možete 
promijeniti pritiskom dodjeljivog gumba 
(stranica 48) kojemu je dodijeljena funkcija 
Focus Setting kako biste promijenili prikaz 
područja fokusiranja na narančastu boju 
i zatim ga možete pomicati s pomoću rada 
dodirom.
Dodirnite zaslon za pomicanje područja 
fokusiranja tako da je područje fokusiranja 
centrirano na položaj koji ste dodirnuli. 
Povucite po zaslonu kako biste pomaknuli 
područje fokusiranja u položaj koji pratite 
prstom (stranica 10).

[Savjet]
Rad fokusiranja dodirom možete omogućiti/
onemogućiti na zaslonu snimanja s pomoću dodjeljivog 
gumba kojemu je dodijeljena funkcija Focus Setting.

Dodirnite bilo koji položaj

Područje fokusiranja se pomiče, a područje 
fokusiranja centrirano je na dodirnuti 
položaj.

Povucite za pomicanje područja 
fokusiranja, prateći položaj prsta

[Napomene]
ˎˎ Ako dodirnete položaj ili povučete područje 

fokusiranja u položaj koji premašuje raspon postavke, 
područje fokusiranja postavlja se na gornji/donji/
lijevi/desni rub raspona fokusiranja.
ˎˎ Ova funkcija ne radi u sljedećim okolnostima.

–– Kada je funkcija Touch Operation (stranica 93) 
u izborniku Technical cijelog izbornika postavljena 
na Off

–– Kada je područje fokusiranja prikazano sivom 
bojom ili se uopće ne prikazuje

Namještanje funkcije Auto Focus Action 
(brzina prijelaza pri automatskom 
fokusiranju, osjetljivost na zamjenu 
objekta pri automatskom fokusiranju)

Brzina prijelaza pri automatskom fokusiranju
Brzinu otvora fokusiranja kada se objekt 
mijenja možete postaviti s pomoću funkcije 
Focus >AF Transition Speed (stranica 75) 
u izborniku Shooting cijelog izbornika.
Kada je postavljen na nisku brzinu, fokus 
se polako pomiče kada se fokusirani 
objekt mijenja, što omogućuje snimanje 
dojmljivih slika.
Kada je postavljen na visoku brzinu, fokus se 
brzo mijenja između objekata. Objekt koji uđe 
u kadar trenutačno se fokusira, što postavku 
čini idealnom za dokumentarističko snimanje 
koje zahtijeva brzo fokusiranje.

Tijekom promjene:
1 (sporo): Fokusiranje se 
provodi sporo
.
.
.
7 (brzo): Fokusiranje se 
provodi brzo

Fokusiranje na udaljeni objekt

Fokusiranje na bliski objekt
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AF osjetljivost na zamjenu objekta
Osjetljivost za zamjenu objekata možete 
postaviti s Focus >AF Subj. Shift Sens. 
(stranica 75) u izborniku Shooting cijelog 
izbornika.
Kada je postavljena na malu osjetljivost, 
fokus se ne mijenja lako čak ni kada se ispred 
fokusiranog objekta pomakne drugi objekt. 
Kada je postavljena na veliku osjetljivost, fokus 
se mijenja i dodjeljuje prioritet objektu koji 
se pomiče ispred.

[Savjet]
Ako je funkcija AF Speed/Sens. dodijeljena dodjeljivom 
gumbu, stupci razine za namještanje vrijednosti 
prikazuju se sljedećim redoslijedom svaki put kada 
pritisnete gumb zbog čega možete promijeniti 
postavke brzine prijelaza pri automatskom fokusiranju 
i osjetljivosti na zamjenu objekta pri automatskom 
fokusiranju.
Brzina prijelaza pri automatskom fokusiranju  
Osjetljivost na zamjenu objekta pri automatskom 
fokusiranju  Bez prikaza…

AF Subj. Shift Sens.: 1 (zaključano) AF Subj. Shift Sens.: 5(osjetljivo)

Sporo premještanje fokusa na drugi objekt Brzo premještanje fokusa na drugi objekt

Ručna promjena mete fokusiranja 
(AF Assist)

Kada je funkcija Focus >AF Assist 
(stranica 75) u izborniku Shooting cijelog 
izbornika uključena s On, tijekom automatskog 
fokusiranja i dalje je moguće namještati 
fokus na objekt.
Kada prestanete upotrebljavati rad prstena za 
fokusiranje, funkcija automatskog fokusiranja 
i dalje fokusira na objekt s pomoću prstena 
za fokusiranje (stanje AF Assist).
Nakon upravljanja prstenom za fokusiranje, 
pomicanje fokusa na drugi objekt malo je teže, 
bez obzira na postavku Focus >AF Subj. Shift 
Sens. (stranica 75) u izborniku Shooting 
cijelog izbornika.
Stanje AF Assist prekida se kada dođe do 
sljedećeg:
ˎˎ Kada objekt koji je fokusiran s pomoću 
prstena za fokusiranje više nije vidljiv
ˎˎ Pri prebacivanju na ručno fokusiranje
ˎˎ Kada je otkriveno lice

[Savjeti]
ˎˎ Stanje AF Assist može se otkazati upotrebom 

dodjeljivog gumba (stranica 48) kojemu je 
dodijeljena funkcija Push AF/Push MF.
ˎˎ Upravljanjem prstenom za fokusiranje čisti se odabir 

registriranog lica.
ˎˎ U načinu Face/Eye Only AF automatsko fokusiranje 

fokusira se na lice najbliže položaju fokusiranja 
prstena za fokusiranje.
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Privremena primjena ručnog 
fokusiranja (Push Manual Focus)

U načinu za automatsko fokusiranje pritisnite 
gumb PUSH AUTO FOCUS (stranica 4) kako 
biste uz pritisnut gumb mogli ručno fokusirati.
Po otpuštanju gumba fokusiranje se vraća na 
automatsko.
To omogućuje privremeno zaustavljanje 
automatskog fokusiranja te ručno fokusiranje 
kada nešto što nije objekt prođe ispred 
objekta.

[Savjet]
Istu radnju podržava dodjeljivi gumb (stranica 48) 
kojem je dodijeljena funkcija Push AF/Push MF.

Privremena primjena 
automatskog fokusiranja (Push 
Auto Focus)

Kada je način Focus >Push AF mode 
(stranica 75) u izborniku Shooting cijelog 
izbornika postavljen na AF, za automatsko 
fokusiranje u načinu ručnog fokusiranja 
pritisnite gumb PUSH AUTO FOCUS 
(stranica 4).
Do fokusiranja dolazi unutar područja 
fokusiranja postavljenog s pomoću funkcije 
Focus >Focus Area (stranica 75) u izborniku 
Shooting cijelog izbornika.
Po otpuštanju gumba fokusiranje se vraća na 
ručno.
To je praktično kada tijekom ručnog 
fokusiranja fokus želite polako pomaknuti s 
jednog objekta na drugi.

[Savjet]
Istu radnju podržava dodjeljivi gumb (stranica 48) 
kojem je dodijeljena funkcija Push AF/Push MF.

[Napomena]
Funkcija Push Auto Focus ne radi ako je objektiv 
postavljen na ručno fokusiranje.

Upotreba automatskog fokusiranja 
za pojedinačno snimanje (Push 
Auto Focus (AF-S))

Postavite funkciju Focus >Push AF Mode 
(stranica 75) u izborniku Shooting 
cijelog izbornika na Single-shot AF(AF-S), 
zatim postavite područje fokusiranja s 
pomoću funkcije Focus >Focus Area(AF-S) 
(stranica 75) u izborniku Shooting cijelog 
izbornika.
U načinu za ručno fokusiranje pritisnite gumb 
PUSH AUTO FOCUS  kako biste automatski 
fokusirali velikom brzinom. Fokusiranje se 
prekida po otpuštanju gumba.
Status fokusiranja prikazuje indikator 
fokusiranja.
ˎˎ Uključeno: fokus je nepromjenjiv u položaju 
fokusiranja.
ˎˎ Treperi: izvan fokusa. Budući da fokusiranje 
nije automatsko, promijenite kompoziciju 
i postavke fokusiranja kako biste postigli 
fokus.

Po otpuštanju gumba fokusiranje se vraća 
na ručno.
To je praktično kada prije početka snimanja 
želite brzo fokusirati objekt.

[Savjeti]
ˎˎ Istu radnju podržava dodjeljivi gumb (stranica 48) 

kojem je dodijeljena funkcija Push AF/Push MF.
ˎˎ Funkciju Push AF Mode možete dodijeliti i dodjeljivom 

gumbu (stranica 48).
ˎˎ Funkciju Focus Area(AF-S) također možete dodijeliti 

i dodjeljivom gumbu (stranica 48).
ˎˎ Možete prikazati/sakriti okvir područja fokusiranja 

s pomoću funkcije Display On/Off >Focus Area Ind. 
(AF-S) (stranica 87) u izborniku Monitoring cijelog 
izbornika.
ˎˎ Tijekom povećavanja fokus se prilagođava 

povećanom dijelu zaslona.

[Napomene]
ˎˎ Funkcija Push Auto Focus ne radi ako je objektiv 

postavljen na ručno fokusiranje.
ˎˎ Okvir područja fokusiranja nije sakriven 

kada primjenjujete gumb DISPLAY.

Fokusiranje s povećanim 
pregledom (Focus Magnifier)

Po tvorničkim postavkama funkcija Focus 
Magnifier ×3/×6 dodijeljena je gumbu ASSIGN 
4 na daljinskom upravljaču na drški i gumbu 
ASSIGN 7 na ručki (stranica 48).
Pritisnite gumb ASSIGN 4 ili gumb ASSIGN 
7 za prebacivanje tražila na zaslon povećanja 
za fokusiranje, pri čemu je sredina povećana 
otprilike tri puta. Ponovno pritisnite gumb 
kako biste povećanje povećali na približno 
šest puta. Funkcija je praktična pri provjeri 
fokusa.
Ponovno pritisnite gumb za povratak 
na normalan zaslon.
Možete pomicati položaj koji želite povećati 
tijekom povećanja fokusiranja s pomoću 
višestrukog birača (stranica 7). Pritiskom 
višestrukog birača vraćate se na sredinu slike.
Kada se tijekom povećanja fokusiranja 
upotrebljava funkcija Push Auto Focus (AF), do 
fokusiranja dolazi unutar područja fokusiranja 
postavljenog s pomoću funkcije Focus >Focus 
Area (stranica 75) u izborniku Shooting 
cijelog izbornika.
Ako tijekom povećanja za fokusiranje 
pritisnete automatsko fokusiranje (AF), 
fokusiranje se prilagođava povećanom 
položaju zaslona.

[Napomene]
ˎˎ Snimana slika ili slika koja se izvozi priključkom SDI/

HDMI nije povećana pri povećanju fokusa.
ˎˎ Tijekom povećanja fokusa onemogućeni su gumb 

MENU i druge radnje.
ˎˎ Pri isključenju videokamere povećani položaj vraća se 

u sredinu zaslona.
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Fokusiranje s pomoću funkcije 
otkrivanja lica i oka (Face/Eye 
Detection AF)

Videokamera može otkriti lica i oči ljudi i zatim 
namjestiti fokus na lica i oči u okviru područja 
fokusiranja.
Ova je funkcija dostupna samo kada je 
prilagodba fokusa u načinu AF ili tijekom 
automatskog fokusiranja pritiskanjem.
Kada se otkriju lica, prikazuju se sivi okviri 
otkrivanja lica/oka. Kada je moguće 
automatsko fokusiranje, okviri postaju bijeli. 
Kada su otkrivene oči i fokus je namješten, 
okvir otkrivanja lica/oka prikazuje se na očima. 
Kada se otkrije više pojedinaca, glavni objekt 
određuje se automatski.

[Savjeti]
ˎˎ Kada je područje fokusiranja postavljeno na Zone ili 

Flexible Spot i lica ili oči preklapaju se s određenim 
područjem fokusiranja, okviri otkrivanja lica/oka 
postaju bijeli, a videokamera se fokusira na ta lica/oči.
ˎˎ Kada se primjenjuje automatsko fokusiranje 

pritiskanjem (AF-S), okviri otkrivanja lica/oka na 
fokusiranim licima postaju zeleni.

Postavite radnju Face/Eye Detection AF 
s pomoću funkcije Focus >Face/Eye Detection 
AF (stranica 75) u izborniku Shooting.

Face/Eye Only AF:
Kamera otkriva lica/oči objekata (ljudi) 
i fokusira samo njihova lica/oči. Dok lice 
ili oko nije otkriveno, AF se privremeno 
zaustavlja (MF) i prikazuje se ikona pauziranja 
automatskog fokusiranja za način Face/
Eye Only AF  (stranica 11). Ovaj način 
se primjenjuje samo kada želite automatski 
fokusirati isključivo lica/oči.

Face/Eye Priority AF:
Kamera otkriva lica/oči objekata (ljudi) i 
dodjeljuje prioritet fokusiranju samo njihovih 
lica/očiju. Kada lice ili oči nisu otkriveni, 
fokusiranje je u načinu AF (zadana postavka).

Isključeno:
Funkcija Face/Eye Detection AF je 
onemogućena.

[Napomene]
ˎˎ Tijekom rada funkcije automatskog fokusiranja 

pritiskanjem funkcija Face/Eye Priority AF aktivirana 
je čak i ako je trenutačno odabrana funkcija Face/Eye 
Only AF.
ˎˎ Kada je sklopka FOCUS postavljena na MAN, 

automatsko fokusiranje s otkrivanjem lica/oka 
onemogućeno je (osim tijekom rada automatskog 
fokusiranja pritiskanjem).
ˎˎ Ako isključite videokameru dok je odabrana 

funkcija Face/Eye Only AF, pri sljedećem uključenju 
videokamere način automatski prelazi na Face/Eye 
Priority AF.
ˎˎ Funkcija Face/eye AF nije podržana tijekom rada 

funkcije zuma za jasnu sliku. Aktivirana je funkcija 
Normal AF.

Skrivanje okvira otkrivanja lica/oka

Možete prikazati/sakriti okvire otkrivanja 
lica/oka s pomoću funkcije Display On/Off 
>Face/Eye Detection Frame (stranica 87) 
u izborniku Monitoring cijelog izbornika.

[Napomena]
Zeleni okviri otkrivanja lica/oka prikazuju se za lica 
i oči koji su u fokusu s pomoću funkcije automatskog 
fokusiranja pritiskanjem (AF-S) i nisu skriveni s pomoću 
gumba DISPLAY ili kada je funkcija Face/Eye Detection 
Frame postavljena na Off.

Fokusiranje na registrirano lice

Tijekom rada funkcije automatskog fokusiranja 
s otkrivanjem lica/oka za objekt (osobu) 
moguće je registrirati lice za fokusiranje.
Moguće je registrirati samo jedno lice. 
Registriranjem lica prebrisuje se postojeća 
registracija.

Kada je lice registrirano, okvir otkrivanja 
lica/oka mijenja se u dvostruki okvir (okvir 
registriranog lica) i prikazuje se ikona 
registriranog lica (stranica 11).
Ovisno o kombinaciji registriranog lica 
i radnog načina automatskog fokusiranja 
s otkrivanjem lica/oka, u načinu automatskog 
fokusiranja s otkrivanjem lica provode 
se sljedeće radnje.

U načinu Face/Eye Priority AF:
Ako kamera otkrije registrirano lice, kamera 
fokusira to lice. Ako registrirano lice nije otkriveno, 
aktivira se automatsko fokusiranje s otkrivanjem 
lica.

U načinu Face/Eye Only AF:
Ako kamera otkrije samo registrirano lice, 
kamera fokusira to lice/oko. Dok registrirano 
lice nije otkriveno, AF se privremeno 
zaustavlja (MF) i prikazuje se ikona pauziranja 
automatskog fokusiranja za način Face/
Eye Only AF  (stranica 11). Ovaj način 
se primjenjuje samo kada želite automatski 
fokusirati registriranu osobu.

Postavljanje registriranog lica
Pomaknite pokazivač za odabir lica 
(narančasta crta) na lice koje želite registrirati 
s pomoću višestrukog birača (stranica 7) 
i pritisnite višestruki birač.

Drugi okviri otkrivanja lica/oka 
(sivo)

Okvir 
registriranog 
lica (dvostruki 
bijeli okvir)

Pokazivač za odabir lica 
(narančasti)

Brisanje registriranog lica
Pomaknite pokazivač za odabir lica na 
registrirano lice s pomoću višestrukog birača 
(stranica 7) i pritisnite višestruki birač.
Registrirano lice je izbrisano, okvir otkrivanja 
lica/oka postaje jedan okvir, a ikona 
registriranog lica uklanja se.
Kada se otkrivaju lica/oči bez prikaza okvira 
registriranog lica i pokazivača za odabir lica 
(narančasto), registrirano lice može se izbrisati 
s dva pritiska višestrukog birača.

[Napomene]
ˎˎ U načinu AF Assist (stranica 39) odabir registriranog 

lica je očišćen.
ˎˎ Pri upotrebi funkcije zuma za jasnu sliku, nije moguće 

upotrebljavati funkciju Face/Eye Detection AF.
ˎˎ Ovisno o okruženju snimanja, stanju objekta ili 

postavkama, otkrivanje lica/oka može biti nemoguće.
ˎˎ U nekim okruženjima snimanja možda nećete dobiti 

odgovarajući učinak ili se drugi objekti mogu otkrivati kao 
ljudska lica. U tom slučaju funkciju automatskog fokusiranja 
s otkrivanjem lica/oka isključite postavljanjem na Off.
ˎˎ Preporučuje se prije snimanja registrirati lice 

pojedinca kojeg želite fokusirati.
ˎˎ Ovisno o frizuri, ukrasima lica, ili ako nije usmjereno izravno 

u kameru, registracija lica može biti neuspješna. U tom 
slučaju okvir otkrivanja lica/oka može se udvostručiti, no ne 
prikazuje se ikona registriranog lica i lice nije registrirano.
ˎˎ Ako je lice već bilo registrirano, preporučuje se 

izbrisati postojeće lice i tada registrirati novo lice.

Zamjena rada funkcije automatskog 
fokusiranja s otkrivanjem lica/oka s 
dodjeljivim gumbom

Funkciju Face/Eye Detection AF dodijelite 
dodjeljivom gumbu (stranica 48). Zatim 
možete prebaciti rad funkcije automatskog 
fokusiranja s otkrivanjem lica/oka 
redoslijedom Face/Eye Priority Af, Face/Eye 
Only AF i Off svaki put kada pritisnete gumb.

Postavljanje u izravnom izborniku

Rad funkcije automatskog fokusiranja 
s otkrivanjem lica/oka možete postaviti 
i u izravnom izborniku (stranica 48).
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Podešavanje svjetline

B

C
D
E

F
H

I

A

Svjetlinu možete prilagoditi podešavanjem 
irisa, razine signala, brzine zatvarača 
i podešavanjem razine svjetline filtrima ND. 
Podešavanja je također moguće provesti 
automatski.
Ciljna razina za automatsko namještanje 
svjetline postavljena je s pomoću funkcije 
Auto Exposure (stranica 73) >Level u 
izborniku Shooting cijelog izbornika. Funkciju 
Auto Exposure Level također možete dodijeliti 
dodjeljivom gumbu ili dodjeljivom kotačiću 
(stranica 48).

[Napomena]
Razinu signala nije moguće podešavati u načinu Cine 
EI. Temeljna osjetljivost je fiksna. Također, svjetlinu nije 
moguće automatski podešavati brzinom zatvarača. 
Automatsko podešavanje svjetline s iris i filtrom ND 
je podržano.

Odabir temeljne osjetljivosti

Možete birati između dvije vrste temeljne 
osjetljivosti na videokameri.
U načinu Custom možete postaviti temeljnu 
osjetljivost na High ili Low s pomoću funkcije 
Base ISO/Sensitivity na zaslonu Main Status 
(stranica 13) ili zaslonu Camera Status 
(stranica 14) ili funkciju ISO/Gain/EI>Base 
Sensitivity (stranica 72) u izborniku 
Shooting cijelog izbornika.
U načinu Cine EI možete postaviti temeljni ISO 
na ISO 12800 ili ISO 800 s pomoću funkcije 
Base ISO/Sensitivity na zaslonu Main Status 
(stranica 13) ili zaslonu Camera Status 
(stranica 14) ili funkciju ISO/Gain/EI>Base 
ISO (stranica 72) u izborniku Shooting 
cijelog izbornika.
Preporučuje se odabir Low ili ISO 800 tijekom 
uvjeta normalne osvijetljenosti i odabir High ili 
ISO 12800 u uvjetima slabije osvijetljenosti.

*	 Može se konfigurirati i na zaslonu statusa.

[Savjet]
Funkciju Base ISO/Sensitivity možete dodijeliti i 
dodjeljivom gumbu (stranica 48).

Podešavanje irisa

Podešavanjem irisa možete prilagoditi 
svjetlinu.

Automatsko podešavanje irisa

Ova funkcija podešava svjetlinu prema 
objektu. Potreban je objektiv koji podržava iris.

1	 Ako je postavljen objektiv s funkcijom 
Auto Iris, sklopku postavite na AUTO.

2	 Pritisnite i zadržite gumb funkcije IRIS (E) 
kako biste prikazali izravni izbornik 
(stranica 48) te odaberite Auto.

	 [Savjet]
Funkciju Auto Iris također možete dodijeliti 
dodjeljivom gumbu (stranica 48).

	 [Napomena]
Na objektivu A-mount iris je nemoguće 
podešavati automatski.

Ručno podešavanje irisa

1	 Pritisnite i zadržite gumb funkcije IRIS (E) 
kako biste prikazali izravni izbornik 
(stranica 48) te odaberite Manual.

2	 Pritisnite gumb funkcije IRIS (E) kako biste 
vrijednost irisa prikazali na bijeloj 
pozadini.

3	 Okrećite višenamjenski kotačić kako biste 
podesili vrijednost.

	 [Savjeti]
ˎˎ Višenamjenski kotačić također možete 

primjenjivati kao kotačić za IRIS (stranica 48) 
dodjelom funkcije IRIS višenamjenskom 
kotačiću.
ˎˎ Funkciju IRIS također možete dodijeliti 

dodjeljivom kotačiću (stranica 48).

Privremeno automatsko podešavanje

Pritisnite dodjeljivi gumb (stranica 48) 
kojemu je dodijeljena funkcija Push Auto 
Iris za privremeno automatsko namještanje 
irisa dok je gumb pritisnut.
Po otpuštanju gumba iris se vraća 
na prethodnu postavku.

[Napomena]
Kada je sklopka za Auto Iris postavljena na MANUAL, 
funkcije videokamere Auto Iris i Push Auto Iris nemaju 
učinak. Ručno podešavanje irisa na videokameri nema 
učinak.

Podešavanje razine signala

U ručnom načinu rada Custom podešavanjem 
jačine signala možete prilagoditi svjetlinu.

Automatsko podešavanje jačine signala

Pritisnite i zadržite gumb funkcije ISO/
GAIN (H) kako biste prikazali izravni izbornik 
(stranica 48) te odaberite Auto.

[Savjeti]
ˎˎ Istu radnju možete provesti u izborniku Shooting 

uključenjem funkcije Auto Exposure (stranica 73) 
>AGC postavljanjem na On.
ˎˎ Funkciju AGC također možete dodijeliti dodjeljivom 

gumbu (stranica 48).

Ručno podešavanje jačine signala

Jačinom signala možete upravljati kada 
želite podesiti ekspoziciju uz fiksnu postavku 
ekspozicije ili kada želite spriječiti porast jačine 
signala zbog funkcije AGC.

1	 Pritisnite i zadržite gumb funkcije ISO/
GAIN (H) kako biste prikazali izravni 
izbornik (stranica 48) te odaberite 
Manual.

2	 Prekidač za ISO/GAIN (I) postavite na H, 
M ili L.

[Savjeti]
ˎˎ Funkciju Push AGC također možete dodijeliti 

dodjeljivom gumbu, a funkciju AGC privremeno 
postaviti na On pritiskom i zadržavanjem gumba.
ˎˎ Možete promijeniti unaprijed postavljenu vrijednost 

položaja svake sklopke s pomoću funkcije ISO / 
Gain<L>/<M>/<H> (stranica 14) na zaslonu Camera 
Status ili funkcije ISO/Gain/EI >ISO/Gain<H>/<M>/<L> 
(stranica 72) u izborniku Shooting cijelog izbornika.
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Upravljanje jačinom signala (precizno 
podešavanje)

1	 Pritisnite gumb funkcije ISO/GAIN (H) kako 
biste vrijednost jačine signala prikazali na 
bijeloj pozadini.

2	 Okrećite višenamjenski kotačić kako biste 
podesili vrijednost.

[Savjet]
Promijenite tvornički zadanu vrijednost jačine signala 
prema postavci sklopke ISO/GAIN (I).

Privremeno upravljanje jačinom signala 
(precizno podešavanje)

Okrećite dodjeljivi kotačić (stranica 48) 
kojemu je dodijeljena funkcija ISO/Gain/EI 
kako biste namjestili vrijednost jačine signala 
postavljenu sklopkom ISO/GAIN (I).
To je praktično kada želite podesiti ekspoziciju 
za jedan korak bez promjene dubine polja.
Namještena vrijednost jačine signala prekida 
se uklopom sklopke ISO/GAIN (I), promjenom 
temeljne osjetljivosti, uključenjem funkcije 
AGC postavljanjem na On ili isključenjem 
napajanja.

[Savjeti]
ˎˎ Ovu funkciju također možete dodijeliti 

višenamjenskom kotačiću (stranica 48).
ˎˎ Funkciju Push AGC također možete dodijeliti 

dodjeljivom gumbu, a funkciju AGC privremeno 
postaviti na On pritiskom i zadržavanjem gumba.

Podešavanje razine ekspozicije

U načinu Cine EI pretpostavlja se kako se 
video ulaz s funkcijom MLUT isključenom 
s Off snima kao glavni signal. Promjenom 
svjetline slike s funkcijom MLUT uključenom 
s on za podudaranje s vrijednosti EI, rezultat 
postprodukcijskog podešavanja osjetljivosti 
ekspozicije može se provjeriti tijekom 
snimanja.
Vrijednost EI možete promijeniti postavljanjem 
sklopke ISO/GAIN (I) na H, M ili L.

[Savjet]
Možete promijeniti unaprijed postavljenu vrijednost 
EI svake sklopke s pomoću funkcije ISO/Gain/
EI (stranica 14) na zaslonu Camera Status ili 
funkcije ISO/Gain/EI >Exposure Index<H>/<M>/<L> 
(stranica 72) u izborniku Shooting cijelog izbornika.

Precizno podešavanje razine ekspozicije

1	 Pritisnite gumb funkcije ISO/GAIN (H) kako 
biste vrijednost EI prikazali na bijeloj 
pozadini.

2	 Okrećite višenamjenski kotačić kako biste 
podesili vrijednost.

[Savjet]
Promijenite tvornički zadanu vrijednost EI prema 
postavci sklopke ISO/GAIN (I).

Podešavanje zatvarača

Podešavanjem zatvarača možete prilagoditi 
svjetlinu.

Automatsko podešavanje zatvarača

Pritisnite i zadržite gumb funkcije SHUTTER (F) 
za prikaz izravnog izbornika (stranica 48) 
i odaberite Auto kako biste brzinu zatvarača ili 
kut zatvarača automatski odzivno namještali 
prema svjetlini slike.

[Savjet]
Istu radnju možete provesti u izborniku Shooting cijelog 
izbornika uključenjem funkcije Auto Exposure >Auto 
Shutter (stranica 74) postavljanjem na On.

Ručno podešavanje zatvarača

1	 Pritisnite i zadržite gumb funkcije 
SHUTTER (F) kako biste prikazali izravni 
izbornik (stranica 48) te odaberite 
Speed ili Angle.

2	 Pritisnite gumb funkcije SHUTTER (F) kako 
biste vrijednost zatvarača prikazali na 
bijeloj pozadini.

3	 Okrećite višenamjenski kotačić kako biste 
podesili brzinu zatvarača.

[Savjeti]
ˎˎ Za podešavanje vremena ekspozicije prema intervalu 

kadra odaberite Off u 1. koraku.
ˎˎ Također možete postaviti kut te podesiti frekvenciju 

(stranica 72).

Podešavanje razine svjetline (filtar ND)

U uvjetima u kojima je svjetlo prejako, 
odgovarajući svjetlinu možete postaviti 
promjenom filtra ND.
Videokamera ima dva načina za filtre ND. Dva 
načina možete mijenjati sklopkom ND PRESET/
VARIABLE.

Podešavanje u tvornički postavljenom 
načinu

Sklopku ND PRESET/VARIABLE (A) postavite 
u položaj PRESET, a gumbe gore/dolje funkcije 
ND FILTER POSITION (B) na jednu od sljedećih 
postavki.
Clear: bez filtra ND
1: Prozirnost postavljena funkcijom ND Filter 
>Preset1 (stranica 72) u izborniku Shooting 
cijelog izbornika.
2: Prozirnost postavljena funkcijom ND Filter 
>Preset2 (stranica 72) u izborniku Shooting 
cijelog izbornika.
3: Prozirnost postavljena funkcijom ND Filter 
>Preset3 (stranica 72) u izborniku Shooting 
cijelog izbornika.

Podešavanje u varijabilnom načinu

Sklopku ND PRESET/VARIABLE (A) postavite 
u položaj VARIABLE. Gumbe gore/dolje (B) 
funkcije ND FILTER POSITION preklapajte 
između CLEAR i On.

Automatsko podešavanje razine svjetline
Filtar Auto ND Filter možete uključiti 
postavljanjem na On kako biste omogućili 
automatsko podešavanje ekspozicije filtrom 
ND.

1	 Pritisnite gumb [+] među gumbima gore/
dolje (B) za ND FILTER POSITION kako biste 
uključili filtar ND.
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2	 Pritisnite i zadržite gumb (C) za ND 
VARIABLE AUTO dok ne odaberete Auto.

Ručno podešavanje razine svjetline

1	 Pritisnite gumb [+] među gumbima gore/
dolje (B) za ND FILTER POSITION kako biste 
uključili filtar ND.

2	 Pritisnite i zadržite gumb (C) za ND 
VARIABLE AUTO dok ne odaberete Manual.

3	 Okrećite kotačić (D) za ND VARIABLE kako 
biste podesili filtar prozirnosti.

[Savjet]
Filtar ND Filter također možete dodijeliti dodjeljivom 
kotačiću (stranica 48).

Privremeno automatsko podešavanje
Funkciju Push Auto ND možete dodijeliti 
dodjeljivom gumbu (stranica 48) i filtar Auto 
ND Filter privremeno uključiti postavljanjem 
na On pritiskanjem i zadržavanjem gumba. 
Otpuštanjem gumba filtar Auto ND ponovno 
se postavlja na Off.
Pritisnite gumb [+] među gumbima gore/dolje 
(B) za ND FILTER POSITION kako biste uključili 
filtar ND.

[Napomena]
Kada se tijekom snimanja uklopi ili isklopi funkcija CLEAR 
filtra ND, okvir filtra ND prikazuje se na slici, a u zvuk se 
dodaje zvuk rada.

[Savjeti]
ˎˎ Funkciju CLEAR možete postaviti okretanjem kotačića 

ND VARIABLE (D) prema dolje od ND1/4. Okretanjem 
kotačića sa CLEAR prema gore postavlja se ND1/4. 
Tu radnju možete onemogućiti s pomoću funkcije 
ND Dial >CLEAR with Dial (stranica 93) u izborniku 
Technical cijelog izbornika.
ˎˎ Funkciju ND Filter Position također možete dodijeliti 

dodjeljivom gumbu (stranica 48) te za promjenu 
postavke umjesto gumba gore/dolje za ND FILTER 
POSITION primijeniti taj gumb.  
Unaprijed postavljeni način: Clear  Preset1  
Preset2  Preset3  Clear… 
Varijabilni način: Clear  On  Clear…

ˎˎ Filtar Auto ND Filter također možete dodijeliti 
dodjeljivom gumbu (stranica 48) te pritiskom 
gumba filtar Auto ND Filter uključivati i isključivati 
postavljanjem na On i Off.
ˎˎ Pri snimanju jako osvijetljenog objekta prejako 

zatvaranje irisa može uzrokovati zamućenje zbog 
prelamanja, zbog čega slika gubi fokus (uobičajena 
pojava na videokamerama). Suzbijanjem ovog efekta 
primjenom filtra ND možete ostvariti bolje rezultate 
snimanja.
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G

J

Način podešavanja možete odabrati tako 
da odgovara uvjetima snimanja.

ATW (Auto Tracing White Balance)

Ovom funkcijom balans bijele boje automatski 
se podešava na odgovarajuću razinu.
Balans bijele boje automatski se prilagođava 
promjeni temperature boje izvora svjetlosti.
Pritisnite i zadržite gumb funkcije WHT 
BAL (G) kako biste prikazali izravni izbornik 
(stranica 48) te odaberite ATW.
Možete odabrati brzinu namještanja (pet 
koraka) s pomoću funkcije White Setting 
>ATW Speed (stranica 74) u izborniku 
Shooting cijelog izbornika.

[Savjet]
Trenutačnu postavku balansa bijele možete zamrznuti 
postavljanjem funkcije ATW dodjeljivom gumbu 
(stranica 48) te pritiskom dodjeljivog gumba 
privremeno pauzirati način ATW.

[Napomene]
ˎˎ Funkciju ATW nije moguće upotrebljavati u načinu 

Cine EI.
ˎˎ Ovisno o osvjetljenju i uvjetima objekta, podešavanje 

na odgovarajuću boju funkcijom ATW može biti 
nemoguće.  
Primjeri:
–– Ako jedna boja dominira objektom, poput neba, 

mora, tla ili cvijeća.
–– Kada je temperatura boje iznimno visoka ili 

iznimno niska.
	 Ako odgovarajući efekt nije moguće postići zbog 

preniske brzine automatskog praćenja funkcijom 
ATW ili drugih razloga, izvedite automatski balans 
bijele boje.

Ručno podešavanje balansa bijele boje

1	 Kada je balans bijele boje postavljen 
na način ATW, pritisnite i držite gumb 
funkcije WHT BAL (G) kako biste prikazali 
izravni izbornik (stranica 48) i odaberite 
W:P, W:A ili W:B.

2	 Sklopkom WHT BAL (J) odaberite B, 
A ili PRESET.
B: Način za Memory B
A: Način Memory A
PRESET: Unaprijed postavljeni način

[Savjet]
Funkciju ATW moguće je omogućiti za način Memory 
B postavljanjem funkcije White Setting >White 
Switch<B> (stranica 74) u izborniku Shooting cijelog 
izbornika na ATW.

Način Memory A/Memory B
U ovom načinu balans bijele podešava se 
spremljenu u memoriju A, odnosno memoriju B.

Unaprijed postavljeni način
U ovom načinu temperatura boje prilagođava 
se na unaprijed postavljenu vrijednost 
(tvornička postavka je 3200 K).

Promjena zadane unaprijed postavljene 
vrijednosti

U unaprijed postavljenom načinu izravno 
možete promijeniti postojeću unaprijed 
postavljenu vrijednost.
Pritisnite i zadržite gumb funkcije WHT BAL 
(G) i u izravnom izborniku odaberite jedno 
od sljedećeg.
Način Custom:  3200K,  4300K, 

 5600K,  6300K
Način Cine EI:  3200K,  4300K,  5500K

[Savjet]
Funkciju Preset White Select također možete dodijeliti 
dodjeljivom gumbu (stranica 48) te pritiskom gumba 
mijenjati postavku.
Način Custom: 3200K  4300K  5600K  6300K  
 3200K…

Način Cine EI: 3200K  4300K  5500K  3200K…

Promjena temperature boje

1	 Pritisnite gumb funkcije WHT BAL (G) kako 
biste vrijednost temperature boje prikazali 
na bijeloj pozadini.

2	 Okrećite višenamjenski kotačić kako biste 
podesili vrijednost.

[Savjeti]
ˎˎ U unaprijed postavljenom načinu vrijednost možete 

postaviti u jedinicama od 100 K.
ˎˎ U načinu rada za memoriju vrijednost možete 

postaviti u koracima od 20 K u rasponu od 2000 K do 
5600 K. Vrijednosti iznad 5600 K mogu se postaviti u 
intervalima jednakima iznosu promjene boje (mired) 
od 5580 K do 5600 K. Možete namjestiti i vrijednost 
nijanse tint s pomoću funkcije White (stranica 74) 
>Tint u izborniku Shooting cijelog izbornika.

Izvođenje automatskog balansa 
bijele boje

Balans bijele boje koji se sprema u memoriju 
A/memoriju B konfigurira se automatski.

1	 Odaberite način za memoriju A ili način za 
memoriju B.

2	 Postavite bijeli papir (ili drugi predmet) na 
lokaciju s izvorom svjetlosti i uvjetima 
jednakima onima kojima je izložen objekt, 
a zatim zumirajte papir kako biste 
prikazali bijelu na zaslonu.

3	 prilagodba svjetline.
Podesite iris prateći postupak pod “Ručno 
podešavanje irisa” (stranica 42).

4	 Pritisnite gumb WB SET (stranica 4).
ˎˎ Ako se automatski balans bijele boje 
izvodi u načinu za memoriju, namještena 
vrijednost sprema se u memoriju (A ili B) 
odabranu u 1. koraku.
ˎˎ Ako se automatski balans bijele boje 
izvodi u načinu ATW, po završetku 
podešavanja podešenost balansa bijele 
boje vraća se na balans bijele boje 
u načinu ATW.

[Napomena]
Ako je podešavanje neuspješno, na zaslonu se na oko 
tri sekunde prikazuje poruka o pogrešci. Ako se poruka 
o pogrešci nastavlja pojavljivati nakon uzastopnih 
pokušaja postavljanja balansa bijele boje, obratite 
se servisnom predstavniku tvrtke Sony.

Podešavanje za prirodne boje (White Balance)



3. Shooting46HR

Ulaznim priključnicama, sklopkama 
i kotačićima na videokameri možete odrediti 
koji će se zvuk snimati.

Ulazne priključnice za vanjski zvuk 
i sklopke za odabir

Priključnica INPUT1 (stranica 7)
Priključnica INPUT2 (stranica 7)
Nosač za više sučelja (stranica 7)
Sklopka INPUT1 (LINE/MIC/MIC+48V) 
(stranica 7)
Sklopka INPUT2 (LINE/MIC/MIC+48V) 
(stranica 7)

Sklopke za postavljanje razine zvuka

Sklopka CH1 (AUTO/MAN) (stranica 6)
Sklopka CH2 (AUTO/MAN) (stranica 6)
Kotačić AUDIO LEVEL (CH1) (stranica 6)
Kotačić AUDIO LEVEL (CH2) (stranica 6)

Zaslon Audio Status

Odabir uređaja za unos zvuka

1	 Postavite unos zvuka s pomoću funkcije 
CH1/CH2/CH3/CH4 >Source 
(stranica 14) na zaslonu Audio Status ili 
funkcije Audio Input >CH1 Input Select na 
CH4 Input Select (stranica 90) u 
izborniku Audio cijelog izbornika.
Ako upotrebljavate nosač za mikrofon, 
XLR adapter ili uređaj UWP (UHF bežični 
mikrofon), odredite funkciju Shoe CH1 ili 
Shoe CH2. Detalje a adapteru XLR 
potražite pod “Dodavanje priključnica za 
unos zvuka” (stranica 47).

	 [Napomene]
ˎˎ Zvuk se ne snima u načinu Interval Rec ili načinu 

Slow & Quick Motion.
ˎˎ Videokamera ima ugrađeni mikrofon za pričanje 

za snimanje zvukova iz okoline. Može se 
upotrebljavati za vremensku sinkronizaciju s 
drugom opremom. U takvim slučajevima odredite 
Internal MIC.
ˎˎ Samo unutarnji mikrofon ručke (stranica 7) 

postaje aktivan za snimanje zvuka kada je 
ručka pričvršćena. Kada ručka nije pričvršćena, 
za snimanje zvukova iz okoline može 
se upotrebljavati mikrofon za pričanje 
(stranica 6).
ˎˎ Kada su CH1 Input Select i CH2 Input Select 

postavljeni na Internal MIC, razina snimanja zvuka 
i za CH1 i CH2 namješta se s pomoću kotačića 
AUDIO LEVEL(CH1) (stranica 6). Kada su CH3 
Input Select i CH4 Input Select postavljeni na 
Internal MIC, razina snimanja zvuka i za CH3 i CH4 
namješta se s pomoću kotačića CH3 Input Level 
(stranica 90).

2	 Odaberite izvor za unos zvuka.
Sklopke INPUT1/INPUT2 (LINE/MIC/
MIC+48V) postavite na uređaje priključene 
na priključnice INPUT1/INPUT2.

Priključeni uređaj Položaj 
sklopke

Izvor vanjskog zvuka 
(npr. mikser)

LINE

Dinamični mikrofon, 
baterijski mikrofon

MIC

Mikrofon s +48 V fantom 
napajanjem

MIC+48V

ˎˎ Odabirom MIC+48V i povezivanjem 
mikrofona nekompatibilnog s izvorom 
od 48 V možete oštetiti priključeni 
uređaj. Prije priključenja uređaja 
provjerite postavku.
ˎˎ Ako na priključnicama na koje nisu 
priključeni uređaji šum stvara problem, 
odgovarajuće sklopke INPUT1/INPUT2 
(LINE/MIC/MIC+48V) postavite na LINE.

Automatsko podešavanje razine 
snimanja zvuka

Sklopke CH1/CH2 (AUTO/MAN) za kanale 
postavite na AUTO za automatsko 
podešavanje.
Kod sklopki CH3/CH4 kontrolu razine zvuka 
na zaslonu Audio Status (stranica 14) 
ili funkciju Audio Input >CH3 Level Control 
i CH4 Level Control u izborniku Audio cijelog 
izbornika postavite na Auto (stranica 90).

Ručno podešavanje razine 
snimanja zvuka

Razina snimanja zvuka za CH1/CH2 podešava 
se sljedećim postupkom.

1	 Sklopke CH1/CH2 (AUTO/MAN) za kanale 
postavite na MAN za ručno podešavanje.

2	 Tijekom snimanja ili stanja pripravnosti 
okrećite kotačiće AUDIO LEVEL (CH1)/(CH2) 
za odgovarajuće kanale kako biste 
prilagodili razinu zvuka.
ˎˎ Kod sklopki CH3/CH4 kontrolu razine 
zvuka CH3/CH4 (stranica 14) na 
zaslonu Audio Status ili funkciju Audio 
Input >CH3 Level Control ili CH4 Level 
Control u izborniku Audio cijelog 
izbornika postavite na Manual te zatim 
namjestite razinu snimanja zvuka s 
pomoću funkcije CH3 Input Level ili CH4 
Input Level.
ˎˎ Razine za od CH1 do CH4 možete 
podesiti kao grupu. Razinu snimanja 
možete namjestiti s pomoću dodjeljivog 
kotačića (stranica 48) kojemu je 
dodijeljena funkcija Audio Input Level, 
zaslona Audio Status ili s pomoću 
funkcije Audio Input >Audio Input Level 
u izborniku Audio cijelog izbornika.

[Savjet]
Zaslon Audio Status pogodan je za provjeru razine 
ulaznog zvuka (stranica 14).

[Napomene]
ˎˎ Ovisno o kombinaciji postavki u izborniku Audio, 

postavke Audio Input Level mogu biti onemogućene. 
Detalje potražite u dijagramu na stranica 124.
ˎˎ Videokamera podržava kombinacije različitih postavki. 

Detalje potražite u dijagramu na stranica 124.

Postavljanje zvuka za snimanje
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Dodavanje priključnica za unos zvuka

Adapterom XLR-K2M XLR (nije obuhvaćen 
isporukom) ili adapterom XLR-K3M XLR 
(nije obuhvaćen isporukom) na videokameru 
istovremeno možete priključiti do četiri kanala 
audio uređaja XLR.
Postavite adapter XLR na podnožje za više 
sučelja i postavite funkciju CH3 >Source na 
Shoe CH1 i CH4 >Source na Shoe CH2 na 
zaslonu Audio Status (stranica 14). Ili 
postavite funkciju Audio Input >CH3 Input 
Select na Shoe CH1 i CH4 Input Select na Shoe 
CH2 u izborniku Audio cijelog izbornika.
Na kanalima za koje je adapter XLR 
postavljen za unos onemogućuju se funkcije 
videokamere koje se preklapaju. Podešavanje 
provedite sklopkama i kotačićima na 
adapteru XLR.

[Napomene]
ˎˎ Videokamera podržava digitalno audio sučelje od 

2 kanala adaptera XLR-K3M.
ˎˎ Ako su funkcije Audio Input >CH3 Level i CH4 Level u 

izborniku Audio postavljene na Audio Input Level, tada 
je funkcija Audio Input Level na videokameri umnožena 
razinom koja je namještena na adapteru XLR.  
Funkcija Audio Input Level također je onemogućena 
kada je adapter XLR postavljen na AUTO.  
Kada je odabrana opcija "Through", zvuk se snima na 
razini podešenoj adapterom XLR (stranica 125).
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Korisne funkcije

Upotreba izbornika Direct Menu

Možete provjeriti status i postavke 
videokamere prikazane za zaslonu tražila 
te izravno odabrati i promijeniti postavke.
Moguće je konfigurirati sljedeće stavke.
ˎˎ Face/Eye Detection AF
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ EI Gain Value
ˎˎ Auto Shutter
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1	 Pritisnite višenamjenski kotačić ili 
dodjeljivi gumb kojem je dodijeljena 
funkcija Direct Menu.
Samo stavke na zaslonu moguće je 
konfigurirati i odabrati narančastim 
pokazivačem u izravnom izborniku.

2	 Okrećite višenamjenski kotačić kako biste 
pokazivač pomaknuli na stavku s kojom 
želite raditi, a potom pritisnite 
višenamjenski kotačić.
Prikazuje se izbornik ili se stavka 
prikazuje na bijeloj pozadini.

3	 Okrećite višenamjenski kotačić za odabir 
postavke, a potom ga pritisnite.
Izbornik ili bijela pozadina nestaju, 
a prikazuje se nova postavka 
s narančastim pokazivačem.
Za napuštanje izravnog izbornika pritisnite 
dodjeljivi gumb kojemu je dodijeljena 
funkcija Direct Menu ili pričekajte tri 
sekunde bez provođenja radnji.

	 [Savjeti]
ˎˎ Izravne postavke također je moguće konfigurirati 

pritiskanjem i zadržavanjem pojedinih gumba 
funkcija (stranica 5).
ˎˎ Kada se stavke prikazuju na bijeloj pozadini, 

višenamjenski kotačić može se upotrebljavati 
kao dodjeljivi kotačić.
ˎˎ Za odabir također se može primijeniti višestruki 

birač (stranica 9).

Dodjeljivi gumbi/kotačići

Na videokameri se nalazi devet dodjeljivih 
gumba (stranica 6, 7, 9) kojima 
možete dodijeliti funkcije.
Funkcije možete dodijeliti i višenamjenskom 
kotačiću na videokameri (stranica 5), 
dodjeljivom kotačiću na ručki (stranica 7) i 
dodjeljivom kotačiću na daljinskom upravljaču 
na drški (stranica 9).

Promjena funkcije gumba

Upotrijebite funkciju Assignable Button 
(stranica 79) u izborniku Project cijelog 
izbornika.
Na zaslonu Assignable Button Status 
(stranica 15) možete pregledati dodijeljene 
funkcije.

Funkcije tvornički dodijeljene pojedinom 
gumbu
Gumb 1	 S&Q Motion
Gumb 2	 AF Speed/Sens.
Gumb 3	 Focus Setting
Gumb 4	 Focus Magnifier x3/x6
Gumb 5	 Direct Menu
Gumb 6	 Off
Gumb 7	 Focus Magnifier x3/x6
Gumb 8	 Direct Menu
Gumb 9	 Video Signal Monitor
Gumb Focus Hold	 Focus Hold

Funkcije koje se mogu dodijeliti
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Reflektor
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot
ˎˎ Rec

ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Volume
ˎˎ Thumbnail (Sličica)
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Promjena funkcije kotačića

Možete promijeniti funkciju višenamjenskog 
kotačića na videokameri, dodjeljivog kotačića 
na drški ili dodjeljivog kotačića na ručki.

Za višefunkcijski kotačić postavite s Multi 
Function Dial (stranica 81) >Default Function 
u izborniku Project.
Tvornički postavljena opcija je Off.
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Funkcije dodjeljive višefunkcijskom kotačiću
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Napomena]
Postavka ne onemogućena dok se prikazuje izbornik.

Za dodjeljivi kotačić postavite s pomoću 
funkcije Assignable Dial (stranica 81) 
u izborniku Project cijelog izbornika.
Tvornički postavljena funkcija za sve je IRIS.

[Savjet]
Dodjeljivi kotačić RM-30BP (nije obavezno) slijedi 
postavku Grip/Remote Dial.

Funkcije dodijeljene dodjeljivom kotačiću 
na ručki
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

Funkcije dodijeljene dodjeljivom kotačiću 
na drški
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

Na zaslonu Assignable Button Status 
(stranica 15) možete pregledati dodijeljene 
funkcije.

Slow & Quick Motion

Kada je format snimanja (stranica 77) postavljen na sljedeće vrijednosti, broj sličica u sekundi 
za snimanje i broja sličica u sekundi za reprodukciju.

Format snimanja Brzina prijenosa
Frekvencija 
sustava

Način skeniranja 
pretražnika

Kodek Format 
videozapisa

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1 – 60

RAW i XAVC-I 3840×2160P 1 – 60

XAVC-I 4096×2160P 1 – 60

3840×2160P 1 – 60, 100, 120

1920×1080P 1 – 60, 100, 120, 
150, 180, 200, 240

XAVC-L 3840×2160P 1 – 60, 100, 120

1920×1080P 1 – 60, 100, 120, 
150, 180, 200, 240

S35 XAVC-I 1920×1080P 1 – 60, 100, 120

XAVC-L 1920×1080P 1 – 60, 100, 120

24 FF XAVC-I 4096×2160P 1 – 60

Način Slow & Quick Motion možete uključiti/
isključiti pritiskanjem dodjeljivog gumba 
(stranica 48) kojem je dodijeljena funkcija 
S&Q Motion.
Broj sličica u sekundi za snimanje možete 
postaviti pritiskanjem i zadržavanjem gumba.

[Napomene]
ˎˎ Način Slow & Quick Motion nije moguće postaviti 

tijekom snimanja, reprodukcije ili tijekom prikaza 
zaslona s minijaturama.
ˎˎ U načinu Slow & Quick Motion snimanje zvuka nije 

podržano.
ˎˎ Funkcija automatskog fokusiranja, funkcija 

automatskog irisa i funkcija automatskog zatvarača 
onemogućena je u načinu Slow & Quick Motion. 
Međutim, funkcija automatskog fokusiranja može se 
upotrebljavati kada je broj sličica u sekundi postavljen 
na sljedeće.

Frekvencija sustava Brzina prijenosa

59,94/29,97/23,98 30, 60, 120, 240

50/25 25, 50, 100, 200

ˎˎ Detalje o upotrebi izlaza RAW potražite pod 
stranica 55.

Snimanje videozapisa s prekidima 
(Interval Rec)

Funkcija videokamere Interval omogućuje 
snimanje ubrzanih videozapisa u internu 
memoriju videokamere. Funkcija predstavlja 
učinkovit način snimanja sporih objekata.
Po pokretanju snimanja videokamera 
automatski snima određeni broj sličica 
u određenom vremenskom intervalu.

Interval snimanja (Interval Time)

Broj okvira u jednoj snimci
(Number of Frames)

Kada je omogućena funkcija Interval Rec, prije 
početka snimanja automatski se uključuje 
svjetlo za videozapis HVL-LBPC (u opciji) 
koje omogućuje snimanja slika u uvjetima 
stabilnog svjetla i temperature boje (funkcija 
prethodnog osvjetljavanja).

[Napomene]
ˎˎ Različite posebne funkcije snimanja, kao što je 

Interval Rec, nije moguće primjenjivati istovremeno.
ˎˎ Ako se tijekom primjene funkcije Interval Rec 

omogući drugi poseban način snimanja, Interval Rec 
automatski se otpušta.

ˎˎ Način Interval Rec automatski se otpušta nakon promjena 
postavki sustava, primjerice formata videozapisa.
ˎˎ Postavke za Interval Rec nije moguće promijeniti 

tijekom snimanja, reprodukcije ili tijekom prikaza 
zaslona s minijaturama.
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Postavljanje načina Interval Rec

Postavite način Interval Rec (stranica 78) 
>Setting u izborniku Project cijelog izbornika na 
On i postavite Number of Frames i Interval Time.
Ako upotrebljavate svjetlo za videozapis 
HVL-LBPC (u opciji), prije početka snimanja po 
potrebi s Interval Rec >Pre-Lighting u izborniku 
Project postavite vremenski interval za 
uključenje svjetla za videozapis.

[Napomene]
ˎˎ Ako svjetlo za videozapis želite uključiti prije početka 

snimanja, sklopku za svjetlo za videozapis postavite 
na AUTO. Svjetlo za videozapis uključuje se i isključuje 
automatski sukladno postavci za Video Light Set 
(stranica 94) u izborniku Technical.
ˎˎ Ako uključite sklopku svjetla za videozapis, svjetlo 

za videozapis uvijek svijetli (svjetlo za videozapis ne 
uključuje/isključuje se automatski).
ˎˎ Ako je svjetlo za videozapis konfigurirano tako da 

se isključuje na pet sekundi ili manje, svjetlo za 
videozapis ne isključuje se.

Videokamera izlazi iz načina Interval Rec mode 
kada je isključite, no postavke za Number of 
Frames, Interval Time i Pre-lighting zadržavaju 
se. Pri sljedećem snimanju u načinu Interval 
Rec nije ih potrebno ponovno postavljati.

Snimanje s načinom Interval Rec

Pritisnite gumb za snimanje START/STOP za 
početak snimanja. Alternativno, u tražilu se 
prikazuje „Int Rec” i „Int Stby”.
Ako upotrebljavate funkciju prethodnog 
osvjetljavanja, svjetlo za videozapis uključuje 
se prije početka snimanja.

Prekidanje snimanja

Prekinite snimanje.
Po završetku snimanja podaci videozapisa, koji 
su se do tada zapisivali u memoriju, zapisuju 
se na medij.

Izlaz iz načina Interval Rec

Učinite jedno od sljedećeg.
ˎˎ Sklopka POWER postavite na Off.
ˎˎ U načinu stanja pripravnosti za snimanje 
isključite Interval Rec >Setting u izborniku 
Project postavljanjem na Off.

Način Interval Rec također se otpušta pri 
ponovnom pokretanju videokamere.

Ograničenja tijekom snimanja

ˎˎ Zvuk se ne snima.
ˎˎ Pregled snimke (Rec Review) nije moguć.

Ako je videokamera isključena tijekom 
snimanja

ˎˎ Ako je sklopka POWER na videokameri 
postavljena u položaj Off, mediju se pristupa 
na nekoliko sekundi radi snimanja slika 
spremljenih u memoriju do tog trenutka, 
a zatim se napajanje isključuje automatski.
ˎˎ Ako dođe do gubitka napajanja zbog 
uklanjanja baterije, odspajanja kabela 
istosmjernog napajanja ili isključenja 
napajanja na izmjeničnom adapteru, 
podaci videozapisa i zvuka snimaju se 
do mogućnosti njihova gubitka (najviše 
10 sekundi). Budite pažljivi pri zamjeni 
baterije.

Istovremeno snimanje na 
memorijsku karticu A i B 
(2-slot Simul Rec)

Možete istovremeno snimati i na memorijsku 
karticu A i memorijsku karticu B postavljanjem 
funkcije Simul Rec (stranica 14) na zaslonu 
Project status ili funkcije Simul Rec >Setting 
(stranica 78) u izborniku Project cijelog 
izbornika na On.

Video Signal Monitor

Vrstu videosignala za prikaz na zaslonu tražila 
možete postaviti na valni oblik, vektroskop 
ili histogram s Display On/Off >Video 
Signal Monitor (stranica 88) u izborniku 
Monitoring.
Narančasta linija prikazuje postavljenu 
vrijednost funkcije zebra.

Zaslon za praćenje mete

U načinu Cine EI postavka informacije 
o prostoru boje (stranica 24) ili postavci LUT 
monitora (stranica 76) u gornjem desnom 
dijelu monitora za videosignal za prikaz 
mete nadzora.

Zastavice za isječak

Isječku možete dodati zastavicu za isječak 
OK pritiskom gumba Clip Flag (stranica 5) 
i odabirom funkcije Add OK.
Zastavicu za isječak možete izbrisati pritiskom 
gumba dva puta i odabirom funkcije 
Delete Clip Flag.

[Savjeti]
ˎˎ Za dodavanje zastavica za isječak možete upotrijebiti 

i dodjeljivi gumb kojemu je dodijeljena funkcija 
zastavice za isječak (stranica 48).
ˎˎ Možete dodati i zastavicu za isječak s pomoću 

funkcije Set Clip Flag (stranica 92) u izborniku 
Thumbnail cijelog izbornika (stranica 65).
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Snimanje proxyja
Ova funkcija omogućuje vam da istovremeno 
snimate proxy podatke niske rezolucije 
i izvorne podatke videozapisa u visokoj 
rezoluciji.

Detalje o podržanim memorijskim karticama, formatiranju 
memorijskih kartica i provjeri preostalog kapaciteta 
pogledajte u odjeljku “Upotreba memorijskih kartica” 
(stranica 26).

Konfiguriranje prije snimanja

1	 Postavite funkciju Proxy Rec 
(stranica 14) na zaslonu Project ili Proxy 
Rec >Setting (stranica 78) u izborniku 
Project cijelog izbornika na On.

2	 Umetnite memorijsku karticu u utor za 
CFexpress Type A karticu / SD karticu 
(stranica 6).
ˎˎ Kod CFexpress kartica naljepnica 
je okrenuta na lijevu stranu.
ˎˎ Kod SD kartica naljepnica je okrenuta 
na desnu stranu s nakošenim rubom 
na dnu.

[Napomena]
Funkciju Proxy Rec nije moguće postaviti na On u 
isto vrijeme kao i funkciju S&Q Motion ili Interval Rec. 
Kada se funkcija Proxy Rec uključi postavljanjem na 
On, ovi drugi načini snimanja prisilno se isključuju 
postavljanjem na Off.

Snimanje proxyja

Pritisnite gumb za snimanje START/STOP za 
početak snimanja nakon dovršetka potrebne 
postavke za snimanje.

[Napomene]
ˎˎ Ako se tijekom pristupa memorijskoj kartici isključi 

videokamera ili ukloni memorijska kartica, nije 
moguće zajamčiti cjelovitost podataka na kartici. 
Svi podaci snimljeni na memorijsku karticu mogu biti 
odbačeni. Prije isključenja videokamere ili uklanjanja 
memorijske kartice obavezno provjerite je li indikator 
pristupa memorijskoj kartici isključen.
ˎˎ Provjerite da memorijska kartica ne iskače kad je 

umećete ili uklanjate.

Za izlaz zaustavite snimanje.

Postavljanje funkcije Audio 
Channel za snimanje proxyja

Odaberite funkciju Proxy Rec >Audio Channel 
(stranica 78) u izborniku Project cijelog 
izbornika i postavite kanal za zvuk za snimanje 
proxy podataka.

O snimljenoj datoteci

Nastavak naziva datoteke je ".mp4".
Istovremeno se snima i vremenski kod.

Odredište za spremanje snimljene 
datoteke

Snimljena datoteka sprema se u sljedeći 
direktorij.

Mediji za snimanje Put mape
SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

O nazivu datoteke

Naziv datoteke sastoji se od naziva isječka 
snimljenog na memorijsku karticu i sufiksa 
„S03”.
Pojedinosti o nazivima isječaka pogledajte 
pod Clip Name Format (stranica 86) 
izbornika TC/Media cijelog izbornika.
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Snimanje sa željenim izgledom
Kada je videokamera u načinu Custom, 
možete namještati crnu boju, matricu i druge 
parametre za stvaranje „izgleda” na temelju 
temeljnog izgleda.

：

Izgled

Matrix

Crni

Temeljni izgled

Možete i brzo odabrati drugačiji izgled 
spremanjem različitih kombinacija postavki 
u datotekama kadra.
Videokamera dolazi s ukupno šest unaprijed 
postavljenih izgleda.

Odabir izgleda

1	 Kada se prikazuje zaslon za snimanje, 
pritisnite višenamjenski kotačić.

2	 Odaberite ikonu SCN.

3	 Pritisnite višenamjenski kotačić.

4	 Odaberite željeni izgled s izbornika 
i pritisnite višenamjenski kotačić.

[Savjeti]
ˎˎ Tvornički su postavljene i konfigurirane sljedeće 

unaprijed postavljene postavke.

Shooting Mode Custom
Target Display SDR(BT.709) HDR(HLG)
Datoteka kadra 1 S-Cinetone HLG Live

Datoteka kadra 2 Standard HLG Natural

Datoteka kadra 3 Still (Nije 
registrirano

Datoteka kadra 4 ITU709 (Nije 
registrirano

Datoteke kadra  
od 5 do 16

(Nije 
registrirano

(Nije 
registrirano

ˎˎ Izgled možete odabrati i s pomoću funkcije Scene File 
(stranica 13) na zaslonu Main Status ili Scene File 
>Recall (stranica 83) u izborniku Paint/Look cijelog 
izbornika. Možete i opozvati prethodno postavljeni 
izgled s pomoću funkcije Scene File >Preset Recall.

Uvoz željenog temeljnog izgleda

Možete uvesti 3D LUT datoteku stvorenu na 
računalu ili drugom uređaju kao temeljni 
izgled. Moguće je uvesti do 16 datoteka.
ˎˎ Format datoteke: Datoteka CUBE (*.cube) 
za 3D LUT datoteku od 17 točaka ili 33 
točke s pomoću aplikacija Catalyst Browse, 
RAW Viewer ili DaVinci Resolve* (tvrtka 
Blackmagic Design Pty. Ltd.).
*	 Provjereno u skladu s Resolve V9.0, V10.0 i V11.0.

ˎˎ Ulazni prostor boja / gama: S-Gamut3.
Cine/S-Log3 ili S-Gamut3/S-Log3

1	 Na računalu ili drugom uređaju spremite 
3D LUT datoteku u posebnu mapu ili 
medij za snimanje.

Mediji za 
snimanje

Put mape

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress 
Type A

/SONY/PRO/LUT/

2	 Umetnite medij za snimanje na koji su 
spremljene 3D LUT datoteke u utor za 
CFexpress Type A karticu / SD karticu (B).

3	 Odaberite funkciju Base Look >Import 
(stranica 83) u izborniku Paint/Look 
cijelog izbornika.

4	 Odaberite odredište za uvoz.

5	 Odaberite 3D LUT datoteku za uvoz.
Slijedite upute na zaslonu. Videokamera 
upravlja 3D LUT datotekom kao temeljnim 
izgledom.

6	 Odaberite 3D LUT datoteku s pomoću 
funkcije Base Look >Select (stranica 83) 
u izborniku Paint/Look cijelog izbornika.

7	 Konfigurirajte funkciju Base Look >Input 
and Output (stranica 83) u izborniku 
Paint/Look cijelog izbornika kako biste 
uskladili atribute uvezene 3D LUT 
datoteke.

Namještanje nedovoljne ekspozicije

Ako postoji tendencija za nedovoljnu 
ekspoziciju kada je odabrana automatska 
ekspozicija pri upotrebi uvezenog temeljnog 
izgleda, namjestite funkciju Base Look >AE 
Level Offset (stranica 83) u izborniku 
Paint/Look.

[Napomene]
ˎˎ Sami uvoz 3D LUT datoteke ne utječe na sliku. Učitajte 

3D LUT datoteku s pomoću funkcije Base Look 
>Select (stranica 83) u izborniku Paint/Look cijelog 
izbornika.
ˎˎ Ako funkcija Input nije ispravno postavljena, nećete 

dobiti odgovarajući izgled.
ˎˎ Postavke stavki izbornika Input, Output i AE Level 

Offset primjenjuju se na temeljni izgled s pomoću 
funkcije Select. Ako se uveze više 3D LUT datoteka, 
odaberite Select za svaku 3D LUT datoteku i 
konfigurirajte funkcije Input, Output i AE Level Offset 
pojedinačno za svaku datoteku.
ˎˎ Konfigurirane postavke Input, Output i AE Level Offset 

spremljene su za svaku 3D LUT datoteku.
ˎˎ Opcije odabira temeljnog izgleda / LUT-a za uvezene 

3D LUT datoteke zajedničke su za načine SDR(BT.709) 
/ HDR(HLG) / Cine EI, ali konverzija prostora boja 
i game ne obavljaju se u skladu s tim načinima.
ˎˎ 3D LUT datoteke nisu izbrisane kada je u izborniku 

Maintenance odabrana funkcija All Reset >Reset.
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Prilagođavanje izgleda

Izgled možete prilagoditi na temelju 
temeljnog izgleda s pomoću funkcije Matrix 
i drugih stavki za postavljanje u izborniku 
Paint/Look cijelog izbornika. Pojedinosti 
o svakoj stavci za postavljanje potražite pod 
stranica 83.
Povežite videokameru s TV-om ili monitorom 
i namjestite kvalitetu slike dok gledate sliku 
na TV-u ili zaslonu monitora.

[Napomena]
Kada uvozite 3D LUT datoteku i primijenite je na sliku, 
željeni izgled definiran u 3D LUT datoteci neće biti 
moguće ostvariti ako su postavke funkcije Matrix i druge 
postavke osim postavki temeljnog izgleda u izborniku 
Paint/Look promijenjene. Možete ponovno postaviti 
sve prilagođene postavke s pomoću funkcije Reset 
Paint Settings >Reset without Base Look (stranica 83) 
u izborniku Paint/Look cijelog izbornika.

Spremanje izgleda

Trenutačni izgled možete spremiti kao 
datoteku kadra u internu memoriju s pomoću 
funkcije Scene File >Store (stranica 83) 
u izborniku Paint/Look cijelog izbornika.
Možete brzo spremiti s pomoću operacija 
u izravnom izborniku sa zaslona za snimanje.

[Napomena]
Ako odaberete drugi izgled bez spremanja trenutačnog 
izgleda, trenutačni izgled se odbacuje.

[Savjet]
Možete prepisati unaprijed postavljene datoteke kadra.
Za obnovu unaprijed postavljene datoteke kadra učitajte 
izgled koji želite obnoviti s pomoću funkcije Scene File 
>Preset Recall (stranica 83) u izborniku Paint/Look 
cijelog izbornika i zatim spremite datoteku kadra s 
pomoću funkcije Scene File >Store.

Brisanje spremljenog izgleda

Datoteku kadra spremljenu u internu memoriju 
možete izbrisati s pomoću funkcije Scene File 
>Delete (stranica 83) u izborniku Paint/Look 
cijelog izbornika.

[Savjet]
Kada je izbrišete, više se neće prikazivati u izravnom 
izborniku.

Brisanje temeljnog izgleda

Uvezenu 3D LUT datoteku možete izbrisati 
s pomoću funkcije Base Look >Delete 
(stranica 83) u izborniku Paint/Look cijelog 
izbornika.
Sve uvezene 3D LUT datoteke možete izbrisati 
s pomoću funkcije Base Look >Delete All 
(stranica 83) u izborniku Paint/Look cijelog 
izbornika.

[Napomene]
ˎˎ Prije brisanja provjerite da se temeljni izgled ne 

upotrebljava u bilo kojim datotekama kadra. Ako se 
izbriše temeljni izgled koji se upotrebljava, izgled 
odgovarajućih datoteka kadra neće biti točan.
ˎˎ Uvezene 3D LUT datoteke nisu izbrisane kada je 

odabrana funkcija All Reset >Reset (stranica 99) 
u izborniku Maintenance cijelog izbornika.
ˎˎ Izbrisani temeljni izgled više se ne može 

upotrebljavati kao LUT u načinu Cine EI 
(stranica 54).
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Snimanje s pomoću namještanja izgleda u postprodukciji
Upotrebom videokamere u načinu Cine 
EI i ravnomjernim snimanjem gradacija 
od tamnih područja do svijetlih područja 
možete napraviti fine izmjene poput lokalnog 
obnavljanja gradacije tamnih područja 
i svijetlih područja u postprodukciji.
Međutim, kada gledate snimljene slike na 
konvencionalnom monitoru, cjelokupni 
kontrast bit će nizak zbog čega će namještanje 
fokusa i ekspozicije biti teže.
LUT možete primijeniti na metu praćenja na 
videokameri kako bi vam pomogao u raznim 
namještanjima tijekom snimanja. LUT možete 
primijeniti i na reprodukciju videozapisa kako 
biste provjerili konačan rezultat.
LUT-ove primjenjuju sljedeći sustavi. Međutim, 
moguće je primijeniti samo jedan LUT.
ˎˎ Izlaz za SDI i izlaz za HDMI
ˎˎ Tražilo i proxy slike, emitiranje
ˎˎ Videozapis snimljen na mediju za snimanje

Primjena LUT-a na sliku tražila

1	 Pritisnite gumb MENU za prikaz zaslona 
Monitoring Status.

2	 Odaberite stupac Gamut/Gamma 
u redu VF.

3	 Odaberite On ili Off.

[Napomene]
ˎˎ Postavka LUT On/Off funkcije VF primjenjuje se 

i na proxy datoteku i videozapis za emitiranje.
ˎˎ Funkcija Gamma Display Assist dostupna je tijekom 

rada povećala za fokusiranje.

[Savjeti]
ˎˎ Možete namjestiti i s pomoću funkcije LUT On/

Off >VF/Proxy/Stream (stranica 76) u izborniku 
Shooting cijelog izbornika.
ˎˎ SDI/HDMI može biti postavljen slično kao i VF.
ˎˎ Kod videozapisa na mediju za snimanje možete 

postaviti s pomoću funkcije LUT On/Off >Internal Rec 
(stranica 76) u izborniku Shooting cijelog izbornika.

Promjena LUT-a

1	 Pritisnite gumb MENU za prikaz zaslona 
Monitoring Status.

2	 Odaberite polje Base Look/LUT.

3	 Odaberite LUT koji će se primjenjivati s 
popisa temeljnog izgleda.

[Savjeti]
ˎˎ Možete uvesti i primijeniti i 3D LUT datoteku. Moguće 

je odabrati s709, 709(800%) ili S-Log3 za temeljni 
izgled. Pojedinosti potražite u odjeljku “Uvoz željenog 
temeljnog izgleda” (stranica 52) i “Brisanje 
temeljnog izgleda” (stranica 53).
ˎˎ Temeljni izgled možete postaviti i s pomoću funkcije 

Base Look >Select (stranica 83) u izborniku Paint/
Look cijelog izbornika.

Promjena distribucije tamnih 
i svijetlih područja u snimljenom 
videozapisu

Možete promijeniti distribuciju tamnih 
i svijetlih područja, primjerice, ako želite 
prioritet dati tonu tamnih područja u odnosu 
na svijetla područja promjenom funkcije 
Exposure Index iz osnovne osjetljivosti.

1	 Primijenite LUT na sliku tražila 
(stranica 54).

2	 Pritisnite gumb MENU za prikaz zaslona 
Camera Status.

3	 Postavite polja L/M/H funkcije Exposure 
Index.
Pojedinačne postavke dodijeljene su 
položajima L/M/H sklopke ISO/GAIN 
(stranica 5).

4	 Odaberite vrijednost funkcije Exposure 
Index koju ćete primijeniti s pomoću 
sklopke ISO/GAIN.

5	 Namjestite ekspoziciju slike tražila kako 
vam odgovara.

[Napomena]
Funkcija Gamma Display Assist dostupna je tijekom rada 
povećala za fokusiranje. Postavka Exposure Index ne 
primjenjuje se na funkciju Gamma Display Assist.

[Savjeti]
ˎˎ Ekspozicija se može namjestiti i s pomoću funkcije 

ISO/Gain/EI >Exposure Index (stranica 72) 
u izborniku Shooting cijelog izbornika.
ˎˎ Druga numerička vrijednost postavke navodi koliko 

je koraka informacija o svjetlini dodijeljeno za svijetla 
područja (svjetlina viša od 18 % sive boje). Područja 
svjetlija od ovih imaju prejaku ekspoziciju.  
Primjer: U postavki „400EI/5.0E,” koraci od 0,5 
dodjeljuju se svijetloj strani.

ˎˎ To možete upotrebljavati i kao vodič za provjeru 
tona tamnih i svijetlih područja tijekom snimanja. 
Primjerice, ako je M položaj temeljna osjetljivost, 
L položaj iznosi minus 2 koraka, a položaj H plus 2 
koraka, možete provjeriti prebacivanjem sklopke ISO/
GAIN. Zapamtite da se trebate vratiti u M položaj 
nakon provjere ekspozicije.
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Možete snimiti RAW videosignal iz priključnice 
SDI OUT videokamere na podržani vanjski snimač.

1	 Spojite vanjski RAW snimač na priključnicu 
SDI OUT videokamere.

2	 Postavite način snimanja s pomoću 
zaslona Project status (stranica 14) ili 
funkcije Base Setting >Shooting Mode 
(stranica 77) u izborniku Project cijelog 
izbornika na način Cine EI.

3	 Postavite način skeniranja (samo FF) 
s pomoću funkcije Imager Scan na 
zaslonu Project status ili s pomoću 
funkcije Rec Format >Imager Scan 
Mode (stranica 77) u izborniku Project 
cijelog izbornika.

4	 Postavite kodek s pomoću zaslona Project 
status ili funkcije Rec Format >Codec 
(stranica 77) u izborniku Project cijelog 
izbornika na kodek koji uključuje RAW.
Odabirom funkcije RAW & XAVC-I 
istovremeno će se snimati RAW 
videozapis na vanjski RAW snimač 
i videozapis na memorijske kartice 
u videokameri.

5	 Postavite rezoluciju s pomoću zaslona 
Project status ili funkcije Rec Format >RAW 
Output Format (stranica 77) u izborniku 
Project cijelog izbornika.

6	 Provjerite je li vanjski snimač uključen i 
zatim pritisnite gumb za snimanje START/
STOP na videokameri.

	 [Napomena]
Nakon početka snimanja na vanjski snimač, bez 
upotrebe gumba za snimanje START/STOP na 
videokameri, isječci možda neće biti ispravno 
snimljeni.

Podržani RAW izlazni formati prikazani 
su u nastavku.

Frekvencija 
sustava

Kodek RAW izlazni 
format

59,94/
50/
29,97/
25/
23,98

RAW 4096×2160

3840 × 2160

RAW i XAVC-I 4096×2160

3840 × 2160

24 RAW 4096×2160

RAW i XAVC-I 4096×2160

Indikator statusa snimanja

Kada je funkcija Display On/Off (stranica 87) 
>RAW Output Control Status u izborniku 
Monitoring cijelog izbornika postavljena na 
On, status RAW snimanja naveden je ikonom 
koja se prikazuje na zaslonu tražila.

[Napomena]
Kontrolni signal snimanja jest izlaz iz priključnice 
SDI OUT  videokamere, no nije moguće dobiti status 
vanjskog snimača. U skladu s navedenim, na videozapisu 
može biti navedeno da je snimanje RAW videozapisa 
u tijeku kada vanjski snimač ustvari ne snima. Provjerite 
indikatore na vanjskom snimaču kako biste dobili točan 
status rada.

[Savjet]
Prikazuje se i vrijednost postavke RAW izlaznog formata.

Usporene i ubrzane snimke

Ako je funkcija S&Q Motion >Setting 
u izborniku Shooting postavljena na On, 
RAW videozapis snima se u načinu Slow & 
Quick Motion.
Pojedinosti o podržanim brzinama sličica 
u sekundi za snimanje potražite ovdje 
stranica 49.

Snimanje RAW videozapisa
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Povezivanje s drugim uređajima putem mreže LAN
Videokameru je vezom LAN moguće povezati 
s pametnim telefonima, tabletima i drugim 
uređajima.
Stvaranje veze LAN između uređaja 
i videokamere s pomoću aplikacije „Content 
Browser Mobile” omogućuje sljedeće.
ˎˎ Daljinsko upravljanje putem mreže LAN 
Videokamerom možete upravljati 
s pametnim telefonom, tabletom 
ili računalom povezanim s videokamerom 
putem mreže LAN.
ˎˎ Prijenos datoteka putem mreže LAN 
Možete prenositi proxy datoteke (niska 
rezolucija) ili originalne datoteke (visoka 
rezolucija) koje su snimljene na memorijsku 
karticu u videokameri na server putem 
mreže LAN.
ˎˎ Praćenje videozapisa putem mreže LAN 
Možete stvoriti usmjeravanje (H.264) 
s kamere ili reproducirati videozapis 
videokamere te pratiti videozapis 
aplikacijom "Content Browser Mobile" 
na uređaju putem mreže LAN.

Aplikacija "Content Browser Mobile"

Videokamerom možete upravljati daljinski 
na zaslonu uređaja dok pratite videozapis 
s videokamere s aplikacijom "Content Browser 
Mobile".

Za detalje o aplikaciji "Content Browser Mobile" obratite 
se prodajnom ili servisnom predstavniku tvrtke Sony.

Postavljanje korisničkog imena 
User Name i lozinke Password

Za primjenu mrežne funkcije postavite 
korisničko ime i lozinku.

1	 Postavite funkciju Access Authentication 
>User Name (stranica 95) u izborniku 
Network cijelog izbornika.

2	 Postavite funkciju Access Authentication 
>Password (stranica 95) u izborniku 
Network cijelog izbornika.

Povezivanje s Wireless LAN Access 
Point Mode

Videokamera radi kao pristupna točka 
i povezuje se s uređajem putem bežične 
mreže LAN.

Pametni telefon/tablet

Povezivanje s uređajem kompatibilnim s 
tehnologijom s jednim dodirom

Tehnologija BFC omogućuje povezivanje 
uređaja koji podržavaju NFC (povezivanje 
dodirom).

1	 Otvorite [Settings] na uređaju, odaberite 
[More] i u potvrdni okvir za NFC postavite 
kvačicu.

2	 Uključite videokameru.

3	 Uključite funkciju NFC.
Pritisnite i zadržite (na 3 sekunde) 
dodjeljivi gumb kojem je dodijeljena 
funkcija NFC ili odaberite Wireless LAN 
>NFC u izborniku Network kako biste 
uključili način za povezivanje 
tehnologijom NFC.
Funkcija NFC dostupna je samo dok 
se na zaslonu prikazuje .

4	 Uređajem dodirnite videokameru.
Uređaj se povezuje s videokamerom 
i pokreće se aplikacija "Content Browser 
Mobile".

	 [Napomene]
ˎˎ Prethodno onemogućite način za automatsko 

isključivanje i zaključavanje zaslona.
ˎˎ Dodirnite i držite uređaj dok se ne pokrene 

aplikacija "Content Browser Mobile" (od 1 do 2 
sekunde).
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Povezivanje s uređajem kompatibilnim s 
protokolom WPS

Protokol WPS omogućuje povezivanje uređaja 
koji podržavaju protokol WPS.

1	 Odaberite funkciju Wireless LAN >Setting 
>Access Point Mode u izborniku Network 
cijelog izbornika.

2	 Odaberite funkciju Wireless LAN >WPS 
>Execute u izborniku Network cijelog 
izbornika.

3	 Otvorite mrežne postavke uređaja ili 
postavke za Wi-Fi na uređaju i uključite 
Wi-Fi.

4	 S popisa identifikatora SSID pod Wi-FI 
Network na uređaju odaberite SSID 
videokamere, a zatim pod Option na 
uređaju odaberite WPS Push Button 
kako biste se povezali.

	 [Napomene]
ˎˎ Metode rada razlikuju se ovisno o uređaju.
ˎˎ SSID i lozinku videokamere potražite pod AP 

Mode Settings >Camera SSID & Password 
(stranica 95) u izborniku Network cijelog 
izbornika.

5	 Povežite putem aplikacije Content 
Browser Mobile.

Povezivanje unosom identifikatora SSID 
i lozinke u uređaj

Videokameru možete povezati s uređajem 
unosom identifikatora SSID i lozinke u uređaj.

1	 Odaberite funkciju Wireless LAN >Setting 
>Access Point Mode u izborniku Network 
cijelog izbornika.

2	 Otvorite mrežne postavke uređaja 
ili postavke za Wi-Fi na uređaju 
i uključite Wi-Fi.

3	 Povežite uređaj s videokamerom 
odabirom identifikatora SSID videokamere 
na popisu identifikatora SSID pod Wi-Fi 
Network i unosom lozinke.
SSID i lozinku videokamere potražite pod 
AP Mode Settings >Camera SSID & 
Password (stranica 95) u izborniku 
Network.

	 [Napomena]
Metode rada razlikuju se ovisno o uređaju.

4	 Povežite putem aplikacije Content 
Browser Mobile.

Povezivanje s Wireless LAN Station 
Mode

Videokamera se kao klijent povezuje 
s postojećom pristupnom točkom bežične 
mreže LAN. Videokamera i uređaj povezuju 
se putem pristupne točke.
U povijesti se prikazuje 10 pristupnih točki 
s kojima je ostvarena veza.
Povijest veza sprema se u datoteci ALL, 
no pristupne lozinke ne spremaju se. Pri 
sljedećem povezivanju nakon unosa datoteke 
ALL nužno je unijeti lozinku.

Pametni 
telefon/tablet

Pristupna točka

Računalo

Povezivanje s pristupnom točkom 
funkcijom WPS

Ako je pristupna točka kompatibilna 
s funkcijom WPS, s pristupnom točkom 
povezuje se s jednostavnim postavkama.

1	 Uključite pristupnu točku.

2	 Uključite videokameru.

3	 Odaberite funkciju Wireless LAN >Setting 
> Station Mode u izborniku Network 
cijelog izbornika.

4	 Odaberite funkciju ST Mode Settings 
>Camera Remote Control (stranica 95) 
>Enable u izborniku Network cijelog 
izbornika.

5	 Odaberite funkciju Wireless LAN >WPS 
>Execute u izborniku Network cijelog 
izbornika.

6	 Pritisnite gumb WPS na pristupnoj točki.
Više detalja o radu s gumbom WPS 
potražite u uputama za upotrebu 
pristupne točke.
Nakon uspješnog povezivanja ikona 
indikatora statusa mreže na zaslonu 
tražila prikazuje 1 ili više.

	 [Napomena]
Ako povezivanje ne uspije, ponovno provedite 
korake od prvog koraka.

7	 Povežite uređaj s pristupnom točkom.
Pojedinosti o povezivanju potražite 
u uputama za upotrebu uređaja.

8	 Povežite putem aplikacije Content 
Browser Mobile.
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Povezivanje s pristupnom točkom 
automatskim ili ručnim otkrivanjem 
mreže

Vezu za povezivanje sa željenom pristupnom 
točkom moguće je konfigurirati u cijelom 
izborniku.
Vezu za povezivanje sa željenom pristupnom 
točkom moguće je konfigurirati funkcijom 
automatskog otkrivanja mreže.

Povezivanje funkcijom automatskog otkrivanja 
mreže

1	 Provedite korake od 1 do 3 pod 
“Povezivanje s pristupnom točkom 
funkcijom WPS” (stranica 57).

2	 Odaberite funkciju ST Mode Settings 
>Scan Networks (stranica 96) >Execute 
u izborniku Network cijelog izbornika.
Videokamera počinje tražiti odredišta 
za povezivanje.
Pronađena moguća odredišta prikazuju 
se na popisu.

3	 Odaberite odredište s popisa.
Prikazuje se zaslon se detaljima o mreži 
(pristupnoj točki). Odabrana veza 
prikazuje se pod SSID.

4	 Odaberite Password i postavite lozinku 
na zaslonu za unos lozinke.
Odabirom identifikatora SSID u povijesti 
veza automatski se konfiguriraju postavke, 
uključujući lozinku.
Odaberite lozinku za povratak na zaslon 
se detaljima o mreži (pristupnoj točki).

5	 Konfigurirajte sljedeće mrežne postavke.
ˎˎ DHCP 
Postavite postavke za DHCP.  
Kada uključite postavljanjem na On, 
IP adresa automatski se dodjeljuje 
videokameri.  
Za ručnu dodjelu IP adrese videokameri 
isključite postavljanjem na Off.
ˎˎ IP Address 
Unesite IP adresu jedinice.  
Postavka je dostupna samo kada 
je DHCP isključen s Off.
ˎˎ Subnet Mask 
Unesite masku podmreže jedinice.  
Postavka je dostupna samo kada 
je DHCP isključen s Off.
ˎˎ Gateway 
Unesite pristupnik za pristupnu točku.  
Postavka je dostupna samo kada je 
DHCP isključen s Off.
ˎˎ DNS Auto 
Postavljanje automatskog dohvata 
sustava DNS.  
Kada uključite postavljanjem na 
On, adresa poslužitelja sustava DNS 
automatski se dohvaća. Postavka je 
dostupna samo kada je DHCP uključen 
s On.
ˎˎ Primary DNS Server 
Unesite primarni poslužitelj sustava 
DNS za pristupnu točku.  
Postavka je dostupna samo kada je 
funkcija DNS Auto isključena s Off.
ˎˎ Secondary DNS Server 
Unesite sekundarni poslužitelj sustava 
DNS za pristupnu točku.  
Postavka je dostupna samo kada je 
funkcija DNS Auto isključena s Off.

6	 Po dovršetku odaberite Connect kako 
biste se povezali s pristupnom točkom.

Ručno povezivanje

1	 Provedite korake od 1 do 3 pod 
“Povezivanje s pristupnom točkom 
funkcijom WPS” (stranica 57).

2	 Odaberite funkciju ST Mode Settings 
>Manual Register (stranica 96) 
>Execute u izborniku Network cijelog 
izbornika.
Trenutačno se prikazuje se zaslon se 
detaljima o mreži (pristupnoj točki).

3	 Konfigurirajte sljedeće mrežne postavke.
ˎˎ SSID 
Unesite SSID za pristupnu točku veze.
ˎˎ Security 
Odaberite metodu šifriranja.
ˎˎ Password 
Unesite lozinku za pristupnu točku veze.
ˎˎ DHCP 
Postavite postavke za DHCP.  
Kada uključite postavljanjem na On, 
IP adresa automatski se dodjeljuje 
videokameri.  
Za ručnu dodjelu IP adrese videokameri 
isključite postavljanjem na Off.
ˎˎ IP Address 
Unesite IP adresu jedinice.  
Postavka je dostupna samo kada je 
DHCP isključen s Off.
ˎˎ Subnet Mask 
Unesite masku podmreže jedinice.  
Postavka je dostupna samo kada je 
DHCP isključen s Off.
ˎˎ Gateway 
Unesite adresu pristupnika.  
Postavka je dostupna samo kada je 
DHCP isključen s Off.

ˎˎ DNS Auto 
Postavljanje automatskog dohvata 
sustava DNS.  
Kada uključite postavljanjem na 
On, adresa poslužitelja sustava DNS 
automatski se dohvaća. Postavka je 
dostupna samo kada je DHCP uključen 
s On.
ˎˎ Primary DNS Server 
Unesite adresu primarnog poslužitelja 
sustava DNS.  
Postavka je dostupna samo kada je 
funkcija DNS Auto isključena s Off.
ˎˎ Secondary DNS Server 
Unesite adresu sekundarnog poslužitelja 
sustava DNS.  
Postavka je dostupna samo kada je 
funkcija DNS Auto isključena s Off.

4	 Po dovršetku odaberite Connect kako 
biste se povezali s pristupnom točkom.
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Povezivanje s uređajem s kabelom 
za LAN

Povezivanje s uređajem možete napraviti 
povezivanjem žične priključnice za LAN žičnog 
adaptera za LAN (nije obavezno) koja je 
spojena na USB-C priključnicu (stranica 7) 
videokamere s Wi-Fi usmjerivačem (nije 
obavezno) s pomoću kabela za LAN.

Pametni telefon/tablet

Wi-Fi usmjerivač

Veze kabelom za LAN i postavke žične 
mreže LAN

1	 Povežite žičnu priključnicu za LAN žičnog 
adaptera za LAN s Wi-Fi usmjerivačem 
s pomoću kabela za LAN.

2	 Uključite videokameru.

3	 Postavite funkciju Wired LAN >Setting 
(stranica 97) u izborniku Network 
cijelog izbornika na On.

4	 Konfigurirajte postavke veze s Wired LAN 
>Detail Settings (stranica 97) u 
izborniku Network.
ˎˎ DHCP 
Postavite postavke za DHCP.  
Kada uključite postavljanjem na On, 
IP adresa automatski se dodjeljuje 
videokameri. 
Za ručnu dodjelu IP adrese videokameri 
isključite postavljanjem na Off.
ˎˎ IP Address 
Unesite IP adresu jedinice.  
Postavka je dostupna samo kada je 
DHCP isključen s Off.
ˎˎ Subnet Mask 
Unesite masku podmreže jedinice.  
Postavka je dostupna samo kada je 
DHCP isključen s Off.
ˎˎ Gateway 
Unesite adresu pristupnika.  
Postavka je dostupna samo kada 
je DHCP isključen s Off.
ˎˎ DNS Auto 
Postavljanje automatskog dohvata 
sustava DNS.  
Kada uključite postavljanjem na On, adresa 
poslužitelja sustava DNS automatski se 
dohvaća. Postavka je dostupna samo kada 
je DHCP uključen s On.
ˎˎ Primary DNS Server 
Unesite adresu primarnog 
poslužitelja sustava DNS.  
Postavka je dostupna samo kada je 
funkcija DNS Auto isključena s Off.

ˎˎ Secondary DNS Server 
Unesite adresu sekundarnog 
poslužitelja sustava DNS.  
Postavka je dostupna samo kada je 
funkcija DNS Auto isključena s Off.

5	 Po dovršetku odaberite Set za primjenu 
postavki.

[Napomene]
ˎˎ Nakon promjena postavki veze uvijek odaberite Set. 

Postavke se ne primjenjuju ako ne odaberete Set.
ˎˎ Upotrijebite žični adapter za LAN USB Type C. 

Preporučuje se upotreba kompatibilnog adaptera 
Gigabit Ethernet. Međutim, rad nije zajamčen sa svim 
uređajima.
ˎˎ Može utjecati na funkciju Wi-Fi komunikacije, ovisno 

o modelu žičnog adaptera za LAN (nije obavezno).
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Videokameru s internetom možete povezati 
dijeljenjem putem USB-a, žičnom mrežom LAN 
ili bežičnom mrežom LAN.

Povezivanje dijeljenjem putem USB-a

Jedinicu možete spojiti s pametnim telefonom 
putem USB kabela i zatim je povezati na 
internet s pomoću pametnog telefona.

Konfiguracija komunikacije s pametnim 
telefonom

Omogućavanje dijeljenja komunikacije 
na pametnom telefonu.
Pojedinosti potražite u uputama za upotrebu 
pametnog telefona.

Postavljanje pametnog telefona na 
videokameru

Spojite USB kabel na priključnicu USB-C 
(stranica 7) videokamere i zatim spojite 
pametni telefon.

[Napomene]
ˎˎ Pametni telefon postavite/uklonite dok je 

videokamera isključena.
ˎˎ Dijeljenje putem USB-a nije moguće ako je pametni 

telefon spojen putem USB koncentratora.
ˎˎ Dijeljenje putem USB-a nije moguće ako je računalo 

postavljeno na priključnicu USB/multi (stranica 7).

Spajanje s mrežom

1	 Uključite videokameru.

2	 Postavite funkciju Modem >Setting 
(stranica 97) izbornika Network cijelog 
izbornika na On.

Omogućavanje rada s pametnog telefona

Za upravljanje videokamerom na daljinu 
s pomoću aplikacije Content Browser Mobile na 
pametnom telefonu postavite funkciju Modem 
>Camera Remote Control (stranica 95) u 
izborniku Network cijelog izbornika na Enable.

Povezivanje s Wireless LAN Station 
Mode

Videokameru možete povezati s internetom u 
načinu za stanicu za Wi-Fi s opcionalnim Wi-Fi 
usmjerivačem ili dijeljenjem s drugim uređajem.

Pametni 
telefon/tablet

Wi-Fi usmjerivač

Računalo

Internet

Pametni 
telefon/tablet

Internet

Povežite s Wi-Fi usmjerivačem ili uređajem 
kako je opisano u odjeljku “Povezivanje s 
Wireless LAN Station Mode” (stranica 57).

Povezivanje s kabelom za LAN

Povezivanje na internet možete napraviti 
povezivanjem žične priključnice za LAN žičnog 
adaptera za LAN (nije obavezno) koja je 
spojena na USB-C priključnicu (stranica 7) 
videokamere s Wi-Fi usmjerivačem (nije 
obavezno) s pomoću kabela za LAN.

Pametni 
telefon/tablet

Računalo

Wi-Fi usmjerivač

Internet

Povežite s Wi-Fi usmjerivačem ili uređajem 
kako je opisano u odjeljku “Povezivanje s 
uređajem s kabelom za LAN” (stranica 59).

[Napomene]
ˎˎ Nije moguće upotrebljavati žični USB adapter za LAN 

ako je računalo postavljeno na priključnicu USB/multi 
(stranica 7).
ˎˎ Može utjecati na funkciju Wi-Fi komunikacije, ovisno 

o modelu žičnog adaptera za LAN (nije obavezno).

Povezivanje s internetom
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Prijenos datoteka
Datoteku proxy ili originalnu datoteku snimljenu 
na videokameru možete prenijeti na poslužitelj 
na internetu ili poslužitelj u lokalnoj mreži putem 
pametnog telefona ili pristupne točke.

Pripreme

Spajanje s mrežom

Povežite videokameru s internetom ili lokalnom 
mrežom prateći upute pod “Povezivanje s 
internetom” (stranica 60) ili “Povezivanje 
s drugim uređajima putem mreže LAN” 
(stranica 56).

Registriranje odredišta za prijenos 
datoteke

Unaprijed registrirajte poslužitelj za prijenos.

1	 Odaberite funkciju File Transfer >Server 
Settings1 (ili Server Settings2, Server 
Settings3) u izborniku Network cijelog 
izbornika.
Prikazuje se zaslon za postavljanje 
odredišta prijenosa.

2	 Postavite svaku stavku na zaslonu za 
postavljanje odredišta prijenosa.
Display Name
Unesite naziv poslužitelja koji se prikazuje 
u popisu za odredište prijenosa.
Service
Prikazuje vrstu poslužitelja.
“FTP”: Poslužitelj FTP
Host Name
Unesite adresu poslužitelja.
Port
Unesite broj ulaza na koji se priključuje 
poslužitelj.
User Name

Unesite korisničko ime.
Password
Unesite lozinku.
Passive Mode
Uključite/isključite pasivni način rada.
Destination Directory
Unesite naziv mape na odredišnom 
poslužitelju.

	 [Napomene]
ˎˎ Pri uređivanju, "" označava znakove koje nije 

moguće mijenjati. Pri uređivanju naziva mape koji 
sadrži te znakove ispravan rad nije zajamčen.  
Ako trebate urediti, izbrišite sve znakove 
i ponovno unesite vrijednost.
ˎˎ Ako pod Destination Directory unesete znakove 

koji nisu valjani na odredišnom poslužitelju, 
datoteke se prenose u početnu mapu korisnika. 
Znakovi koji nisu valjani razlikuju se ovisno 
o poslužitelju.

Using Secure Protocol
Postavljanje provedbe sigurnog prijenosa 
FTP.
Root Certificate
Učitavanje/brisanje certifikata.
ˎˎ Load 
U 3. koraku odaberite Set za uvoz 
certifikata CA.

*	 Certifikat koji treba učitati mora biti u PEM 
formatu s nazivom datoteke „certification.pem” 
i treba biti zapisan u korijenskom direktoriju 
memorijske kartice umetnute u utor za CFexpress 
Type A karticu / SD karticu (B).

ˎˎ Clear 
U 3. koraku odaberite Set za brisanje 
certifikata CA.
ˎˎ None 
Bez učitavanja ili brisanja certifikata.

	 [Napomene]
ˎˎ Prije uvoza certifikata CA sat videokamere 

postavite na točno vrijeme.
ˎˎ Pri snimanju u formatu XAVC-I 4096×2160P/ 

3840×2160P 59.94/50P funkciju Load nije 
moguće odabrati.
ˎˎ U stanju slabog napajanja za certifikat CA nije 

moguće odabrati funkcije Load/Clear.

Root Certificate Status
Prikazuje status učitavanja certifikata.
Reset
Postavke pod Server Settings ponovno 
postavlja na zadane vrijednosti.

3	 Po dovršetku odaberite Set za primjenu 
postavki.
Nakon promjena postavki uvijek odaberite 
Set. Postavke se ne primjenjuju ako ne 
odaberete Set.

Odabir datoteke i prijenos

Možete odabrati proxy datoteke ili originalne 
datoteke snimljene na memorijske kartice za 
prijenos na server.

Učitavanje proxy datoteke na memorijsku 
karticu sa zaslona s minijaturama

1	 Povežite videokameru i uređaj vezom LAN 
(stranica 56).

2	 Odaberite funkciju Transfer Clip (Proxy) 
>Select Clip u izborniku Thumbnail cijelog 
izbornika.
Zaslon s prikaza cijelog izbornika prelazi 
na zaslon s minijaturama.
Isječke je moguće prenositi sa zaslona s 
minijaturama ili zaslona s minijaturama 
filtriranih isječaka.

3	 Odaberite isječak koji želite prenijeti, a 
zatim pritisnite gumb MENU.
Na zaslonu se prikazuje potvrda za 
prijenos.

4	 Odaberite Execute.
Datoteka proxy koja odgovara odabranoj 
datoteci registrira se kao zadatak 
prijenosa i započinje prijenos.
Po uspješnoj registraciji zadatka prijenosa 
prikazuje se zaslon s rezultatima prijenosa.

5	 Odaberite OK.

Prijenos svih datoteka
U 2. koraku umjesto Select Clip odaberite All 
Clips kako biste prenijeli sve datoteke proxy 
koje odgovaraju svim datotekama.

[Napomena]
Moguće je prenijeti do 200 datoteka.
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Učitavanje originalne datoteke na 
memorijsku karticu sa zaslona 
s minijaturama

1	 Povežite videokameru i uređaj vezom 
LAN (stranica 56).

2	 Odaberite funkciju Transfer Clip >Select Clip 
u izborniku Thumbnail cijelog izbornika.
Zaslon s prikaza cijelog izbornika prelazi 
na zaslon s minijaturama.
Isječke je moguće prenositi sa zaslona s 
minijaturama ili zaslona s minijaturama 
filtriranih isječaka.

3	 Odaberite isječak koji želite prenijeti, 
a zatim pritisnite gumb MENU.
Na zaslonu se prikazuje potvrda 
za prijenos.

4	 Odaberite Execute.
Odabrana datoteka registrira se kao 
zadatak prijenosa te započinje prijenos.
Po uspješnoj registraciji zadatka prijenosa 
prikazuje se zaslon s rezultatima 
prijenosa.

5	 Odaberite OK.

Prijenos svih datoteka
Za prijenos svih datoteka u 2. koraku umjesto 
Select Clip odaberite All Clips.

[Napomena]
Moguće je prenijeti do 200 datoteka.

Provjera prijenosa datoteka

Status datoteke možete provjeriti odabirom 
funkcije File Transfer >View Job List 
(stranica 97) u izborniku Network cijelog 
izbornika.
Možete i provjeriti status prijenosa datoteke 
na zaslonu aplikacije Content Browser Mobile.

[Savjet]
Ako je funkcija File Transfer >Auto Upload (Proxy) 
(stranica 97) u izborniku Network cijelog izbornika 
postavljena na On, a postoji mrežna veza, po dovršetku 
snimanja datoteke proxy automatski se prenose 
na poslužitelj naveden pod Default Upload Server 
(stranica 97).

[Napomene]
ˎˎ Moguće je registrirati do 200 zadataka prijenosa.
ˎˎ Popis zadataka zadržava se nakon isključenja 

videokamere, no do 10 minuta posljednjih informacija 
o napretku može se izgubiti pri uklanjanju kompleta 
baterija ili ako se videokamera isključi bez prethodnog 
postavljanja sklopke napajanja na STANDBY.
ˎˎ Zadaci dodani nakon stanja niske napunjenosti 

baterije ne spremaju se na popis zadataka.
ˎˎ Ako tijekom prijenosa datoteka dođe do pogreške, 

ovisno o postavkama i statusu odredišnog poslužitelja 
za prijenos, možda se neće nastaviti prijenos isječka 
s nazivom jednakim onom prenošenog isječka. U 
tom slučaju provjerite postavke i status odredišnog 
poslužitelja za prijenos.

Prijenos sigurnim protokolom FTP

Primjenom funkcije FTPS u načinu Explicit 
(FTPES) za vezu s odredišnim podatkovnim 
poslužiteljem možete prenositi šifrirane 
datoteke.

Postavljanje sigurnog prijenosa FTP

Za sigurni prijenos FTP funkciju Using Secure 
Protocol na odredišnom podatkovnom 
poslužitelju uključite postavljanjem na 
ON i uvezite certifikat.
Detalje o konfiguraciji potražite pod 
“Registriranje odredišta za prijenos datoteke” 
(stranica 61).
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Zaslon Thumbnail
Kada pritisnete gumb THUMBNAIL (stranica 5), isječci snimljeni na memorijsku karticu na zaslonu prikazuju se kao minijature.
Na zaslonu s minijaturama možete odabrati isječak i pokrenuti njegovu reprodukciju. Reproducirana slika može se prikazivati na tražilu i na vanjskom monitoru.
Ponovnim pritiskom gumba THUMBNAIL zatvara se zaslon s minijaturama i vraća na sliku kamere.

[Napomena]
Na zaslonu s minijaturama prikazuju se samo isječci snimljeni u trenutačno odabranom formatu snimanja. Ako se očekivani snimljeni isječak ne prikazuje, provjerite format snimanja. Posebnu pažnju na ovo obratite prije formatiranja 
(inicijaliziranja) medija.

Raspored na zaslonu

Informacije o isječku u položaju pokazivača prikazuju se na dnu zaslona.

4 5

6

3

1

2

Trenutačno odabran indikator memorijske kartice
(Ako je kartica zaštićena, prikazuje se ikona lokota).

Pokazivač (žuti)

Broj isječka/ukupan broj isječaka

1.	 Minijatura (indeksna slika)
Prikaz indeksne slike isječka. Kada se snimi 
isječak, prvi kadar automatski se odabire 
za indeksnu sliku.
Informacije o isječku/kadru prikazuju se 
ispod minijature. Informacije koje se prikazuju 
možete promijeniti s pomoću funkcije 
Customize View (stranica 92) >Thumbnail 

Caption u izborniku Thumbnails cijelog 
izbornika.

2.	 Naziv isječka
Prikaz naziva odabranog isječka.

3.	 Format snimanja videozapisa
Prikaz formata datoteke odabranog isječka.

4.	 Posebne informacije o snimanju
Prikaz načina snimanja, samo ako je isječak 
snimljen u posebnom načinu snimanja.
Brzina prijenosa u bitovima isječaka Slow & 
Quick Motion prikazuje se na desnoj strani.

5.	 Trajanje isječka

6.	 Datum izrade
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Reprodukcija isječaka

Reprodukcija snimljenih isječaka

Snimljene isječke moguće je reproducirati 
kada je videokamera u načinu pripravnosti 
za snimanje (Stby).

1	 Umetnite memorijsku karticu 
za reprodukciju.

2	 Pritisnite gumb THUMBNAIL.

3	 Primijenite višestruki birač (stranica 7) 
ili višenamjenski kotačić (stranica 5) za 
pomicanje pokazivača do minijature 
isječka koji želite reproducirati.

4	 Pritisnite gumb za primjenu višestrukog 
birača ili višenamjenski kotačić.
Započinje reprodukcija od početka 
odabranog isječka.

Reprodukcijom možete upravljati pritiskanjem 
sljedećih gumba.
Pritisnite gumb za primjenu višestrukog 

birača ili višenamjenski kotačić: 
Pauzira reprodukciju.  
Ponovno pritisnite za povratak na 
normalnu reprodukciju.

Pritisnite gumbe za lijevo/desno višestrukog 
birača: 
skok na početak isječka/početak sljedećeg 
isječka.

Pritisnite i držite gumbe za lijevo/desno 
višestrukog birača: 
brzo premotavanje natrag/naprijed.  
Po otpuštanju gumba vraćate se na 
normalnu reprodukciju.

Gumb CANCEL/BACK: 
zaustavljanje reprodukcije i povratak 
u način pripravnosti za snimanje.

[Napomene]
ˎˎ Na granici između isječaka može doći do trenutnog 

prekida slike ili prikaza fotografije. Tijekom tog 
razdoblja nemoguće je upravljati videokamerom.
ˎˎ Kada odaberete isječak na zaslonu s minijaturama 

i pokrenete reprodukciju, može doći do trenutnog 
prekida slike na početku isječka. Za gledanje početka 
isječka bez prekida, stavite videokameru u način rada 
za reprodukciju, pauzirajte, upotrijebite gumb za lijevo 
višestrukog birača za povratak na početak isječka 
i ponovno reproducirajte.
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Na zaslonu s minijaturama možete upravljati 
isječcima ili provjeriti svojstva isječka s 
pomoću izbornika Thumbnail cijelog izbornika.
Izbornik Thumbnail (stranica 92) pojavljuje 
se kada pritisnete i držite gumb MENU 
i odaberete Thumbnail.

Operacije u izborniku Thumbnail

Pritisnite višestruki birač (stranica 7) ili 
višenamjenski kotačić (stranica 5) za 
odabir funkcije, a zatim pritisnite gumb za 
primjenu višestrukog birača ili višenamjenski 
kotačić.
Pritisnite gumb CANCEL/BACK (stranica 5) 
za povratak na prethodni zaslon.

[Napomena]
Ovisno o stanju pri prikazu izbornika, neke stavke 
nemoguće je odabrati.

Stavke izbornika za operacije s isječcima

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

Detalje o stavkama izbornika s operacije s 
isječcima pogledajte u izborniku Thumbnail 
(stranica 92).

Prikaz svojstava isječka

Za prikaz zaslona sa svojstvima isječka 
odaberite Display Clip Properties 
(stranica 92) u izborniku Thumbnail.

Dodavanje zastavica za isječak

Možete dodati zastavice za isječak (oznake OK, 
NG ili KP) isječcima kako biste filtrirali prikaz 
isječaka na temelju zastavica za isječak.
Odaberite minijaturu isječka kojemu želite 
dodati zastavicu za isječak, a zatim odaberite 
zastavicu za isječak s pomoću funkcije Set Clip 
Flag (stranica 92) u izborniku Thumbnail 
cijelog izbornika.

Setting Dodana zastavica za 
isječak

Add OK U redu

Add NG NG

Add KEEP KP

[Savjeti]
ˎˎ Za dodavanje zastavica za isječak možete upotrijebiti 

i dodjeljivi gumb kojemu je dodijeljena funkcija 
zastavice za isječak (stranica 48).
ˎˎ Zastavicu za isječak OK možete dodati minijaturi 

odabranog isječka (stranica 50) pritiskom gumba 
Clip Flag (stranica 5).

Prikaz zaslona s minijaturama 
s filtriranim isječcima

Odaberite funkciju Filter Clips (stranica 92) 
u izborniku Thumbnail cijelog izbornika 
i odaberite vrstu zastavice za isječak za prikaz 
samo onih isječaka s tom zastavicom.
Za prikaz svih isječaka odaberite All.

[Savjet]
Također možete redom uklapati filtre gumbom DISPLAY.

Brisanje isječaka

S memorijske kartice moguće je izbrisati 
isječke.
Odaberite funkciju Delete Clip >Odaberite 
Clip ili All Clips u izborniku Thumbnail cijelog 
izbornika.
Select Clip: 

Brisanje odabranog isječka. Podržan 
je odabir više isječaka.

All Clips: 
brisanje svih prikazanih isječaka.

Promjena informacija koje se prikazuju 
na zaslonu s minijaturama

Informacije o isječku/kadru ispod minijature 
moguće je promijeniti.
Odaberite funkciju Customize View 
>Thumbnail Caption u izborniku Thumbnail 
cijelog izbornika i odaberite informacije koje 
želite prikazati.
Date Time: 

prikaz datuma i vremena nastanka 
i posljednje izmjene isječka.

Time Code: 
prikaz vremenskog koda.

Trajanje: 
prikaz trajanja isječka.

Sequential Number: 
prikaz rednog broja na svakoj minijaturi.

Operacije s isječcima
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Konfiguracija i hijerarhija cijelog izbornika
Pritisnite i držite gumb MENU kako biste na 
tražilu prikazali cijeli izbornik i odabrali različite 
stavke za snimanje, spremanje i reprodukciju 
(izbornik je također moguće prikazati na 
vanjskom monitoru). Cijeli izbornik sastoji se 
od sljedećih izbornika.

Konfiguracija izbornika

Izbornik User
Obuhvaća stavke izbornika koje 
konfigurira korisnik izbornikom Edit User 
Menu.

Izbornik Edit User
Obuhvaća stavke izbornika za uređivanje 
izbornika User.

Izbornik Shooting
Obuhvaća postavke za snimanje.

Izbornik Project
Obuhvaća osnovne postavke projekta.

Izbornik Paint/Look
Obuhvaća postavke za kvalitetu slike.

Izbornik TC/Media
Obuhvaća postavke za vremenske kodove 
i medije za snimanje.

Izbornik Monitoring
Obuhvaća postavke za unos videozapisa i 
prikaz na tražilu.

Izbornik Audio
Obuhvaća postavke za zvuk.

Izbornik Thumbnail
Obuhvaća postavke za prikaz minijatura.

Izbornik Technical
Obuhvaća postavke za tehničke stavke.

Izbornik Network
Obuhvaća postavke za mreže.

Izbornik Maintenance
Obuhvaća postavke uređaja, primjerice sat 
i jezik.

Hijerarhija cijelog izbornika

User 
(tvorničke 
postavke)

Base Setting
Focus
S&Q Motion
LUT On/Off
Simul Rec
Proxy Rec
Interval Rec
Gumb za dodjelu
Assignable Dial
Multi Function Dial
All File
Clip Name Format
Format Media
VF Setting
Zebra
Zum
Menu Settings

Izbornik Edit User Add Item
Customize Reset

Shooting ISO/Gain/EI
ND Filter
Shutter
Auto Exposure
Bijeli
White Setting
Offset White
Focus
S&Q Motion
LUT On/Off
Noise Suppression
Flicker Reduce
SteadyShot

Project Base Setting
Rec Format
Cine EI Setting
Simul Rec
Proxy Rec
Interval Rec
SDI/HDMI Rec Control
Gumb za dodjelu
Assignable Dial
Multi Function Dial
User File
All File

Paint/Look Scene File
Base Look
Ponovno postavljanje 
postavki boje
Crni
Komprimiranje
Detalj
Matrix
Multi Matrix

TC/Media Timecode
TC Display
Users Bit
HDMI TC Out
Clip Name Format
Update Media
Format Media

Monitoring Output On/Off
Output Format
Output Display
Prikaz - uključeno/
isključeno
Marker
VF Setting
Gamma Display Assist
Peaking
Zebra

Audio Audio ulaz
Audio Output

Thumbnail 
(Sličica)

Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Delete Clip
Transfer Clip
Transfer Clip (Proxy)
Filter Clips
Customize View

Technical Color Bars
ND Dial
Tally
HOLD Switch Setting
Touch Operation
Rec Review
Zum
Handle Zoom
Menu Settings
Fan Control
Objektiv
Video Light Set
APR
Camera Battery Alarm
Camera DC IN Alarm

Network Access Authentication
Bežični LAN
AP Mode Settings
ST Mode Settings
Wired LAN
Modem
File Transfer
Network Reset
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Održavanje Language
Clock Set
All Reset
Hours Meter
Verzija
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Operacije cijelog izbornika
Pritisnite i držite gumb MENU kako biste 
na tražilu prikazali cijeli izbornik i odabrali 
detaljne postavke (izbornik je također moguće 
prikazati na vanjskom monitoru).

Komande izbornika

Gumb MENU (stranica 5)
Pritisnite i držite za prikaz cijelog 
izbornika. Pritisnite ponovno dok je 
prikazan cijeli izbornik kako biste sakrili 
izbornik.

Višestruki birač (osmosmjerni D-upravljač 
i gumbi za primjenu) (stranica 7)

Pritisnite gumbe D-upravljača kako biste 
pokazivač pomaknuli gore/dolje/lijevo/
desno za odabir stavki ili postavki 
u izborniku.
Za primjenu odabrane stavke pritisnite 
gumb za primjenu višestrukog birača.

Višenamjenski kotačić (stranica 5)
Okrećite višenamjenski kotačić kako biste 
pokazivač pomaknuli gore/dolje za odabir 
stavki ili postavki u izborniku.
Za primjenu odabrane stavke pritisnite 
višenamjenski kotačić.

Gumb CANCEL/BACK (stranica 5)
Pritisnite za povratak na prethodni 
izbornik. Nedovršena promjena se 
odbacuje.

[Napomene]
ˎˎ Cijeli izbornik nije moguće primijeniti u načinu 

povećanja za fokusiranje (stranica 40).
ˎˎ Ovisno o stanju pri prikazu izbornika, neke stavke 

nemoguće je odabrati.

Stavke izbornika za postavljanje

Pritišćite gumbe D-upravljača ili okrećite 
višenamjenski kotačić za pomicanje 
pokazivača do stavke koju želite postaviti, 
a zatim pritisnite gumb za primjenu ili 
višenamjenski kotačić za odabir stavke.
ˎˎ U području za odabir stavki izbornika 
prikazuje se do osam redaka. 
Ako istovremeni prikaz dostupnih opcija 
za stavku nije moguć, listajte kroz prikaz 
pomicanjem pokazivača gore/dolje.
ˎˎ Za podstavke s velikim rasponom 
postavljanja (primjerice od -99 do +99), 
područje za postavljanje ne prikazuje se. 
Trenutačna postavka istaknuta je kako bi se 
prikazala mogućnost promjene vrijednosti.
ˎˎ Odabirom [Execute] za funkciju izvodi se 
odgovarajuća funkcija.
ˎˎ Pri odabiru stavke koju je potrebno potvrditi 
prije izvođenja privremeno se sakriva 
izbornik i prikazuje potvrdna poruka. 
Provjerite poruku i zatim odaberite želite 
li izvesti ili odbaciti funkciju.

Unos niza znakova

Kada odaberete stavku koja zahtjeva unos 
znakova, primjerice naziv datoteke, prikazuje 
se zaslon sa znakovima.

1

2 3

1	 Pritišćite gumbe D-upravljača ili okrećite 
višenamjenski kotačić za odabir vrste 
znakova, a zatim primijenite postavku.
ABC: velika slova
abc: mala slova
123: numerički znakovi
!#$: posebni znakovi

2	 Odaberite znak iz odabrane vrste znakova 
i primijenite postavku.
Pokazivač prelazi na sljedeće polje.

Space: unos znaka razmaka u položaj 
pokazivača.

/: Promjena položaja pokazivača.
BS: brisanje znaka lijevo od pokazivača 

(backspace).

3	 Po dovršetku odaberite [Done] 
za primjenu postavki.
Niz znakova potvrđuje se i uklanja 
se zaslon za unos znakova.

Zaključavanje i otključavanje izbornika

Cijeli izbornik moguće je zaključati tako 
da se prikazuje samo izbornik User.
U ovom stanju postavke nije moguće mijenjati 
s pomoću zaslona sa statusom.

Zaključavanje izbornika

1	 Pritisnite i zadržite višenamjenski kotačić, 
a zatim pritisnite i držite gumb MENU.

2	 Odaberite Menu Settings >User Menu with 
Lock u izborniku Technical.

	 [Napomena]
Kada pritisnete i držite samo gumb MENU za prikaz 
normalnog cijelog izbornika, prikaz User Menu 
Only prikazuje se u funkciji Menu Settings izbornika 
Technical. Pritisnite i zadržite višenamjenski kotačić, 
a zatim pritisnite i držite gumb MENU za prikaz User 
Menu with Lock.

3	 Uključite postavljanjem na On, a zatim 
pritisnite gumb za primjenu ili 
višenamjenski kotačić.
Prikaz na zaslonu tražila prelazi na zaslon 
za unos broja pristupnog koda.

4	 Unesite proizvoljni broj.
Unesite četveroznamenkasti broj iz raspona 
od 0000 do 9999. Zadana vrijednost je 0000.
Unesite broj i pritisnite gumb za primjenu ili 
višenamjenski kotačić kako biste pokazivač 
pomaknuli na sljedeću znamenku.
Nakon unosa svih znamenki pomaknite 
pokazivač na SET.

5	 Pritisnite gumb za primjenu ili 
višenamjenski kotačić.
Unos se primjenjuje.
Prikazuje se potvrdna poruka, a zaslon 
prelazi na izbornik User.



6. Prikaz i postavke izbornika: Operacije cijelog izbornika69HR

Otključavanje izbornika

1	 Pritisnite i zadržite višenamjenski kotačić, 
a zatim pritisnite i držite gumb MENU.

2	 Odaberite Menu Settings >User Menu with 
Lock u izborniku User.

	 [Napomena]
Kada pritisnete i držite samo gumb MENU za prikaz 
normalnog cijelog izbornika, prikaz User Menu 
Only prikazuje se u funkciji Menu Settings izbornika 
Technical. Pritisnite i zadržite višenamjenski kotačić, 
a zatim pritisnite i držite gumb MENU za prikaz 
User Menu with Lock.

3	 Isključite postavljanjem na Off, a zatim 
pritisnite gumb za primjenu ili 
višenamjenski kotačić.
Prikaz na zaslonu tražila prelazi na zaslon 
za unos broja pristupnog koda.

4	 Unesite broj pristupnog koda kojim se 
zaključava izbornik.
Unesite broj i pritisnite gumb za primjenu ili 
višenamjenski kotačić kako biste pokazivač 
pomaknuli na sljedeću znamenku.
Nakon unosa svih znamenki pomaknite 
pokazivač na Set.

5	 Pritisnite gumb za primjenu 
ili višenamjenski kotačić.
Unos se primjenjuje.
Ako uneseni broj pristupnog koda 
odgovara broju pristupnog koda kojim 
se izbornik zaključava, izbornik 
se otključava i prikazuje.

[Napomene]
ˎˎ Ako uneseni broj pristupnog koda ne odgovara broju 

pristupnog koda kojim se izbornik zaključava, izbornik 
se ne otključava.
ˎˎ Preporučuje se da u blizini zabilježite pristupni kod, 

u slučaju da ga zaboravite. Ako zaboravite broj 
pristupnog koda, obratite se servisnom predstavniku 
tvrtke Sony.

ˎˎ Ako se izbornik zaključa bez registriranja stavki cijelog 
izbornika iz sljedeće tablice u izborniku User, te 
funkcije nemoguće je dodijeliti dodjeljivim gumbima.
ˎˎ Ako su te funkcije već dodijeljene dodjeljivim 

gumbima, dodjeljiva postavka prisilno se 
onemogućuje u trenutku zaključavanja izbornika.

Stavke cijelog 
izbornika

Odabir dodjeljivog 
gumba

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI> 
Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Reflektor

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Technical >Rec Review 
>Setting

Rec Review

Stavke cijelog 
izbornika

Odabir dodjeljivog 
gumba

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Izbornik User
U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.

User
Stavka Opis
Base Setting Stavka Project >Base Setting

Focus Stavka Shooting >Focus

S&Q Motion Stavka Shooting >S&Q Motion

LUT On/Off Shooting >LUT On/Off item

Simul Rec Stavka Project >Simul Rec

Proxy Rec Stavka Project >Proxy Rec

Interval Rec Project >Interval Rec item

Gumb za dodjelu Stavka Project >Assignable Button

Assignable Dial Stavka Project >Assignable Dial

Multi Function Dial Stavka Project >Multi Function Dial

All File Stavka Project >All File

Clip Name Format Stavka TC/Media >Clip Name Format

Format Media Stavka TC/Media >Format Media

VF Setting Stavka Monitoring >VF Setting

Zebra Monitoring >Zebra item

Zum Technical >Zoom item

Menu Settings Stavka Technical >Menu Settings

Izbornik Edit User Prikaz zaslona izbornika Edit User.

[Napomena]
S izbornikom Edit User u izbornik User možete dodavati iz njega uklanjati stavke izbornika. Moguće je konfigurirati do 
20 stavki.
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Izbornik Edit User
Kada se u izborniku User odabere Edit User Menu, izbornik Edit User prikazuje se na gornjoj 
razini.

Edit User
Stavka Postavka podstavke Opis
Add Item
Dodaj stavku izborniku 
User

Dodaje stavku izbornika u izbornik 
User.

Customize Reset
Ponovno postavlja 
stavke u izborniku User

Vraća stavke izbornika registriranih 
u izborniku User na tvorničke 
postavke.

Stavka izbornika 
odabrana tijekom 
uređivanja

Delete Briše registriranu stavku izbornika 
iz izbornika User.

Move Mijenja raspored registriranih stavki 
izbornika unutar izbornika User.

Edit Sub Item Uređuje (registriranje/brisanje) 
registriranih podstavki izbornika 
u izborniku User.
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Izbornik Shooting
U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

Shooting >ISO/Gain/EI
Postavljanje postavki jačine signala.

Stavka Postavka podstavke Opis
Mode ISO/dB Odabir načina za postavljanje jačine 

signala.

ISO/Gain<H> Detalje o postavkama potražite pod 
"Postavke i zadane vrijednosti ISO/Gain" 
(stranica 100).

Postavlja pojačanje signala <H> na 
unaprijed postavljenu vrijednost.

ISO/Gain<M> Detalje o postavkama potražite pod 
"Postavke i zadane vrijednosti ISO/Gain" 
(stranica 100).

Postavlja pojačanje signala <M> na 
unaprijed postavljenu vrijednost.

ISO/Gain<L> Detalje o postavkama potražite pod 
"Postavke i zadane vrijednosti ISO/Gain" 
(stranica 100).

Postavlja pojačanje signala <L> na 
unaprijed postavljenu vrijednost.

Exposure 
Index<H>

Kada je Base ISO postavljen na ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Kada je Base ISO postavljen na ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Postavlja vrijednost razine ekspozicije 
<H>.
Dostupno samo u načinu Cine EI.

Shooting >ISO/Gain/EI
Postavljanje postavki jačine signala.

Stavka Postavka podstavke Opis
Exposure 
Index<M>

(Iste postavke kao pod Exposure Index<H>)
Kada je Base ISO postavljen na ISO 800:

1000EI / 6.3E
Kada je Base ISO postavljen na ISO 12800:

16000EI / 6.3E

Postavlja vrijednost razine 
ekspozicije <M>.

Exposure 
Index<L>

(Iste postavke kao pod Exposure Index<H>)
Kada je Base ISO postavljen na ISO 800:

800EI / 6.0E
Kada je Base ISO postavljen na ISO 12800:

12800EI / 6.0E

Postavlja vrijednost razine 
ekspozicije <L>.

Shockless 
Gain

On / Off Uključenje/isključenje funkcije 
postupnog pojačanja signala.

Base 
Sensitivity

High / Low Postavlja temeljnu osjetljivost za način 
SDR/HDR.

Base ISO ISO 12800 / ISO 800 Postavlja temeljnu ISO osjetljivost za 
način Cine El.

Shooting >ND Filter
Postavlja unaprijed postavljenu vrijednost za filtar ND.

Stavka Postavka podstavke Opis

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Postavlja unaprijed postavljenu 
vrijednost 1 za filtar ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Postavlja unaprijed postavljenu 
vrijednost 2 za filtar ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Postavlja unaprijed postavljenu 
vrijednost 3 za filtar ND.

Shooting >Shutter
Postavljanje postavki za uvjete rada elektroničkog zatvarača.

Stavka Postavka podstavke Opis

Mode Speed / Angle Odabir načina rada elektroničkog 
zatvarača.
Upotrebljava se za jasno za snimanje brzih 
objekata. Odabir načina za postavljanje 
brzine zatvarača u sekundama (Speed) ili 
kao kut zatvarača (Angle).

Shutter 
Speed  
On/Off

On / Off Postavlja prati li vrijeme ekspozicije kada 
je odabran način Speed vrijednost 
funkcije Shutter Speed ili je postavljena 
na punu ekspoziciju.
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Shooting >Shutter
Postavljanje postavki za uvjete rada elektroničkog zatvarača.

Stavka Postavka podstavke Opis

Brzina 
zatvarača

64F to 1/8000
Dostupne postavke razlikuju se ovisno 
o frekvenciji kadra odabranog formata 
za videozapis.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Postavlja brzinu zatvarača kada je način 
Mode postavljen na Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° /  
270.0° / 240.0° / 216.0° / 210.0° /  
180.0° / 172.8° / 150.0° / 144.0° /  
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 
30.0° / 22.5° / 11.25° / 5.6°

Postavlja kut zatvarača kada je način 
Mode postavljen na Angle.

ECS On/Off On / Off Uključenje/isključenje funkcije External 
Clear Scan.

Shooting >Shutter
Postavljanje postavki za uvjete rada elektroničkog zatvarača.

Stavka Postavka podstavke Opis

ECS 
Frequency

od 23,99 do 8000
Dostupne postavke razlikuju se ovisno 
o frekvenciji kadra odabranog formata 
za videozapis.
Zadane vrijednosti navedene su u nastavku.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24,02

Postavlja frekvenciju ECS kada je način 
Mode postavljen na ECS.

Shooting >Auto Exposure
Postavljanje postavki za prilagodbu automatske ekspozicije.

Stavka Postavka podstavke Opis

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / –3.0

Postavlja razinu svjetline za automatski 
otkrivenu ekspoziciju.

Mode Backlight / Standard / Spotlight Postavlja način rada za automatsko 
podešavanje ekspozicije.
Backlight: 

način za pozadinsko osvjetljenje (način 
za smanjeno zatamnjenje objekta kada 
je objekt pozadinski osvijetljen)

Standardna: 
standardni način rada

Spotlight: 
način za reflektor (način za smanjenu, 
podrezanu bijelu boju kada je objekt 
osvijetljen reflektorom)

Speed od -99 do +99 (±0) Postavlja brzinu podešavanja za 
automatsko podešavanje ekspozicije.

AGC On / Off Uključenje/isključenje funkcije 
automatskog pojačanja signala, (AGC, 
auto gain control).

 Limit AGC-a Detalje o postavkama potražite pod 
"Postavke limita AGC-a i zadane 
vrijednosti" (stranica 102).

Postavlja maksimalno pojačanje signala 
za funkciju AGC.

AGC Point F2.8 / F4 / F5.6 Postavlja vrijednost F-stop irisa kada 
započinje operacija AGC uz funkciju AGC 
uključenu postavljanjem na On.
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Shooting >Auto Exposure
Postavljanje postavki za prilagodbu automatske ekspozicije.

Stavka Postavka podstavke Opis

Auto Shutter On / Off Uključenje/isključenje funkcije 
automatskog upravljanja zatvaračem.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Postavlja najveću brzinu zatvarača 
za funkciju automatskog zatvarača.

A.SHT Point F5.6 / F8 / F11 / F16 Postavlja vrijednost F-stop irisa pri 
pokretanju rada automatskog zatvarača.

Clip High 
light

On / Off Uključenje/isključenje funkcije koja 
zanemaruje najsvjetlije površine kako bi 
se dobio plošniji odgovor na visoku 
osvijetljenost.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Postavlja raspon mjerenja svjetlosti 
za automatsko podešavanje ekspozicije 
sukladno svjetlini objekta. (Nedostupno 
pri ručnom podešavanju ekspozicije)

Detect 
Window 
Indication

On / Off Uključenje/isključenje raspona mjerenja 
svjetlosti.

Custom 
Width

od 40 do 999 (500) Postavlja širinu raspona za mjerenje 
svjetlosti.

Custom 
Height

od 70 do 999 (500) Postavlja visinu raspona za mjerenje 
svjetlosti.

Custom H 
Position

od -479 do +479 (±0) Postavlja vodoravni položaj raspona za 
mjerenje svjetlosti.

Custom V 
Position

od -464 do +464 (±0) Postavlja okomiti položaj raspona za 
mjerenje svjetlosti.

Shooting >White
Postavljanje postavki balansa bijele boje.

Stavka Postavka podstavke Opis

Preset White od 2000 K do 15.000 K (3200K) Postavlja zadanu vrijednost balansa bijele boje.

Color Temp 
<A>

od 2000 K do 15.000 K (3200K) Postavlja temperaturu balansa bijele boje koja 
se sprema u memoriju A.

[Napomena]
Budući da se temperatura boje Color Temp pri 
operaciji R/B Gain podrezuje na 2000 K i 15.000 K, 
za vrijednost R/B Gain može biti moguće prikazati 
ispravnu vrijednost za Color Temp.

Shooting >White
Postavljanje postavki balansa bijele boje.

Stavka Postavka podstavke Opis

Tint<A> od -99 do +99 (±0) Postavlja vrijednost nijanse balansa bijele boje 
koja se sprema u memoriju A.

[Napomena]
Budući da se nijansa Tint pri operaciji R/B Gain 
podrezuje na ±99, za vrijednost R/B Gain može biti 
moguće prikazati ispravnu vrijednost za Tint.

R Gain <A> od -99,0 do +99,0 (±0,0) Postavlja vrijednost pojačanja signala R balansa 
bijele boje koja se sprema u memoriju A.

B Gain <A> od -99,0 do +99,0 (±0,0) Postavlja vrijednost pojačanja signala B balansa 
bijele boje koja se sprema u memoriju A.

Color Temp 
<B>

od 2000 K do 15.000 K (3200K) Postavlja temperaturu balansa bijele boje koja 
se sprema u memoriju B.

[Napomena]
Budući da se temperatura boje Color Temp pri 
operaciji R/B Gain podrezuje na 2000 K i 15.000 K, 
za vrijednost R/B Gain može biti moguće prikazati 
ispravnu vrijednost za Color Temp.

Tint<B> od -99 do +99 (±0) Postavlja vrijednost nijanse balansa bijele boje 
koja se sprema u memoriju B.

[Napomena]
Budući da se nijansa Tint pri operaciji R/B Gain 
podrezuje na ±99, za vrijednost R/B Gain može biti 
moguće prikazati ispravnu vrijednost za Tint.

R Gain <B> od -99,0 do +99,0 (±0,0) Postavlja vrijednost pojačanja signala R balansa 
bijele boje koja se sprema u memoriju B.

B Gain <B> od -99,0 do +99,0 (±0,0) Postavlja vrijednost pojačanja signala B balansa 
bijele boje koja se sprema u memoriju B.

Shooting >White Setting
Podešava postavke balansa bijele boje.

Stavka Postavka podstavke Opis

Shockless 
White

Off / 1 / 2 / 3 Postavlja brzinu odziva balansa bijele boje pri 
promjeni načina balansa bijele boje.
Isključeno: uklapa trenutačno.
od 1 do 3: uklapa sporije što je broj veći.

ATW Speed 1 / 2 / 3 / 4 / 5 Postavlja brzinu odziva u načinu ATW.
1: najveća brzina odziva

White 
Switch<B>

Memory / ATW Odabir načina za podešavanje balansa bijele 
boje koji se odabire pri postavljanju sklopke 
WHT BAL na B.
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Shooting >White Setting
Podešava postavke balansa bijele boje.

Stavka Postavka podstavke Opis

Filter White 
Memory

On / Off Uključenje/isključenje funkcije koja postavlja 
područje memorije balansa bijele boje za svaki 
filtar ND.
Uključeno: postavlja memoriju balansa bijele 

boje za svaki filtar ND.

	 [Savjet]
U unaprijed postavljenom načinu četiri su 
postavke (CLEAR / 1 / 2 / 3). U promjenjivom 
načinu dvije su postavke (CLEAR / On).

Isključeno: postavlja zajedničku memoriju 
balansa bijele boje za sve filtre ND.

Shooting >Offset White
Postavljanje postavki pomaka balansa bijele boje.

Stavka Postavka podstavke Opis

Offset White 
<A>

On / Off Odabire treba li dodati (On) ili ne treba dodati 
(Off) vrijednost pomaka balansu bijele boje 
u memoriji A.

Offset Color 
Temp<A>

od -99 do +99 (±0) Postavlja pomak temperature boje koji se 
dodaje balansu bijele boje u memoriji A kada je 
funkcija Offset White <A> uključena s On.

Offset 
Tint<A>

od -99 do +99 (±0) Postavlja vrijednost nijanse Tint koja se dodaje 
balansu bijele boje u memoriji A kada je 
funkcija Offset White <A> uključena s On.

Offset White 
<B>

On / Off Odabire treba li dodati (On) ili ne treba dodati 
(Off) vrijednost pomaka balansu bijele boje u 
memoriji B.

Offset Color 
Temp<B>

od -99 do +99 (±0) Postavlja pomak temperature boje koji se 
dodaje balansu bijele boje u memoriji B kada je 
funkcija Offset White <B> uključena s On.

Offset 
Tint<B>

od -99 do +99 (±0) Postavlja vrijednost nijanse Tint koja se dodaje 
balansu bijele boje u memoriji B kada je 
funkcija Offset White <B> uključena s On.

Offset White 
<ATW>

On / Off Odabire treba li dodati (On) ili ne treba dodati 
(Off) vrijednost pomaka balansu bijele boje 
ATW.

Offset Color 
Temp<ATW>

od -99 do +99 (±0) Postavlja pomak temperature boje koji se 
dodaje balansu bijele boje ATW kada je funkcija 
Offset White <ATW> uključena s On.

Shooting >Offset White
Postavljanje postavki pomaka balansa bijele boje.

Stavka Postavka podstavke Opis

Offset 
Tint<ATW>

od -99 do +99 (±0) Postavlja vrijednost nijanse Tint koja se dodaje 
balansu bijele boje ATW kada je funkcija Offset 
White <ATW> uključena s On.

Shooting >Focus
Postavljanje postavki za fokusiranje.

Stavka Postavka podstavke Opis

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Postavlja brzinu pogona za fokusiranje za 
promjene objekta tijekom automatskog 
fokusiranja.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 
5(Responsive)

Postavlja osjetljivost za promjenjivo 
izoštravanje objekta tijekom automatskog 
fokusiranja.

Područje 
izoštrav.

Wide / Zone / Flexible Spot Postavlja ciljno područje automatskog 
fokusiranja i automatskog fokusiranja 
pritiskanjem (AF) (stranica 37).
Široko: 

pri fokusiranju traži objekt kroz široki kut 
slike.

Zone: 
automatski pretražuje točku za fokusiranje 
unutar određene zone.

Fleksibilni spot: 
fokusiranje u određenu točku na slici.

Focus Area 
(AF-S)

Fleksibilni spot Postavlja ciljno područje automatskog 
fokusiranja pritiskanjem (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / 
Face/Eye Priority AF / Off

Omogućivanje/onemogućivanje automatskog 
fokusiranja s otkrivanjem lica.

Push AF 
Mode

AF / Single-shot AF(AF-S) Postavlja način za automatsko fokusiranje 
pritiskanjem.

AF Assist On / Off Kada je funkcija postavljena na On, omogućuje 
privremeno premoštenje automatskog 
fokusiranja i ručno postavljanje fokusa.
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Shooting >S&Q Motion
Postavljanje postavki načina Slow & Quick Motion (stranica 49).

Stavka Postavka podstavke Opis

Setting On / Off Uključenje/isključenje načina Slow & Quick 
Motion.
Kada je način uključen s On, sljedeće funkcije su 
onemogućene.

ˎˎ Automatski iris
ˎˎ Automatsko izoštravanje

Frekvencija 
okvira

Od 1 fps do 60 fps / 100 fps / 120 
fps / 150 fps / 180 fps / 200 fps / 
240 fps

Postavlja brzinu prijenosa za snimanja u načinu 
Slow & Quick Motion.

[Napomena]
Dostupne postavke razlikuju se ovisno o odabranoj 
frekvenciji sustava, kodeku i formatu videozapisa.

Shooting >LUT On/Off
Postavljanje postavki za LUT.

Stavka Postavka podstavke Opis

SDI/HDMI MLUT On / MLUT Off Odabire treba li primijeniti LUT monitor na video 
izlaz za SDI i HDMI.

VF/Proxy/
Stream

MLUT On / MLUT Off Odabire treba li primijeniti LUT monitor na 
tražilo, proxy i video izlaz za emitiranje.

Internal Rec MLUT On / MLUT Off Odabire treba li primijeniti LUT monitor na 
interno snimanje videozapisa.

Shooting >Noise Suppression
Postavljanje postavki za uklanjanje buke.

[Savjet]
Postavke Setting(Custom) i Level(Custom) odražavaju se u postavci Target Display (stranica 104).

Stavka Postavka podstavke Opis

Setting 
(Custom)

On / Off Uključenje/isključenje funkcije uklanjanja buke 
u načinu Custom.

Level 
(Custom)

Low / Mid / High Postavlja razinu uklanjanja buke u načinu 
Custom.

Setting  
(Cine EI)

On / Off Uključenje/isključenje funkcije uklanjanja buke 
u načinu Cine El.

Shooting >Noise Suppression
Postavljanje postavki za uklanjanje buke.

[Savjet]
Postavke Setting(Custom) i Level(Custom) odražavaju se u postavci Target Display (stranica 104).

Stavka Postavka podstavke Opis

Level 
(Cine EI)

Low / Mid / High Postavlja razinu uklanjanja buke u načinu Cine El.

Shooting >Flicker Reduce
Postavljanje postavki za ispravljanje treperenja.

Stavka Postavka podstavke Opis

Mode Auto / On / Off Postavljanje načina za ispravljanje treperenja.

Frekvencija 50Hz / 60Hz Postavljanje frekvencije izvora napajanja za 
svjetlo koje uzrokuje treperenje.

Shooting >SteadyShot
Postavljanje postavki stabilizacije.

Stavka Postavka podstavke Opis

Setting Active / Standard / Off Postavlja funkciju stabilizacije slike.

[Napomena]
Omogućuje se kada je priključen kompatibilan 
objektiv.
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U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

Project >Base Setting
Postavljanje osnovnih postavki.

Stavka Postavka podstavke Opis

Način 
snimanja

Custom / Cine EI Postavljanje načina snimanja.

Target 
Display

SDR(BT.709) / HDR(HLG) Postavlja prostor boja snimanja/izlaza 
u načinu Cine EI.

Project >Rec Format
Postavljanje postavki za format snimanja.

Stavka Postavka podstavke Opis

Frekvencija 59,94 / 50 / 29.97 / 25 / 24 / 23.98 Odabir frekvencije sustava.

Imager Scan 
Mode

FF / S35 Postavljanje kombinacije metode 
očitavanja pretražnika (svi pikseli/spajanje 
piksela) i postavke veličine pretražnika.

Kodek RAW / RAW & XAVC-I / XAVC-I / XAVC-L Postavljanje načina snimanja/reprodukcije.

RAW Output 
Format

Dostupne postavke razlikuju se ovisno o 
postavkama pod Frequency i Codec.

Postavlja format snimanja za vanjski RAW 
snimač.

[Napomena]
Kada je Codec postavljen na RAW & XAVC-I, 
postavka Video Format prebacuje se u vezi s 
postavkom RAW Output Format.

Frekvencija Kodek Opcije za odabir

59,94
50
29,97
25
23,98

RAW 4096×2160

3840 × 2160

RAW i 
XAVC-I

4096×2160

3840 × 2160

24 RAW 4096×2160

RAW i 
XAVC-I

4096×2160

Project >Rec Format
Postavljanje postavki za format snimanja.

Stavka Postavka podstavke Opis

Video Format Dostupne postavke razlikuju se ovisno o 
postavkama pod Frequency i Codec.

Postavljanje formata snimanja.

Frekvencija Kodek Opcije za odabir

59,94 RAW –

RAW i 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW –

RAW i 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

29,97 RAW –

RAW i 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Izbornik Project
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Project >Rec Format
Postavljanje postavki za format snimanja.

Stavka Postavka podstavke Opis

Video Format 25 RAW –

RAW i 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

23,98 RAW –

RAW i 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW –

RAW i 
XAVC-I

4096×2160P

XAVC-I 4096×2160P

Project >Cine EI Setting
Postavljanje postavki za način Cine EI.

Stavka Postavka podstavke Opis

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Postavljanje prostora boje u načinu Cine El.
S-Gamut3/SLog3: 

postavljanje prostora boje u načinu 
Cine El na S-Gamut3.

S-Gamut3.Cine/SLog3: 
postavljanje prostora boje u načinu 
Cine El na S-Gamut3.Cine.

Project >Simul Rec
Postavljanje postavki za način za istovremeno snimanje (stranica 50).

Stavka Postavka podstavke Opis

Postavljanje On / Off Uključenje/isključenje funkcije 
istovremenog snimanja i postavljanje 
odredišnog medija za snimanje.

Project >Proxy Rec
Postavljanje postavki za način za snimanje proxy.

Stavka Postavka podstavke Opis

Postavljanje On / Off Uključenje/isključenje načina za snimanje 
proxy.

Audio 
Channel

CH1/CH2 / CH3/CH4 Odabir zvučnog kanala za snimanje 
podataka proxy.

Project >Interval Rec
Postavljanje postavki za način snimanja s intervalima (stranica 49).

Stavka Postavka podstavke Opis

Postavljanje On / Off Uključenje/isključenje načina za snimanje 
s intervalima. (Uključenjem ovog načina 
postavljanjem na On svi drugi posebni 
načini isključuju se postavljanjem na Off).

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (sekunde)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (minute)
1 / 2 / 3 / 4 / 6 / 12 / 24 (sati)

Postavljanje intervala između snimanja 
u načinu snimanja Interval Rec recording 
(kada je način Interval Rec uključen s On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Dostupne postavke razlikuju se ovisno o 
frekvenciji kadra odabranog formata za 
videozapis.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Postavljanje broja kadrova po snimanju 
u načinu snimanja Interval Rec recording 
(kada je način Interval Rec uključen s On).

Pre-Lighting Off / 2sec / 5sec / 10sec Postavljanje broja sekundi za koje 
se svjetlo za videozapis uključuje prije 
početka snimanja u načinu snimanja 
Interval Rec.

[Savjet]
Dostupno samo pri upotrebi HVL-LBPC 
(u opciji).
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Project >SDI/HDMI Rec Control
Postavljanje postavki za upravljanje snimanjem putem SDI/HDMI.

Stavka Postavka podstavke Opis

Postavljanje Off / SDI/HDMI Remote I/F / Parallel Rec Postavljanje upravljanja pokretanjem/
zaustavljanjem snimanja vanjskim 
uređajem putem izlaznog signala 
SDI/HDMI.
Isključeno: 

nemojte upotrebljavati daljinski 
upravljač.

SDI/HDMI Remote I/F: 
upravljanje pokretanjem/
zaustavljanjem snimanja vanjskog 
priključenog uređaja kada 
u videokameru nije umetnut medij. 
Nije sinkronizirano s točnošću kadra 
za medij videokamere.

Parallel Rec: 
upravljanja pokretanjem/
zaustavljanjem snimanja vanjskog 
priključenog uređaja kada je 
u videokameru umetnut medij. 
Sinkronizirano s točnošću kadra 
za medij videokamere.

[Napomena]
Za kontrolu s pomoću izlaznog HDMI signala 
postavite funkciju HDMI TC Out >Setting 
(stranica 85) u izborniku TC/Media cijelog 
izbornika na On.

Project >Assignable Button
Postavljanje dodjele funkcija dodjeljivim gumbima.

Stavka Postavka podstavke Opis

<1> to <9>, 
Gumb za 
zadržavanje 
fokusa

Off / Base ISO/Sensitivity / AGC / 
Push AGC / ND Filter Position / 
Auto ND Filter / Push Auto ND / 
Auto Iris / Push Auto Iris / Auto 
Shutter / Auto Exposure Level / 
Backlight / Spotlight / Preset 
White Select / ATW / ATW Hold / 
AF Speed/Sens. / Focus Setting / 
Focus Area / Focus Area(AF-S) / 
Face/Eye Detection AF / Push AF 
Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / 
Focus Magnifier x3 / Focus 
Magnifier x6 / S&Q Motion / 
SteadyShot / Rec / Rec Review / 
Clip Flag OK / Clip Flag NG / Clip 
Flag Keep / Color Bars / Tally 
[Front] / DURATION/TC/U-BIT / 
Display / Lens Info / Video Signal 
Monitor / Marker / VF Adjust / VF 
Mode / Gamma Display Assist / 
Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / 
Handle Zoom / NFC / Auto Upload 
(Proxy) / Direct Menu / User 
Menu / Menu

Dodjela funkcija dodjeljivim gumbima.
Base ISO/Sensitivity: 

izmjena osnovne osjetljivosti slikovnog 
senzora.

AGC: 
Uključenje/isključenje funkcije AGC.

Push AGC: 
omogućuje funkciju AGC dok je gumb 
pritisnut.

ND Filter Position: 
zamjena filtara ND.

Auto ND Filter: 
Uključenje/isključenje funkcije automatskog 
filtra ND.

Push Auto ND: 
omogućuje funkciju automatskog filtra ND 
dok je gumb pritisnut.

Auto Iris: 
uključenje/isključenje funkcije irisa.

Push Auto Iris: 
omogućuje funkciju automatskog irisa dok je 
gumb pritisnut.

Auto Shutter: 
uključenje/isključenje funkcije automatskog 
zatvarača.

Auto Exposure Level: 
prikaz/napuštanje izravnog izbornika Auto 
Exposure Level.

Backlight: 
zamjena Backlight i Standard.

Spotlight: 
zamjena između opcija Backlight i Standard.

Preset White Select: 
promjena vrijednosti načina zadanog balansa 
bijele boje.

ATW: 
uključenje/isključenje funkcije ATW.

ATW Hold: 
pauzira rad funkcije ATW.
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Project >Assignable Button
Postavljanje dodjele funkcija dodjeljivim gumbima.

Stavka Postavka podstavke Opis

<1> to <9>, 
Gumb za 
zadržavanje 
fokusa

AF Speed/Sens.: 
Prebacuje postavku brzine prijelaza pri 
automatskom fokusiranju i postavku 
osjetljivosti na zamjenu objekta pri 
automatskom fokusiranju.

Focus Setting: 
postavljanje područja fokusiranja.

Focus Area: 
postavlja područje izoštravanja za automatsko 
izoštravanje i automatsko izoštravanje 
pritiskom.

Focus Area(AF-S): 
postavljanje područja fokusiranja za 
automatsko fokusiranje pritiskanjem (AF-S).

Face/Eye Detection AF: 
Prebacuje postavke otkrivanja lica/oka pri 
automatskom fokusiranju.

Push AF Mode: 
zamjena postavke načina Push AF.

Push AF/Push MF: 
u načinu ručnog fokusiranja uključuje 
automatsko fokusiranje dok je gumb pritisnut. 
U načinu automatskog fokusiranja uključuje 
ručno fokusiranje dok je gumb pritisnut.

Focus Hold: 
u načinu automatskog fokusiranja fokus se 
fiksira dok je gumb pritisnut.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

uključenje/isključenje funkcije povećanja za 
fokusiranje.

S&Q Motion: 
uključenje/isključenje načina Slow & Quick 
Motion. 
Postavlja brzinu snimanja sličica kada je 
pritisnut i kada se drži.

SteadyShot: 
zamjena između Active, Standard i Off.

Rec: 
pokretanje/zaustavljanje snimanja.

Rec Review: 
uključenje/isključenje funkcije Rec Review.

Project >Assignable Button
Postavljanje dodjele funkcija dodjeljivim gumbima.

Stavka Postavka podstavke Opis

<1> to <9>, 
Gumb za 
zadržavanje 
fokusa

Clip Flag OK: 
izvodi se funkcija Add OK. 
Pritisnite dva puta za izvođenje Delete 
Clip Flag.

Clip Flag NG: 
izvodi se funkcija Add NG. 
Pritisnite dva puta za izvođenje Delete 
Clip Flag.

Clip Flag Keep: 
izvodi se funkcija Add Keep. 
Pritisnite dva puta za izvođenje Delete 
Clip Flag.

Color Bars: 
Uključenje/isključenje stupaca boje.

Tally [Front]: 
uključenje/isključenje funkcije svijetljenja/
treperenja lampice snimanja/signalizacije.

DURATION/TC/U-BIT: 
zamjena između Time Code, Users Bit 
i Duration.

Zaslon: 
uključenje/isključenje indikatora na zaslonu.

Lens Info: 
uklapa indikator dubine polja.

Video Signal Monitor: 
uklapa monitor videosignala (poput monitora 
za valne oblike).

Marker: 
uključenje/isključenje funkcije označavanja.

VF Adjust: 
prikaz stupaca razine za prilagodbu svjetline 
zaslona tražila.

VF Mode: 
zamjena prikaza u boji i crno-bijelog prikaza 
na tražilu.

Gamma Display Assist: 
uklapa pomoćnu funkciju prikaza game.

Peaking: 
Uključenje/isključenje funkcije naglašavanja.
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Project >Assignable Button
Postavljanje dodjele funkcija dodjeljivim gumbima.

Stavka Postavka podstavke Opis

<1> to <9>, 
Gumb za 
zadržavanje 
fokusa

Zebra: 
Uključenje/isključenje funkcije Zebra.

Volume: 
Namještanje izlazne razine zvuka monitora na 
priključak za slušalice i ugrađeni zvučnik.

Thumbnail: 
prikaz/izlaz iz zaslona s minijaturama.

Rad dodirom: 
Uključuje/isključuje rad dodirom.

Handle Zoom: 
uklapa rad zumiranja s ručkom.

NFC: 
Izvodi funkciju NFC.

Auto Upload (Proxy): 
Uključenje/isključenje automatskog prijenosa 
datoteke proxy.

Direct Menu: 
prikaz/izlaz iz izravnog izbornika.

User Menu: 
prikaz/izlaz iz izbornika User.

Menu: 
Prikaz/izlaz iz cijelog izbornika.

Project >Assignable Dial
Postavljanje dodjela funkcije za dodjeljivi kotačić te postavljanje smjera vrtnje.

Stavka Postavka podstavke Opis

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level

Dodjela funkcija dodjeljivom kotačiću.
ISO/Gain/EI: 

podešavanje pojačanja ili EI.
ND Filter: 

podešavanje filtra ND.
IRIS: 

podešavanje irisa.
Auto Exposure Level: 

Namještanje automatske razine 
ekspozicije.

Audio Input Level: 
Podešava razinu snimanja zvuka.

Smjer 
kotačića na 
drški

Normal / Opposite Postavljanje smjera vrtnje dodjeljivog 
kotačića na drški.
Normal: okretanje u normalnom smjeru.
Opposite: okretanje u suprotnom smjeru.

Project >Assignable Dial
Postavljanje dodjela funkcije za dodjeljivi kotačić te postavljanje smjera vrtnje.

Stavka Postavka podstavke Opis

Kotačić na 
ručki

Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level / Multi 
Function Dial

Dodjela funkcija dodjeljivom kotačiću na 
ručki.
ISO/Gain/EI: 

podešavanje pojačanja ili EI.
ND Filter: 

podešavanje filtra ND.
IRIS: 

podešavanje irisa.
Auto Exposure Level: 

Namještanje automatske razine 
ekspozicije.

Audio Input Level: 
Podešava razinu snimanja zvuka.

Višenamjenski kotačić: 
Funkcionira kao višenamjenski kotačić.

Smjer 
kotačića na 
ručki

Normal / Opposite Postavljanje smjera vrtnje dodjeljivog 
kotačića na ručki.
Normal: okretanje u normalnom smjeru.
Opposite: okretanje u suprotnom smjeru.

Project >Multi Function Dial
Dodjela funkcija višenamjenskom kotačiću.

Stavka Postavka podstavke Opis

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Dodjela zadane funkcije višenamjenskom 
kotačiću.
IRIS: 

podešavanje irisa.
ISO/Gain/EI: 

podešavanje pojačanja ili EI.
Auto Exposure Level: 

Namještanje automatske razine 
ekspozicije.

Audio Input Level: 
Podešava razinu snimanja zvuka.
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Project >User File
Postavljanje postavki za operacije s korisničkom datotekom.

Stavka Postavka podstavke Opis

Load 
Media(B)

Execute / Cancel Učitava postavke datoteke korisnika 
s memorijske kartice umetnute u utor za 
CFexpress Type A karticu / SD karticu (B).
Execute: izvođenje funkcije.

Save 
Media(B)

Execute / Cancel Sprema postavke datoteke korisnika na 
memorijsku karticu umetnutu u utor za 
CFexpress Type A karticu / SD karticu (B).
Execute: izvođenje funkcije.

File ID Prikaz zaslona za prikazivanje/uređivanje 
ID-ja datoteke za korisničke datoteke.

Load 
Customize 
Data

On / Off Postavljanje učitavanja prilagođenih 
informacija izbornika User kada je 
izvršena funkcija Load Media(B).

Load White 
Data

On / Off Postavljanje učitavanja informacija 
o balansu bijele boje kada je izvršena 
funkcija Load Media(B).

Project >All File
Postavljanje postavki za SVE datoteke.

Stavka Postavka podstavke Opis

Load 
Media(B)

Execute / Cancel Učitavanje SVIH datoteka
Execute: izvođenje funkcije.

Save 
Media(B)

Execute / Cancel Spremanje SVIH datoteka.
Execute: izvođenje funkcije.

File ID Dodjela naziva datoteci.

Load Network 
Data

On / Off Postavljanje učitavanja postavki izbornika 
Network kada je izvršena funkcija Load 
Media(B).
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Izbornik Paint/Look
U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

Paint/Look >Scene File
Postavljanje postavki za datoteke kadra.

Stavka Postavka podstavke Opis

Pozivanje Učitavanje datoteke kadra pohranjene u 
internu memoriju i primjena postavki kao 
trenutačnih postavki za kvalitetu slike.

Spremanje Sprema trenutačno stanje kvalitete slike 
kao datoteku kadra u internu memoriju.

Brisanje Brisanje datoteke kadra pohranjene u 
internu memoriju.

Pozivanje 
unaprijed 
postavljene 
postavke

Kada je način snimanja postavljen na 
Custom i funkcija Target Display je 
postavljena na SDR(BT.709):

S-Cinetone / Standard / Still / ITU709
Kada je način snimanja postavljen na 
Custom i funkcija Target Display je 
postavljena na HDR(HLG):

HLG Live / HLG Natural

Primjenjuje unaprijed postavljene 
postavke kvalitete slike (ponovno 
ispisivanje nije moguće) kao trenutačne 
postavke kvalitete slike.

Paint/Look >Base Look
Postavljanje postavki povezanih s temeljnim izgledom.

Stavka Postavka podstavke Opis

Select Kada je način snimanja postavljen na 
Custom i funkcija Target Display je 
postavljena na SDR(BT.709):

S-Cinetone / Standard / Still / 
ITU709 / od User1 do User16

Kada je način snimanja postavljen na 
Custom i funkcija Target Display je 
postavljena na HDR(HLG):

HLG Live / HLG Natural / od User1 do 
User16

Kada je način snimanja postavljen na Cine EI:
s709 / 709(800) / S-Log3 / od User1 
do User16

Odabire temeljni izgled.

Brisanje Briše odabrani temeljni izgled.

Izbriši sve Briše sve temeljne izglede.

Uvoz Učitava datoteku temeljnog izgleda s 
medija za snimanje.

Paint/Look >Base Look
Postavljanje postavki povezanih s temeljnim izgledom.

Stavka Postavka podstavke Opis

Ulaz S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Postavlja ulaznu skalu za odabrani 
temeljni izgled.

Izlaz BT.709 / HLG Postavlja izlaznu skalu boja za odabrani 
temeljni izgled.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Postavljanje referentne vrijednosti 
ekspozicije za odabrani temeljni izgled.

Paint/Look >Reset Paint Settings
Ponovno postavljanje postavki izbornika Paint/Look, bez temeljnog izgleda.

Stavka Postavka podstavke Opis

Ponovno 
postavljanje 
bez funkcije 
Base Look

Execute / Cancel Ponovno postavljanje postavki izbornika 
Paint/Look, bez temeljnog izgleda.
Execute: izvođenje funkcije.

Paint/Look >Black
Postavljanje postavki za crnu boju.

Stavka Postavka podstavke Opis

Master Black od -99,0 do +99,0 (±0,0) Postavljanje glavne razine crne boje.

R Black od -99,0 do +99,0 (±0,0) Postavljanje razine R crne boje.

B Black od -99,0 do +99,0 (±0,0) Postavljanje razine B crne boje.

Paint/Look >Knee
Postavljanje postavki za korekciju komprimiranja.

Stavka Postavka podstavke Opis

Setting Kada je funkcija Target Display postavljena 
na SDR(BT.709):

On / Off / ---
Kada je funkcija Target Display postavljena 
na HDR(HLG):

On / Off

Uključenje/isključenje funkcije korekcije 
komprimiranja.

Auto Knee Kada je funkcija Target Display postavljena 
na SDR(BT.709):

On / Off / ---
Kada je funkcija Target Display postavljena 
na HDR(HLG):

On / Off

Uključenje/isključenje funkcije 
automatskog komprimiranja.

Point od 75 % do 109 % (90 %) postavlja točku komprimiranja.

Slope od -99 do +99 (±0) postavlja nagib komprimiranja.
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Paint/Look >Detail
Postavlja postavke namještanja detalja.

Stavka Postavka podstavke Opis

Setting On / Off Uključenje/isključenje funkcije detalja.

Level Od –7 do +7 (±0) Postavljanje razine detalja.

Ručne 
postavke

On / Off Uključenje/isključenje funkcije ručnog 
namještanja detalja.

Balans V/H Od -2 do +2 (±0) Postavljanje balansa između okomitog 
(V) i vodoravnog detalja (H) za ručno 
namještanje detalja.

Balans B/W Type1 / Type2 / Type3 / Type4 / Type5 Postavlja balans između crnog (B) detalja 
za slabo osvijetljena područja i bijelog 
(W) detalja za visoko osvijetljena 
područja za ručno namještanje detalja.

Ograničenje od 0 do 7 Postavljanje razine ograničenja detalja za 
ručno namještanje detalja.

Crispening Od 0 do 7 Postavljanje razine crispeninga za ručno 
namještanje detalja.

Visoko 
osvijetljeni 
detalj

Od 0 do 4 Postavljanje razine detalja visoke 
osvijetljenosti za ručno namještanje 
detalja.

Paint/Look Matrix
Postavljanje postavki za korekciju matrice.

Stavka Postavka podstavke Opis

User Matrix On / Off Uključenje/isključenje funkcije korekcije 
korisničke matrice.

User Matrix 
Level

od -99 do +99 (±0) Podešavanje zasićenja boje na cijeloj slici.

User Matrix 
Phase

od -99 do +99 (±0) Podešavanje tona boje (faze) na 
cijeloj slici.

User Matrix 
R-G

od -99 do +99 (±0) Postavljanje korisnički definirane 
korisničke matrice R-G.

User Matrix 
R-B

od -99 do +99 (±0) Postavljanje korisnički definirane 
korisničke matrice R-B.

User Matrix 
G-R

od -99 do +99 (±0) Postavljanje korisnički definirane 
korisničke matrice G-R.

User Matrix 
G-B

od -99 do +99 (±0) Postavljanje korisnički definirane 
korisničke matrice G-B.

User Matrix 
B-R

od -99 do +99 (±0) Postavljanje korisnički definirane 
korisničke matrice B-R.

User Matrix 
B-G

od -99 do +99 (±0) Postavljanje korisnički definirane 
korisničke matrice B-G.

Paint/Look >Multi Matrix
Postavljanje postavki za korekciju višestruke matrice.

Stavka Postavka podstavke Opis

Setting On / Off Uključenje/isključenje funkcije korekcije 
višestruke matrice.

Reset Execute / Cancel Ponovno postavljanje nijanse i zasićenja 
svake boje osi na zadane vrijednosti.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Odabir osovine.

Hue od -99 do +99 (±0) Postavljanje nijanse boje koja se 
upotrebljava za korekciju višestruke 
matrice.

Zasićenost od -99 do +99 (±0) Postavljanje zasićenja boje koja se 
upotrebljava za korekciju višestruke 
matrice.
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Izbornik TC/Media
U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

TC/Media >Timecode
Postavljanje postavki vremenskog koda.

Stavka Postavka podstavke Opis

Mode Preset / Regen / Clock Postavljanje načina izvođenja 
vremenskog koda.
Preset: 

pokretanje izvođenja od prethodno 
zadane vrijednosti.

Regen: 
Pokretanje izvođenja od vremenskog 
koda do završetka prethodnog isječka.

Clock: 
primjena unutarnjeg sata za 
vremenski kod.

Pokreni Rec Run / Free Run Rec Run: izvodi se samo pri snimanju.
Free Run: izvodi se uvijek, neovisno o 

radu videokamere.

Setting Postavljanje vremenskog koda na 
proizvoljnu vrijednost.
SET: postavljanje vrijednosti.

Reset Execute / Cancel Ponovno postavljanje vremenskog koda 
na 00:00:00:00.
Execute: izvođenje funkcije.

TC Format DF / NDF Postavljanje formata vremenskog koda.
DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display
Postavljanje postavki prikaza podataka o vremenu.

Stavka Postavka podstavke Opis

Display Select Timecode / Users Bit / Duration Zamjena prikaza podataka o vremenu.

TC/Media >Users Bit
Postavljanje postavki za korisničke informacije.

Stavka Postavka podstavke Opis

Mode Fix / Time Postavljanje načina za korisničke informacije.
Fix: upotreba proizvoljne fiksne vrijednosti 

u korisničkim informacijama.
Time: upotreba trenutačnog vremena 

u korisničkim informacijama.

TC/Media >Users Bit
Postavljanje postavki za korisničke informacije.

Stavka Postavka podstavke Opis

Setting Postavljanje korisničkih informacija 
na proizvoljnu vrijednost.

TC/Media >HDMI TC Out
Postavljanje postavki za izvoz vremenskog koda pri primjeni priključnice HDMI.

Stavka Postavka podstavke Opis

Postavljanje On / Off Postavljenja izvoza vremenskog koda na 
uređaje za druge svrhe putem 
priključnice HDMI.
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TC/Media >Clip Name Format
Postavljanje postavki za dodjelu naziva i brisanje isječaka.

Stavka Postavka podstavke Opis

Title Prefix nnn_ (nnn su posljednje tri znamenke 
serijskog broja)
(Maks. sedmeroznamenkasti naziv)

Postavljanje dijela naslova (od 4 do 46 
znakova) u nazivu isječka.
Otvaranje zaslona za unos niza znakova.

Struktura zaslona za unos niza 
znakova
Područje za odabir znakova (tri retka): 

odabir znakova za unos u položaj 
pokazivača na području Title Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Radno područje pokazivača (jedan redak): 
Space: Umetanje znaka razmaka 
u položaj pokazivača.  
: pomak pokazivača ulijevo.  
: pomak pokazivača udesno.  
BS: brisanje znaka lijevo od položaja 
pokazivača.

Područje za Title Prefix (jedan redak): 
područje za unos naslova.

Postavljanje naslova
1.	 Odaberite znak koji želite unijeti na 

položaj pokazivača u području Title 
Prefix s područja za odabir znakova s 
pomoću višestrukog birača 
(stranica 7) i pritisnite gumb za 
primjenu višestrukog birača. 
(Odabrani znak se umeće, a 
pokazivač se pomiče udesno).

2.	 Ponovite 1. korak za postavljanje 
naslova. (Po potrebi primijenite BS).

3.	 Nakon postavljanja naslova odaberite 
Done kako biste zatvorili zaslon za 
unos znakova.

Number Set od 0001 do 9999 Postavljanje četveroznamenkastog 
brojčanog sufiksa za naziv isječka.

TC/Media >Update Media
Ažuriranje datoteke za upravljanje na memorijskim karticama.

Stavka Postavka podstavke Opis

Media(A) Execute / Cancel Ažuriranje datoteke za upravljanje 
na memorijskoj kartici u utoru A.
Execute: izvođenje funkcije.

Media(B) Execute / Cancel Ažuriranje datoteke za upravljanje 
na memorijskoj kartici u utoru B.
Execute: izvođenje funkcije.

TC/Media >Format Media
Vraćanje memorijskih kartica.

Stavka Postavka podstavke Opis

Media(A) Full Format / Quick Format / Cancel Formatiranje memorijske kartice u utoru A.

Media(B) Full Format / Quick Format / Cancel Formatiranje memorijske kartice u utoru B.
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U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

Monitoring >Output On/Off
Postavljanje postavki videoizlaza.

Stavka Postavka podstavke Opis

SDI On / Off Uključenje/isključenje izlaza za SDI.

HDMI On / Off Uključenje/isključenje izlaza HDMI.

Monitoring >Output Format
Postavljanje postavki za izlazni format.

Stavka Postavka podstavke Opis

SDI Pojedinosti o postavkama potražite pod 
"Izlazni formati i ograničenja" 
(stranica 110).

Postavljanje izlazne razlučivosti za SDI i 
HDMI.HDMI

Monitoring >Output Display
Postavljanje postavki za izlazni signal.

Stavka Postavka podstavke Opis

SDI On / Off Prikaz ugrađivanja izbornika i informacija 
o statusu u izlazni signal SDI.

HDMI On / Off Prikaz ugrađivanja izbornika i informacija 
o statusu u izlazni signal HDMI.

Monitoring >Display On/Off
Postavljanje prikaza postavki za stavke.

Stavka Postavka podstavke Opis

Network 
Status

On / Off Odabir stavki za prikaz u tražilu.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off

Base Look/
LUT

On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Izbornik Monitoring



6. Prikaz i postavke izbornika: Izbornik Monitoring88HR

Monitoring >Display On/Off
Postavljanje prikaza postavki za stavke.

Stavka Postavka podstavke Opis

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Blenda On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Postavljanje postavki za oznake za zaslonu.

Stavka Postavka podstavke Opis

Setting On / Off Uključenje/isključenje svih oznaka na 
zaslonu.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Odabir boje signala oznaka.

Center 
Marker

1 / 2 / 3 / 4 / Off Odabir oznake središta.

Safety Zone On / Off Uključenje/isključenje oznake sigurnog 
područja.

Safety Area 80% / 90% / 92.5% / 95% Odabir veličine oznake sigurnog područja 
(kao postotak ukupne veličine zaslona).

Aspect 
Marker

Line / Mask / Off Odabir vrste oznake omjera.

Aspect Mask od 0 do 15 (12) Odabir razine videosignala izvan oznake.

Aspect Safety 
Zone

On / Off Uključenje/isključenje oznake omjera u 
sigurnom području.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Odabir veličine oznake omjera sigurnog 
područja (kao postotak ukupne veličine 
zaslona).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Odabir način za prikaz oznake omjera.

Custom 
Aspect Ratio

Unos proizvoljne vrijednosti (01.00:01.00) Postavljanje razmjera proporcija na 
proizvoljnu vrijednost.

[Napomena]
Postavka je omogućena kada je funkcija Aspect 
Select postavljena na Custom.

Guide Frame On / Off Uključenje/isključenje prikaza okvira za 
navođenje.

100% Marker On / Off Uključenje/isključenje oznake za 100 %.

User Box On / Off Uključenje/isključenje oznake korisničke 
kutije.

User Box 
Width

od 3 do 479 (240) Postavljanje širine oznake korisničkog 
okvira (udaljenost od sredine do lijevog 
i desnog ruba).

User Box 
Height

od 3 do 269 (135) Postavljanje visine oznake korisničkog 
okvira (udaljenost od sredine do gornjeg 
i donjeg ruba).

User Box H 
Position

od -476 do +476 (0) Postavljanje vodoravnog položaja sredine 
oznake korisničkog okvira.

User Box V 
Position

od -266 do +266 (0) Postavljanje okomitog položaja sredine 
oznake korisničkog okvira.
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Monitoring >VF Setting
Postavljanje postavki tražila.

Stavka Postavka podstavke Opis

Brightness Od 1 do 15 (8) Podešavanje svjetline slike tražila.

Način boje Color / B&W Odabir načina prikaza tražila u načinu 
E-E/recording.

Monitoring >Gamma Display Assist
Postavljanje pomoćnih postavki za prikaz game.

Stavka Postavka podstavke Opis

Setting On / Off Uključivanje/isključivanje funkcije 
pomoćnog prikaza game u načinu 
Custom kada je funkcija Target Display 
postavljena na HDR(HLG).

Monitoring >Peaking
Postavljanje postavki naglašavanja.

Stavka Postavka podstavke Opis

Setting On / Off Uključenje/isključenje funkcije 
naglašavanja.

Peaking Level High / Mid / Low Postavljanje razine signala 
naglašavanja u boji.

Color B&W / Red / Yellow / Blue Odabir boje za signal naglašavanju u boji.

Monitoring >Zebra
Postavljanje postavki za uzorak zebre.

Stavka Postavka podstavke Opis

Setting Off / Zebra1 / Zebra2 Odabire vrstu uzorka zebre (Off, Zebra 1, 
Zebra 2).

Zebra1 Level Od 0 do 109 % (70 %) Postavljanje razine prikaza za Zebra 1.

Zebra1 
Aperture 
Level

Od 2 do 20 % (10 %) Postavljanje razine otvora blende za 
Zebra 1.

Zebra2 Level od 0% do 109% (100%) Postavljanje razine prikaza za Zebra 2.
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Izbornik Audio
U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).
Pogledajte "Blokovski dijagrami" (stranica 124).

Audio >Audio Input
Postavljanje postavki za ulazni zvuk.

Stavka Postavka podstavke Opis

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Uklapanje izvora unosa za snimanje na 
kanalu 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Uklapanje izvora unosa za snimanje na 
kanalu 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Uklapanje izvora unosa za snimanje na 
kanalu 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Uklapanje izvora unosa za snimanje na 
kanalu 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Postavljanje referentne razine snimanja 
za ulaz mikrofona XLR s INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Postavljanje referentne razine snimanja 
za ulaz mikrofona XLR s INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Odabir referentne razine unosa kada je 
sklopka INPUT1/INPUT2 postavljena na LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Odabir razine snimanja za referentni 
tonski signal od 1 kHz.

CH1 Wind 
Filter

On / Off Omogućivanje/onemogućivanje filtar za 
smanjenje vjetra za snimanje na kanalu 1.

CH2 Wind 
Filter

On / Off Omogućivanje/onemogućivanje filtar za 
smanjenje vjetra za snimanje na kanalu 2.

CH3 Wind 
Filter

On / Off Omogućivanje/onemogućivanje filtar za 
smanjenje vjetra za snimanje na kanalu 3.

CH4 Wind 
Filter

On / Off Omogućivanje/onemogućivanje filtar za 
smanjenje vjetra za snimanje na kanalu 4.

CH3 Level 
Control

Auto / Manual Odabir automatske razine ulaza zvuka ili 
ručnog podešavanja za kanal za 
snimanje 3.

[Napomena]
Ako su CH3 Input Select i CH4 Input Select 
postavljeni na Internal MIC, CH4 se uklapa na 
automatski/ručno sukladno ovoj postavci.

Audio >Audio Input
Postavljanje postavki za ulazni zvuk.

Stavka Postavka podstavke Opis

CH4 Level 
Control

Auto / Manual Odabir automatske razine ulaza zvuka ili 
ručnog podešavanja za kanal za snimanje 4.

[Napomena]
Ako su CH3 Input Select i CH4 Input Select 
postavljeni na Internal MIC, CH4 se uklapa na 
automatski/ručno sukladno postavci CH3 Level 
Control.

CH3 Input 
Level

Od 0 do 99 (49) Postavljanje razine unosa za snimanje na 
kanalu 3.

CH4 Input 
Level

Od 0 do 99 (49) Postavljanje razine unosa za snimanje na 
kanalu 4.

Audio Input 
Level

od 0 do 99 Postavljanje razine ulaza zvuka.
Može se primijeniti kao glavna jačina 
zvuka, sukladno postavkama u rasponu 
od CH1 Level do CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Odabir karakteristika limitatora za velike 
ulazne signale pri ručnom podešavanju 
razine ulaza zvuka.

CH1&2 AGC 
Mode

Mono / Stereo Postavljanje načina za automatsko 
podešavanje razine za kanal za snimanje 
1 i kanal 2. Kada je postavljena na Stereo, 
funkcija AGC povezuje se između kanala.

CH3&4 AGC 
Mode

Mono / Stereo Postavljanje načina za automatsko 
podešavanje razine za kanal za snimanje 
3 i kanal 4. Kada je postavljena na Stereo, 
funkcija AGC povezuje se između kanala.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Odabir karakteristika za AGC.

1kHz Tone on 
Color Bars

On / Off Uključenje/isključenje referentnog 
tonskog signala od 1 kHz pri prikazu 
stupaca boje.

[Napomena]
Kada je uključen s On, referentni tonski signal 
od 1 kHz postavlja se za snimanje na kanalu 3 
i kanalu 4, čak i ako su CH3 Input Select i CH4 
Input Select postavljeni na Off.
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Audio >Audio Input
Postavljanje postavki za ulazni zvuk.

Stavka Postavka podstavke Opis

CH1 Level Input without XLR adaptor
Audio Input Level / Side / Level+Side

Input with XLR adaptor (stranica 47)
Audio Input Level / Through

Postavljanje kombinacije podešavanja 
razine ulaza zvuka omogućene za kanal 
za snimanje 1.

[Napomena]
"Strana" se odnosi na kotačić AUDIO LEVEL 
(CH1) na strani videokamere. Po odabiru 
Level+Side razina snimanja zvuka određuje 
se kombinacijom funkcije Audio Input Level 
i postavki kotačića (stranica 124).

CH2 Level Input without XLR adaptor
Audio Input Level / Side / Level+Side

Input with XLR adaptor (stranica 47)
Audio Input Level / Through

Postavljanje kombinacije podešavanja 
razine ulaza zvuka omogućene za kanal 
za snimanje 2.

[Napomena]
"Strana" se odnosi na kotačić AUDIO LEVEL 
(CH2) na strani videokamere. Po odabiru 
Level+Side razina snimanja zvuka određuje 
se kombinacijom funkcije Audio Input Level i 
postavki kotačića (stranica 124).

CH3 Level Input without XLR adaptor
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Input with XLR adaptor (stranica 47)
Audio Input Level / Through

Postavljanje kombinacije podešavanja 
razine ulaza zvuka omogućene za kanal 
za snimanje 3.

CH4 Level Input without XLR adaptor
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Input with XLR adaptor (stranica 47)
Audio Input Level / Through

Postavljanje kombinacije podešavanja 
razine ulaza zvuka omogućene za kanal 
za snimanje 4.

Audio >Audio Output
Postavljanje postavki za izlazni zvuk.

Stavka Postavka podstavke Opis

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Odabir izlaza zvučnog kanala na 
priključnicu za slušalice i ugrađeni zvučnik.

[Napomena]
Ako je zvuk za višestruke kanale postavljen na 
istovremeni izlaz, razina izlaza za svaki kanal za 
izlaz se smanjuje kako bi se spriječilo rezanje.

Jačina zvuka Od 0 do 50 Namještanje izlazne razine zvuka 
monitora na priključak za slušalice 
i ugrađeni zvučnik.

Izlaz za 
slušalice

Mono / Stereo Odabir mono (Mono) ili stereo (Stereo) 
izlaza na priključnicu za slušalice.

Alarm Level od 0 do 7 (4) Podešavanje glasnoća alarma.

HDMI 
Output CH

CH1/CH2 / CH3/CH4 Postavljanje kombinacije zvučnih kanala 
na izlazu HDMI.
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U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

Thumbnail (Sličica)

Stavka Postavka podstavke Opis

Display Clip 
Properties

Prikaz zaslona sa svojstvima isječka.

Thumbnail >Set Clip Flag
Postavljanje postavki za zastavice za isječak.

Stavka Postavka podstavke Opis

Add OK Dodavanje zastavice OK.

Add NG Dodavanje zastavice NG.

Add KEEP Dodavanje zastavice Keep.

Delete Clip 
Flag

Brisanje svih zastavica.

Thumbnail >Lock/Unlock Clip
Postavljanje postavki za zaštitu isječka.

Stavka Postavka podstavke Opis

Select Clip Odabir i zaključavanje/otključavanje isječka.

Lock All Clips Zaključavanje svih isječaka.

Unlock All 
Clips

Otključavanje svih isječaka.

Thumbnail >Delete Clip
Brisanje isječaka.

Stavka Postavka podstavke Opis

Select Clip Brisanje odabranog isječka.

All Clips Brisanje svih isječaka.

Thumbnail >Transfer Clip
Prijenos isječaka.

[Napomena]
Funkcija Transfer Clip ne može se konfigurirati kada je funkcija Access Authentication >Password u izborniku 
Network nedefinirana.

Stavka Postavka podstavke Opis

Select Clip Prijenos odabranih isječaka.

All Clips Prijenos svih isječaka.

[Napomena]
Moguće je prenijeti do 200 isječaka.

Thumbnail >Transfer Clip (Proxy)
Prijenos isječaka proxy.

[Napomena]
Funkcija Transfer Clip (Proxy) ne može se konfigurirati kada je funkcija Access Authentication >Password 
u izborniku Network nedefinirana.

Stavka Postavka podstavke Opis

Select Clip Prijenos isječaka proxy koji odgovaraju 
odabranim isječcima.

All Clips Prijenos isječaka proxy koji odgovaraju 
svim isječcima.

[Napomena]
Moguće je prenijeti do 200 isječaka.

Thumbnail >Filter Clips
Postavljanje postavki za prikaz isječaka.

Stavka Postavka podstavke Opis

U redu Prikaz samo isječaka sa zastavicom OK.

NG Prikaz samo isječaka sa zastavicom NG.

KEEP Prikaz samo isječaka sa zastavicom Keep.

None Prikaz samo isječaka bez zastavice.

All Prikaz svih isječaka, neovisno o zastavicama.

Thumbnail >Customize View
Zamjena prikaza zaslona s minijaturama.

Stavka Postavka podstavke Opis

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Zamjena informacija koje se prikazuju 
ispod minijatura.

Izbornik Thumbnail
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Izbornik Technical
U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

Technical >Color Bars
Postavljanje postavki stupca boje.

Stavka Postavka podstavke Opis

Setting On / Off Uključenje/isključenje stupaca boje.

Vrsta ARIB / 100% / 75% / SMPTE Odabir vrste stupca boje.

Technical >ND Dial
Postavljanje postavki za operacije s kotačićem ND VARIABLE.

Stavka Postavka podstavke Opis

CLEAR with 
Dial

On / Off Postavljanje omogućivanja uklopa 
statusa ND (CLEAR  On) radnjom 
s kotačićem ND VARIABLE.

Technical >Tally
Postavljanje postavki lampice snimanja/signalizacije.

Stavka Postavka podstavke Opis

Prednja 
strana

On / Off Uključenje/isključenje funkcije lampice 
snimanja/signalizacije.

Stražnja 
strana

On / Off Uključenje/isključenje funkcije lampice 
snimanja/signalizacije (stražnje).

Technical >HOLD Switch Setting
Postavljanje postavki za sklopku za privremeni prekid.

Stavka Postavka podstavke Opis

with Rec 
Button

On / Off Postavljanje zaključavanja rada gumba 
za snimanje START/STOP.

with Hand 
Grip Remote

On / Off Postavljanje zaključavanja operacija na 
daljinskom upravljaču na ručki.

Technical >Touch Operation
Postavlja postavke povezane s radom dodirom.

Stavka Postavka podstavke Opis

Setting On / Off Uključuje/isključuje rad dodirom.

Technical >Rec Review
Postavljanje postavki za pregled snimanja.

Stavka Postavka podstavke Opis

Setting 3sec / 10sec / Clip Odabir vremena za reprodukciju netom 
snimljenih isječaka za pregled snimke.

Technical >Zoom
Postavljanje postavki zumiranja.

Stavka Postavka podstavke Opis

Vrsta 
zumiranja

Optical Zoom Only / On(Clear Image 
Zoom)

Postavljanje vrste zumiranja.
Samo optički zum: 

Optički zum namješta se radom objektiva.
On(Clear Image Zoom): 

Elektronički zum s malo ili bez 
pogoršavanja kvalitete slike.

Technical >Handle Zoom
Postavljanje postavki za zumiranje na ručki.

Stavka Postavka podstavke Opis

Setting Off / Low / High / Variable Postavljanje brzine zuma na ručki.

High (Visok) od 1 do 8 (8) Odabir brzine zuma na ručki kada je za 
brzinu zuma na ručki odabrana funkcija High.

Low (Nizak) od 1 do 8 (3) Odabir brzine zuma na ručki kada je za 
brzinu zuma na ručki odabrana funkcija Low.

[Napomena]
Kada je brzina zumiranja postavljena na nisku 
vrijednost, može doći do neujednačenog 
zumiranja.

Technical >Menu Settings
Postavljanje postavki za izbornik.

Stavka Postavka podstavke Opis

User Menu 
Only

On / Off Postavljanje samo prikaza izbornika User 
(On) ili prikaza popisa izbornika (Off) 
kada videokamera prikazuje izbornik.

User Menu 
with Lock

On / Off Postavljanje zaključavanja prikaza 
izbornika, prikaza samo izbornika User.

[Napomena]
U normalnom radu s prikazom izbornika 
ova se stavka ne prikazuje. Detalje 
o radu s prikazom izbornika potražite 
pod stranica 68.
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Technical >Fan Control
Postavljanje postavki za način upravljanja ventilatorom.

Stavka Postavka podstavke Opis

Setting Auto / Minimum / Off in Rec Postavljanje načina za upravljanje 
ventilatorom videokamere.

[Napomena]
Čak i kada je odabrana funkcija Even when Off in 
Rec, ventilator radi kada unutarnja temperatura 
videokamere prekorači određenu vrijednost.

Technical >Lens
Postavljanje postavki za objektive.

Stavka Postavka podstavke Opis

Smjer prstena 
za zum

Left(W)/Right(T) / Right(W)/Left(T) Postavljanje smjera za upotrebu prstena 
za zumiranje.

[Napomena]
Omogućeno samo pri primjeni objektiva E-mount 
koji podržava zamjenu smjera prstena za zumiranje.

Shading 
Compensation

Auto / Off Uključenje/isključenje automatske 
kompenzacije sjenčanja.

Chroma 
Aberration 
Comp.

Auto / Off Uključenje/isključenje automatske 
kompenzacije kromatske aberacije.

Komp. 
iskrivljenja

Auto / Off Uključenje/isključenje automatske 
kompenzacije izobličenja.

Distance 
Display

Meter / Feet Postavljanje prikazanih jedinica za 
informacije o objektivu i položaj fokusa.

Zoom 
Position 
Display

Focal Length / Number / Bar Postavljanje formata prikaza za položaj 
zuma.

Technical >Video Light Set
Postavljanje metode osvjetljavanja svjetlom za videozapis. Dostupno samo pri upotrebi HVL-LBPC 
(u opciji).

Stavka Postavka podstavke Opis

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Postavljanje metode upravljanja svjetlom 
za videozapis postavljenim na nosač za 
više sučelja.
Veza napajanja: 

uključenje/isključenje svjetla za videozapis 
kada je videokamera uključena/isključena.

Rec Link: 
uključenje/isključenje svjetla za 
videozapis kada videokamera 
pokreće/zaustavlja snimanje.

Rec Link + Stby: 
uključenje/ postavljanje svjetla za 
videozapis u način pripravnosti kada 
videokamera pokreće/zaustavlja snimanje.

Technical >APR
Izvodi APR.

Stavka Postavka podstavke Opis

APR Execute / Cancel Izvodi APR (Automatic Pixel Restoration) za 
automatsko podešavanje slikovnog senzora.
Execute: izvođenje funkcije.

[Napomena]
Prije izvođenja funkcije APR uvijek postavite 
poklopac objektiva.

Technical >Camera Battery Alarm
Postavljanje postavki alarma za nizak napon baterije.

Stavka Postavka podstavke Opis

Low Battery 5% / 10% / 15% / … / 45% / 50% Postavljanje preostale razine baterije 
za prikaz alarma za niski napon baterije 
(koraci od 5 %).

Battery 
Empty

od 3% do 7% Postavljanje preostale razine baterije 
za prikaz alarma za praznu bateriju.

Technical >Camera DC IN Alarm
Postavljanje postavki za alarm za ulazni napon.

Stavka Postavka podstavke Opis

DC Low 
Voltage1

od 16,0 V do 19,0 V (16,5 V) Postavljanje napona na kojem se prikazuje 
alarm za nizak ulazni napon na DC IN.

DC Low 
Voltage2

od 15,5 V do 18,5 V Postavljanje napona na kojem se prikazuje 
alarm za nedovoljan ulazni napon na DC IN.
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Izbornik Network
U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

Network >Access Authentication
Postavljanje postavki za provjeru autentičnosti.

Stavka Postavka podstavke Opis

User Name Postavljanje korisničkog imena za 
provjeru autentičnosti za pristup.

Password Postavljanje lozinke za provjeru 
autentičnosti za pristup.

Network >Wireless LAN
Postavljanje postavki za bežične veze LAN.

Stavka Postavka podstavke Opis

Setting Access Point Mode / Station Mode / Off Odabir načina rada bežične veze LAN.

WPS Execute / Cancel Uspostavljanje veze putem 
WPS (Wi-Fi Protected Setup).
Execute: izvođenje funkcije.

NFC Execute / Cancel Uspostavljanje veze putem NFC 
(Near Field Communication).
Execute: izvođenje funkcije.

MAC Address Prikaz MAC adrese za bežično sučelje 
LAN na videokamere.

Network >AP Mode Settings
Postavljanje postavki za veze za način za pristupnu točku.

Stavka Postavka podstavke Opis

Kanal Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Postavljanje kanala za bežični LAN.
Auto(5GHz) je dostupan samo na 
ILME‑FX6V/VK.

Camera SSID 
& Password

Prikaz identifikatora SSID i lozinke 
videokamere.

Regenerate 
Password

Execute / Cancel Stvaranje nove lozinke.
Execute: izvođenje funkcije.

IP Address Prikaz IP adrese videokamere u načinu 
za pristupnu točku.

Subnet Mask Prikaz maske podmreže videokamere 
u načinu za pristupnu točku.

Network >ST Mode Settings
Postavljanje postavki za veze za način za stanicu.

Stavka Postavka podstavke Opis

Daljinski 
upravljač 
kamere

Enable / Disable Postavljanje omogućivanja daljinskog 
upravljanja s uređaja povezanog s 
videokamerom bežičnom vezom LAN 
u načinu za stanicu.

Connected 
Network

Prikaz povezanih bežičnih mreža LAN 
(pristupna točka).

SSID Prikaz identifikatora SSID pristupne točke 
za povezivanje.

Sigurnost Prikaz vrste sigurnosti pristupne točke za 
povezivanje.

Password Prikaz lozinke pristupne točke za 
povezivanje.
Kada je funkcija Security postavljena na 

WEP ili WPA: *******
Kada je funkcija Security postavljena na 

None: (prazno)

DHCP Prikaz uključenosti/isključenosti 
poslužitelja DHCP.

IP Address Prikaz IP adrese videokamere kada je 
DHCP postavljen na Off.

Subnet Mask Prikaz maske podmreže videokamere 
kada je DHCP postavljen na Off.

Gateway Prikaz zadanog pristupnika videokamere 
kada je DHCP postavljen na Off.

DNS Auto Prikaz uključenosti/isključenosti 
dobavljanja sustava DNS.

Primary DNS Server Prikaz primarnog poslužitelja za DNS 
videokamere kada je funkcija DNS Auto 
postavljena na Off.

Secondary DNS Server Prikaz sekundarnog poslužitelja za DNS 
videokamere kada je funkcija DNS Auto 
postavljena na Off.
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Network >ST Mode Settings
Postavljanje postavki za veze za način za stanicu.

Stavka Postavka podstavke Opis

Scan 
Networks

Otkrivanje bežičnih mreža LAN (pristupne 
točke) i prikaz popisa.
Odabir odredišta s popisa za povezivanje.

SSID Prikaz identifikatora SSID pristupne točke 
za povezivanje.

Sigurnost Prikaz vrste sigurnosti pristupne točke za 
povezivanje.

Password Unos lozinke za povezivanje 
s pristupnom točkom.

DHCP 
On / Off

Uključenje/isključenje poslužitelja DHCP.

IP Address Unos IP adrese videokamere kada je 
DHCP postavljen na Off.

Subnet Mask Unos maske podmreže videokamere 
kada je DHCP postavljen na Off.

Gateway Unos zadanog pristupnika videokamere 
kada je DHCP postavljen na Off.

DNS Auto 
On / Off

Uključenje/isključenje automatskog 
dobavljanja sustava DNS.

Primary DNS Server Unos primarnog poslužitelja za DNS 
videokamere kada je funkcija DNS Auto 
postavljena na Off.

Secondary DNS Server Unos sekundarnog poslužitelja za DNS 
videokamere kada je funkcija DNS Auto 
postavljena na Off.

Network >ST Mode Settings
Postavljanje postavki za veze za način za stanicu.

Stavka Postavka podstavke Opis

Manual 
Register

Registriranje postavki za ručno 
povezivanje s pristupnom točkom.

SSID Unos identifikatora SSID pristupne točke 
za povezivanje.

Security 
None / WEP / WPA

Postavljanje vrste sigurnosti pristupne 
točke za povezivanje. Odaberite WPA ako 
je vrsta sigurnosti odredišne pristupne 
točke WPA ili WPA2.

Password Unos lozinke za povezivanje 
s pristupnom točkom.

DHCP 
On / Off

Uključenje/isključenje poslužitelja DHCP.

IP Address Unos IP adrese videokamere kada je 
DHCP postavljen na Off.

Subnet Mask Unos maske podmreže videokamere 
kada je DHCP postavljen na Off.

Gateway Unos zadanog pristupnika videokamere 
kada je DHCP postavljen na Off.

DNS Auto 
On / Off

Uključenje/isključenje automatskog 
dobavljanja sustava DNS.

Primary DNS Server Unos primarnog poslužitelja za DNS kada 
je funkcija DNS Auto postavljena na Off.

Secondary DNS Server Unos sekundarnog poslužitelja za DNS 
kada je funkcija DNS Auto postavljena 
na Off.
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Network >Wired LAN
Postavljanje postavki za žične veze LAN.

Stavka Postavka podstavke Opis

Postavljanje On / Off Uključenje/isključenje funkcije žične 
veze LAN.

Camera 
Remote 
Control

Enable / Disable Postavljanje omogućivanja daljinskog 
upravljanja s uređaja povezanog s 
videokamerom žičnom vezom LAN.

Detail 
Settings

Konfiguriranje postavki žične veze LAN.

DHCP 
On / Off

Uključenje/isključenje poslužitelja DHCP.

IP Address Unos IP adrese videokamere kada je 
DHCP postavljen na Off.

Subnet Mask Unos maske podmreže videokamere 
kada je DHCP postavljen na Off.

Gateway Unos zadanog pristupnika videokamere 
kada je DHCP postavljen na Off.

DNS Auto 
On / Off

Uključenje/isključenje automatskog 
dobavljanja sustava DNS.

Primary DNS Server Unos primarnog poslužitelja za DNS kada 
je funkcija DNS Auto postavljena na Off.

Secondary DNS Server Unos sekundarnog poslužitelja za DNS 
kada je funkcija DNS Auto postavljena 
na Off.

Network >Modem
Postavljanje postavki povezanih s dijeljenjem putem USB-a.

Stavka Postavka podstavke Opis

Postavljanje On / Off Uključenje/isključenje veze s pametnim 
telefonom.

Camera 
Remote 
Control

Enable / Disable Postavljanje dozvole povezivanja za 
pristup s aplikacije Content Browser 
Mobile s pomoću pametnog telefona.

Device Name Prikazuje naziv uređaja pametnog 
telefona.

IP Address Prikazuje IP adresu pametnog telefona.

Subnet Mask Prikazuje masku podmreže pametnog 
telefona.

Network >File Transfer
Postavljanje postavki za prijenose.

Stavka Postavka podstavke Opis

Auto Upload 
(Proxy)

On / Off Uključenje/isključenje automatskog 
prijenosa datoteke proxy.

Default 
Upload 
Server

Odabir poslužitelja za prijenos datoteka. 
Ovdje odabran poslužitelj postaje 
automatsko odredište za prijenos 
datoteka proxy, kao i odredište 
za prijenos datoteka sa zaslona 
s minijaturama.
Prikazuje naziv prikaza konfiguriran 
u postavkama servera od 1 do 3.

Clear 
Completed 
Jobs

Execute / Cancel Brisanje dovršene zadatke prijenosa 
s popisa.
Execute: izvođenje funkcije.

Clear All Jobs Execute / Cancel Brisanje svih zadataka prijenosa s popisa.
Execute: izvođenje funkcije.

View Job List Prikaz popisa sa zadacima prijenosa.
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Network >File Transfer
Postavljanje postavki za prijenose.

Stavka Postavka podstavke Opis

Server 
Settings1

Display Name Postavljanje naziva za prikaz koji se 
prikazuje u izborniku za postavljanje 
odredišta za prijenos.

Service 
FTP

Prikaz vrste poslužitelja.

Host Name Postavljanje naziva domaćina odredišnog 
poslužitelja za prijenos.

Port (od 1 do 65535 (21)) Postavljanje broja ulaza odredišnog 
poslužitelja za prijenos.

User Name Postavljanje korisničkog imena za 
provjeru autentičnosti za vezu 
s odredišnim poslužiteljem za prijenos.

Password Postavljanje lozinku za provjeru 
autentičnosti veze s odredišnim 
poslužiteljem.

Passive Mode 
On / Off

Uključenje/isključenje načina PASV.

Destination Directory Unos naziva odredišne mape za prijenos.

Using Secure Protocol 
On / Off

Postavljanje primjene (On) ili izostave 
primjene (Off) sigurnog prijenosa FTP 
(FTPS Explicit Mode: FTPES).

Root Certificate 
Load / Clear / None

Učitavanje korijenskog certifikata za 
siguran prijenos FTP te brisanje postavki.

Root Certificate Status 
Loaded / No Certificate

Prikaz statusa učitavanja korijenskog 
certifikata za siguran prijenos FTP.

Reset 
Execute / Cancel

Ponovno postavljanje postavki pod 
Server Settings na zadane vrijednosti.
Execute: izvođenje funkcije.

Server 
Settings2

Isto kao Server Settings1.

Server 
Settings3

Isto kao Server Settings1.

Network >Network Reset
Ponovno postavljanje mrežnih postavki.

Stavka Postavka podstavke Opis

Reset Execute / Cancel Ponovno postavljanje mrežnih postavki.
Execute: izvođenje funkcije.
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U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornički zadane postavke prikazuju se podebljane (na primjer 18dB).

Maintenance >Language
Postavljanje jezika prikaza.

Stavka Postavka podstavke Opis

Select Postavljanje jezika prikaza.
SET: postavljanje jezika.

Maintenance >Clock Set
Postavljanje postavki unutarnjeg sata.

Stavka Postavka podstavke Opis

Time Zone od UTC – 12:00 do UTC + 14:00 Postavljanje vremenske razlike od UTC 
u jedinicama od 30 minuta.

Date Mode YYMMDD / MMDDYY / DDMMYY Odabir formata prikaza datuma.
YYMMDD: godina, mjesec, dan
MMDDYY: mjesec, dan, godina
DDMMYY: dan, mjesec, godina

12H/24H 12H / 24H Odabir formata prikaza sata.
12H: način od 12
24H: način od 24

Date Postavljanje trenutačnog datuma.
SET: postavljanje vrijednosti.

Time Postavljanje trenutačnog vremena.
SET: postavljanje vrijednosti.

Maintenance >All Reset
Ponovno postavljanje postavki na tvornički zadane vrijednosti.

Stavka Postavka podstavke Opis

Reset Execute / Cancel Ponovno postavljanje svih postavki na 
tvornički zadane vrijednosti.
Execute: izvođenje funkcije.

[Napomena]
3D LUT datoteka uvezena s pomoću funkcije 
Base Look >Import (stranica 83) u izborniku 
Paint/Look izbrisana je. Za brisanje svih 3D LUT 
datoteka odaberite funkciju Base Look >Delete 
All u izborniku Paint/Look (stranica 83).

Reset without 
Network

Execute / Cancel Ponovno postavljanje postavki izbornika, 
izuzev postavki izbornika Network, 
u tvornički zadano stanje.

Maintenance >Hours Meter
Prikaz ukupnog vremena rada.

Stavka Postavka podstavke Opis

Hours 
(System)

Prikaz ukupnih radnih sati (nije moguće 
ponovno postaviti).

Hours (Reset) Prikaz ukupnih radnih sati (moguće je 
ponovno postaviti).

Reset Execute / Cancel Ponovno postavljanje prikaza Hours 
(Reset) na 0.
Execute: izvođenje funkcije.

Maintenance >Version
Prikaz informacija o verziji.

Stavka Postavka podstavke Opis

Version 
Number

Vx.xx Prikaz verzije softvera videokamere.

Version Up Execute / Cancel Ažuriranje videokamere.*

Execute: izvođenje funkcije.
*	 Ovom funkcijom ažurira se softver 

videokamere.

Lens Version 
Number

Vxx Prikaz broja verzije softvera objektiva 
E-mount.

Izbornik Maintenance
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Postavke i zadane vrijednosti izbornika Shooting

Postavke i zadane vrijednosti ISO/Gain

Raspon postavki i zadane vrijednosti ISO/Gain (stranica 72) variraju ovisno o postavkama funkcija Mode, Target Display, Base Look >Select i Base Sensitivity. Dostupne opcije istaknute 
su sivom bojom.

Kada je način Mode postavljen na ISO

Target Display SDR(BT.709) HDR(HLG) SDR(BT.709) i HDR(HLG) common
Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live / HLG Natural Od User1 do User16
Base Sensitivity Low (Nizak) High (Visok) Low (Nizak) High (Visok) Low (Nizak) High (Visok)
ISO 320 ISO/Gain<L> default
ISO 400
ISO 500
ISO 640 ISO/Gain<M> default
ISO 800 ISO/Gain<L> default ISO/Gain<L> default
ISO 1000
ISO 1250 ISO/Gain<H> default
ISO 1600 ISO/Gain<M> default ISO/Gain<M> default
ISO 2000
ISO 2500
ISO 3200 ISO/Gain<H> default ISO/Gain<H> default
ISO 4000
ISO 5000 ISO/Gain<L> default
ISO 6400
ISO 8000
ISO 10000 ISO/Gain<M> default
ISO 12800 ISO/Gain<L> default ISO/Gain<L> default
ISO 16000
ISO 20000 ISO/Gain<H> default
ISO 25600 ISO/Gain<M> default ISO/Gain<M> default
ISO 32000
ISO 40000
ISO 51200 ISO/Gain<H> default ISO/Gain<H> default
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Kada je način Mode postavljen na dB

Raspon postavki
–3dB
–2dB
–1dB
0 dB ISO/Gain<L> default
1dB
2dB
3dB
4dB
5dB
6dB ISO/Gain<M> default
7dB
8dB
9dB
10dB
11dB
12dB ISO/Gain<H> default
13dB
14dB
15dB
16dB
17dB
18dB
19dB
20 dB
21 dB
22dB
23dB
24dB
25dB
26dB
27dB
28dB
29dB
30dB
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Postavke limita AGC-a i zadane vrijednosti

Raspon postavki i zadane vrijednosti limita AGC-a (stranica 73) variraju ovisno o postavkama funkcija Mode, Target Display, Base Look >Select i Base Sensitivity. Dostupne opcije istaknute 
su sivom bojom.

Kada je način Mode postavljen na ISO

Target Display SDR(BT.709) HDR(HLG) HDR(HLG) SDR(BT.709) i HDR(HLG) common
Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live HLG Natural Od User1 do User16
Base Sensitivity Low (Nizak) High (Visok) Low (Nizak) High (Visok) Low (Nizak) High (Visok) Low (Nizak) High (Visok)
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000 Default
ISO 2500
ISO 3200
ISO 4000
ISO 5000 Default Default Default
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000 Default
ISO 40000
ISO 51200
ISO 64000
ISO 80000 Default Default Default
ISO 102400
ISO 128000
ISO 160000

ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Kada je način Mode postavljen na dB

Raspon postavki
3dB
6dB
9dB
12dB
15dB Default
18dB
21 dB
24dB
27dB
30dB
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Postavke kvalitete slike spremljene za svaki način snimanja
Trenutačni status stavki konfiguracije povezan s kvalitetom slike spremljen za svaki od sljedećih načina snimanja (stranica 24). Kada promijenite način snimanja, odgovarajuće spremljene postavke 
primjenjuju se na ciljani način snimanja.
ˎˎ Način Custom SDR(BT.709)
ˎˎ Način Custom HDR(HLG)
ˎˎ Način Cine EI

Stavke konfiguracije povezane s kvalitetom slike koje su spremljene za svaki način snimanja prikazane su u nastavku.
Da: stavka je spremljena.
Ne: stavka nije spremljena.

Stavka konfiguracije Režim snimanja
Način Custom Način Cine EI
SDR(BT.709) HDR(HLG)

Izbornik Shooting ISO/Gain/EI ISO/Gain Da1) Ne

Exposure Index Ne Da

Base Sensitivity Da Ne

Base ISO Ne Da

Bijeli Preset White Da Da

Drugačije od navedenog Da

White Setting Da

Offset White Da Ne

LUT On/Off Ne Da

Noise Suppression Setting(Custom) Da Da Ne

Level(Custom) Da Da Ne

Setting(Cine EI) Ne Da

Level(Cine EI) Ne Da

Izbornik Paint/Look Base Look Odaberite Da Da Da

Input2) Da

Output2) Da

AE Level Offset2) Da

Crni Da Da Ne

Komprimiranje Auto Knee Da Ne Ne

Drugačije od navedenog Da Da Ne

Detalj Da Da Ne

Matrix Da Da Ne

Multi Matrix Da Da Ne

1)	 Odvojene postavke ISO osjetljivosti spremljene su i za način Custom SDR(BT.709) i HDR(HLG).
2)	Postavke su spremljene za svaki temeljni izgled i ne ovise o načinu snimanja.
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Podaci za konfiguraciju

Možete spremiti postavke cijelog izbornika 
na memorijsku karticu umetnutu u utor za 
CFexpress Type A karticu / SD karticu (B). To 
omogućuje brzo pozivanje odgovarajućeg 
kompleta postavki za trenutačnu situaciju.
Podaci za konfiguraciju spremaju se u sljedeće 
kategorije.

Korisničke datoteke
U korisničke datoteke spremaju stavke 
za postavljanje i podaci iz prilagodljivog 
izbornika User.
Možete spremiti do 64 datoteke na 
memorijsku karticu.
Učitavanjem ove datoteke u memoriju 
videokamere moguće je prilagoditi postavke 
izbornika User.

Datoteke ALL (sve postavke)
U datoteke ALL spremaju se podaci za 
konfiguraciju za sve izbornike. Možete spremiti 
do 64 datoteke na memorijsku karticu.

[Napomena]
Posebni podaci uređaja (sjenčanje, izlazne razine i drugi 
podaci koji zahtijevaju prilagodbu za poseban uređaj) ne 
spremaju se.

Spremanje korisničke datoteke / 
datoteke ALL

1	 Umetnite memorijsku karticu u utor za 
CFexpress Type A karticu / SD karticu (B) 
(stranica 6).
ˎˎ Kod CFexpress kartica naljepnica je 
okrenuta na lijevu stranu.
ˎˎ Kod SD kartica naljepnica je okrenuta 
na desnu stranu s nakošenim rubom 
na dnu.

2	 Za datoteku korisnika odaberite funkciju 
User File >Save Media(B) (stranica 82) 
>Execute u izborniku Project cijelog 
izbornika.
Za SVE datoteke odaberite funkciju All File 
>Save Media(B) (stranica 82) >Execute 
u izborniku Project cijelog izbornika.
Prikazuje se zaslon s odredištem 
za spremanje datoteke.

3	 Odaberite redak "No File" na zaslonu 
s odredištem za spremanje.
Odabirom retka s unosom File ID prepisuje 
se odabrana datoteka.
File ID generira se automatski, no možete 
ga izmijeniti.

4	 Odaberite Execute na zaslonu za potvrdu.

Učitavanje korisničke datoteke / 
datoteke ALL

1	 Umetnite memorijsku karticu na koju je 
datoteka spremljena u utor za CFexpress 
Type A karticu / SD karticu (B) 
(stranica 6).
ˎˎ Kod CFexpress kartica naljepnica je 
okrenuta na lijevu stranu.
ˎˎ Kod SD kartica naljepnica je okrenuta 
na desnu stranu s nakošenim rubom 
na dnu.

2	 Za datoteku korisnika odaberite funkciju 
User File >Load Media(B) (stranica 82) 
>Execute u izborniku Project cijelog 
izbornika.
Za SVE datoteke odaberite funkciju All File 
>Load Media(B) (stranica 82) >Execute 
u izborniku Project cijelog izbornika.
Prikazuje se zaslon s popisom datoteka.

3	 Odaberite datoteku za učitavanje.
Prikazuje se zaslon za potvrdu.

4	 Odaberite Execute.

[Napomene]
ˎˎ Nakon učitavanja podataka za konfiguraciju jedinica 

se automatski ponovno pokreće.
ˎˎ Kada je funkcija All File >Load Network Data 

u izborniku Project cijelog izbornika postavljena na 
Off, učitane su sve postavke u SVIM datotekama 
osim postavki izbornika Network.

Promjena stavke File ID

1	 Za datoteku korisnika odaberite funkciju 
User File >File ID (stranica 82) u 
izborniku Project cijelog izbornika.
Za SVE datoteke odaberite funkciju All File 
>File ID (stranica 82) u izborniku Project 
cijelog izbornika.
Prikazuje se zaslon za uređivanje 
stavke File ID.

2	 Odaberite znak s pomoću višestrukog 
birača (stranica 7) ili višenamjenskog 
kotačića (stranica 5), zatim pritisnite 
gumb za primjenu višestrukog birača 
ili višenamjenski kotačić.

3	 Po potrebi ponovite 2. korak.

4	 Po dovršetku unosa znakova 
odaberite Done.

Spremanje i učitavanje podataka za konfiguraciju



106HR 7. Priključenje vanjskog uređaja

Priključenje vanjskih monitora i uređaja za snimanje
Za prikaz snimljenih slika/reprodukciju 
na vanjski monitor odaberite izlazni signal 
videokamere i upotrijebite odgovarajući 
kabel za monitor koji priključujete.
Također možete priključiti uređaje za snimanje, 
poput magnetoskopa, i snimati izlazne signale 
s videokamere.
Na vanjskom monitoru moguće je prikazati 
iste informacije koje se mogu pregledati 
na tražilu, primjerice informacije o statusu 
i izbornike. Informacije o postavljanju Zaslon 
(stranica 14) na zaslonu Monitoring Status 
ili zaslonu Output Display (stranica 87) 
izbornika Monitoring cijelog izbornika 
postavite na On u skladu sa signalom za izlaz 
na monitor.

Priključnica SDI OUT (vrsta BNC)

U izborniku Monitoring (stranica 87) 
postavite postavku uključenja/isključenja 
izlaza i izlazni format.
Za povezivanje upotrijebite komercijalno 
dostupan koaksijalni kabel od 75 Ω.

[Napomena]
Prije uključenja uređaja provjerite je li veza videokamere 
i vanjskog uređaja uzemljena.

(Nakon priključenja koaksijalnog kabela od 
75 Ω preporučuje se uključiti videokameru 
i vanjski uređaj.)
Ako je vanjski uređaj nužno priključiti dok je 
videokamera uključena, koaksijalni kabel od 
75 Ω prvo priključite na vanjski uređaj, a potom 
na videokameru.

Istovremeno pokretanje snimanja 
videokamerom i vanjskim uređajem

S omogućenim izlazom signala SDI, funkciju 
SDI/HDMI Rec Control (stranica 79) >Setting 
u izborniku Project cijelog izbornika postavite 
na SDI/HDMI Remote I/F ili Parallel Rec kako 
biste omogućili izlaz pokretačkog signala REC 
na vanjski uređaj priključen na priključnicu SDI 
OUT. Tako se sinkronizira snimanje na vanjski 
uređaj s videokamerom.

[Napomene]
ˎˎ Ako priključeni vanjski uređaj ne podržava pokretački 

signal REC, uređaj ne može raditi.
ˎˎ Kada nije umetnut medij, izvozi se samo pokretački 

signal REC.

Priključnica HDMI OUT 
(priključnica vrste A)

U izborniku Monitoring (stranica 87) cijelog 
izbornika postavite postavku uključenja/
isključenja izlaza i izlazni format.

Istovremeno pokretanje snimanja 
videokamerom i vanjskim uređajem

S omogućenim izlazom signala HDMI, funkciju 
HMDI TC Out >Setting (stranica 85) u 
izborniku TC/Media cijelog izbornika postavite 
na On, a funkciju SDI/HDMI Rec Control 
>Setting (stranica 79) u izborniku Project 
postavite na SDI/HDMI Remote I/F ili Parallel 
Rec kako biste omogućili izlaz pokretačkog 
signala REC na vanjski uređaj priključen na 
priključnicu HDMI OUT. Tako se sinkronizira 
snimanje na vanjski uređaj s videokamerom.
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Sinkronizacija vremenskih kodova
Možete sinkronizirati vremenski kod jedinice 
s drugim uređajima.

Zaključavanje vremenskog koda 
za druge uređaje

Jedinicu koja osigurava vremenski kod 
postavite u način u kojem se vremenski kod 
stalno izvozi (poput Free Run ili Clock).

1	 Postavite vremenski kod (stranica 85) 
u izborniku TC/Media cijelog izbornika 
kako slijedi.
Način rada: Preset
Run: Free Run

2	 Pritisnite dodjeljivi gumb (stranica 48) 
kojemu je dodijeljena funkcija DURATION/
TC/U-BIT kako biste vremenski kod 
prikazali na zaslonu.

3	 Provjerite je li sklopka za odabir TC IN/
OUT (stranica 4) postavljena u položaj 
IN, zatim unesite referentni vremenski kod 
za sinkronizaciju frekvencije sustava 
videokamere u TC IN/TC OUT priključnicu.

Generator vremenskog koda na videokameri 
zaključava se s referentnim vremenskim 
kodom, a na zaslonu se prikazuje "EXT-LK".
Deset sekundi nakon zaključavanja 
vremenskog koda vanjsko stanje zaključanosti 
održava se čak i ako se odspoji vanjski izvor 
referentnog vremenskog koda.

[Napomene]
ˎˎ Tijekom rada s vanjskim zaključavanjem vremenski 

kod trenutačno se zaključava na vanjski vremenski 
kod, a vrijednost vanjskog vremenskog koda prikazuje 
se na podatkovnom dijelu zaslona. Međutim, 
nemojte odmah pokrenuti snimanje. Prije snimanje 
pričekajte nekoliko sekundi na stabilizaciju generatora 
vremenskog koda.
ˎˎ Ako frekvencija referentnog vremenskog koda 

i frekvencija kadra na videokameri nisu jednake, 
zaključavanje je nemoguće postići i videokamera će 
raditi neispravno. Ako se to dogodi, vremenski kod 
neće se uspješno zaključati na vanjski vremenski kod.
ˎˎ Vremenski kod može se prebacivati jedan kadar po 

satu na temelju referentnog vremenskog koda.

Otpuštanje vanjskog zaključavanja

Promijenite postavku vremenskog koda 
u izborniku TC/Media cijelog izbornika ili 
isključite videokameru.
Vanjska sinkronizacija također se otpušta 
ako se promijenite frekvencija sustava te pri 
pokretanju snimanja u posebnom načinu 
snimanja (Slow & Quick Motion ili Interval Rec).

Sinkronizacija vremenskog koda 
drugog uređaja s vremenskim 
kodom videokamere

Jedinicu koja osigurava vremenski kod 
postavite u način u kojem se vremenski kod 
stalno izvozi (poput Free Run ili Clock).

1	 Postavite vremenski kod videokamere 
s pomoću vremenskog koda 
(stranica 85) u izborniku TC/Media 
cijelog izbornika.

2	 Provjerite je li sklopka za odabir TC IN/
OUT (stranica 4) postavljena u položaj 
OUT i spojite TC IN/TC OUT priključnicu za 
ulaz vremenskog koda uređaja koji želite 
sinkronizirati.
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Upravljanje/uređivanje isječaka na računalu

Povezivanje s USB kabelom

Upotreba čitača kartice (nije obavezno)

Spojite čitač CFexpress kartica ili čitač SD 
kartica na računalo s pomoću USB kabela 
i unesite memorijsku karticu u utor za očitanje 
kartice. Memorijska kartica prepoznaje se 
kao dodani pogon računala. Na podržana 
računala možete velikom brzinom uvoziti 
isječke primjenom načina rada videokamere 
za masovnu pohranu.

Upotreba načina za masovnu pohranu

[Napomena]
Način za masovnu pohranu ne može se upotrebljavati 
kada je funkcija Modem >Setting u izborniku Network 
cijelog izbornika postavljena na On ili kada je funkcija 
Wired LAN >Setting u izborniku Network postavljena na 
On. Obje funkcije postavite na Off.

Priključite videokameru kabelom USB i umetnite 
memorijsku karticu u utor A ili B. Memorijska 
kartica prepoznaje se kao dodatni pogon računala.

1	 Spojite priključnicu USB-C (stranica 7) 
ili priključnicu USB/multi (stranica 7) 
na računalo s pomoću USB kabela.

2	 Sklopku videokamere POWER postavite 
u položaj ON.
Na zaslonu tražila prikazuje se poruka s 
upitom o omogućivanju priključka USB.

	 [Napomena]
Potvrdna poruka za vezu USB ne prikazuje se dok 
se prikazuje druga potvrdna poruka ili poruka 
o napretku, primjerice pri formatiranju ili oporavku 
memorijske kartice.
Potvrdna poruka prikazuje se nakon dovršetka 
formatiranja ili obnavljanja. Potvrdna poruka za 
USB također se ne prikazuje prikazati kada se 
prikazuje zaslon sa svojstvima. Poruka se prikazuje 
po dovršetku obrade ili povratku na zaslon 
s minijaturama.

3	 Okrenite višenamjenski kotačić i odaberite 
Execute.

4	 U prozoru "Moje računalo" sustava 
Windows provjerite je li kartica dodana 
kao izmjenjivi disk.
Na računalu Mac provjerite je li se mapa 
„NO NAME” ili „Untitled” (može se 
uređivati) stvorila na radnoj površini.

[Napomene]
ˎˎ Ako je pristupni indikator crven, nemojte provoditi 

sljedeće operacije.
–– Isključivanje ili odspajanje kabela za napajanje
–– Vađenje memorijske kartice.
–– Odspajanje kabela USB

ˎˎ Rad nije zajamčen na svim računalima.

Upotreba nelinearnih sustava 
uređivanja

U nelinearnim sustavima uređivanja potreban 
je softver za uređivanje (u opciji) koji podržava 
formate snimljene videokamerom.
Namjenskim aplikacijskim softverom isječke 
koje želite uređivati prethodno spremite na 
tvrdi disk računala.
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Mjere opreza pri upotrebi
O kondenzaciji

Ako se jedinica brzo prenese s hladne na 
toplu lokaciju, ili ako dođe do naglog porasta 
okolne temperature, na vanjskoj površini i/
ili u unutrašnjosti jedinice može se nakupiti 
vlaga. Ta pojava naziva se kondenzacija. Ako 
dođe do kondenzacije, isključite jedinicu i 
nemojte je upotrebljavati dok se kondenzacija 
ne raščisti. Rad s jedinicom na kojoj ima 
kondenzata može uzrokovati njeno oštećenje.

Na LCD zaslonima

LCD zaslon postavljen na jedinicu proizveden 
je tehnologijom visoke preciznosti i daje omjer 
radnih piksela od najmanje 99,99 %. Stoga se 
vrlo mali broj piksela može „zaglaviti”, tako da 
uvijek budu isključeni (crni), uključeni (crveno, 
zeleno ili plavo) ili bljeskaju. Osim toga, takvi 
se „zaglavljeni” pikseli, zbog fizičkih svojstava 
zaslona s tekućim kristalima, mogu spontano 
pojaviti nakon dugotrajne upotrebe. Takvi 
problemi nisu kvar. Takvi problemi ne utječu 
na snimane podatke.

Pojava na slikovnom senzoru CMOS 
kamere

[Napomena]
Na slikama može doći do sljedeće pojave, specifične za 
slikovne senzore. To se ne smatra neispravnim radom.

Bijele mrlje
Premda se slikovni senzori proizvode 
tehnologijom visoke preciznosti, na zaslonu se 
u rijetkim slučajevima mogu pojaviti fine bijele 
mrlje uzrokovane kozmičkim zračenjem itd.
To je povezano s principom slikovnog senzora 
i ne smatra se kvarom.
Bijele mrlje posebno su vidljive u sljedećim 
slučajevima:

ˎˎ tijekom rada na visokim temperaturama 
okoline
ˎˎ pri povećanju jačine signala (osjetljivost).

Treperenje
Ako snimate pod fluorescentnom rasvjetom, 
natrijevim svjetiljkama, živinim svjetiljkama ili 
LED svjetiljkama, zaslon može treperiti ili se 
boje mogu razlikovati.

Potrošni dijelovi

ˎˎ Ventilator i baterija potrošni su dijelovi koje 
periodički treba zamijeniti.  
Kada rade na sobnoj temperaturi, uobičajeni 
ciklus zamjene je oko pet godina. Međutim, 
ovaj ciklus zamjene opća je smjernica i ne 
jamči vijek trajanja ovih dijelova. Za detalje 
o zamjenskim dijelovima obratite se 
distributeru.
ˎˎ Očekivani vijek trajanja adaptera 
za izmjeničnu struju i elektrolitskog 
kondenzatora je, pod normalnim radnim 
temperaturama i pri normalnoj upotrebi 
(8 sati dnevno; 25 dana mjesečno), oko pet 
godina. Ako upotreba prekoračuje navedenu 
normalnu učestalost, očekivani vijek trajanja 
smanjuje se sukladno upotrebi.
ˎˎ Priključak za bateriju na ovoj jedinici 
(priključnica za komplete baterija i adaptere 
za izmjeničnu struju) potrošni je dio.  
Ako su polovi priključka za bateriju izobličeni 
udarcima ili vibracijama, ili ako su korodirali 
tijekom dugotrajne upotrebe na otvorenom, 
jedinicu nije moguće pravilno napajati.  
Preporučuju se periodički pregledi radi 
održavanja jedinice u radnom stanju te 
produljenja iskoristivog vijeka trajanja. 
Više informacija i pregledima zatražite 
od servisnog ili prodajnog predstavnika 
tvrtke Sony.

Ugrađena punjiva baterija

Videokamera ima ugrađenu punjivu bateriju za 
spremanje datuma, vremena i drugih postavki 
čak i kada je videokamera isključena. Ugrađena 
punjiva baterija napuni se nakon isteka 24 
sata ako je jedinica priključena na električnu 
utičnicu putem adaptera za izmjeničnu struju 
ili ako je postavljen potpuno napunjen komplet 
baterija, neovisno o tome je li videokamera 
uključena/isključena. Punjiva baterija potpuno 
se prazni nakon dva mjeseca ako nije priključen 
adapter za izmjeničnu struju ili se videokamera 
upotrebljava bez kompleta baterija. 
Videokameru upotrebljavajte nakon punjenja 
baterije. Međutim, čak i ako punjiva baterija nije 
napunjena, to ne utječe na rad videokamere 
sve dok ne trebate datum snimanja.

Upotreba i prostor za spremanje

Spremite u ravan, prozračan prostor.
Izbjegavajte upotrebu ili spremanje jedinice na 
sljedećim mjestima.
ˎˎ Na prevelikoj toplini ili hladnoći (raspon 
radne temperature: od 0 °C do 40 °C (od 
32 °F do 104 °F))  
Imajte na umu kako tijekom ljeta u vrućim 
područjima temperature u automobilu sa 
zatvorenim prozorima može lako prekoračiti 
50 °C (122 °F).
ˎˎ Na vlažnim ili prašnjavim lokacijama. Lokacije 
na kojima jedinica može biti izložena kiši
ˎˎ Lokacije podložne snažnim vibracijama
ˎˎ Blizu jakih magnetskih polja.
ˎˎ Blizu radijskih ili televizijskih odašiljača koji 
proizvode jaka elektromagnetska polja.
ˎˎ Dugotrajno na izravnoj sunčevoj svjetlosti ili 
u blizini grijača

Napomena o laserskim zrakama

Laserske zrake mogu oštetiti slikovni senzor 
CMOS. Ako snimate scenu koja obuhvaća 
lasersku zraku, budite pažljivi i nemojte je 

usmjeriti izravno u objektiv jedinice. Posebice 
snažne laserske zrake medicinskih ili drugih 
uređaja mogu uzrokovati oštećenja zbog 
reflektiranja i loma svjetlosti.

Sprječavanje elektromagnetskih smetnji 
od prijenosnih komunikacijskih uređaja

Upotreba prijenosnih telefona i drugih 
komunikacijskih uređaja u blizini ove 
kamere može uzrokovati kvarove i smetnje 
zvučnih signala i videosignala. U blizini 
kamere preporučuje se isključiti prijenosne 
komunikacijske uređaje.

Sigurnosne mjere opreza

ˎˎ SONY NE SNOSI ODGOVORNOST ZA 
BILO KOJU VRSTU ŠTETE PROISTEKLE 
IZ NEPOŠTIVANJA ODGOVARAJUĆIH 
SIGURNOSNIH MJERA NA UREĐAJIMA 
ZA PRIJENOS, NEIZBJEŽNOG CURENJA 
PODATAKA PROUZROČENOG 
SPECIFIKACIJAMA PRIJENOSA NI 
SIGURNOSNIH PROBLEMA BILO KOJE VRSTE.
ˎˎ Ovisno o radnoj okolini, neovlaštene treće 
strane na mreži mogu ostvariti mogućnost 
pristupa jedinici. Kada jedinicu povezujete 
s mrežom, obavezno provjerite je li mreža 
pravilno zaštićena.
ˎˎ Sadržaj komunikacije mogu neprimjetno 
presresti neovlaštene treće strane u blizini 
signala. Kada upotrebljavate bežičnu 
komunikaciju mrežom LAN, pravilno 
primijenite sigurnosne mjere kako biste 
zaštitili sadržaj komunikacije.
ˎˎ Kada ovaj proizvod spajate na mrežu, 
povežite ga putem sustava koji pruža 
funkciju zaštite poput usmjerivača ili 
vatrozida. Ako je povezan bez takve zaštite, 
može doći do problema sa sigurnošću.
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Tvornički zadane postavke prikazuju se podebljane (na primjer 1920×1080P (Level A)).

[Napomene]
ˎˎ Rezolucija izlaznog formata ograničena je postavkama Rec Format >Frequency, Video Format i Codec u izborniku 

Project cijelog izbornika (stranica 77).
ˎˎ Rezolucija izlaznog formata ograničena je kombinacijom snimanja broja sličica u sekundi u načinu S&Q. Izlaz za 

HDMI mijenja se u Full HD ako su svi sljedeći uvjeti u cijelom izborniku ispunjeni.
–– Funkcija Rec Format >Video Format postavljena je na 4096×2160 ili 3840×2160 u izborniku Project
–– Funkcija S&Q Motion >Setting u izborniku Shooting postavljena na On
–– Funkcija S&Q Motion >Frame Rate u izborniku Shooting viša je od 60 fps
–– Funkcija Rec Format >Codec u izborniku Project postavljena je na RAW ili RAW & XAVC-I ili je funkcija Output On/

Off >SDI u izborniku Monitoring postavljena na On
ˎˎ Kada je izlaz za HDMI postavljen na 4096×2160P ili 3840×2160P, izlaz za HDMI mijenja se u 1920×1080P ako su 

ispunjeni prethodni uvjeti. Kada dođe do toga, opcije odabira izlaza za HDMI 4096×2160P i 3840×2160P za funkciju 
Output Format >SDI/HDMI (stranica 87) u izborniku Monitoring označene su sivom bojom i ne mogu se odabrati.
ˎˎ Ako je izlazna razlučivost videozapisa viša od razlučivosti slike, ne izvozi se slika reprodukcije.

Izlazni formati na priključnici SDI OUT/HDMI OUT

Frekvencija 
sustava 
(Rec Format 
>Frequency u 
izborniku Project)

Format 
videozapisa 
(Rec Format 
>Video Format u 
izborniku Project)

Stanje izlaza 
za RAW
(Rec Format 
>Codec u izborniku 
Project)

Izlazni format (Output Format 
u izborniku Monitoring)

SDI HDMI

59,94 / 50 4096×2160 S izlazom za RAW – 4096×2160P

1920×1080P

1920×1080i

3840×2160P

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i

Frekvencija 
sustava 
(Rec Format 
>Frequency u 
izborniku Project)

Format 
videozapisa 
(Rec Format 
>Video Format u 
izborniku Project)

Stanje izlaza 
za RAW
(Rec Format 
>Codec u izborniku 
Project)

Izlazni format (Output Format 
u izborniku Monitoring)

SDI HDMI

Bez izlaza za RAW 4096×2160P 4096×2160P

1920×1080P

1920×1080i

3840×2160P 3840×2160P

1920×1080P

1920×1080i

1920×1080P 
(razina A)

1920×1080P

1920×1080i

1920×1080P 
(razina B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

3840 × 2160 S izlazom za RAW – 3840×2160P

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i

Bez izlaza za RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080i

1920×1080P 
(razina A)

1920×1080P

1920×1080i

1920×1080P 
(razina B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

Izlazni formati i ograničenja
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Frekvencija 
sustava 
(Rec Format 
>Frequency u 
izborniku Project)

Format 
videozapisa 
(Rec Format 
>Video Format u 
izborniku Project)

Stanje izlaza 
za RAW
(Rec Format 
>Codec u izborniku 
Project)

Izlazni format (Output Format 
u izborniku Monitoring)

SDI HDMI

1920×1080 Bez izlaza za RAW 1920×1080P 
(razina A)

1920×1080P

1920×1080i

1920×1080P 
(razina B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

– 59,94: 720×480P
50: 720×576P

29,97/25 4096×2160 S izlazom za RAW – 4096×2160P

1920×1080P

3840×2160P

1920×1080P

1920×1080P

1920×1080i

Bez izlaza za RAW 4096×2160P 4096×2160P

1920×1080P

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

3840 × 2160 S izlazom za RAW – 3840×2160P

1920×1080P

1920×1080P

1920×1080i

Bez izlaza za RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

1920×1080 Bez izlaza za RAW 1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

Frekvencija 
sustava 
(Rec Format 
>Frequency u 
izborniku Project)

Format 
videozapisa 
(Rec Format 
>Video Format u 
izborniku Project)

Stanje izlaza 
za RAW
(Rec Format 
>Codec u izborniku 
Project)

Izlazni format (Output Format 
u izborniku Monitoring)

SDI HDMI

24 4096×2160 S izlazom za RAW – 4096×2160P

1920×1080P

Bez izlaza za RAW 4096×2160P 4096×2160P

1920×1080P 1920×1080P

23,98 4096×2160 S izlazom za RAW – 4096×2160P

1920×1080P

3840×2160P

1920×1080P

1920×1080P

Bez izlaza za RAW 4096×2160P 4096×2160P

1920×1080P

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

3840 × 2160 S izlazom za RAW – 3840×2160P

1920×1080P

1920×1080P

Bez izlaza za RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080 Bez izlaza za RAW 1920×1080P 1920×1080P
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Izvor napajanja

Simptom Uzrok Rješenje
Videokamera se ne uključuje. Nije postavljen komplet 

baterija i nema napajanja na 
priključnici DC IN.

Postavite komplet baterija 
(stranica 17) ili priključite na 
izmjenično napajanje adapterom za 
izmjeničnu struju (stranica 18).

Komplet baterija potpuno je 
ispražnjen.

Komplet baterija zamijenite s potpuno 
napunjenim (stranica 17).

Električno napajanje prekida 
se tijekom rada.

Komplet baterija prazni se. Komplet baterija zamijenite s potpuno 
napunjenim (stranica 17).

Komplet baterija vrlo se brzo 
prazni.

Okolna temperatura vrlo je 
niska.

To uzrokuju karakteristike baterije i ne 
smatra se kvarom.

Komplet baterija nepravilno 
je napunjen.

Ponovno napunite komplet baterija 
(stranica 17).
Ako se komplet baterija brzo prazni čak 
i nakon potpunog pražnjenja, možda je 
na kraju vijeka trajanja. Zamijenite je 
novom.

Snimanje/reprodukcija

Simptom Uzrok Rješenje
Snimanje ne započinje kada 
pritisnete gumb za snimanje 
START/STOP.

Memorijska kartica je puna. Zamijenite memorijsku karticu karticom 
s dovoljno prostora.

Potreban je oporavak 
memorijske kartice.

Oporavite memorijsku karticu 
(stranica 33).

Snimanje zvuka nije moguće. Kotačići AUDIO LEVEL (CH1/
CH2) postavljeni su na 
minimalnu razinu.

Namjestite razine za snimanje zvuka 
kotačićima AUDIO LEVEL (CH1/CH2) 
(stranica 46).

Snimljeni zvuk je izobličen. Razina zvuka je previsoka. Namjestite razine za snimanje zvuka 
kotačićima AUDIO LEVEL (CH1/CH2) 
(stranica 46).

Snimljeni zvuk ima visoku 
razinu šuma.

Razina zvuka je preniska. Namjestite razine za snimanje zvuka 
kotačićima AUDIO LEVEL (CH1/CH2) 
(stranica 46).
Kada je odabran vanjski mikrofon, 
također prilagodite postavku INPUT MIC 
Reference pod Audio Input u izborniku 
Audio (stranica 90).

Simptom Uzrok Rješenje
Isječak nije moguće 
reproducirati.

Isječak se uređuje. Isječke nije moguće reproducirati ako 
ste izmijenili nazive ili datoteke, ili ako 
se isječak upotrebljava na računalu. 
Ne radi se o kvaru.

Isječak se snima na drugi 
uređaj.

Isječke snimljene na druge uređaje 
nemoguće je reproducirati ili se 
prikazuju u neispravnoj veličini. 
Ne radi se o kvaru.

Vanjski uređaji

Simptom Rješenje
Računalo ne prepoznaje 
videokameru.

Odspojite kabel USB od računala, a potom ga ponovno čvrsto 
priključite.

Odspojite kabel USB od računala, ponovno pokrenite računalo 
i ponovno pratite korake ispravnim redoslijedom.

Povežite računalo i videokameru umetanjem USB kabela ili 
u priključnicu USB-C ili priključnicu USB/multi.

Isječke nije moguće učitati na 
računalo.

Odspojite kabel USB od računala, ponovno pokrenite videokameru, 
a potom je ponovno priključite.

Za učitavanje isječaka na računalo mora biti instaliran aplikacijski 
softver (stranica 108).

Rješavanje problema
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Bežična LAN veza

[Napomena]
Prepreke i elektromagnetske smetnje između videokamere i pristupne točke za bežični LAN ili priključni uređaj, ili 
okruženje (poput materijala u zidovima), mogu skratiti domet komunikacije ili ju potpuno onemogućiti. Ako dođe do 
ovih problema, provjerite status veze/komunikacije nakon prenošenja videokamere na novu lokaciju ili međusobno 
približite videokameru i pristupnu točku/priključni uređaj.

Simptom Rješenje

Priključni uređaj ne može 
pristupiti videokameri.

ˎˎ Provjerite rad bežične veze LAN (IP adresa itd.).
ˎˎ Postavke komunikacije između pristupne točke i klijenta možda 
nisu valjane. Pojedinosti potražite u uputama za upotrebu 
pristupne točke.

Nije moguća prijava u 
videokameru.

Provjerite postavljeno korisničko ime i lozinku.

Internetska veza

Simptom Rješenje

Prijenos datoteka nije uspio. Korisničko ime i lozinka poslužitelja možda su neispravni.
Unesite ispravno korisničko ime i lozinku.

Prijenos datoteka je nedostupan. Signal može biti loš.
Pređite na drugu lokaciju i pokušajte ponovno.

Pri upotrebi filtra ND

Simptom Rješenje
Filtar ND ne pomiče se. Filtar je sljedećim postupkom moguće ručno pomaknuti u položaj 

Clear.

1	 Sklopku POWER na videokameri postavite u isključeni položaj.

2	 Uklonite okrugli poklopac na donjoj strani.

3	 Umetnite odvijač u otvor i okrenite ga u smjeru suprotnom od smjera kazaljke na satu.
ˎˎ Filtar ND pomiče se u položaj Clear okretanjem u smjeru suprotnom od smjera kazaljke 
na satu. Okrećite do postizanja položaja Clear.
ˎˎ Upotrijebite odvijač promjera ø2.4 mm ili manji. Dubina umetanja odvijača je približno 
3,0 cm (1 3/16 in.).

Otvor za odvijač
(s uklonjenim poklopcem)

4	 Sklopku ND PRESET/VARIABLE (stranica 5) postavite u položaj PRESET, gumbe gore/dolje 
za ND FILTER POSITION (stranica 5) u položaj CLEAR.

[Napomene]
ˎˎ Prethodni postupak nemojte primjenjivati tijekom normalnog rada. Postupak primijenite samo kada se filtar ND ne 

pomiče. Ako postupak primijenite tijekom normalnog rada, može doći do oštećenja filtra ND.
ˎˎ Nakon primjene prethodne procedure obratite se servisnom centru tvrtke Sony radi popravka videokamere.
ˎˎ Ako se i nakon provedbe prethodnog postupka prikazuje poruka o pogrešci, snimanje je i dalje moguće.
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Ako se na videokameri pojavi prikaz upozorenja, opreza ili radnog uvjeta koji zahtjeva potvrdu, na 
tražilu se prikazuje poruka, lampica snimanja/signalizacije počinje treperiti i oglašava se zvučno 
upozorenje.
Ispušta se zvuk upozorenja sa slušalica spojenih na priključak za slušalice.

Poruke o pogreškama

Videokamera prekida rad kada se prikaže sljedeća vrsta prikaza.

Poruka na tražilu Zvuk 
upozorenja

Lampica 
snimanja/
signalizacije

Uzrok i rješenje

E + šifra pogreške Kontinuirano Brzo 
treperenje

Prikazuje nepravilnost na videokameri. Snimanje 
se zaustavlja, čak i ako se na tražilu prikazuje 
REC.
Isključite videokameru i provjerite ima li problema 
s priključenim uređajima, kabelima ili medijima. 
Ako se pogreška i dalje pojavljuje po ponovnom 
uključenju videokamere, obratite se servisnom 
predstavniku tvrtke Sony.
(Ako se videokamera ne isključi pri postavljanju 
sklopke POWER na OFF, uklonite bateriju ili 
odspojite napajanja na DC IN).
Ovisno o statusu videokamere, može se prikazati 
pogreška ili oglasiti zvuk upozorenja.

Poruke upozorenja

Ako se prikaže sljedeći zaslon, pratite priložene upute.

Poruka na tražilu Zvuk 
upozorenja

Lampica 
snimanja/
signalizacije

Uzrok i rješenje

Battery Near End Isprekidan Treperi Preostala napunjenost paketa baterija postaje niska.
Prvom prilikom ponovno napunite.

Battery End Kontinuirano Brzo 
treperenje

Komplet baterija je prazan. Snimanje je 
onemogućeno.
Prekinite rad i zamijenite komplet baterija.

Poruka na tražilu Zvuk 
upozorenja

Lampica 
snimanja/
signalizacije

Uzrok i rješenje

Temperature High Isprekidan Treperi Unutarnja temperatura je visoka.
Isključite videokameru i prije ponovnog rada 
pričekajte da se ohladi.

Visoka temperatura 
medija

Isprekidan Treperi Temperatura CFexpress kartice je visoka.
Zamijenite karticu ili prije ponovne upotrebe 
pričekajte da se ohladi.

Voltage Low Isprekidan Treperi Napon na DC IN je nizak (1. razina). Provjerite izvor 
napajanja.

Insufficient Voltage Kontinuirano Brzo 
treperenje

Napon na DC IN je prenizak (2. razina). Snimanje je 
onemogućeno.
Priključite drugi izvor napajanja.

Media Near Full Isprekidan Treperi Preostali kapacitet memorijske kartice je malen.
Zamijenite prvom prilikom.

Media Full Kontinuirano Brzo 
treperenje

Isječke nije bilo moguće snimiti ili kopirati jer je 
istrošen kapacitet memorijske kartice.
Odmah zamijenite.

Clips Near Full Isprekidan Treperi Broj dodatnih isječaka koje je moguće snimiti na 
memorijsku karticu je malen.
Zamijenite prvom prilikom.

Clips Full Kontinuirano Brzo 
treperenje

Dosegnut je maksimalan broj dodatnih isječaka 
koje je moguće snimiti na memorijsku karticu.
Snimanje ili kopiranje dodatnih isječaka nije 
moguće. Odmah zamijenite.

Last Clip Recording Isprekidan Treperi Budući da je dostignut maksimalni broj isječaka, 
trenutačno snimani isječak posljednji je isječak 
koji je moguće snimiti.
Pripremite novu memorijsku karticu.

Media(A)1) Life Near 
End

Isprekidan Treperi Približava se kraj vijeka trajanja memorijske 
kartice. Zamijenite prvom prilikom.

Media(A)1) Life End Kontinuirano Brzo 
treperenje

Memorijska kartica dosegla je kraj vijeka trajanja. 
Odmah zamijenite.

Media(A)1) Near Full Isprekidan Treperi Pri upotrebi funkcije Simul Rec

Media(A)1) Full Kontinuirano Brzo 
treperenje

Pri upotrebi funkcije Simul Rec

Media(A)1) Clips 
Near Full

Isprekidan Treperi Pri upotrebi funkcije Simul Rec

Media(A)1) Clips Full Kontinuirano Brzo 
treperenje

Pri upotrebi funkcije Simul Rec

Media(A)1) Last Clip 
Rec

Isprekidan Treperi Pri upotrebi funkcije Simul Rec

1)	 "(B)" se prikazuje za karticu u utoru B.

Poruke o pogrešci/upozorenju
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Poruke za oprez i rad

Na sredini zaslona mogu se prikazati sljedeće poruke za oprez i rad. Pratite upute za 
rješavanje problema.

Poruka na zaslonu Uzrok i rješenje

Battery Error
Please Change Battery

Otkrivena je pogreška na paketu baterija.
Zamijenite normalnim kompletom baterija.

Backup Battery End
Please Change

Preostali kapacitet rezervne baterije je nedovoljan.
Promijenite rezervnu bateriju.

Unknown Media (A) 1)

Please Change
Umetnuta je particionirana memorijska kartica ili memorijska 
koja sadrži više isječaka no što videokamera može savladati.
Karticu nije moguće upotrebljavati u videokameri i morate 
je zamijeniti.

Cannot Use Media (A) 1)

Unsupported File System
Umetnuta je kartica s drugim podatkovnim sustavom 
ili neformatirana kartica.
Karticu nije moguće upotrebljavati u videokameri i morate 
je zamijeniti ili formatirati u videokameri.

Media Error
Media (A) 1) Needs to be Restored

Došlo je do pogreške na memorijskoj kartici i karticu je nužno 
oporaviti.
Oporavite memorijsku karticu.

Media Error
Cannot Record to Media (A) 1)

Memorijska kartica možda je oštećena i više se ne može 
upotrebljavati za snimanje.
Reprodukcija je moguća, stoga se preporučuje napraviti kopiju 
i zamijeniti memorijsku karticu.

Media Error
Cannot Use Media (A) 1)

Memorijska kartica možda je oštećena i više se ne može 
upotrebljavati za snimanje ili reprodukciju.
Karticu nije moguće upotrebljavati u videokameri 
i morate je zamijeniti.

Media (A) 1) Error
Recording Halted
Playback Halted

Snimanje i reprodukcija zaustavljeni su jer je došlo 
do pogreške tijekom upotrebe memorijske kartice.
Ako se problem nastavi pojavljivati, zamijenite 
memorijsku karticu.

Media Reached Rewriting Limit
Change Media (A) 1)

Memorijska kartica dosegla je kraj vijeka trajanja.
Napravite rezervnu kopiju i odmah zamijenite karticu. 
Ako nastavite upotrebljavati karticu, snimanje i reprodukcija 
možda neće biti mogući.
Pojedinosti potražite u uputama za upotrebu 
memorijske kartice.

Navedena adresa nije valjana. Navedena adresa nije valjana.
Provjerite je li postavka ispravna.

Cannot Use Specified Port Number Navedeni broj ulaza nije valjan.
Provjerite je li postavka ispravna.

Poruka na zaslonu Uzrok i rješenje

Fan Stopped Ugrađeni ventilator se zaustavio.
Izbjegavajte upotrebu na visokim temperaturama, odspojite 
napajanje i obratite se servisnom predstavniku tvrtke Sony.

Lens I/F Error(xx:xx) Otkrivena je pogreška objektiva u komunikaciji I/F objektiva 
kada je postavljen objektiv E-mount.
Provjerite status veze s objektivom E-mount.
Ako se problem nastavi pojavljivati, sa šifrom pogreške 
obratite se servisnom predstavniku tvrtke Sony 
(pet znakova u zagradi).

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Otkrivena je nekompatibilna dodatna oprema.
Jedina dodatna oprema za Multi Terminal koju podržava 
ova jedinica je priloženi daljinski upravljač na drški.

Failed (Nije uspjelo) Ova se pogreška može prikazati ako nije moguće dohvatiti 
adresu s DHCP postavljenim na On.
Provjerite postavke poslužitelja DHCP.

Cannot add auto upload job of Proxy 
file because maximum number of 
upload jobs was reached.

Dostignut je maksimalan broj zadataka prijenosa.
Obrišite nepotrebne zadatke. Postavka odredišta za 
automatski prijenos datoteka proxy također može biti 
neispravna. Provjerite je li postavka ispravna.

<SSID>Not found. Mrežu (pristupnu točku) s navedenim identifikatorom <SSID> 
nije moguće pronaći.
Provjerite je li postavka ispravna.

<SSID>Authentication Failed Provjera autentičnosti veze na mreži (pristupna točka) s 
navedenim identifikatorom <SSID> nije uspjela.
Provjerite jesu li lozinka i druge postavke ispravne.

An IP address conflict has occurred. 
Please check the network settings.

Postoji konflikt s mrežnom adresom bežične veze LAN, žične 
veze LAN ili dijeljenjem putem USB-a.
Ručno promijenite adresu ili promijenite postavke 
mrežnog usmjerivača.

The IP address of the Wireless 
LAN Access Point Mode has been 
changed due to an IP address 
conflict.

IP adresa pristupne točke za bežični LAN promijenjena je zbog 
konflikta u mrežnim adresama u načinu za pristupnu točku za 
bežični LAN, žični LAN ili dijeljenje putem USB-a.
Provjerite postavke IP adrese.

1)	 "(B)" se prikazuje za karticu u utoru B.
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Stavke konfigurirane u cijelom izborniku

Da: stavka je spremljena.
Ne: stavka nije spremljena.
–: nije spremljeno (privremena postavka)

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Shooting ISO/Gain/EI Mode Da Ne

ISO/Gain<H> Da Ne

ISO/Gain<M> Da Ne

ISO/Gain<L> Da Ne

Exposure Index<H> Da Ne

Exposure Index<M> Da Ne

Exposure Index<L> Da Ne

Shockless Gain Da Ne

Base Sensitivity Da Ne

Base ISO Da Ne

ND Filter Preset1 Da Ne

Preset2 Da Ne

Preset3 Da Ne

Shutter Mode Da Ne

Shutter Speed On/Off Da Ne

Shutter Speed Da Ne

Shutter Angle Da Ne

ECS On/Off Da Ne

ECS Frequency Da Ne

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Shooting Auto Exposure Level Da Ne

Mode Da Ne

Speed Da Ne

AGC Da Ne

AGC Limit Da Ne

AGC Point Da Ne

Auto Shutter Da Ne

A.SHT Limit Da Ne

A.SHT Point Da Ne

Clip High light Da Ne

Detect Window Da Ne

Detect Window Indication Da Ne

Custom Width Da Ne

Custom Height Da Ne

Custom H Position Da Ne

Custom V Position Da Ne

Bijeli Preset White Da Ne

Color Temp <A> Da Ne

Tint<A> Da Ne

R Gain <A> Da Ne

B Gain <A> Da Ne

Color Temp <B> Da Ne

Tint<B> Da Ne

R Gain <B> Da Ne

B Gain <B> Da Ne

White Setting Shockless White Da Ne

ATW Speed Da Ne

White Switch<B> Da Ne

Filter White Memory Da Ne

Stavke spremljene u datotekama
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RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Shooting Offset White Offset White <A> Da Ne

Offset Color Temp<A> Da Ne

Offset Tint<A> Da Ne

Offset White <B> Da Ne

Offset Color Temp<B> Da Ne

Offset Tint<B> Da Ne

Offset White<ATW> Da Ne

Offset Color Temp<ATW> Da Ne

Offset Tint<ATW> Da Ne

Focus AF Transition Speed Da Ne

AF Subj. Shift Sens. Da Ne

Focus Area Da Ne

Focus Area (AF-S) Da Ne

Face/Eye Detection AF Da Ne

Push AF Mode Da Ne

AF Assist Da Ne

S&Q Motion Setting Da Ne

Frame Rate Da Ne

LUT On/Off SDI/HDMI Da Ne

VF/Proxy/Stream Da Ne

Internal Rec Da Ne

Noise Suppression Setting(Custom) Da Ne

Level(Custom) Da Ne

Setting(Cine EI) Da –

Level(Cine EI) Da –

Flicker Reduce Mode Da Ne

Frekvencija Da Ne

SteadyShot Setting Da Ne

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Project Base Setting Shooting Mode Da –

Target Display Da –

Rec Format Frekvencija Da Ne

Imager Scan Mode Da Ne

Kodek Da Ne

RAW Output Format Da Ne

Format videozapisa Da Ne

Cine EI Setting Color Gamut Da –

Simul Rec Setting Da Ne

Proxy Rec Setting Da Ne

Audio Channel Da Ne

Interval Rec Setting Ne Ne

Interval Time Da Ne

Number of Frames Da Ne

Pre-Lighting Da Ne

SDI/HDMI Rec Control Setting Da Ne

Gumb za dodjelu <1> Da Ne

<2> Da Ne

<3> Da Ne

<4> Da Ne

<5> Da Ne

<6> Da Ne

<7> Da Ne

<8> Da Ne

<9> Da Ne

Gumb Zadrž. izošt. Da Ne

Assignable Dial Grip/Remote Dial Da Ne

Smjer kotačića na drški Da Ne

Kotačić na ručki Da Ne

Smjer kotačića na ručki Da Ne

Multi Function Dial Default Function Da Ne
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RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Project User File Load Media(B) – –

Save Media(B) – –

File ID Ne Ne

Load Customize Data Da Ne

Load White Data Da Ne

All File Load Media(B) – –

Save Media(B) – –

File ID Da Ne

Load Network Data Ne Ne

Paint/Look Scene File Pozivanje – –

Pohrana – –

Delete – –

Opoziv unaprijed postavljene 
postavke

– –

Base Look Odaberite Da Da

Delete – –

Delete All – –

Uvoz – –

Ulaz Da Da

Izlaz Da Da

AE Level Offset Da Da

Ponovno postavljanje 
postavki boje

Ponovno postavljanje bez funkcije 
Base Look

– –

Crni Master Black Da Da

R Black Da Da

B Black Da Da

Komprimiranje Setting Da Da

Auto Knee Da Da

Point Da Da

Slope Da Da

Detalj Setting Da Da

Level Da Da

Ručne postavke Da Da

Balans V/H Da Da

Balans B/W Da Da

Ograničenje Da Da

Crispening Da Da

Visoko osvijetljeni detalj Da Da

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Paint/Look Matrix User Matrix Da Da

User Matrix Level Da Da

User Matrix Phase Da Da

User Matrix R-G Da Da

User Matrix R-B Da Da

User Matrix G-R Da Da

User Matrix G-B Da Da

User Matrix B-R Da Da

User Matrix B-G Da Da

Multi Matrix Setting Da Da

Reset – –

Axis Ne Da

Hue Da Da

Zasićenost Da Da

TC/Media Timecode Mode Da Ne

Pokreni Da Ne

Setting Ne Ne

Reset – –

TC Format Da Ne

TC Display Display Select Da Ne

Users Bit Mode Da Ne

Setting Ne Ne

HDMI TC Out Setting Da Ne

Clip Name Format Title Prefix Da Ne

Number Set Ne Ne

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Monitoring Output On/Off SDI Da Ne

HDMI Da Ne

Output Format SDI Da Ne

HDMI Da Ne

Output Display SDI Da Ne

HDMI Da Ne
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RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Monitoring Prikaz - uključeno/
isključeno

Network Status Da Ne

File Transfer Status Da Ne

Rec/Play Status Da Ne

RAW Output Control Status Da Ne

Tally Da Ne

Battery Remain Da Ne

Focus Mode Da Ne

Focus Position Da Ne

Focus Area Indicator Da Ne

Focus Area Ind.(AF-S) Da Ne

Face/Eye Detection Frame Da Ne

Lens Info Da Ne

Imager Scan Mode Da Ne

Rec Format Da Ne

Frame Rate Da Ne

Zoom Position Da Ne

UWP RF Level Da Ne

SteadyShot Da Ne

Base Look/LUT Da Ne

SDI/HDMI Rec Control Da Ne

Gamma Display Assist Da Ne

Proxy Status Da Ne

Base ISO/Sensitivity Da Ne

Media Status Da Ne

Video Signal Monitor Da Ne

Clip Name Da Ne

White Balance Da Ne

Scene File Da Ne

Focus Indicator Da Ne

Auto Exposure Mode Da Ne

Auto Exposure Level Da Ne

Timecode Da Ne

ND Filter Da Ne

Blenda Da Ne

ISO/Gain/EI Da Ne

Shutter Da Ne

Level Gauge Da Ne

Audio Level Meter Da Ne

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Monitoring Prikaz - uključeno/
isključeno

Video Level Warning Da Ne

Clip Number Da Ne

Notice Message Da Ne

Marker Setting Da Ne

Color Da Ne

Center Marker Da Ne

Safety Zone Da Ne

Safety Area Da Ne

Aspect Marker Da Ne

Aspect Mask Da Ne

Aspect Safety Zone Da Ne

Aspect Safety Area Da Ne

Aspect Select Da Ne

Custom Aspect Ratio Da Ne

Guide Frame Da Ne

100% Marker Da Ne

User Box Da Ne

User Box Width Da Ne

User Box Height Da Ne

User Box H Position Da Ne

User Box V Position Da Ne

VF Setting svjetlina Da Ne

Način boje Da Ne

Gamma Display Assist Setting Da Ne

Peaking Setting Da Ne

Peaking Level Da Ne

Color Da Ne

Zebra Setting Da Ne

Zebra1 Level Da Ne

Zebra1 Aperture Level Da Ne

Zebra2 Level Da Ne
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RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Audio Audio ulaz CH1 Input Select Da Ne

CH2 Input Select Da Ne

CH3 Input Select Da Ne

CH4 Input Select Da Ne

INPUT1 MIC Reference Da Ne

INPUT2 MIC Reference Da Ne

Line Input Reference Da Ne

Reference Level Da Ne

CH1 Wind Filter Da Ne

CH2 Wind Filter Da Ne

CH3 Wind Filter Da Ne

CH4 Wind Filter Da Ne

CH3 Level Control Da Ne

CH4 Level Control Da Ne

CH3 Input Level Da Ne

CH4 Input Level Da Ne

Audio Input Level Da Ne

Limiter Mode Da Ne

CH1&2 AGC Mode Da Ne

CH3&4 AGC Mode Da Ne

AGC Spec Da Ne

1kHz Tone on Color Bars Da Ne

CH1 Level Da Ne

CH2 Level Da Ne

CH3 Level Da Ne

CH4 Level Da Ne

Audio Output Monitor CH Da Ne

Volume Ne Ne

Izlaz za slušalice Da Ne

Alarm Level Da Ne

HDMI Output CH Da Ne

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Thumbnail 
(Sličica)

Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips U redu – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Da –

Technical Color Bars Setting Ne Ne

Vrsta Da Ne

ND Dial CLEAR with Dial Da Ne

Tally Prednja strana Da Ne

Stražnja strana Da Ne

HOLD Switch Setting with Rec Button Da Ne

with Hand Grip Remote Da Ne

Touch Operation Setting Da Ne

Rec Review Setting Da Ne

Zum Vrsta zumiranja Da Ne

Handle Zoom Setting Da Ne

High (Visok) Da Ne

Low (Nizak) Da Ne

Menu Settings User Menu Only Da Ne

User Menu with Lock Ne Ne

Fan Control Setting Da Ne



8. Dodatak: Stavke spremljene u datotekama121HR

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Technical Objektiv Zoom Ring Direction Da Ne

Shading Compensation Da Ne

Chroma Aberration Comp. Da Ne

Komp. iskrivljenja Da Ne

Distance Display Da Ne

Zoom Position Display Da Ne

Video Light Set Video Light Set Da Ne

APR APR – –

Camera Battery Alarm Low Battery Da Ne

Battery Empty Da Ne

Camera DC IN Alarm DC Low Voltage1 Da Ne

DC Low Voltage2 Da Ne

Network Access Authentication User Name Ne Ne

Password Ne Ne

Bežični LAN Setting Da Ne

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Kanal Da Ne

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Network ST Mode Settings Camera Remote Control Da Ne

Connected Network

SSID – –

Sigurnost – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Sigurnost – –

Password Ne Ne

DHCP Da Ne

IP Address Da Ne

Subnet Mask Da Ne

Gateway Da Ne

DNS Auto Da Ne

Primary DNS Server Da Ne

Secondary DNS Server Da Ne

Manual Register

SSID Da Ne

Sigurnost Da Ne

Password Ne Ne

DHCP Da Ne

IP Address Da Ne

Subnet Mask Da Ne

Gateway Da Ne

DNS Auto Da Ne

Primary DNS Server Da Ne

Secondary DNS Server Da Ne
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RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Network Wired LAN Setting Da Ne

Camera Remote Control Da Ne

Detail Settings

DHCP Da Ne

IP Address Da Ne

Subnet Mask Da Ne

Gateway Da Ne

DNS Auto Da Ne

Primary DNS Server Da Ne

Secondary DNS Server Da Ne

Modem Setting Da Ne

Camera Remote Control Da Ne

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload (Proxy) Da Ne

Default Upload Server Da Ne

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Da Ne

Service Da Ne

Host Name Da Ne

Port Da Ne

User Name Ne Ne

Password Ne Ne

Passive Mode Da Ne

Destination Directory Da Ne

Using Secure Protocol Da Ne

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Održavanje Language Odaberite Da Ne

Clock Set Time Zone Da Ne

Date Mode Da Ne

12H/24H Da Ne

Date Ne Ne

Time Ne Ne

All Reset Reset – –

Reset without Network – –

Hours Meter Hours (System) – –

Hours (Reset) – –

Reset – –

Verzija Version Number – –

Version Up – –

Lens Version Number – –
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Stavke konfigurirane dodjeljivim gumbima

Da: stavka je spremljena.
Ne: stavka nije spremljena.
–: nije spremljeno (privremena postavka)

Odabir dodjeljivog gumba All File Scene File
ND Filter Position Da Ne

Auto Iris Da Ne

ATW Da Ne

Focus Setting Da Ne

Display Da –

VF Adjust Da –

Stavke konfigurirane dodjeljivim kotačićem

Da: stavka je spremljena.
Ne: stavka nije spremljena.
–: nije spremljeno (privremena postavka)

Odabir dodjeljivog kotačića All File Scene File
IRIS Da Ne

ND Filter Da Ne

Audio Input Level Da Ne
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Pregledajte povezane stavke pod “Postavljanje zvuka za snimanje” (stranica 46) i “Izbornik User” (stranica 70).

Ulaz zvuka (CH1 i CH2)

Sljedeće prikazuje blokovski dijagram s postavljenom ručkom.

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Postavite na Manual kada se zvuk uvozi s adaptera XLR.

Blokovski dijagrami
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Ulaz zvuka (CH3 i CH4)

Sljedeće prikazuje blokovski dijagram s postavljenom ručkom.

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ~ 99

CH4

[CH4 Input Level]
0 ~ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Postavite na Manual kada se zvuk uvozi s adaptera XLR.
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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Softver objektiva E-mount moguće je ažurirati 
pomoću videokamere.
Na web-mjestu s objektivima potražite 
objektive koje je moguće ažurirati i 
odgovarajući softver.

Provjera verzije

1	 Postavite objektiv E-mount na 
videokameru (stranica 22).

2	 Odaberite funkciju Version u izborniku 
Maintenance cijelog izbornika za prikaz 
Lens Version Number (stranica 99).
Broj verzije softvera objektiva E-mount 
prikazuje se sa strane.

Ažuriranje softvera

Postavite videokameru u način za masovnu 
pohranu (stranica 108).
Ažurirajte softver prateći postupak isporučen 
sa softverom objektiva.

Ažuriranje softvera za objektiv E-mount
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Licenca portfelja patenta MPEG-4 
Visual

OVAJ PROIZVOD LICENCIRAN JE U SKLOPU 
LICENCE PORTFELJA PATENTA AVC ZA OSOBNU 
I NEKOMERCIJALNU POTROŠAČKU UPOTREBU 
U SVRHU
(i)	 KODIRANJE VIDEOSADRŽAJA U SKLADU S 

VIZUALNIM STANDARDOM MPEG-4 ("MPEG-
4 VIDEO") I/ILI

(ii)	DEKODIRANJE VIDEO SADRŽAJA MPEG-4 
KOJI JE KODIRAO KORISNIK ZA OSOBNE I 
NEKOMERCIJALNE AKTIVNOSTI I/ILI KOJI 
JE NABAVIO DOBAVLJAČ VIDEOSADRŽAJA 
KOJEG JE MPEG LA LICENCIRAO ZA 
DOBAVLJANJE VIDEOSADRŽAJA MPEG-4.

LICENCA SE NE DAJE NITI ĆE SE 
PODRAZUMIJEVATI NI ZA KOJU DRUGU SVRHU. 
DODATNE INFORMACIJE, UKLJUČUJUĆI ONE O 
PROMOTIVNOJ, INTERNOJ I KOMERCIJALNOJ 
UPOTREBI TE LICENCIRANJU, ZATRAŽITE OD 
TVRTKE MPEG LA, LLC. POGLEDAJTE HTTP://
WWW.MPEGLA.COM

Preuzimanje softvera pod 
licencom GPL/LGPL

U proizvodu se upotrebljava softver na kojeg 
se primjenjuje GPL/ LGPL. Time vam se daje 
do znanja da imate pravo na pristup, izmjenu 
i redistribuciju izvornog koda ovih softverskih 
programa u skladu s uvjetima GPL-a/LGPL-a.
Izvorni kod dostupan je na internetu. 
Pristupite sljedećem URL-u i pratite upute za 
preuzimanje.
http://www.sony.net/Products/Linux/
common/search.html

Cijenili bismo kad nam se ne bi obraćali s 
pitanjima o sadržaju izvornog koda.

Licence (na engleskom) snimljene su u 
unutarnjoj memoriji proizvoda.
Uspostavite vezu masovne pohrane između 
proizvoda i računala da biste pročitali licence u 
mapi „LICENSE” – „PMHOME”.

Ako upotrebljavate Mac, mapa „PMHOME” – 
„LICENSE” možda neće biti dostupna.
Za pregled datoteka upotrijebite računalo koje 
nije Mac ili posjetite sljedeći URL.
https://oss.sony.net/License/ILME-FX6/

UGOVOR ZA KRAJNJEG KORISNIKA 
LICENCE

VAŽNO: 
PRIJE UPOTREBE SOFTVERA S MEMORIJE BEZ 
POKRETNIH DIJELOVA U VIDEOKAMERI PAŽLJIVO 
PROČITAJTE OVAJ LICENCNI UGOVOR ZA KRAJNJEG 
KORISNIKA (END USER LICENSE AGREEMENT, "EULA"). 
UPOTREBOM SOFTVERA PRIHVAĆATE UVJETE OVOG 
UGOVORA EULA. AKO NE PRIHVAĆATE UVJETE OVOG 
UGOVORA EULA, NE SMIJETE UPOTREBLJAVATI SOFTVER.

EULA je pravni sporazum između vas i tvrtke Sony 
Corporation („SONY”). Ovaj ugovor EULA regulira vaša 
prava i obveze u vezi sa softverom tvrtke SONY i/ili njenih 
davatelja licenci trećih strana (uključujući podružnice 
tvrtke SONY) i njihovih podružnica (zajedno „DOBAVLJAČI 
TREĆE STRANE”), uključujući bežični adapter i sva 
ažuriranja/nadogradnje koje osigurava tvrtka SONY, svu 
tiskanu, internetsku ili drugu elektronsku dokumentaciju 
za takav softver te sve podatkovne datoteke stvorene 
radom takvog softvera (zajedno "SOFTVER").

Bez obzira na gore navedeno, svaki softver u okviru 
SOFTVERA koji ima zaseban ugovor za krajnjeg korisnika 
licence (uključujući, ali ne ograničavajući se na GNU-ovu 
Opću javnu licencu i Nižu/Opću javnu licencu za 

knjižnice) bit će obuhvaćen odgovarajućim zasebnim 
ugovorom za krajnjeg korisnika licence umjesto 
odredbama ovog ugovora EULA do mjere do koje to 
zahtijeva zaseban ugovor za krajnjeg korisnika licence 
(„IZUZETI SOFTVER”).

LICENCA SOFTVERA
SOFTVER se licencira, a ne prodaje. SOFTVER je zaštićen 
zakonima o autorskim pravima i drugim međunarodnim 
zakonima i ugovorima o intelektualnom vlasništvu.

AUTORSKO PRAVO
Sva prava i vlasnička prava na SOFTVER (uključujući, ali ne 
ograničavajući se na bilo koje slike, fotografije, animacije, 
video, audio, glazbene i tekstne sadržaje te „aplete” 
obuhvaćene SOFTVEROM) pripadaju tvrtki SONY ili 
jednom ili više njenih DOBAVLJAČA TREĆIH STRANA.

ODOBRENJE LICENCE
SONY dodjeljuje ograničenu licencu za upotrebu 
SOFTVERA isključivo s bežičnim adapterima i samo za 
individualnu upotrebu. SONY i DOBAVLJAČI TREĆIH 
STRANA izričito zadržavaju sva prava, vlasništvo i 
vlasnički udio (uključujući, ali ne ograničavajući se na sva 
prava intelektualnog vlasništva) u SOFTVERU koja ovaj 
ugovor EULA ne dodjeljuje posebno vama.

ZAHTJEVI I OGRANIČENJA
Ne smijete kopirati, objavljivati, prilagođavati, 
redistribuirati, pokušavati rekonstruirati izvorni kod, 
mijenjati, vršiti obrnuti inženjering, dekompilirati ili 
rastavljati nijedan SOFTVER, bilo u cjelini ili u dijelovima, 
ili stvarati bilo kakva izvedena djela iz SOFTVERA ili na 
njemu samom, izuzev ako su takva izvedena djela 
namjerno omogućena SOFTVEROM. Ne smijete mijenjati 
ni preinačavati nijednu od funkcija za upravljanje 
digitalnim pravima SOFTVERA. Ne smijete zaobilaziti, 
mijenjati, dekonstruirati ni opstruirati nijednu funkciju ili 
zaštitnu značajku SOFTVERA ili bilo koji mehanizam 
operativno povezan sa SOFTVEROM. Ne smijete odvajati 
nijednu pojedinačnu komponentu SOFTVERA radi 
upotrebe na više od jednog bežičnog adaptera, osim 
ako za to imate izričito dopuštenje tvrtke SONY. Ne 
smijete uklanjati, mijenjati, pokrivati ili uništavati 
nikakve zaštitne znakove ili obavijesti o SOFTVERU. Ne 
smijete dijeliti, distribuirati, iznajmljivati, davati u zakup, 
podlicencirati, dodjeljivati, prenositi ili prodavati 

SOFTVER. Softver, mrežne usluge i drugi proizvodi koji 
nisu SOFTVER, a o kojima ovisi rad SOFTVERA, mogu biti 
prekinuti ili obustavljeni prema diskrecijskom pravu 
dobavljača (dobavljača softvera, dobavljača usluga ili 
tvrtke SONY). SONY i takvi dobavljači ne jamče da će 
SOFTVER, mrežne usluge, sadržaji ili drugi proizvodi i 
dalje biti dostupni ili da će raditi bez prekida ili izmjena. 

IZUZETI SOFTVER I KOMPONENTE 
OTVORENOG KODA
Bez obzira na gore navedeno odobrenje ograničene 
licence, prihvaćate da SOFTVER može sadržavati IZUZETI 
SOFTVER. Određeni IZUZETI SOFTVER može biti 
obuhvaćen licencama za softver otvorenog koda 
(„Komponente otvorenog koda”), što podrazumijeva sve 
softverske licence koje su odobrene kao licence za 
otvoreni kôd od strane Inicijative za otvoreni kôd ili sve u 
značajnoj mjeri slične licence, uključujući ali ne 
ograničavajući se na bilo koju licencu koja, kao preduvjet 
za distribuciju softvera licenciranog u okviru takve 
licence, zahtijeva da distributer učini softver dostupnim 
u formatu izvornog koda. Da biste saznali postoji li 
obveza objavljivanja informacija i u kojoj mjeri, posjetite 
web-mjesto www.sony.com/linux ili neko drugo 
odgovarajuće web-mjesto tvrtke SONY i s vremena na 
vrijeme potražite popis odgovarajućih KOMPONENTI 
OTVORENOG SOFTVERA obuhvaćenih SOFTVEROM te 
odgovarajuće odredbe i uvjete koji reguliraju njegovu 
upotrebu. Odgovarajuća treća strana može promijeniti 
takve odredbe i uvjete bez ikakvih obveza prema vama. 
U mjeri u kojoj to zahtijevaju licence koje obuhvaćaju 
IZUZETI SOFTVER, umjesto odredbi ovog ugovora EULA 
primjenjivat će se odredbe takvih licenci. U mjeri u kojoj 
odredbe licenci koje se odnose na IZUZETI SOFTVER 
zabranjuju bilo kakva ograničenja u ovom ugovoru EULA 
s obzirom na takav IZUZETI SOFTVER, takva ograničenja 
neće se odnositi na IZUZETI SOFTVER. U mjeri u kojoj 
licence primjenjive na Komponente otvorenog koda 
zahtijevaju da SONY ponudi pružanje izvornog koda u 
vezi s ovim SOFTVEROM, on se ovdje nudi. 

UPOTREBA SOFTVERA S MATERIJALOM 
ZAŠTIĆENIM AUTORSKIM PRAVIMA
Ovaj SOFTVER možete upotrebljavati za pregledavanje, 
pohranjivanje, obradu i/ili upotrebu sadržaja koji ste 
stvorili vi i/ili treće strane. Takav sadržaj može biti 
zaštićen zakonima o autorskim pravima, drugim 

Licence

http://www.sony.net/Products/Linux/common/search.html
http://www.sony.net/Products/Linux/common/search.html
http://https://oss.sony.net/License/ILME-FX6/
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zakonima o intelektualnom vlasništvu i/ili sporazumima. 
Slažete se da ćete se služiti SOFTVEROM samo u skladu 
sa svim takvim zakonima i sporazumima koji se odnose 
na spomenuti sadržaj. Prihvaćate i slažete se da SONY 
može poduzeti odgovarajuće mjere radi zaštite autorskih 
prava nad sadržajem koji pohranjuje, obrađuje ili 
upotrebljava SOFTVER. Takve mjere uključuju, ali ne 
ograničavaju se na prebrojavanje učestalosti vaših 
postupaka sigurnosnog kopiranja i vraćanja podataka 
putem određenih značajki SOFTVERA, odbijanje 
prihvaćanja vašeg zahtjeva za omogućivanje vraćanja 
podataka te poništenje ovog ugovora EULA u slučaju 
vaše nelegitimne upotrebe SOFTVERA. 

USLUGA SADRŽAJA 
ISTO TAKO, IMAJTE NA UMU DA SOFTVER MOŽE BITI 
NAMIJENJEN ZA UPOTREBU SA SADRŽAJEM DOSTUPNIM 
PUTEM JEDNE ILI VIŠE USLUGA SADRŽAJA („USLUGA 
SADRŽAJA”). UPOTREBA USLUGE I TAKVOG SADRŽAJA 
PODLIJEŽE UVJETIMA PRUŽANJA USLUGE TAKVE USLUGE 
SADRŽAJA. AKO ODBIJETE PRIHVATITI TE UVJETE, VAŠA 
UPOTREBA SOFTVERA BIT ĆE OGRANIČENA. Prihvaćate 
i slažete se da određene sadržaje i usluge koji su 
dostupni putem SOFTVERA mogu pružati treće strane 
nad kojima tvrtka SONY nema nadzor. UPOTREBA 
USLUGE SADRŽAJA ZAHTIJEVA INTERNETSKU VEZU. 
USLUGA SADRŽAJA MOŽE BITI PREKINUTA U BILO KOJEM 
TRENUTKU.

MOGUĆNOST INTERNETSKE VEZE I USLUGE 
TREĆE STRANE
Prihvaćate i slažete se da pristup određenim značajkama 
SOFTVERA može zahtijevati internetsku vezu za koju ste 
isključivo vi odgovorni. Nadalje, vi ste isključivo 
odgovorni za plaćanje bilo kakvih naknada koje 
zahtijevaju treće strane povezane s vašom internetskom 
vezom, uključujući ali ne ograničavajući se na naknade 
pružatelja internetskih usluga ili naknade za emitiranje. 
Rad SOFTVERA može biti ograničen ovisno o 
mogućnostima, širini pojasa ili tehničkim ograničenjima 
vaše internetske veze i usluge. Omogućavanje, kvaliteta i 
sigurnost takve internetske veze isključiva su 
odgovornost treće strane koja pruža takvu uslugu. 

IZVOZNI I DRUGI PROPISI
Slažete se da ćete se pridržavati svih važećih ograničenja 
i propisa u vezi s izvozom i ponovnim izvozom koja su 
na snazi u području ili državi u kojoj živite te da nećete 
prenositi ili davati ovlaštenje za prijenos SOFTVERA 
u državu u koju je izvoz zabranjen ili onu koja na drugi 
način krši ograničenja ili propise.

AKTIVNOSTI VISOKOG RIZIKA
SOFTVER nije otporan na pogreške i nije dizajniran, 
proizveden ili namijenjen za korištenje ili preprodaju kao 
mrežna kontrolna oprema u opasnim okolišima koji 
zahtijevaju izvedbu bez kvarova, primjerice u nuklearnim 
postrojenjima, sustavima za upravljanje zrakoplovima ili 
komunikacijskim sustavima, sustavima za kontrolu leta, 
uređajima za održavanje na životu ili sustavima oružja u 
kojima bi kvar SOFTVERA mogao dovesti do smrti, 
ozljeda ili teških tjelesnih oštećenja („AKTIVNOSTI 
VISOKOG RIZIKA”). SONY, svi DOBAVLJAČI TREĆIH 
STRANA i sve njihove podružnice posebno se odriču bilo 
kakvog izričitog ili podrazumijevanog jamstva, obveze ili 
uvjeta prikladnosti za AKTIVNOSTI VISOKOG RIZIKA.

IZUZEĆE IZ JAMSTVA ZA SOFTVER
Prihvaćate i slažete se da ćete SOFTVER upotrebljavati 
isključivo na vlastiti rizik i da ste vi odgovorni za 
upotrebu SOFTVERA. SOFTVER se isporučuje „KAKAV 
JEST”, bez jamstva, obveze ili uvjeta bilo koje vrste.

SONY i SVI DOBAVLJAČI TREĆIH STRANA (za potrebe 
ovog odjeljka SONY i svi DOBAVLJAČI TREĆIH STRANA 
zajednički se nazivaju „SONY”) IZRIČITO SE ODRIČU SVIH 
JAMSTAVA, OBVEZA ILI UVJETA, IZRIČITIH ILI 
PODRAZUMIJEVANIH, UKLJUČUJUĆI ALI NE 
OGRANIČAVAJUĆI SE NA PODRAZUMIJEVANA JAMSTVA 
UTRŽIVOSTI, NEPOVREDIVOSTI ZAKONA I PRIKLADNOSTI 
ZA POSEBNU SVRHU. SONY NE JAMČI I NE TVRDI DA ĆE 
(A) FUNKCIJE SADRŽANE U BILO KOJEM SOFTVERU 
ZADOVOLJAVATI VAŠE ZAHTJEVE ILI DA ĆE BITI 
AŽURIRANE, (B) DA ĆE RAD BILO KOJEG SOFTVERA BITI 
ISPRAVAN ILI BEZ GREŠKE ILI DA ĆE BILO KOJI 
NEDOSTACI BITI ISPRAVLJENI, (C) DA SOFTVER NEĆE 
OŠTETITI BILO KOJI DRUGI SOFTVER, HARDVER ILI 
PODATKE, (D) DA ĆE BILO KOJI SOFTVER, MREŽNE 
USLUGE (UKLJUČUJUĆI INTERNET) ILI PROIZVODI (IZUZEV 
SOFTVERA) O KOJIMA OVISI RAD SOFTVERA BITI I DALJE 
DOSTUPNI, NEPREKINUTI I NEIZMIJENJENI I (E) NE IZNOSI 

TVRDNJE U VEZI S UPOTREBOM ILI REZULTATIMA 
UPOTREBE SOFTVERA U SMISLU NJEGOVE ISPRAVNOSTI, 
TOČNOSTI, POUZDANOSTI ILI DRUGOGA. 

NITI JEDNA USMENA ILI PISANA INFORMACIJA ILI SAVJET 
DOBIVEN OD TVRTKE SONY ILI OVLAŠTENOG 
PREDSTAVNIKA TVRTKE SONY NEĆE SLUŽITI KAO 
JAMSTVO, OBVEZA ILI UVJET NITI ĆE NA BILO KOJI DRUGI 
NAČIN POVEĆATI OPSEG OVOG JAMSTVA. POKAŽE LI SE 
DA JE SOFTVER MANJKAV, VI PREUZIMATE SVE 
TROŠKOVE SVIH POTREBNIH SERVISIRANJA, POPRAVAKA 
ILI ISPRAVLJANJA. NEKE DRŽAVE NE DOPUŠTAJU 
IZUZEĆE PODRAZUMIJEVANIH JAMSTAVA PA SE 
NAVEDENA IZUZEĆA MOŽDA NEĆE ODNOSITI NA VAS.

OGRANIČENJE ODGOVORNOSTI
SONY I SVI DOBAVLJAČI TREĆIH STRANA (za potrebe 
ovog odjeljka SONY i svi DOBAVLJAČI TREĆIH STRANA 
zajednički se nazivaju „SONY”) NEĆE SNOSITI 
ODGOVORNOST ZA SLUČAJNU ILI POSLJEDIČNU ŠTETU 
NASTALU ZBOG KRŠENJA UVJETA BILO KOJEG 
PODRAZUMIJEVANOG ILI IZRIČITOG JAMSTVA, KRŠENJA 
UGOVORA, NEMARA TE NEĆE SNOSITI ODGOVORNOST 
PREMA PROPISIMA O STROGOJ ODGOVORNOSTI ILI 
DRUGIM ZAKONIMA, UKLJUČUJUĆI ALI NE 
OGRANIČAVAJUĆI SE NA BILO KAKVU ŠTETU NASTALU 
USLIJED GUBITKA PROFITA, GUBITKA PRIHODA, GUBITKA 
PODATAKA, GUBITKA MOGUĆNOSTI UPOTREBE 
SOFTVERA ILI BILO KOJEG POVEZANOG HARDVERA, 
PREKIDA U RADU I GUBITKA KORISNIKOVOG VREMENA, 
ČAK I AKO JE ITKO OD NJIH BIO OBAVIJEŠTEN O 
MOGUĆNOSTI NASTANKA TAKVIH ŠTETA. U SVAKOM 
SLUČAJU, NJIHOVA UKUPNA ODGOVORNOST PREMA 
BILO KOJOJ ODREDBI OVOG UGOVORA EULA BIT ĆE 
OGRANIČENA NA IZNOS KOJI JE STVARNO PLAĆEN ZA 
PROIZVOD. NEKE DRŽAVE NE DOPUŠTAJU IZUZEĆE ILI 
OGRANIČENJE SLUČAJNIH ILI POSLJEDIČNIH ŠTETA PA SE 
GORE NAVEDENI IZUZETAK MOŽDA NEĆE ODNOSITI NA 
VAS.

PRISTANAK NA UPOTREBU INFORMACIJA 
KOJE NISU OSOBNI PODACI, PODATAKA O 
LOKACIJI I SIGURNOST PODATAKA
Prihvaćate i slažete se da tvrtka SONY i njene podružnice, 
partneri i agenti mogu čitati, prikupljati, prenositi, 
obrađivati i pohranjivati određene informacije prikupljene 
putem SOFTVERA, uključujući ali ne ograničavajući se na 

informacije o (i) SOFTVERU i (ii) softverskim aplikacijama, 
sadržajima i perifernim uređajima koji stupaju u interakciju 
s vašim bežičnim adapterom i SOFTVEROM ("Informacije"). 
Informacije obuhvaćaju, ali ne ograničavaju se na sljedeće: 
(1) jedinstvene identifikatore za bežični adapter i njegove 
komponente; (2) performanse bežičnog adaptera, 
SOFTVERA i njihovih komponenti; (3) konfiguracije 
bežičnog adaptera, SOFTVER i softverske aplikacije, 
sadržaje i periferne uređaje koji stupaju u interakciju s 
bežičnim adapterom i SOFTVEROM; (4) upotrebu i 
učestalost upotrebe funkcija (x) SOFTVERA i (y) softverskih 
aplikacija, sadržaja i perifernih uređaja koji stupaju u 
interakciju sa SOFTVEROM; i (5) podatke o lokaciji, kako je 
prikazano u nastavku. Tvrtka SONY i njene podružnice, 
partneri i agenti mogu upotrebljavati i otkrivati Informacije, 
u skladu s važećim zakonima, kako bi poboljšale svoje 
proizvode i usluge ili vama pružale proizvode i usluge. 
Takve upotrebe obuhvaćaju, ali ne ograničavaju se na 
sljedeće: (a) administriranje funkcionalnosti SOFTVERA; (b) 
poboljšavanje, servisiranje, ažuriranje ili nadogradnja 
SOFTVERA; (c) poboljšavanje, razvijanje i unaprjeđenje 
postojećih i budućih proizvoda i usluge tvrtke SONY i 
drugih strana; (d) obavještavanje vas kao korisnika o 
proizvodima i uslugama koje nude tvrtka SONY i druge 
strane; (e) poštivanje važećih zakona i propisa; i (f) do mjere 
u kojoj se to nudi, pružanje usluga tvrtke SONY i drugih 
strana koje se zasnivaju na podacima o lokaciji, kao što je 
navedeno u nastavku. Osim toga, tvrtka SONY zadržava 
pravo na upotrebu Informacija kako bi zaštitila sebe i treće 
strane od nezakonitog, kriminalnog i štetnog postupanja.

Određene usluge dostupne putem SOFTVERA mogu se 
zasnivati na podacima o lokaciji, uključujući ali ne 
ograničavajući se na zemljopisnu lokaciju bežičnog 
adaptera. Prihvaćate da u svrhu pružanja takvih usluga 
tvrtka SONY, DOBAVLJAČI TREĆIH STRANA ili njihovi 
partneri mogu prikupljati, arhivirati, obrađivati i 
upotrebljavati takve podatke o lokaciji te da su takve usluge 
regulirane pravilima o zaštiti privatnosti tvrtke SONY ili treće 
strane. Pregledom pravila o privatnosti primjenjivim na 
takve usluge i pristankom na takve aktivnosti. 

Tvrtka SONY, njene podružnice, partneri i agenti neće 
namjerno upotrebljavati informacije kako bi otkrili 
identitet vlasnika ili korisnika SOFTVERA bez vašeg 
znanja ili pristanka. Svaka upotreba Informacija bit će u 
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skladu s pravilima o zaštiti privatnosti tvrtke SONY ili 
treće strane. 

Obratite se na odgovarajuću adresu za kontakt u 
pojedinom području ili državi kako biste saznali o 
trenutnim pravilima za zaštitu privatnosti tvrtke SONY. 
Obratite se odgovarajućim trećim stranama da biste 
saznali o pravilima za zaštitu privatnosti koja se odnose 
na informacije koje otkrivaju identitet i ostale 
informacije koje pružate kada upotrebljavate softver ili 
usluge treće strane ili im pristupate. 

Informacije mogu biti obrađene, pohranjene ili 
prenesene tvrtci SONY, njenim podružnicama ili 
agentima koji se nalaze u državama izvan države u kojoj 
živite. Zakoni o zaštiti podataka i privatnosti informacija 
u nekim državama možda neće nuditi istu razinu zaštite 
koja je omogućena u državi u kojoj živite i vaša zakonska 
prava koja se odnose na obradu i pohranjivanje 
Informacija u takvim državama, ili prijenos u njih, mogu 
biti manja. Tvrtka SONY u razumnoj će se mjeri potruditi 
poduzeti odgovarajuće tehničke i organizacijske korake 
radi sprječavanja neovlaštenog pristupa ili otkrivanja 
Informacija, ali ne jamči da će ukloniti svaki rizik od 
zloupotrebe takvih Informacija.

ZNAČAJKA AUTOMATSKOG AŽURIRANJA
S vremena na vrijeme, SONY ili DOBAVLJAČI TREĆE 
STRANE mogu automatski ažurirati ili na neki drugi način 
izmijeniti SOFTVER, uključujući ali ne ograničavajući se na 
svrhe unaprjeđenja sigurnosnih funkcija, ispravljanja 
pogrešaka i poboljšanja funkcija u trenucima dok stupate 
u interakciju s poslužiteljima tvrtke SONY ili trećih strana, 
ili na druge načine. Takva ažuriranja ili izmjene mogu 
izbrisati ili promijeniti prirodu značajki ili druge aspekte 
SOFTVERA, uključujući ali ne ograničavajući se na funkcije 
na koje se možda oslanjate. Prihvaćate i slažete se da se 
takve aktivnosti mogu odvijati prema isključivom 
diskrecijskom pravu tvrtke SONY i da tvrtka SONY može 
uvjetovati nastavak upotrebe SOFTVERA time da u 
potpunosti instalirate ili prihvatite takvo ažuriranje ili 
izmjene. Za potrebe ovog ugovora EULA sva ažuriranja/
izmjene trebaju se smatrati dijelom SOFTVERA i bit će 
njegov dio. Prihvaćanjem ovog ugovora EULA pristajete 
na takvo ažuriranje/izmjenu.

POTPUNI UGOVOR, ODRICANJE, 
SALVATORNA KLAUZULA
Ovaj ugovor EULA i pravila o zaštiti privatnosti tvrtke 
SONY, oboje u skladu s povremenim dopunama i 
izmjenama, zajedno predstavljaju potpuni ugovor 
između vas i tvrtke SONY u vezi sa SOFTVEROM. Propust 
tvrtke SONY da ostvari ili provede bilo koje pravo ili 
odredbu iz ovog ugovora EULA ne predstavlja odricanje 
od takvog prava ili odredbe. Ako se utvrdi da je neki dio 
ovog ugovora EULA nevaljan, nezakonit ili neprovediv, ta 
će se odredba provoditi u najvećoj mogućoj mjeri koja 
omogućuje zadržavanje svrhe ovog ugovora EULA, dok 
će ostali dijelovi ostati potpuno na snazi.

NADLEŽNI ZAKON I JURISDIKCIJA
Na ovaj ugovor EULA ne primjenjuje se Konvencija 
Ujedinjenih naroda o ugovorima o međunarodnoj 
prodaji robe. Ovaj ugovor EULA bit će reguliran u skladu 
s japanskim zakonima, bez obzira na moguće sukobe u 
zakonskim odredbama. Svi sukobi u vezi ovog ugovora 
EULA rješavaju se isključivo u nadležnosti japanskog 
Okružnog suda u Tokiju u Japanu, a strane ovime 
pristaju na mjesto i nadležnost tih sudova.

PRAVNI LIJEKOVI
Bez obzira na bilo koji dio ovog ugovora EULA koji bi se 
mogao protumačiti drugačije, prihvaćate i slažete se da 
će bilo kakvo kršenje ili nepoštivanje ovog ugovora EULA 
s vaše strane prouzročiti nenadoknadivu štetu tvrtki 
SONY za koju će novčana odšteta biti nedovoljna te 
pristajete da tvrtka SONY ishodi sudsku kaznu ili 
pravičnu naknadu koju tvrtka SONY smatra 
odgovarajućom u takvim slučajevima. Osim toga, SONY 
može poduzeti sve zakonske ili tehničke mjere kako bi 
spriječio kršenje ovog ugovora EULA i/ili nametnuo 
njegovu provedbu, uključujući ali ne ograničavajući se 
na trenutačnu obustavu upotrebe SOFTVERA ako tvrtka 
SONY odluči, po vlastitom diskrecijskom pravu, da kršite 
ili imate namjeru prekršiti ovaj ugovor EULA. Ti pravni 
lijekovi dodatak su svim drugim pravnim lijekovima na 
koje SONY može imati pravo po zakonu, običajnom 
pravu ili prema ugovoru.

PONIŠTAVANJE
Ne dovodeći u pitanje bilo koje svoje drugo pravo, tvrtka 
SONY može poništiti ovaj ugovor EULA u slučaju da se 
ne pridržavate bilo koje njegove odredbe. U slučaju 

takvog poništavanja morate: (i) u potpunosti prestati 
upotrebljavati SOFTVER i uništiti sve njegove primjerke; 
(ii) pridržavati se zahtjeva navedenih u odjeljku „Obveze 
u vezi s vašim računom” u nastavku teksta.

IZMJENE I DOPUNE
TVRTKA SONY ZADRŽAVA PRAVO DA PO VLASTITOJ 
DISKRECIJSKOJ ODLUCI IZMIJENI I DOPUNI BILO KOJU 
ODREDBU OVOG UGOVORA EULA POSTAVLJANJEM 
OBAVIJESTI NA ODGOVARAJUĆE WEB-MJESTO TVRTKE 
SONY, SLANJEM OBAVIJESTI U PORUCI E-POŠTE NA 
ADRESU KOJU STE SAMI DALI, OBAVJEŠTAVANJEM U 
OKVIRU POSTUPKA U KOJEMU VAM SE ISPORUČUJU 
NADOGRADNJE/AŽURIRANJA ILI BILO KOJIM DRUGIM 
ZAKONSKI PRIZNATIM NAČINOM OBAVJEŠTAVANJA. Ako 
ne pristajete na izmjene i dopune, trebate se odmah 
obratiti tvrtki SONY radi dobivanja uputa. Nastavak 
upotrebe SOFTVERA nakon datuma stupanja na snagu 
takve obavijesti smatrat će se vašim pristankom da 
budete obvezani navedenim dopunama i izmjenama.

KORISNICI TREĆE STRANE
Svaki DOBAVLJAČ TREĆE STRANE izričiti je korisnik treće 
strane i imat će sva prava na provedbu svake odredbe 
ovog ugovora EULA u vezi sa SOFTVEROM takve strane. 

U slučaju da imate bilo kakva pitanja u vezi s ovim 
ugovorom EULA, možete se obratiti tvrtki SONY pišući 
tvrtki SONY na odgovarajuću adresu za kontakt u 
pojedinom području ili državi.

Copyright © 2012 Sony Corporation.

Licence za softver otvorenog koda

Temeljem licencnih ugovora između tvrtke 
Sony i nositelja autorskih prava na softver, ovaj 
proizvod upotrebljava softver otvorenog koda.
Kako bi ispunila zahtjeve nositelja autorskih 
prava na softver, tvrtka Sony obvezna je 
informirati vas o sadržaju tih licenci.
Licence (na engleskom) snimljene su u 
unutarnjoj memoriji proizvoda.
Uspostavite vezu masovne pohrane između 
proizvoda i računala da biste pročitali licence u 
mapi „LICENSE” – „PMHOME”.

Ako upotrebljavate Mac, mapa „PMHOME” – 
„LICENSE” možda neće biti dostupna.
Za pregled datoteka upotrijebite računalo koje 
nije Mac ili posjetite sljedeći URL.
https://oss.sony.net/License/ILME-FX6/

https://oss.sony.net/License/ILME-FX6/
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Općenito

Težina

	 Približno 890 g (1 lb 15 oz) (samo kućište)

	 Približno 2,59 kg (5 lb 11 oz) (uključujući 

objektiv SEL24105G, poklopac 

objektiva, bateriju (BP‑U35), 

tražilo, ručku, dršku)

Dimenzije

	 pogledajte odjeljak stranica 133.

Zahtjevi za napajanje

	 19,5 V DC (18,0 V do 20,5 V)

Potrošnja energije

	 Pribl. 18,0 W (kućište, objektiv, XAVC-I QFHD 

59.94P snimanje, uključeno 

tražilo, bez povezanog vanjskog 

uređaja)

	 Pribl. 36,0 W (kućište, objektiv, XAVC-I QFHD 

59.94P snimanje (S&Q 120 fps), 

uključeno tražilo, HDMI, SDI, 

povezani vanjski uređaj)

Radna temperatura

	 od 0 °C do 40 °C (od 32 °F do 104 °F)

Temperatura pohrane

	 -20 °C do +60 °C (-4 °F do +140 °F)

Neprekidno vrijeme rada

	 Pribl. 105 minute (s BP-U35) 

(kućište, objektiv, snimanje XAVC-I 

QFHD s 59,94P, uključeno tražilo, 

bez priključenih vanjskih uređaja)

Format za snimanje (videozapis)

	 XAVC Intra

		  Način XAVC-I 4K/QFHD: 

CBG, brzina prijenosa u bitovima 

600 Mbps (maks.), MPEG-4 

AVC/H.264

		  Način XAVC-I HD: 

CBG, brzina prijenosa u bitovima 

223 Mbps (maks.), MPEG-4 

AVC/H.264

	 XAVC Long

		  Način XAVC-L QFHD: 

VBR, brzina prijenosa u bitovima 

150 Mbps (maks.), MPEG-4 H.264/AVC

		  Način XAVC-L HD 50: 

VBR, brzina prijenosa u bitovima 

50 Mbps (maks.), MPEG-4 H.264/

AVC

		  Način XAVC-L HD 35: 

VBR, brzina prijenosa u bitovima 

35 Mbps (maks.), MPEG-4 H.264/

AVC

Format za snimanje (zvuk)

	 LPCM 24-bit, 48 kHz, 4-kanalni

Brzina sličica za snimanje

	 XAVC Intra

		  Način XAVC-I 4K: 

4096×2160/59.94P, 50P, 29.97P, 

25P, 24P, 23.98P

		  Način XAVC-I QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Način XAVC-I HD: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

	 XAVC Long

		  Način XAVC-L QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Način XAVC-L HD 50: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Način XAVC-L HD 35: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

Vrijeme snimanja/reprodukcije

	 XAVC Intra

		  Način XAVC-I QFHD:

			   59.94P

			   Pribl. 30 minuta 

(koristeći CEA-G160T)

		  Način XAVC-I HD:

			   59.94P

			   Pribl. 78 minuta 

(koristeći CEA-G160T)

	 XAVC Long

		  Način XAVC-L QFHD:

			   59.94P

			   Pribl. 115 minuta 

(koristeći CEA-G160T)

		  Način XAVC-L HD 50:

			   59.94P

			   Pribl. 155 minuta 

(koristeći CEA-G80T)

		  Način XAVC-L HD 35:

			   59.94P

			   Pribl. 210 minuta 

(koristeći CEA-G80T)

[Napomena]
Vrijeme snimanja/reprodukcije može se razlikovati 
ovisno o uvjetima upotrebe i značajkama memorije. 
Vremena snimanja i reprodukcije odnose se na 
neprekidno snimanje jednog isječka. Stvarna vremena 
mogu se razlikovati ovisno o broju snimljenih isječaka.

Odjeljak fotoaparata

Uređaj za fotografiranje (vrsta)

	 Istovrijedno cijelom kadru s 35 mm, CMOS 

slikovni senzor s jednim čipom

Broj piksela

	 12,9 M (ukupno)

	 10,2 M (efektivno)

Automatsko izoštravanje

	 Način otkrivanja: Otkrivanje faze/otkrivanje 

kontrasta

Interni ND filtri

	 CLEAR: OFF

	 1: 1/4ND

	 2: 1/16ND

	 3: 1/64ND

	 Linearly variable ND: 1/4ND to 1/128ND

ISO osjetljivost

	 ISO 800/12800 (način rada Cine EI mode, 

izvor svjetlosti D55)

Element za montažu objektiva

	 E-mount nosač

Zemljopisna širina

	 15+ stanica

Shutter speed (Brzina okidanja)

	 od 64 F do 1/8000 s. (23,98P)

Kut okidača

	 od 5,6° do 360°, od 2 do 64 sličice

Usporene i ubrzane snimke

	 XAVC QFHD: Od 1 fps do 120 fps

	 XAVC HD: od 1 fps do 240 fps

	 XAVC 4K: od 1 fps do 60 fps

	 XAVC HD (S35): od 1 fps do 120 fps

White balance (Podešavanje bijele boje)

	 od 2000 K do 15.000 K

Razina signala

	 od –3 dB do +30 dB (u koracima od 1 dB)

Osnovni izgled

	 S-Cinetone, Standard, Still, ITU709, s709, 

709(800%), S-Log3, HLG Live, 

HLG Natural

Specifikacije
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Odjeljak za zvuk

Frekvencija uzorkovanja

	 48 kHz

Kvantizacija

	 24-bitni

Frekvencijski odziv

	 XLR ulaz, način MIC: od 20 Hz do 20 kHz  

(±3 dB ili manje)

	 XLR ulaz, način LINE: od 20 Hz do 20 kHz  

(±3 dB ili manje)

Dinamički raspon

	 XLR ulaz, način MIC: 80 dB (Typical)

	 XLR ulaz, način LINE: 90 dB (Typical)

Izobličenje

	 XLR ulaz, način MIC: 0,08 % ili manje (ulazna 

razina -40 dBu)

	 XLR ulaz, način LINE: 0,08 % ili niže (ulazna 

razina +14 dBu)

Ugrađeni zvučnik

	 mono

Unutarnji mikrofon 

	 mono

Ručka unutarnjeg mikrofona

	 Electret kondenzatorski stereo mikrofon

[Napomena]
Samo ručka unutarnjeg mikrofona postaje aktivna kada 
je postavljena ručka.

Odjeljak za ulaz/izlaz

Ulazi
INPUT 1/2:

	 vrste XLR, 3-pinski, ženski

	 LINE / MIC / MIC+48V, može se prebacivati

	 MIC: Reference od –30 dBu do –80 dBu

TC IN:

	 vrste BNC

Izlazi
SDI OUT:

	 BNC vrsta, 12G-SDI, 6G-SDI, 3G-SDI (razina 

A/B), HD-SDI

Slušalice (stereo mini utikač):

	 –16 dBu (izlaz referentne razine, maksimalna 

glasnoća nadzora, opterećenje od 

16 Ω)

HDMI:

	 vrste A (19-pinski)

TC OUT:

	 vrste BNC

Ostalo
DC IN:

	 kompatibilno s EIAJ, od 18 V do 20,5 V DC

Podnožje za više sučelja:

	 namjensko (21-pinsko)

Daljinski upravljač:

	 vrste 3-polni sub-mini od 2,5 mm

Priključnica za daljinski upravljač s drškom:

	 3,5 mm 4-polni stereo mini utikač (uključeni 

priključak za daljinski upravljač s 

drškom)

USB-C:

	 USB 3.2 Gen 1

USB/multi:

	 Kompatibilno sa standardom USB 2.0, vrste 

micro B za masovnu pohranu (1)

VF:

	 namjensko (40-pinsko)

Odjeljak za zaslon

Tražilo (LCD)
Veličina zaslona

	 dijagonala od 8,8 cm (3,5'')

Omjer širine i visine

	 16:9

Broj piksela

	 1280 (H) × 720 (V)

Odjeljak za medijske utore

Utor za CFexpress Type A karticu / SD karticu (2)

Bežični LAN

Podržani standardi

	 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

	 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Frekvencijski pojas

	 2,4 GHz

	 5 GHz (samo ILME-FX6V/VK)

Podržani sigurnosni protokoli

	 WEP/WPA-PSK/WPA2-PSK

Način povezivanja

	 Wi-Fi Protected Setup™ (WPS)/ručno

Način pristupa

	 infrastrukturni način

Punjač baterija (BC-CU1)

Težina

	 Približno 60 g (2,1 oz)

Dimenzije

	 Pribl. 57 × 26 × 101 mm  

(2 1/4 × 1 1/16 × 4 in)  

(širina/visina/dubina)

Ulaz

	 19.5 V DC, 26 W

Izlaz

	 16,4 V DC, 1,4 A

Radna temperatura

	 od 0 °C do 40 °C (od 32 °F do 104 °F)

Temperatura pohrane

	 -20 °C do +60 °C (-4 °F do +140 °F)

Priložena dodatna oprema

Adapter za izmjeničnu struju (1)

Strujni kabel (1) 

Punjač za baterije (1) 

Komplet baterija (1)

Držač (1)

LCD monitor (1)

USB-C kabel (1)

Daljinski upravljač s držačem (1)

Poklopac za LCD (1)

Komplet priključaka bez električne veze (1) 

(Priključak bez električne veze (1), opruga nosača 

(1), vijci (4))

Poklopac za montažu objektiva (1)

Zaštitni poklopac za priključak na držaču (1)

Prije upotrebe ovog uređaja (1)

Knjižica s jamstvom (1)

Dizajn i specifikacije podložni su izmjenama 
bez prethodne najave.
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Napomene
ˎˎ Uvijek snimite testnu snimku i provjerite 
je li pravilno snimljena. SONY NE SNOSI 
ODGOVORNOST NI ZA KAKVE ŠTETE 
, UKLJUČUJUĆI, BEZ OGRANIČENJA, 
KOMPENZACIJU ILI POVRAT NOVCA USLIJED 
KVARA OVOG UREĐAJA ILI NJEGOVIH 
MEDIJA ZA SNIMANJE ILI BILO KAKVIH 
MEDIJA ILI SUSTAVA ZA POHRANU RADI 
SNIMANJA SADRŽAJA BILO KOJE VRSTE.
ˎˎ Prije upotrebe obavezno provjerite 
funkcionira li jedinica pravilno. SONY 
NE ODGOVARA NI ZA KAKVE ŠTETE, 
UKLJUČUJUĆI, BEZ OGRANIČENJA, 
KOMPENZACIJU ILI POVRAT NOVCA 
USLIJED GUBITKA SADAŠNJEG ILI 
MOGUĆEG PRIHODA NASTALOG 
ZBOG KVARA OVE JEDINICE TIJEKOM 
JAMSTVENOG RAZDOBLJA ILI NAKON 
NJEGOVA ISTEKA KAO NI ZBOG BILO KOJEG 
DRUGOG RAZLOGA.
ˎˎ SONY NE ODGOVARA NI ZA KAKVE IZJAVE 
KORISNIKA OVE JEDINICE NI TREĆIH 
STRANA.
ˎˎ SONY NE ODGOVARA NI ZA KAKAV 
GUBITAK, POPRAVAK ILI REPRODUKCIJU 
BILO KAKVIH PODATAKA SNIMLJENIH NA 
INTERNI SUSTAV ZA POHRANU, MEDIJE 
ZA SNIMANJE NI BILO KAKVE MEDIJE ILI 
SUSTAVE ZA POHRANU.
ˎˎ SONY NE ODGOVARA ZA OBUSTAVLJANJE 
NI UKIDANJE BILO KOJE USLUGE POVEZANE 
S OVOM JEDNICOM NASTALO USLIJED BILO 
KAKVIH OKOLNOSTI.

Vanjske dimenzije

Jedinica: mm (inči)

UNC 1/4-20

UNC 3/8-16

228 (9)

2-UNC 1/4-20

UNC 1/4-20

143 (5 3/4)

UNC 1/4-20

116  
(4 5/8)

8-UNC 1/4-20

114 (4 1/2)
60  
(2 3/8)

258 (10 1/4)

2-UNC 1/4-20

153 (6 1/8)

28 (1 1/8)

25 (1)

25 (1)
25 (1)

25 (1)

Navedene dimenzije su približne vrijednosti.
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Zaštitni znaci

ˎˎ  je zaštitni znak tvrtke Sony Corporation.
ˎˎ XAVC i  registrirani su zaštitni znaci 
tvrtke Sony Corporation.
ˎˎ Izrazi HDMI i HDMI High-Definition Multimedia 
Interface te logotip HDMI zaštitni su znakovi 
ili registrirani zaštitni znakovi tvrtke HDMI 
Licensing Administrator, Inc u Sjedinjenim 
Američkim Državama i drugim državama.
ˎˎ Microsoft i Windows registrirani su zaštitni 
znakovi ili registrirani zaštitni znakovi 
tvrtke Microsoft Corporation u Sjedinjenim 
Američkim Državama i/ili drugim zemljama.
ˎˎ Mac i Mac OS registrirani su zaštitni znakovi 
tvrtke Apple Inc. u SAD-u i drugim državama.
ˎˎ Logotipi „Catalyst Browse,” „Content 
Browser Mobile,” i „Content Browser Mobile” 
zaštitni su znakovi ili registrirani zaštitni 
znakovi tvrtke Sony Corporation.
ˎˎ iOS je registrirani zaštitni znak ili zaštitni 
znak tvrtke Cisco Systems, Inc. i/ili njenih 
podružnica u Sjedinjenim Državama i 
određenim drugim državama.
ˎˎ Android i Google Play zaštitni su znakovi 
tvrtke Google Inc.
ˎˎ Wi-Fi, logotip Wi-Fi i Wi-Fi PROTECTED 
SETUP zaštitni su znakovi ili registrirani 
zaštitni znakovi tvrtke Wi-Fi Alliance.
ˎˎ Oznaka N zaštitni je znak ili registrirani 
zaštitni znak tvrtke NFC Forum, Inc. u 
Sjedinjenim Američkim Državama i drugim 
državama.
ˎˎ Logotip SDXC zaštitni je znak tvrtke SD-3C, LLC.
ˎˎ Logotipi CFexpress i CFexpress Type A zaštitni 
su znakovi tvrtke CompactFlash Association.

Svi drugi nazivi tvrtki i nazivi proizvoda 
registrirani su zaštitni znakovi ili zaštitni 
znakovi u vlasništvu svojih vlasnika. U ovom 
dokumentu stavke s zaštitnim znakovima nisu 
označene sa simbolom ™ ili ®.
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Konfiguracija sistema

UWP-D21 
UWP-D22 
UWP-D26 
Paket 
brezžičnega 
mikrofona

URX-P03D 
Sprejemnik 
brezžičnega 
mikrofona

SMAD-P3D 
Adapter 
za večvmesniški 
nastavek

SMAD-P5 
Adapter za 
večvmesniški 
nastavek

LA-EA3 
LA-EA4 
Adapter za 
objektive serije A

Objektiv serije E

ECM-VG1 
ECM-MS2 
Mikrofon

RM-30BP 
Daljinski upravljalnik

MCX-500 
Multi Camera Live 
Producer

Držalo z daljinskim 
upravljalnikom (priloženo)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

XLR-K2M 
XLR-K3M 
Komplet 
adapterja XLR

HVL-LBPC 
Video luč

Pomnilniške 
kartice CFexpress 
tipa A

Pomnilniške kartice 
SDXC

BC-CU1  
Polnilnik baterij 
(priložen)

BP-U35, BP-U60, 
BP‑U60T, BP-U70, 
BP‑U90, BP-U100 
Paket baterij

Omrežni napajalnik 
(priložen)

Bralnik kartic CFexpress tipa A/  
bralnik kartic SD

BC-U1A, BC-U2A 
Polnilnik baterij

1. Pregled
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Lokacije in funkcije delov

Leva stran in sprednja stran

11
1

2

4
5
6
7
8

9

12

13

14

3

16

15

10

1.	 Kavelj za merilni trak
Kavelj za merilni trak se nahaja v enaki 
ravnini kot slikovni senzor. Kavelj uporabite 
kot referenčno točko za natančno merjenje 
razdalje med videokamero in subjektom. Na 
kavelj lahko zataknete konec merilnega traku, 
da izmerite razdaljo do subjekta.

2.	 Priključek za iskalo (stran 19)

3.	 Prezračevalna reža

[Opomba]
Ne pokrivajte prezračevalne reže.

4.	 Izbirno stikalo TC IN/OUT (stran 34, 
107)

5.	 Priključek držala z daljinskim 
upravljalnikom (stran 20)

6.	  (oznaka N) (stran 56)
ˎˎ S pametnim telefonom, opremljenim 
s funkcijo NFC, se dotaknite enote, da 
vzpostavite brezžično povezavo.  
Nekateri pametni telefoni, ki podpirajo 
brezžične sisteme plačevanja, morda 
ne podpirajo NFC. Za podrobnosti glejte 
navodila za uporabo pametnega telefona.
ˎˎ NFC (Near Field Communication) je 
mednarodni komunikacijski protokol za 
brezžično komunikacijo med bližnjimi 
napravami.

7.	 Priključitev držala z daljinskim 
upravljalnikom (stran 20)

8.	 Gumb za sprostitev držala z daljinskim 
upravljalnikom (stran 20)

9.	 Antena Wi-Fi

10.	Indikator snemanja (spredaj) (stran 34)
Utripa, ko je preostala kapaciteta 
pomnilniškega medija ali baterije nizka.

11.	Stikalo FOCUS (stran 37)

12.	Slikovni senzor

13.	Gumb PUSH AUTO FOCUS (stran 40)

14.	Kontakti za signal objektiva

[Opomba]
Izogibajte se neposrednemu stiku z rokami.

15.	Gumb WB SET (nastavitev beline) 
(stran 45)

16.	Gumb za sprostitev objektiva (stran 22)
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Desna stran (spredaj/zgoraj/spodaj)

9

20

7

5

3

11
10
8

6

19171514
1816

13

2
1

4

12

1.	 Gumb Clip Flag (stran 50, 65)

2.	 Stikalo HOLD (stran 93)

3.	 Gumb za snemanje START/STOP 
(stran 34)

Za začetek snemanja pritisnite gumb za 
snemanje START/STOP. Med snemanjem sveti 
rdeč indikator LED.

4.	 Kolesce ND VARIABLE (stran 43)

5.	 Stikalo ND PRESET/VARIABLE (stran 43)

6.	 Smerna gumba ND FILTER POSITION 
(stran 43)

7.	 Indikator ND CLEAR (stran 43)

8.	 Gumb ND VARIABLE AUTO (stran 43)
Pritisnite gumb ND VARIABLE AUTO za začetek 
samodejne nastavitve gostote filtra ND. Ob 
vklopu sveti zelen indikator LED.

9.	 Večfunkcijsko kolesce (stran 48)
Pritisnite, ko gledate skozi iskalo, če želite 
odpreti in uporabljati neposredni meni.
Ko je v iskalu prikazan meni, zavrtite kolesce, 
da premaknete kazalec gor/dol za izbiro 
elementov menija ali nastavitev. Pritisnite za 
potrditev izbranega elementa.
Ko meni ni prikazan, lahko kolesce služi tudi 
kot dodeljivo kolesce.

10.	Funkcijski gumb IRIS (stran 42)

11.	Gumb CANCEL/BACK (stran 64)

12.	Gumb THUMBNAIL (stran 63)

13.	Gumb MENU (13, 68)
Pritisnite gumb MENU, da se prikaže zaslon 
stanja. Pritisnite gumb MENU in ga pridržite, 
da se prikaže zaslon glavnega menija. 
Pritisnite gumb med prikazom zaslona stanja 
ali zaslona glavnega menija, če se želite vrniti 
v prikaz prejšnjega zaslona.

14.	Funkcijski gumb ISO/GAIN (stran 42)

15.	Stikalo ISO/GAIN (izbira ojačitve) 
(stran 42)

16.	Funkcijski gumb WHT BAL (belina) 
(stran 45)

17.	Stikalo WHT BAL (izbira pomnilnika 
beline) (stran 45)

18.	Funkcijski gumb SHUTTER (stran 43)

19.	Priključek za slušalke (stran 34)

20.	Stikalo POWER (stran 34)

Desna stran (zadaj) 
(stran 6)
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Desna zadnja stran in reža za kartice

10

8

123

7

6
5

4

11

9

12

15

13

14

1.	 Antena Wi-Fi

2.	 Kolesce AUDIO LEVEL (CH1) (stran 46)

3.	 Stikalo CH1 (AUTO/MAN) (stran 46)

4.	 Gumbi ASSIGN (dodeljivi) od 1 do 3 
(stran 48)

5.	 Notranji mikrofon (stran 46)
Vokalni mikrofon za snemanje ambientalnega 
zvoka. 

[Nasvet]
Mikrofon je onemogočen, ko je pritrjeno držalo, in 
aktivira se notranji mikrofon v držalu (stran 7).

6.	 Gumb DISPLAY (stran 11)

7.	 Vgrajeni zvočnik (stran 34)

8.	 Indikator POWER (stran 34)

9.	 Gumb SLOT SELECT (izbira reže za 
pomnilniško kartico (A)/(B)) (stran 34)

10.	Stikalo CH2 (AUTO/MAN) (stran 46)

11.	Kolesce AUDIO LEVEL (CH2) (stran 46)

12.	Indikator dostopa A (stran 26)

13.	Reža za kartico A/SD tipa CFexpress (A) 
(stran 26)

14.	Reža za kartico A/SD tipa CFexpress (B) 
(stran 26)

15.	Indikator dostopa B (stran 26)
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Držalo, hrbtna stran in priključni blok

11

10

8
7
6
5

4 3 2 1

21

16

10

10
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9
17
18
19

22

23

20

24
25
26

14

13
12

15
20

1.	 Stikalo HOLD na držalu
Uporablja se za izklop drugih stikal na ročaju.

2.	 Gumb za snemanje START/STOP na držalu

3.	 Notranji mikrofon v držalu

4.	 Večvmesniški nastavek

Za podrobnosti o dodatni opremi, ki jo podpira 
večvmesniški nastavek, se obrnite na svojega 
prodajnega predstavnika.

5.	 Dodeljiv gumb v držalu (stran 48)

6.	 Ročica za zoom na držalu (stran 93)

7.	 Gumbi ASSIGN (dodeljivi) od 7 do 8 
(stran 48)

8.	 Večfunkcijski gumb (8-smerna D-ploščica 
in gumbi za potrditev)

9.	 Nastavek za dodatno opremo 
(stran 7)

10.	Odprtine za vijake za pritrditev dodatne 
opreme (1/4 palca)

Združljive z vijaki 1/4-20 UNC (dolžine 6 mm 
ali manj).

[Opomba]
Če uporabite vijake, daljše od 6 mm, lahko poškodujete 
zunanjo površino.

11.	 Indikator snemanja (zadaj) (stran 34)

12.	Gumb BATT RELEASE (stran 17)

13.	Vhodna odprtina za zrak

[Opomba]
Ne pokrivajte vhodne odprtine za zrak.

14.	Pritrdišče za paket baterij (stran 17)

15.	Priključek USB-C (stran 60)

16.	Priključek INPUT2 (avdio vhod 2) 
(stran 46)

17.	Priključek INPUT1 (avdio vhod 1) 
(stran 46)

18.	Stikalo INPUT2 (LINE/MIC/MIC+48V) 
(stran 46)

19.	Stikalo INPUT1 (LINE/MIC/MIC+48V) 
(stran 46)

20.	Odprtine za vijake za zunanje naprave
Združljive z vijaki M3 (dolžine 4 mm ali krajši).

[Opomba]
Če uporabite vijake, daljše od 4 mm, lahko poškodujete 
zunanjo površino.

21.	Priključek HDMI OUT (stran 106)

22.	Priključek SDI OUT (stran 106)

23.	Priključek TC IN/TC OUT (vhod/izhod 
časovne kode) (stran 107)

24.	Priključek REMOTE
Priklopite splošen pripomoček s priključkom 
LANC.

25.	Priključek USB/multi (stran 108)

26.	Priključek DC-IN (standardni vtič DC) 
(stran 18)

Namestitev nastavka za dodatno 
opremo

1	 Dvignite sprednji rob vzmeti nastavka in 
povlecite vzmet v nasprotno smer puščice, 
vgravirane na vzmeti.

Vzmet nastavka

Nastavek za dodatno opremo

1

2	 Nastavek za dodatno opremo položite na 
pritrdišče nastavka za dodatno opremo, 
poravnajte izbokline nastavka z ustreznimi 
točkami na pritrdišču in privijte štiri vijake.
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3	 Vstavite vzmet nastavka v smeri puščice, 
tako da del v obliki črke U nalega na rob 
nastavka za dodatno opremo.

Vzmet 
nastavka

Nastavek za dodatno opremo

2 32 3

Odstranjevanje nastavka za dodatno 
opremo

Odstranite vzmet nastavka, kot je opisano 
v 1. koraku razdelka »Namestitev dodatka 
za dodatno opremo«. Odvijte štiri vijake in 
odstranite nastavek za dodatno opremo.

Namestitev držala

Držalo namestite tako, da bo priključek držala 
poravnan z odprtinama za vijaka, potisnite in 
obrnite vijaka za pritrditev držala v desno, da 
pritrdite držalo na enoto.
Vijaka za pritrditev držala lahko privijete v 
desno tudi z imbus ključem (4 mm).

[Opomba]
Pred uporabo držala preverite, da sta vijaka za pritrditev 
držala dobro privita. Če vijaka nista dobro privita, se 
lahko držalo sname z videokamere.

Odstranitev držala

Odstranite ga po istem postopku v obratnem 
vrstnem redu.

Namestitev zaščitnega pokrovčka 
priključka držala (priloženo)

Ko uporabljate videokamero z odstranjenim 
držalom, zaščitite priključek s priloženim 
zaščitnim pokrovčkom.

[Nasvet]
Ko namestite držalo, pospravite priložen zaščitni 
pokrovček na dno držala.

Zaščita terminalov priključkov

Namestite pokrov na neuporabljene priključke, 
da zaščitite terminale priključkov.

Zgornja stran

1

2 2

2

2

1.	 Priključek držala

2.	 Odprtine za vijake za pritrditev dodatne 
opreme (1/4 palca)

Združljive z vijaki 1/4-20 UNC (dolžine 6 mm 
ali manj).

[Opomba]
Če uporabite vijake, daljše od 6 mm, lahko poškodujete 
dele zunanjega ohišja.
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Spodnja stran

1 2
1.	 Vijačne odprtine za stojalo (1/4 palca, 

3/8 palca)
Združljive z vijaki 1/4-20 UNC in vijaki 3/8-16 
UNC. Pritrdite na trinožno stojalo (možnost, 
vijaki dolžine 5,5 mm ali krajši).

2.	 Odprtina za izhod zraka

[Opomba]
Ne pokrivajte odprtine za izhod zraka.

Iskalo

Za podrobnosti o nameščanju iskala 
(priloženo) glejte stran 19.

1
2
3

4 5

1.	 Gumb PEAKING

2.	 Gumb ZEBRA

3.	 Gumb ASSIGN 9 (dodeljiv gumb) 
(stran 48)

4.	 Plošča na dotik
Upravljanje na dotik lahko izklopite z 
dodeljivim gumbom ali prek menija 
(stran 10).

5.	 Stikalo MIRROR

Držalo z daljinskim upravljalnikom

Za podrobnosti o namestitvi držala z 
daljinskim upravljalnikom (priloženo) glejte 
stran 20.

4

3
2

1

7
8

6
5

1.	 Ročica za zoom

2.	 Gumb ASSIGN 4 (dodeljiv gumb) 
(stran 48) 

3.	 Dodeljiv gumb na držalu (stran 48)

4.	 Gumb ASSIGN 6 (dodeljiv gumb) 
(stran 48) 

5.	 Ročica za vrtenje držala (stran 21) 

6.	 Gumb za snemanje START/STOP

7.	 Večfunkcijski gumb (8-smerna D-ploščica 
in gumbi za potrditev)

8.	 Gumb ASSIGN 5 (dodeljiv gumb) 
(stran 48) 
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Uporaba plošče na dotik

Previdnostni ukrepi glede uporabe 
plošče na dotik

Iskalo enote je plošča na dotik, ki jo 
uporabljate neposredno z dotikom s prstom.
ˎˎ Plošča na dotik je zasnovana tako, da se 
odziva na rahle dotike s prstom. Plošče ne 
pritiskajte močno oziroma se je ne dotikajte 
z ostrimi ali koničastimi predmeti (nohtom, 
kemičnim svinčnikom, iglo ipd.).
ˎˎ V naslednjih okoliščinah se plošča na dotik 
morda ne bo odzvala na dotik. Te okoliščine 
lahko povzročijo tudi okvaro:
ˎˎ 	če uporabite konice nohtov;
ˎˎ 	če jo upravljate, ko se površine dotikajo 
drugi predmeti;
ˎˎ 	če je na njej zaščitna folija ali nalepka;
ˎˎ 	če so na zaslonu vodne kapljice ali 
kondenz.
ˎˎ 	če jo upravljate z mokrimi ali potnimi 
prsti.

Gibi na plošči na dotik

Dotaknite se
S prstom se rahlo dotaknite elementa, kot sta 
na primer ikona ali možnost v meniju, nato pa 
prst takoj odmaknite.

Povlecite
Dotaknite se zaslona in prst povlecite na želeni 
položaj na zaslonu, nato pa odmaknite prst.

Frcnite/podrsajte
Dotaknite se zaslona in s prstom hitro frcnite/
podrsajte navzgor, navzdol, v levo ali v desno.

[Nasvet]
Če se vsebina zaslona nadaljuje prek robov zaslona, 
lahko s prstom podrsate ali frcnite in zaslon se bo 
premaknil ter pokazal preostalo vsebino.

Konfiguracija plošče na dotik

Upravljanje zaslona na dotik lahko vklopite/
izklopite s funkcijo Touch Operation 
(stran 93) v meniju Technical.
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Zaslonski prikaz
Med snemanjem (snemanje/stanje pripravljenosti) in predvajanjem so podatki o stanju in 
nastavitvah videokamere vstavljeni v sliko, prikazano v iskalu.
Podatke lahko prikažete/skrijete z gumbom DISPLAY. Tudi ko je skrit, se bo prikazal, če izvedete 
neposredne operacije v meniju (stran 48).
Za vsak element lahko tudi posebej izberete, ali ga želite prikazati/skriti (stran 87).

Podatki, prikazani na zaslonu med snemanjem

3 42

6
8

9 1075

11
12

13
14

15
16
17

18 19 20 21 22 23 24 25 26 27 28

29

30
31
32
33
34
35
36

1

1.	 Indikator stanja omrežja (stran 13)
V obliki ikone prikaže stanje omrežne 
povezave.

2.	 Indikator nalaganja/indikator preostalih 
datotek (stran 61)

3.	 Indikator območja ostrenja (stran 37)
Prikaže območje ostrenja samodejnega 
ostrenja.

4.	 Indikator načina snemanja, reže A/B, 
intervala načina snemanja Interval Rec 
(stran 49)

Display Pomen

Rec Recording (5-sekundno snemanje)

Stby Stanje pripravljenosti snemanja

5.	 Indikator globinske ostrine

6.	 Indikator načina zajemanja slike 
(stran 24)

Ob neujemanju velikosti kroga slike objektiva 
in efektivne velikosti slike v nastavljenem 
načinu zajemanja slike, je prikazana oznaka .
Ko je nastavitev Imager Scan Mode 
nastavljena na FF, se v načinih z ožjim zornim 
kotom prikaže oznaka »C« (obrezano).
Do obrezovanja pride v naslednjih načinih.
ˎˎ Ko je format zapisovanja 3840×2160 in je 
hitrost sličic S&Q Motion 100 ali 120 sličic na 
sekundo.
ˎˎ Ko je nastavitev Codec nastavljena na RAW 
ali RAW & XAVC-I in je izhodni format RAW 
3840×2160.

7.	 Indikator stanja delovanja izhodnega 
formata RAW (stran 55)

Prikazuje izhodno stanje signala RAW.

8.	 Indikator stanja serije UWP-D (stran 13)
V obliki ikone prikaže moč signala ravni RF, 
ko je naprava serije UWP-D priključena na 
nastavek MI, konfiguriran za digitalni prenos 
zvoka.

9.	 Indikator hitrosti sličic pri snemanju 
počasnih in hitrih posnetkov (stran 49)

10.	Preostala napolnjenost baterije/indikator 
napetosti DC IN (stran 17)

11.	 Indikator načina ostrenja (stran 41)

Pomen Display
Način Focus Hold Focus Hold

Način ročnega ostrenja MF

Način ročnega ostrenja AF

AF z zaznavanjem obrazov/oči  
(AF/ /Only/ / )

Ikona zaznavanja obrazov/
oči

Ikona AF z zaznavanjem 
obrazov/oči

Only

Ikona registriranega 
obraza

 

Ikona začasne prekinitve 
AF med AF z zaznavanjem 
obrazov/oči 1)

1)	 Prikazana je, ko ni registriranega obraza in obraz 
ni zaznan ali, ko je prisoten registriran obraz in 
registriran obraz ni zaznan.

12.	Indikator položaja zooma (stran 36)
Prikaže položaj zooma v razponu od 0 (široki 
kot) do 99 (telefoto) (če je nameščen objektiv, 
ki podpira prikaz nastavitve zooma).
Prikaz je mogoče spremeniti v črtni indikator 
ali indikator razdalje ostrenja (stran 94).
Ko je vklopljena funkcija Clear Image Zoom, so 
na zaslon dodani naslednji elementi.

Display Pomen
Funkcija Clear Image Zoom je 
vklopljena

Vrednost 
povečave

Uporaba funkcije Clear Image 
Zoom

13.	Indikator načina stabilizacije slike

14.	Indikator stanja izhoda SDI/funkcije Rec 
Control izhoda HDMI (stran 106)

Prikaže izhodno stanje signala REC control.

15.	Indikator ostrenja (stran 40)

16.	Indikator preostalega prostora na 
pomnilniškem mediju

17.	 Indikator načina beline

Display Pomen
Način Auto

 Hold Način Auto začasno prekinjen

W:P Prednastavljeni način

W:A Način pomnilnika A

W:B Način pomnilnika B

18.	Indikator zunanjega zaklepa časovne 
kode/prikaz podatkov o času (stran 34)

Ob zaklepu na časovno kodo zunanje naprave 
prikazuje »EXT-LK«.

19.	Indikator filtra ND (stran 43)

20.	Indikator scenske datoteke (stran 105)

21.	Indikator zaslonke
Prikaže položaj zaslonke (vrednost F) (če 
je nameščen objektiv, ki podpira prikaz 
nastavitve zaslonke).

22.	Opozorilni indikator ravni videa

23.	Indikator ojačitve (stran 42)
Prikaže vrednost EI v načinu Cine EI 
(stran 24).

Display Pomen
Način Auto

H Način Preset H

M Način Preset M

L Način Preset L

Način začasne 
prilagoditve
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24.	Prikaz imena posnetka (stran 63)

25.	Indikator zaklopa (stran 43)

26.	Način AE/indikator ravni AE (stran 42)

27.	Indikator izravnanosti
Prikaže vodoravno izravnanost do ±15° v 
korakih po ±1°.

28.	Merilnik ravni zvoka
Prikaže raven zvoka za kanala CH1 in CH2.
Kanalov CH3 in CH4 ni mogoče nadzorovati na 
zaslonu stanja.

29.	Nadzor video signala (stran 50)
Prikaže valovno obliko, vektorskop in 
histogram.
Oranžna črta označuje nastavljeno vrednost 
na ravni Zebra.
V načinu Cine EI (stran 24) prikazuje vrsto 
signala LUT, ki je pod nadzorom.

30.	Indikator Base Sensitivity/indikator Base 
ISO (stran 42)

V načinu Custom (stran 24) prikazuje 
osnovno občutljivost, nastavljeno z možnostjo 
ISO/Gain/EI, na zaslonu Main status ali 
nastavitev ISO/Gain/EI > Base Sensitivity v 
meniju Shooting glavnega menija.
V načinu Cine EI (stran 24) prikazuje 
osnovno občutljivost ISO, nastavljeno z 
možnostjo ISO/Gain/EI, na zaslonu Main 
status ali nastavitev ISO/Gain/EI > Base ISO v 
meniju Shooting glavnega menija.

31.	Pomočnik za gammo zaslona/indikator 
LUT monitorja

Prikaže stanje pomočnika za gammo zaslona. 
Funkcijo pomočnika za gammo zaslona lahko 
vklopite/izklopite z dodelitvijo možnosti 
Gamma Display Assist dodeljivemu gumbu 
(stran 48).
V načinu Cine EI (stran 24) prikazuje 
nastavitev funkcije Monitor LUT (stran 76).

32.	Indikator Base Look (stran 52)
Prikazuje nastavitev osnovnega videza.
V načinu Cine EI (stran 24) prikazuje 
nastavitev LUT za snemanje videoposnetkov 
na pomnilniške kartice (stran 76).

33.	Indikator stanja proxyja

34.	Indikator formata snemanja (kodeka) 
(stran 77)

Prikaže ime formata za snemanje na 
pomnilniške kartice.

35.	Indikator formata snemanja (hitrost sličic 
in način zajema)

36.	Indikator formata snemanja (velikosti 
slike) (stran 77)

Prikaže velikost slike za snemanje na 
pomnilniške kartice.

Podatki, prikazani na zaslonu med predvajanjem

Sledeči podatki so dodani predvajani sliki.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1.	 Indikator stanja omrežja

2.	 Indikator nalaganja/indikator preostalih 
datotek

3.	 Številka posnetka/skupno število 
posnetkov

4.	 Indikator stanja predvajanja

5.	 Indikator formata predvajanja (hitrost 
sličic in način zajemanja)

6.	 Indikator formata predvajanja (velikosti 
slike)

7.	 Preostala napolnjenost baterije/indikator 
napetosti DC IN

8.	 Indikator formata predvajanja (kodeka)

9.	 Indikator pomnilniškega medija
Ikona  se prikaže, če je pomnilniška kartica 
zaščitena pred zapisovanjem.

10.	Prikaz podatkov o času

11.	Prikaz imena posnetka

12.	Indikator pomočnika za gammo zaslona

13.	Merilnik ravni zvoka
Prikaže raven zvoka pri predvajanju.

14.	Indikator Base Look
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Prikaz ikon

Prikaz ikon omrežne povezave

Način omrežja Stanje povezave Ikona
Način dostopovne točke Delovanje kot dostopovna točka

Napaka v delovanju dostopovne točke

Način postaje Povezava Wi-Fi
Ikona se spremeni glede na moč 
signala (4 koraki)

   

Prekinjena povezava Wi-Fi  
(tudi pri vzpostavljanju povezave)

Napaka povezave Wi-Fi

Povezava USB Povezava USB vzpostavljena

Povezava USB prekinjena

Napaka pri povezavi USB

Prikaz ikon serije UWP-D

Stanje oddajnika Stanje sprejemanja Ikona
Izklopljen Ne sprejema

Normalno stanje oddajanja Sprejemanje

 –   
(raven sprejemanja (4 
stopnje))

Stanje utišanja Sprejemanje (utišano)

Stanje opozorila preostale napolnjenosti 
baterije

Sprejemanje
 (ikona utripa)

Utišanje in stanje opozorila preostale 
napolnjenosti baterije

Sprejemanje

 (ikona utripa)

Zaslon stanja

Na zaslonu stanja lahko preverite nastavitve in 
stanje videokamere. Nastavitve elementov, ki 
so označeni z zvezdico (*), lahko spreminjate.
Zaslon stanja podpira upravljanje na dotik.

Prikaz zaslona stanja
ˎˎ Pritisnite gumb MENU.

Preklop zaslona stanja
ˎˎ Zavrtite večfunkcijsko kolesce.
ˎˎ Potisnite večfunkcijski gumb navzgor/
navzdol
ˎˎ Podrsajte navzgor/navzdol po zaslonu 
stanja.

Skritje zaslona stanja
ˎˎ Pritisnite gumb MENU.

Spreminjanje nastavitve
Ko je prikazan zaslon stanja, pritisnite 
večfunkcijsko kolesce ali večfunkcijski gumb, 
da omogočite izbiro elementa nastavitve na 
strani. Izberite številko strani in nato pritisnite 
za obračanje strani.
Elemente lahko izbirate tudi z neposrednim 
dotikom.

[Opomba]
Spremembe na zaslonu stanja lahko omogočite tako, 
da vklopite možnost Menu Settings > User Menu Only 
(stran 93) v meniju Technical glavnega menija.

Glavni zaslon stanja

Prikaže glavne funkcije videokamere in prazen 
prostor na pomnilniških medijih.

Element 
prikaza

Opis

S&Q Frame Rate Nastavitev hitrosti sličic za 
snemanje počasnih in hitrih 
posnetkov

Frequency/
Scan*

Nastavitev sistemske 
frekvence in načina zajema 
slike

Imager Scan* Način, kako slikovni senzor 
zajema sliko

Media Remain 
(A)

Preostali prostor na 
pomnilniškem mediju v reži A

ND Filter Nastavitev filtra ND

ISO/Gain/EI Nastavitev ISO/Gain/
Exposure Index

Base ISO/
Sensitivity*

Nastavitev Base ISO/Base 
Sensitivity

Codec* Nastavitev kodeka za 
snemanje

Media Remain 
(B)

Preostali prostor na 
pomnilniškem mediju v reži B

Scene File* Scenska datoteka v uporabi in 
njena nastavitev File ID

Base Look/LUT* Nastavitev funkcije Monitor 
LUT

Zaklop Nastavitev hitrosti zaklopa ali 
kota zaklopa

Iris Nastavitev zaslonke

Video Format* Velikost slike za snemanje na 
pomnilniške kartice

Izhodni format 
RAW*

Velikost slike izhodnega 
formata RAW

White Balance Nastavitev beline
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Zaslon stanja videokamere

Prikazuje stanje različnih prednastavitev 
videokamere.

Element prikaza Opis
White Switch<B> Nastavitev pomnilnika B za 

belino

White Switch<A> Nastavitev pomnilnika A za 
belino

White Switch<P> Prednastavljena nastavitev 
beline

ND<Preset> Nastavitve Preset1 do 3 filtra 
ND

ISO / Gain<L>* Nastavitev ISO/Gain<L>

ISO / Gain<M>* Nastavitev ISO/Gain<M>

ISO / Gain<H>* Nastavitev ISO/Gain<H>

Base ISO/
Sensitivity*

Nastavitev Base ISO/Base 
Sensitivity

Zebra1 Nastavitev On/Off in ravni za 
Zebra1

Zebra2 Nastavitev On/Off in ravni za 
Zebra2

VF Gamma/
Gamma

Kategorija in krivulja gamme

Scene File* Scenska datoteka v uporabi 
in njena nastavitev File ID

Zaslon stanja zvoka

Za vsak kanal prikaže nastavitev vhoda, 
merilnik ravni zvoka in nastavitev nadzora 
glasnosti.

Element prikaza Opis
CH1 Regulacija 

stopnje
Stanje Auto adjustment On/
Off

Merilnik 
stopnje

Merilnik ravni zvoka

Vir* Vhodni vir

Ref./Sens.* Referenčna raven vhoda

Wind 
Filter*

Nastavitev filtra za 
zmanjševanje šuma vetra v 
mikrofonu

CH2 Regulacija 
stopnje

Stanje Auto adjustment On/
Off

Merilnik 
stopnje

Merilnik ravni zvoka

Vir* Vhodni vir

Ref./Sens.* Referenčna raven vhoda

Wind 
Filter*

Nastavitev filtra za 
zmanjševanje šuma vetra v 
mikrofonu

CH3 Level 
Control*

Stanje Auto adjustment On/
Off

Level 
Meter*

Merilnik ravni zvoka

Vir* Vhodni vir

Ref./Sens.* Referenčna raven vhoda

Wind 
Filter*

Nastavitev filtra za 
zmanjševanje šuma vetra v 
mikrofonu

CH4 Level 
Control*

Stanje Auto adjustment On/
Off

Level 
Meter*

Merilnik ravni zvoka

Vir* Vhodni vir

Ref./Sens.* Referenčna raven vhoda

Wind 
Filter*

Nastavitev filtra za 
zmanjševanje šuma vetra v 
mikrofonu

Element prikaza Opis
Audio Input 
Level*

Nastavitev ravni vhoda 
(glavna nastavitev glasnosti)

HDMI Output CH* Nastavitev avdio kanala 
izhoda HDMI

Glasnost* Nastavitev glasnosti slušalk/
vgrajenega zvočnika

Monitor CH* Nastavitev kanala monitorja

Zaslon stanja projekta

Prikazuje osnovne nastavitve, ki so povezane s 
snemalnim projektom.

Element prikaza Opis

Frequency/Scan* Nastavitev sistemske 
frekvence in načina zajema 
slike

Codec* Nastavitev kodeka za 
snemanje

Rec Function Omogočen poseben format 
snemanja in nastavitve

Simul Rec* Stanje On/Off sočasnega 
snemanja na 2 režah

Title Prefix Naslovni del imena posnetka

Imager Scan* Način, kako slikovni senzor 
zajema sliko

Video Format* Velikost slike za snemanje 
na pomnilniške kartice

Number Številčna pripona imena 
posnetka

Shooting Mode* Nastavitev načina snemanja

Izhodni format 
RAW*

Velikost slike izhodnega 
formata RAW

Proxy Rec* Stanje On/Off in nastavitev 
funkcije snemanja proxy

Zaslon Monitoring Status

Prikazuje nastavitve izhodov SDI in HDMI.

Element prikaza Opis
SDI Signal* Velikost izhodne slike

Info. 
Disp.*

Nastavitev On/Off prikaza 
izhoda

Color 
Gamut*

Nastavitev barvnega 
prostora/stanje monitorja 
LUT

HDMI Signal* Velikost izhodne slike

Info. 
Disp.*

Nastavitev On/Off prikaza 
izhoda

Color 
Gamut*

Nastavitev barvnega 
prostora/stanje monitorja 
LUT

Pretaka-
nje

Signal Velikost izhodne slike

Info. 
Disp.

Prikaz izhoda (izklopljeno 
(fiksno))

Color 
Gamut*

Nastavitev barvnega 
prostora/stanje monitorja 
LUT

VF Color 
Gamut*

Nastavitev Gamma display 
assist/nastavitev Color 
space/stanje Monitor LUT

Base Look/LUT* Nastavitev Base Look/LUT

Gamma Display 
Assist*

Nastavitev vklopa/izklopa 
Gamma Display Assist



1. Pregled: Zaslonski prikaz15 SL

Zaslon stanja dodeljivih gumbov

Prikaže funkcije, dodeljene vsakemu od 
dodeljivih gumbov.

Element prikaza Opis
1 Funkcija, dodeljena gumbu 

ASSIGN 1

2 Funkcija, dodeljena gumbu 
ASSIGN 2

3 Funkcija, dodeljena gumbu 
ASSIGN 3

4 Funkcija, dodeljena gumbu 
ASSIGN 4

5 Funkcija, dodeljena gumbu 
ASSIGN 5

6 Funkcija, dodeljena gumbu 
ASSIGN 6

7 Funkcija, dodeljena gumbu 
ASSIGN 7

8 Funkcija, dodeljena gumbu 
ASSIGN 8

9 Funkcija, dodeljena gumbu 
ASSIGN 9

Focus Hold 
Button

Funkcija, dodeljena gumbu 
Focus Hold na objektivu

Multi Function 
Dial

Funkcija, dodeljena 
večfunkcijskemu kolescu

Kolesce na držalu Funkcija, dodeljena 
dodeljivemu kolescu na 
držalu

Kolesce na ročaju Funkcija, dodeljena 
dodeljivemu kolescu na 
ročaju

Zaslon stanja baterije

Prikazuje podatke o bateriji in viru napajanja 
DC IN.

Element prikaza Opis
Detected Battery Tip baterije

Remaining Preostala zmogljivost (%)

Charge Count Število ponovnih polnjenj

Capacity Preostala zmogljivost (Ah)

Voltage Napetost baterije (V)

Manufacture 
Date

Datum izdelave baterije

Video Light 
Remaining

Prikazuje preostalo 
napolnjenost baterije za 
video luč.

Power Source Vir napajanja

Supplied Voltage Napetost vira napajanja

Zaslon stanja pomnilniških medijev

Prikaže preostali prostor in preostali čas 
snemanja pomnilniških medijev.

Element prikaza Opis
Media A 
information

Prikaže ikono pomnilniškega 
medija, ko je pomnilniški 
medij vstavljen v režo A.

Media A 
remaining 
capacity meter

Prikaže preostali prostor na 
pomnilniškem mediju, 
vstavljenem v režo A, izražen 
kot odstotek na črtnem 
grafu.

Media A 
remaining 
recording time

Prikaže ocenjen preostali čas 
snemanja na pomnilniški 
medij, vstavljen v režo A, 
izražen v minutah, 
upoštevaje trenutne razmere 
snemanja.

Media B 
information

Prikaže ikono pomnilniškega 
medija, ko je pomnilniški 
medij vstavljen v režo B.

Media B 
remaining 
capacity meter

Prikaže preostali prostor na 
pomnilniškem mediju, 
vstavljenem v režo B, izražen 
kot odstotek na črtnem 
grafu.

Media B 
remaining 
recording time

Prikaže ocenjen preostali čas 
snemanja na pomnilniški 
medij, vstavljen v režo B, 
izražen v minutah, 
upoštevaje trenutne razmere 
snemanja.

Zaslon stanja omrežja

Prikazuje stanje omrežne povezave.

Element prikaza Opis
Brezžični LAN Nastavitve brezžičnega 

omrežja in stanje povezave

Wired LAN Nastavitve žičnega omrežja 
LAN in stanje povezave

Modem Nastavitve brezžičnega 
omrežja in stanje povezave 
USB

Zaslon stanja prenosa datotek

Prikaže podatke o prenosu datotek.

Element prikaza Opis
Auto Upload 
(Proxy)

Stanje On/Off funkcije Auto 
Upload (Proxy)

Job Status 
(Remain / Total)

Preostalo število nalaganj in 
skupno število nalaganj

Total Transfer 
Progress

Napredek prenosa vseh 
nalaganj

Default Upload 
Server

Ime ciljnega strežnika za 
Auto Upload (Proxy)

Current File 
Transfer Progress

Napredek prenosa 
trenutnega prenosa 
datoteke

Current 
Transferring File 
Name

Ime datoteke, ki se trenutno 
prenaša

Server Address Naslov ciljnega strežnika za 
prenos datotek

Destination 
Directory

Ciljna mapa ciljnega 
strežnika za prenos datotek
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Uporaba zaslonov z nastavitvami na dotik

Postavitev zaslona

Element

Oznaka trenutne nastavitve

Gumb Set (uporabi)

Izbirnik nastavitve 
(oranžen okvirček)

Ime elementa

Možnosti izbire

Operacija

1	 Tapnite element nastavitve.

Dotaknite se

Prikažejo se izbirne možnosti za vrednost.

2	 Povlecite ali frcnite nastavitev, da izberete 
vrednost.

Frcnite

3	 Tapnite gumb Set ali izbirnik vrednosti.
Vrednost je dodeljena in znova se prikaže 
prejšnji zaslon.

[Nasveti]
ˎˎ Za vrnitev na prejšnjo vrednost pritisnite gumb 

CANCEL/BACK.
ˎˎ Uporabite lahko tudi večfunkcijsko kolesce ali 

večfunkcijski gumb.
ˎˎ Upravljanje na dotik lahko tudi izklopite (stran 93).
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Napajanje
Uporabite lahko paket baterij ali napajanje iz 
omrežnega napajalnika.
Iz varnostnih razlogov uporabljajte samo 
pakete baterij Sony in omrežne napajalnike, ki 
so navedeni spodaj.

Paketi litij-ionskih baterij
BP-U35 (priloženo)
BP-U60
BP-U60T
BP-U70
BP-U90
BP-U100

Polnilnika baterij
BC-CU1 (priloženo)
BC-U1A
BC-U2A

Omrežni napajalnik (priložen)
[OPOZORILO]

Paketov baterij ne shranjujte na mestih, 
izpostavljenih neposredni sončni svetlobi, 
plamenu ali visoki temperaturi.

[Opombe]
ˎˎ Za napajanje iz omrežnega vira uporabljajte samo 

priložen omrežni napajalnik.
ˎˎ Pred priklopom baterije ali omrežnega napajalnika 

vedno prestavite stikalo POWER v položaj Off. Če 
priklapljate, ko je stikalo POWER v položaju On, se 
videokamera v nekaterih primerih morda ne bo 
mogla zagnati. Če se videokamera ne more zagnati, 
prestavite stikalo POWER v položaj Off in začasno 
odklopite paket baterij ali omrežno napajanje. Pred 
ponovnim priklopom počakajte približno 30 sekund. 
(Če želite priključiti omrežni napajalnik medtem, ko 
se videokamera napaja iz paketa baterij, lahko to brez 
težav storite tudi, ko je stikalo POWER v položaju On.)

Uporaba paketa baterij

Za priklop paketa baterij, vstavite paket baterij 
v ležišče (stran 7) vse do konca, dokler gre. 
Nato ga potisnite navzdol, da se zaklene.

Za odstranitev paketa baterij pritisnite in 
zadržite gumb BATT RELEASE (stran 7), 
potisnite paket baterij navzgor in ga nato 
povlecite iz ležišča.

Gumb BATT 
RELEASE

[Opombe]
ˎˎ Pred priklopom paketa baterij, napolnite baterijo z 

namenskim polnilnikom baterij BC-CU1, BC-U1A ali 
BC‑U2A.
ˎˎ Če paket baterij polnite, ko je topel (na primer 

takoj po uporabi), se baterija morda ne bo povsem 
napolnila.

Preverjanje preostale napolnjenosti 
baterije

Ko snemate/predvajate z uporabo paketa 
baterij, je preostala napolnjenost baterije 
prikazana v iskalu (stran 11).

Ikona Pomen
91 % do 100 %

71 % do 90 %

51 % do 70 %

31 % do 50 %

11 % do 30 %

0 % do 10 %

Videokamera prikazuje preostalo napolnjenost 
baterije tako, da izračunava razpoložljiv čas 
uporabe s paketom baterij, če bo poraba 
energije še naprej takšna, kot je pri trenutni 
uporabi videokamere.

Če raven napolnjenosti paketa baterij 
postane nizka

Če preostala raven napolnjenosti baterije med 
delovanjem pade pod določeno raven (stanje 
Low Battery), vas na to opozorita sporočilo za 
nizko raven napolnjenosti baterije in utripajoč 
svetlobni indikator snemanja.
Če preostala raven napolnjenosti baterije pade 
pod raven, pri kateri je še mogoče delovanje 
(stanje Battery Empty), se pojavi sporočilo za 
izpraznjeno baterijo.
Zamenjajte paket baterij z napolnjenim 
paketom baterij.

Spreminjanje ravni opozoril

Tovarniško privzeto je raven Low Battery 
nastavljena na 10 % povsem napolnjene 
baterije in raven Battery Empty na 3 %. 

Nastavitve ravni opozoril lahko spremenite 
z uporabo možnosti Camera Battery Alarm 
(stran 94) v meniju Technical glavnega 
menija.

Polnjenje paketa baterij s priloženim 
polnilnikom baterij (BC-CU1)

1	 Omrežni napajalnik (priložen) priklopite na 
polnilnik baterij. Napajalni kabel (priložen) 
povežite z električno vtičnico.

2	 Vstavite baterijo v prostor za baterijo in jo 
potisnite v smeri puščice.
Lučka za polnjenje CHARGE zasveti 
oranžno in polnjenje se začne.

CHARGE, lučka

Omrežni napajalnik

Napajalni kabel
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Lučka CHARGE (oranžna)
Sveti:�Polnjenje
Utripa:�Napaka pri polnjenju ali pa je 

temperatura zunaj delovnega razpona 
in se polnjenje začasno prekine

ˎˎ Ko je baterija polna, lučka CHARGE na 
polnilniku baterij ugasne.
ˎˎ Uporabljate samo originalne baterije Sony.

čas polnjenja
Približen čas (v minutah) polnjenja, ko polnite 
popolnoma izpraznjen paket baterij.

Paket baterij Celoten čas polnjenja
BP-U35 120 min

[Opomba]
Če omrežni napajalnik odklopite iz polnilnika baterij in 
baterija ostane priklopljena na polnilnik baterij, se bo 
baterija začela prazniti.

Uporaba omrežnega napajanja

Priklop videokamere na omrežno napajanje 
vam omogoča uporabo brez skrbi glede 
potrebe po polnjenju paketa baterij.

Priključek DC IN

Omrežni napajalnik

Napajalni 
kabel

Omrežni napajalnik priklopite na priključek DC 
IN na videokameri. Napajalni kabel (priložen) 
povežite z električno vtičnico.

Če se izhodna napetost omrežnega 
napajalnika zniža

Če izhodna napetost omrežnega napajalnika 
med delovanjem pade pod določeno raven 
(stanje DC Low Voltage1), se pojavi sporočilo, 
ki vas obvesti, da se je izhodna napetost 
omrežnega napajalnika znižala. Hkrati začne 
utripati svetlobni indikator snemanja.
Če izhodna napetost omrežnega napajalnika 
pade na raven, pri kateri videokamera ne 
more več delovati (stanje DC Low Voltage2), se 
pojavi sporočilo, ki vas obvesti, da je izhodna 
napetost omrežnega napajalnika prenizka.
Če se to zgodi, pomeni, da je omrežni 
napajalnik lahko okvarjen. Preverite omrežni 
napajalnik.

Spreminjanje opozorilnih napetosti

Tovarniško privzeto je raven DC Low Voltage1 
nastavljena na 16,5 V in raven DC Low Voltage2 
na 15,5 V. Nastavitve ravni za opozorila lahko 
spremenite z uporabo možnosti Camera DC IN 
Alarm (stran 94) v meniju Technical.

Omrežni napajalnik

ˎˎ Omrežnega napajalnika ne priklopite in 
ne uporabljajte v omejenem prostoru, na 
primer med zidom in pohištvom.
ˎˎ Omrežni napajalnik priklopite v najbližjo 
električno vtičnico. Če se med delovanjem 
pojavi težava, takoj izvlecite napajalni kabel 
iz električne vtičnice.
ˎˎ Ne povzročite kratkega stika na kovinskih 
delih vtiča omrežnega napajalnika. To bi 
lahko povzročilo okvaro.
ˎˎ Baterije ni mogoče polniti, ko je priklopljena 
na videokamero, tudi če je priklopljen 
omrežni napajalnik.
ˎˎ Ko omrežni napajalnik odklopite z enote, 
primite vtič in ga izvlecite naravnost. Če 
boste vlekli kabel, lahko pride do okvare.
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Namestitev naprav

Pritrditev mikrofona 
(naprodaj posebej)

1	 Namestite mikrofon v držalo za mikrofon.

2	 Priključite kabel mikrofona v priključek 
INPUT1 ali INPUT2.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Mikrofon

Držalo za 
mikrofon

INPUT1 INPUT2

3	 Namestite kabel mikrofona v držalo kabla, 
kot je prikazano na skici.

Nosilec za kabel

[Nasveti]
ˎˎ Če mikrofona ne uspete trdno namestiti, uporabite 

priloženi distančnik.
ˎˎ Od vrste nameščenega objektiva je odvisno, ali bo na 

sliki videokamere vidna konica mikrofona. Nastavite 
položaj mikrofona.

Namestitev iskala

[Opomba]
Iskalo namestite/odstranite, ko je videokamera 
izklopljena.

Namestitev iskala na sprednji del držala

1	 Adapter z objemko za namestitev iskala 
vstavite v nastavek za iskalo na držalu () 
in privijte (priloženi) vijak v desno, da ga 
pritrdite na položaj ().
Adapter z objemko za namestitev lahko 
premikate v korakih po 45°, toda 
priporočamo položaj, pri katerem bo točka 
namestitve točno nad vijakom.

Vijak
Adapter z objemko 
za namestitev iskala

2	 Objemko iskala namestite na adapter z 
objemko za namestitev iskala () in 
obrnite zaklepni gumb v desno, da ga 
pritrdite v položaj ().

[Opomba]
Dobro zategnite zaklepni gumb, ko uporabljate iskalo. 
Če ni dobro zategnjen, se lahko iskalo sname.

3	 Poravnajte oznako  na videokameri z 
oznako  na priključku iskala in vstavite 
kabel.
Poskrbite, da je oznaka  na zunanji 
strani, preden vstavite priključek.

4	 Namestite kabel v držalo kabla, kot je 
prikazano na skici.

Nosilec za kabel
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Namestitev iskala na zadnji del držala

Na zadnji strani držala () in na zadnji strani 
videokamere () sta po dve točki za pritrditev 
iskala. Pritrdite iskalo na način, ki je opisan v 
razdelku »Namestitev iskala na sprednji del 
držala«.

Prilagajanje položaja iskala

Nagnite iskalo navzgor/navzdol, da nastavite 
kot iskala.
S stikalom MIRROR lahko obrnete sliko, 
ko jo na primer gledate s sprednje strani 
videokamere.

[Nasvet]
Ko enote ne uporabljate ali jo prevažate, vam 
priporočamo, da iskalo zaščitite tako, da ga premaknete 
v položaj, ki je prikazan na skici.

Odstranitev iskala

Odvijte zaklepni gumb iskala in sledite 
postopku za namestitev iskala v obratnem 
vrstnem redu.

Namestitev senčila iskala

1	 Odpnite kovinske sponke na senčilu 
iskala.

2	 Namestite kovinsko sponko na vrhu 
senčila iskala na kljuko na vrhu iskala in 
namestite kovinsko sponko na spodnji 
strani senčila iskala na kovinsko sponko 
na spodnji strani iskala.

Kljuke za pritrditev

3	 Potisnite zaklepno ploščico na spodnji 
strani senčila iskala v smeri puščice, da 
zaklenete senčilo iskala na svoje mesto.

Zaklepna 
ploščica

Odpiranje senčila iskala

Povlecite srednji spodnji del senčila iskala k 
sebi, nato pa ga povlecite, da odprete senčilo.

[Opomba]
Ko želite premakniti iskalo, primite ohišje iskala, nato pa 
ga premaknite Ne držite senčila iskala.

Odstranjevanje senčila iskala

Odpnite zaklep senčila iskala in ga snemite z 
iskala.

Namestitev držala z daljinskim 
upravljalnikom

[Opomba]
Držalo z daljinskim upravljalnikom namestite/odstranite, 
ko je videokamera izklopljena.

1	 Priključite kabel v priključek držala z 
daljinskim upravljalnikom.
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2	 Poravnajte nastavek za držalo z daljinskim 
upravljalnikom videokamere in oznako za 
namestitev na držalu (), pritrdite držalo 
na videokamero in ga počasi privijte v 
levo ().
Ko se zaklene v položaj, klikne.

Oznaka

[Opomba]
Če ga ne morete pravilno pritrditi, ga pritrdite znova 
brez pretiranega pritiskanja na držalo z daljinskim 
upravljalnikom ali videokamero.

3	 Vstavite kabel, ki ste ga priključili v 2. 
koraku, pod režo na držalu z daljinskim 
upravljalnikom, kot je prikazano na skici.

[Opomba]
Če kabel ni napeljan pod režo, bo ob spremembi kota 
nastavka za držalo nanj delovala prevelika sila ali pa se 
bo zataknil v obračalni mehanizem.

Nastavitev kota držala z daljinskim 
upravljalnikom

Kot držala z daljinskim upravljalnikom lahko 
nastavite v razponu, ki je prikazan na skici, 
tako, da bo ustrezal vašemu slogu snemanja.

Standardni položaj

Obrnjeno proti objektivu (največ 90°)

Obrnjeno nazaj (največ 83°)

1	 Ročico za vrtenje držala premaknite v 
položaj, ki je prikazan na skici, in obrnite 
držalo, ne da bi pritisnili ročico.

2	 Odmaknite prst z ročice za vrtenje držala, 
ko je blizu želenega položaja.

3	 Držalo rahlo premaknite, da klikne, kar 
pomeni, da je nameščeno v položaju.
Ko je držalo v svojem položaju, se ročica 
za vrtenje držala vrne v prvotni položaj.

[Opombe]
ˎˎ Po spremembi položaja vedno preverite, ali je držalo 

zaklenjeno v svojem položaju.
ˎˎ Kot nastavitve držala je omejen. Pri obračanju držala 

ne uporabljajte pretirane sile.

Držanje držala (priporočena metoda)

Ni pravil za držanje držala, toda na tem 
primeru lahko vidite, kako ga lahko enostavno 
uporabljate.

Uporaba gumba ASSIGN 5 ali večfunkcijskega 
gumba

A: S kazalcem upravljajte dodeljivo kolesce na 
držalu.
B: S palcem upravljajte večfunkcijski gumb in 
gumb ASSIGN 5.
C: S sredincem, prstancem in mezincem trdno 
držite držalo.



2 Priprava: Namestitev naprav22 SL

Uporaba zooma

A: Ročico zooma upravljajte s kazalcem in 
sredincem.
B: S palcem trdno držite držalo.
C: S prstancem in mezincem trdno držite 
držalo.

Odstranjevanje držala

[Opomba]
Pri odstranjevanju držala postavite videokamero na 
ravno površino, na primer na mizo.

1	 Odklopite kabel s priključka držala z 
daljinskim upravljalnikom.

2	 Pritisnite in pridržite gumb za sprostitev 
držala z daljinskim upravljalnikom na 
videokameri in odvijte držalo v desno, 
dokler se ne sname.

Gumb za sprostitev držala z 
daljinskim upravljalnikom

[Nasvet]
Na pritrdišče za držalo na enoti in na ustrezno pritrdišče 
na držalu lahko namestite rozeto.
Za informacije o nakupu rozet se obrnite na prodajalca 
izdelkov Sony.
–– Na videokameri: 4-546-932- (dodatna možnost)
–– Na držalu: 4-547-089- (dodatna možnost)
–– Vijaki za pritrditev* 

Na videokameri: 7-627-556- (dodatna možnost) 
Na držalu: 7-627-556- (dodatna možnost)

*	 Za vsako rozeto potrebujete štiri vijake (odprtine 
za vijake so na skici označene s krožci). Če 
uporabite druge vijake namesto priporočenih, lahko 
poškodujete zunanjo površino.

Na 
videokameri

Na držalu

Namestitev objektiva

[OPOZORILO]

Objektiva ne puščajte obrnjenega proti soncu. 
Neposredna sončna svetloba lahko vstopi 
skozi objektiv, se zbere v točki v videokameri 
in povzroči požar.

[Opombe]
ˎˎ Objektiv namestite/odstranite, ko je videokamera 

izklopljena.
ˎˎ Objektiv je zelo natančen izdelek. Objektiva ne 

polagajte na površino obrnjenega z nastavkom 
navzdol. Namestite priložen pokrovček za objektiv.

[Nasvet]
Za podrobnosti o podprtih objektivih se obrnite na 
servisnega predstavnika podjetja Sony.

Namestitev objektiva serije E

1	 Snemite pokrovček objektiva in pokrov z 
videokamere in objektiva.

2	 Poravnajte oznako za namestitev 
objektiva (belo) z videokamero in 
previdno nataknite objektiv, nato pa ga 
zasukajte v desno.
Ko se zaklene v položaj, klikne.

Namestitvene oznake (bele barve)

[Opomba]
Pri nameščanju objektiva ne pritisnite gumba za 
sprostitev objektiva.

Namestitev objektiva serije A

Za uporabo objektiva serije A namestite 
adapter z nastavkom za objektiv (možnost) in 
nato namestite objektiv serije A.

[Opomba]
Pri uporabi objektiva serije A se zaslonka nastavlja ročno 
in ostrenje je nastavljeno na ročno ostrenje.

Odstranitev objektiva

Objektiv odstranite po sledečem postopku.

1	 Pritisnite in pridržite gumb za sprostitev 
objektiva in zasukajte objektiv v levo, 
medtem ko ga držite.

2	 Izvlecite objektiv v smeri naprej.

[Opombe]
ˎˎ Ko odstranjujete objektiv, poravnajte namestitveno 

oznako na obroču za zaklepanje objektiva z 
namestitveno oznako na videokameri.
ˎˎ Z roko čvrsto držite objektiv, da preprečite njegov 

padec.
ˎˎ Če ne boste takoj namestili drugega objektiva, vedno 

namestite pokrovček ohišja.

Prilagajanje zaslonke pri objektivih s 
stikalom Auto Iris

ˎˎ Ko je stikalo Auto Iris na objektivu 
nastavljeno na AUTO, se zaslonka prilagaja 
samodejno, lahko pa jo tudi prilagajate 
ročno na videokameri.
ˎˎ Ko je stikalo Auto Iris na objektivu 
nastavljeno na MANUAL, lahko zaslonko 
nastavljate samo z obročem na objektivu. 
Upravljanje zaslonke na videokameri nima 
učinka.
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Prilagajanje ostrenja pri objektivih s 
stikalom ostrenja

ˎˎ Ko je stikalo ostrenja na objektivu 
nastavljeno na AF/MF ali AF, se ostrenje 
prilagaja samodejno, lahko pa ga prilagajate 
tudi ročno z daljinskim upravljalnikom.
ˎˎ Ko je stikalo ostrenja na objektivu 
nastavljeno na MF, lahko ostrenje prilagajate 
z obročem na objektivu ali prav tako ročno z 
daljinskim upravljalnikom.

	 [Opomba]
Ob uporabi objektiva serije A ročno prilagajanje z 
daljinskim upravljalnikom morda ne bo na voljo.

ˎˎ Ko je stikalo ostrenja na objektivu 
nastavljeno na Full MF, lahko ostrenje 
prilagajate samo z obročem za ostrenje. 
Upravljanje ostrenja na videokameri nima 
učinka.

Namestitev stojala

Pri nameščanju videokamere na stojalo 
uporabite vijačne odprtine za stojalo na 
videokameri. Uporaba nosilca za stojalo na 
objektivu lahko povzroči poškodbe.
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Nastavitev osnovnih funkcij videokamere
Prvič, ko vklopite videokamero ali po popolni 
izpraznitvi pomožne baterije, se v iskalu 
prikaže zaslon začetnih nastavitev.
Na tem zaslonu nastavite datum in čas 
vgrajene ure.

Time Zone
Z možnostjo Time Zone nastavite razliko do 
časa UTC (univerzalni koordinirani čas). Po 
potrebi spremenite nastavitev.

Nastavitev datuma in časa

Z večfunkcijskim gumbom (stran 7) ali 
večfunkcijskim kolescem (stran 5) izberite 
elemente in nastavitve, nato pa pritisnite 
gumb na sredini večfunkcijskega gumba ali 
večfunkcijskega kolesca, da potrdite nastavitve 
in sprožite uro.
Ko se zaslon nastavitev zapre, lahko datum, 
čas in časovni pas spremenite z uporabo 
možnosti Clock Set (stran 99) v meniju 
Maintenance.

[Opombe]
ˎˎ Če se nastavitev ure izbriše, ker se pomožna baterija 

popolnoma izprazni, do česar pride ob daljšem 
odklopu napajanja (priklopljen ni niti paket baterij, 
niti omrežno napajanje), se bo ob naslednjem vklopu 
videokamere prikazal zaslon začetnih nastavitev.
ˎˎ Ko je prikazan zaslon začetnih nastavitev, ne morete 

uporabljati videokamere – lahko jo le izklopite – 
dokler ne opravite nastavitev na tem zaslonu.
ˎˎ Videokamera ima vgrajeno akumulatorsko baterijo za 

shranjevanje datuma, časa in ostalih nastavitev, tudi 
ko je videokamera izklopljena.

Pred snemanjem nastavite osnovno delovanje 
videokamere na zaslonu Project status, da bo 
ustrezalo namenu uporabe.

4/12
Frequency/Scan

59.94P
Imager Scan

FF
Shooting Mode

Custom (709)
Codec

XAVC-I
Video Format

2160P3840
RAW Output Format

- - -
Rec Function

O�
Simul Rec

O�
Proxy Rec

O�
Title Prefix

000_
Number

0001

Project

Shooting Mode

Izbirate lahko med načinom snemanja 
»Custom mode« za fleksibilno ustvarjanje 
posnetkov na mestu snemanja in načinom 
snemanja »Cine EI« (v katerem videokamera 
deluje podobno kot filmska kamera, kjer se 
'razvijanje' posnetega materiala izvede v 
postprodukciji).
Nastavite način snemanja s funkcijo Shooting 
Mode (stran 14) na zaslonu Project status.

[Nasvet]
Način snemanja lahko nastavite tudi z nastavitvijo Base 
Setting > Shooting Mode (stran 77) v meniju Project 
glavnega menija.

Način Custom

V načinu snemanja Custom lahko izberete 
video standard.
Video standard lahko nastavite z nastavitvijo 
Base Setting > Target Display (stran 77) v 
meniju Project glavnega menija.
ˎˎ SDR(BT.709): Snemanje v skladu s 
standardom oddajanja v visoki ločljivosti
ˎˎ HDR(HLG): Snemanje v skladu s standardom 
oddajanja v ločljivosti 4K naslednje 
generacije

Za podrobnosti glejte razdelek 52.

Način Cine EI

Ko je način snemanja nastavljen na način Cine 
EI, izberite barvni prostor za signal snemanja 
in izhodni signal. Tukaj izbran barvni prostor 
je barvni prostor video izhoda, ko je MLUT 
nastavljen na Off.
Barvni prostor lahko nastavite s funkcijo Cine 
EI Setting > Color Gamut (stran 78) v meniju 
Project glavnega menija.
ˎˎ S-Gamut3.Cine/SLog3: Enostavno nastavljiv 
barvni obseg za digitalni kino (DCI-P3).
ˎˎ S-Gamut3/SLog3: Sonyjeva široka barvna 
lestvica, ki zajema barvni prostor ITU-R 
BT.2020.

Za podrobnosti glejte razdelek 54.

[Opombe]
ˎˎ Način Cine EI ima sledeče omejitve.

ˎˎ Funkcije, ki jih ni mogoče prilagoditi samodejno 
(sledenje)
–– White balance (Nastavitev beline)
–– Ojačitev
–– Zaklop

ˎˎ Funkcije, ki jih ni mogoče konfigurirati
–– Občutljivost ISO/ojačitev (nastavljeno na 

osnovno občutljivost ISO (fiksno))
–– Nastavitve menija Paint/Look (razen Base 

Look)
–– Scenska datoteka (onemogočeno)

ˎˎ Naslednje funkcije so na voljo samo v načinu Cine EI 
(stran 54).

ˎˎ Indeks osvetlitve
ˎˎ Monitor LUT

Sistemska frekvenca

Nastavite frekvenco sistema z nastavitvijo 
Frequency/Scan (stran 14) na zaslonu 
Project status. Videokamera se lahko po 
preklopu samodejno ponovno zažene, kar je 
odvisno od izbrane vrednosti.

[Nasvet]
Frekvenco sistema lahko nastavite tudi z nastavitvijo 
Rec Format > Frequency (stran 77) v meniju Project 
glavnega menija.

[Opomba]
Sistemske frekvence ne morete spremeniti med 
snemanjem ali predvajanjem.

Imager Scan Mode

Nastavite lahko efektivno velikost slike in 
ločljivost slikovnega senzorja.
Način skeniranja nastavite z nastavitvijo 
Imager Scan (stran 14) na zaslonu Project 
status.
ˎˎ FF: Velikost polnega formata.
ˎˎ S35: Velikost Super 35 mm.

[Nasvet]
Način skeniranja lahko nastavite tudi z nastavitvijo 
Rec Format > Imager Scan Mode (stran 77) v meniju 
Project glavnega menija.

[Opombe]
ˎˎ Načina zajemanja slike ne morete spreminjati med 

snemanjem ali predvajanjem.
ˎˎ Ko je nastavljen na S35, je video format omejen na 

ločljivost 1920×1080.

Kodek

Nastavite kodek z možnostjo Codec 
(stran 14) na zaslonu Project status.

[Nasvet]
Kodek lahko nastavite tudi z nastavitvijo Rec Format > 
Codec (stran 77) v meniju Project glavnega menija.

[Opomba]
Kodeka ne morete spreminjati med snemanjem ali 
predvajanjem.
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Video Format

Nastavite lahko video format za snemanje. 
Nastavite video format z možnostjo Video 
Format (stran 14) na zaslonu Project status.

[Nasvet]
Video format lahko nastavite tudi z nastavitvijo Rec 
Format > Video Format (stran 77) v meniju Project 
glavnega menija.

[Opombe]
ˎˎ Video formata ne morete spreminjati med 

snemanjem ali predvajanjem.
ˎˎ Pri signalu na priključkih SDI OUT in HDMI OUT lahko 

obstajajo omejitve, kar je odvisno od nastavljenega 
video formata.
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Videokamera snema zvok in video na pomnilniške kartice CFexpress 
tipa A (naprodaj posebej) ali pomnilniške kartice SDXC (naprodaj posebej), ki jih vstavite v reže 
za kartice. Pomnilniške kartice se uporabljajo tudi za proxy snemanje in shranjevanje/nalaganje 
nastavitev ter pri nadgradnji (posodobitvi programske opreme).

Več o pomnilniških karticah CFexpress tipa A

Uporabljajte pomnilniške kartice Sony CFexpress tipa A*, ki so navedene »Priporočeni mediji« 
(stran 27) v videokameri.
Za podrobnosti o delovanju s pomnilniškimi karticami drugih proizvajalcev glejte navodila za 
uporabo konkretnega pomnilniškega medija ali poiščite proizvajalčeve podatke.
* �V tem dokumentu se uporablja izraz »CFexpress cards«.

Več o pomnilniških karticah SDXC

Uporabljajte pomnilniške kartice SDXC*, ki so navedene »Priporočeni mediji« (stran 27) v 
videokameri.
* �V tem dokumentu se uporablja izraz »SD cards«.

Uporaba pomnilniških kartic
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Priporočeni mediji

Zagotovljeni pogoji delovanja se razlikujejo glede na format snemanja in nastavitev snemanja.
Da: Podprto delovanje
Ne: Normalno delovanje ni zagotovljeno

Format zapisovanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096×2160
Class300

Način Normal 59,94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

24P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

3840×2160
Class300

Način Normal 59,94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (60 sličic na sekundo ali manj) 59,94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da
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Format zapisovanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Način Normal 59,94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

24P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (60 sličic na sekundo ali manj) 59,94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

24P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

3840×2160
Class300 

Način Normal 59,94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (60 sličic na sekundo ali manj) 59,94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (100 sličic na sekundo, 
120 sličic na sekundo)

59,94P Da Ne Ne Ne Ne Ne Ne Ne

50P Da Ne Ne Ne Ne Ne Ne Ne

29,97P Da Ne Ne Ne Ne Ne Ne Ne

25P Da Ne Ne Ne Ne Ne Ne Ne

23,98P Da Ne Ne Ne Ne Ne Ne Ne
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Format zapisovanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Način Normal 59,94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (60 sličic na sekundo ali manj) 59,94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (100 sličic na sekundo, 
120 sličic na sekundo)

59,94P Da Ne Ne Ne Ne Ne Ne Da

50P Da Ne Ne Ne Ne Ne Ne Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (150 sličic na sekundo, 
180 sličic na sekundo)

59,94P Da Ne Ne Ne Ne Ne Ne Ne

50P Da Ne Ne Ne Ne Ne Ne Ne

29,97P Da Ne Ne Ne Ne Ne Ne Ne

25P Da Ne Ne Ne Ne Ne Ne Ne

23,98P Da Ne Ne Ne Ne Ne Ne Ne

S&Q (200 sličic na sekundo, 
240 sličic na sekundo)

59,94P Da Ne Ne Ne Ne Ne Ne Ne

50P Da Ne Ne Ne Ne Ne Ne Ne

29,97P Da Ne Ne Ne Ne Ne Ne Ne

25P Da Ne Ne Ne Ne Ne Ne Ne

23,98P Da Ne Ne Ne Ne Ne Ne Ne
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Format zapisovanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Način Normal 59,94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (60 sličic na sekundo ali manj) 59,94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (100 sličic na sekundo, 
120 sličic na sekundo)

59,94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Ne

1920×1080
HD50

Način Normal 59,94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (60 sličic na sekundo ali manj) 59,94P Da Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (100 sličic na sekundo, 
120 sličic na sekundo)

59,94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da
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Format zapisovanja CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150 sličic na sekundo, 
180 sličic na sekundo)

59,94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (200 sličic na sekundo, 
240 sličic na sekundo)

59,94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

1920×1080
HD35

Način Normal 59,94P Da Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da Da

29,97P Da Da Da Da Da Da Da Da

25P Da Da Da Da Da Da Da Da

23,98P Da Da Da Da Da Da Da Da

S&Q (60 sličic na sekundo ali manj) 59,94P Da Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (100 sličic na sekundo, 
120 sličic na sekundo)

59,94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (150 sličic na sekundo, 
180 sličic na sekundo)

59,94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da

S&Q (200 sličic na sekundo, 
240 sličic na sekundo)

59,94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Ne Da
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Vstavljanje pomnilniške kartice

1	 Odprite pokrov reže za pomnilniško 
kartico.

2	 Vstavite pomnilniško kartico.
ˎˎ Pri karticah CFexpress mora biti nalepka 
na levi strani.

Oznaka

ˎˎ Pri karticah SD mora biti nalepka na 
desni strani, z zaobljenim vogalom na 
dnu.

Zaobljen vogal

Indikator dostopa (stran 6) zasveti v 
rdeči barvi in če je kartica uporabna, se 
barva spremeni v zeleno.

	 [Opomba]
Če indikator dostopa neprekinjeno utripa rdeče 
in ne preklopi na zeleno, začasno izklopite 
videokamero in odstranite ter ponovno vstavite 
pomnilniško kartico.

3	 Zaprite pokrov reže za pomnilniško 
kartico.

[Opombe]
ˎˎ Če poskušate pomnilniško kartico vstaviti v 

nepravilnem položaju in s silo, se pomnilniška kartica, 
reža za pomnilniško kartico in podatki na pomnilniški 
kartici lahko poškodujejo.
ˎˎ Ko snemate na pomnilniški kartici, vstavljeni v reži A 

in B za kartice CFexpress tipa A/SD, v obe reži vstavite 
takšni kartici, kot sta priporočeni za snemanje v 
izbranem formatu.

Odstranjevanje pomnilniške kartice

Odprite pokrov reže za pomnilniško kartico in 
rahlo pritisnite na pomnilniško kartico, da jo 
izvržete.

[Opombe]
ˎˎ Celovitost podatkov na kartici ne bo zagotovljena, 

če izklopite videokamero ali odstranite pomnilniško 
kartico medtem, ko je dostop do kartice še v teku. 
Vsi podatki, zapisani na kartici, bodo lahko zavrženi. 
Vedno se prepričajte, da je indikator dostopa 
izklopljen preden izklopite videokamero ali odstranite 
pomnilniško kartico.
ˎˎ Če pomnilniško kartico odstranite takoj po 

zaključenem snemanju, je pomnilniška kartica lahko 
še vroča, kar ni znak težav.

Formatiranje (ponastavitev) 
pomnilniških kartic

Če vstavite neformatirano pomnilniško kartico 
ali pomnilniško kartico, ki je bila formatirana z 
drugačnimi specifikacijami, se v iskalu pojavi 
sporočilo »Media Needs to be Formatted«.

Kartico formatirajte po naslednjem postopku.

1	 Izberite možnost Format Media 
(stran 86) v meniju TC/Media glavnega 
menija.

2	 Izberite možnost Media(A) (reža A) ali 
Media(B) (reža B), nato pa izberite način 
formatiranja (Full Format ali Quick Format).
Prikaže se potrditveno sporočilo.
ˎˎ Full Format: Popolna ponastavitev 
medija, vključno z informacijami o regiji 
podatkov in upravljanju podatkov.
ˎˎ Quick Format: Samo ponastavitev 
informacij o upravljanju podatkov 
medija.

3	 Izberite Execute.
Ko je formatiranje v teku, je prikazano 
sporočilo. Indikator dostopa sveti rdeče.
Ko je formatiranje zaključeno, se prikaže 
sporočilo o zaključku. Pritisnite 
večfunkcijsko kolesce, da zaprete 
sporočilo.

[Opombe]
ˎˎ Formatiranje pomnilniške kartice izbriše vse 

podatke, vključno z videoposnetki in nastavitvenimi 
datotekami.
ˎˎ Med izvajanjem se lahko izpišejo sporočila, kar je 

odvisno od trajanja postopka formatiranja.

Če formatiranje ne uspe

Pomnilniških kartic, ki jih videokamera ne 
podpira, ni mogoče formatirati.
Prikaže se opozorilno sporočilo. Sledite 
navodilom in zamenjajte kartico s podprto 
pomnilniško kartico.

Uporaba kartice SD, formatirane v 
videokameri, v reži druge naprave

Najprej naredite varnostno kopijo kartice, nato 
ponovno formatirajte kartico v napravi, v kateri 
bo uporabljena.

Preverjanje preostalega časa 
snemanja

Med snemanjem (snemanje/stanje 
pripravljenosti) lahko nadzorujete preostali 
prostor na pomnilniški kartici v vsaki reži. To 
storite z uporabo indikatorjev preostalega časa 
snemanja za režo A/B v iskalu (stran 11).
Preostali čas snemanja se izračunava na 
podlagi preostalega prostora na pomnilniškem 
mediju v vsaki reži in trenutnega video 
formata (bitna hitrost snemanja). Prikazan je v 
obliki minut.

Kdaj zamenjati pomnilniško kartico

ˎˎ Ko preostali čas snemanja na obeh 
pomnilniških karticah pade pod 5 minut, se 
izpiše sporočilo »Media Near Full«. Dodatno 
začne utripati svetlobni indikator snemanja 
in zasliši se zvočno opozorilo (na izhodu za 
slušalke).  
Zamenjajte pomnilniški medij s praznim.
ˎˎ Če nadaljujete s snemanjem dokler preostali 
čas snemanja ne doseže ničle, se sporočilo 
spremeni v »Media Full« in snemanje se 
ustavi.

[Opomba]
Na eno pomnilniško kartico je mogoče posneti do 
približno 600 posnetkov.
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Obnovitev pomnilniških kartic

Če pride iz kateregakoli vzroka do napake 
na pomnilniški kartici, morate kartico pred 
uporabo obnoviti.
Ko vstavite pomnilniško kartico, ki jo je treba 
obnoviti, se v iskalu izpiše sporočilo, ki vas 
vpraša, ali jo želite obnoviti.

Obnovitev kartice

Obrnite večfunkcijsko kolesce (stran 5), da 
izberete možnost Execute, nato pa pritisnite 
večfunkcijsko kolesce.
Ko je formatiranje v teku, sta prikazana 
sporočilo in stanje napredka (%). Indikator 
dostopa sveti rdeče.
Ko je obnovitev zaključena, se prikaže 
sporočilo o zaključku.

Če obnovitev ne uspe

ˎˎ Pomnilniških kartic, na katerih je prišlo do 
pomnilniških napak, ni mogoče obnoviti. 
Prikaže se opozorilno sporočilo. Sledite 
navodilom za zamenjavo pomnilniške 
kartice.
ˎˎ Pomnilniške kartice, na katerih je prišlo 
do pomnilniških napak, lahko postanejo 
uporabne, če jih ponovno formatirate.
ˎˎ V nekaterih primerih je nekatere posnetke 
mogoče obnoviti, drugih ne. Obnovljene 
posnetke je mogoče normalno predvajati.

[Opombe]
ˎˎ Prepričajte se, da za obnovitev pomnilniških medijev 

uporabljate videokamero, s katero so bili ti posneti.
ˎˎ Pomnilniških medijev, posnetih z drugo napravo ali z 

videokamero drugačne različice (celo istega modela), 
morda ne bo mogoče obnoviti s to videokamero.
ˎˎ Posnetkov, ki so krajši od 2 sekund, ni mogoče 

obnoviti.
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Postopek osnovnega upravljanja
Osnovno snemanje izvedete po sledečem 
postopku.

1	 Priklopite potrebne naprave in preverite, 
da je prisotno napajanje.

2	 Vstavite pomnilniško kartico.

3	 Stikalo POWER prestavite v položaj za 
vklop.
Vklopi se indikator POWER in v iskalu se 
prikaže slika kamere.

4	 Pritisnite gumb za snemanje START/STOP 
(stran 5).
Svetlobni indikator, ki označuje snemanje, 
zasveti in snemanje se začne.

5	 Če želite zaustaviti snemanje, znova 
pritisnite gumb za snemanje START/STOP.
Snemanje se ustavi in videokamera 
preklopi v način STBY (stanje 
pripravljenosti).

[Opomba]
Če gumb za snemanje START/STOP pritisnete v nekaj 
sekundah po vklopu videokamere, svetlobni indikator, 
ki označuje snemanje, zasveti, kar označuje, da poteka 
snemanje. Toda zapisovanje na pomnilniški medij lahko 
v tem primeru zakasni za nekaj sekund, odvisno od 
izbranega snemalnega formata.

Preklapljanje med pomnilniškima 
karticama

Ko sta vstavljeni dve pomnilniški kartici, 
pritisnite gumb SLOT SELECT (stran 6), da 
preklopite med karticama.
Zapisovanje se samodejno preklopi na 
drugo pomnilniško kartico tik preden se 
prva pomnilniška kartica zapolni (preklopno 
snemanje). Z neprekinjenim snemanjem lahko 
nadaljujete z zamenjavo pomnilniške kartice, 
tako da polno pomnilniško kartico zamenjate 
z novo.

[Opomba]
Med pomnilniškima karticama ne morete preklapljati v 
načinu predvajanja. Dodatno, neprekinjeno predvajanje 
posnetka, ki se delno nahaja na pomnilniški kartici v reži 
A in delno na pomnilniški kartici v reži B, ni podprto.

Posnetki (posneti podatki)
Ko ustavite snemanje, se video, zvočni in 
spremljajoči podatki od začetka do konca 
snemanja shranijo v en sam »posnetek« na 
pomnilniški kartici.

Imena posnetkov
Ime vsakega posnetka, ki ga posname 
videokamera, je samodejno ustvarjeno s 
formatom, kot je nastavljen v razdelku Clip 
Name Format (stran 86) v meniju TC/Media 
glavnega menija.

Najdaljše trajanje posnetka
Do 6 ur na posnetek.
Najdaljše trajanje neprekinjenega snemanja 
je enako najdaljšemu trajanju posnetka. 
Če čas snemanja preseže najdaljše trajanje 
posnetka, se samodejno ustvari nov posnetek 
in snemanje se nadaljuje. Nov posnetek se na 
zaslonu sličic prikaže kot ločen posnetek.

Med preklopnim snemanjem se posname večje 
število posnetkov, kljub temu pa se bo snemanje 
samodejno ustavilo po približno 24 urah.

[Opombe]
ˎˎ Ne odstranjujte pomnilniške kartice medtem, ko 

poteka snemanje. Med snemanjem lahko zamenjate 
pomnilniške kartice samo v tistih režah, katerih 
indikator dostopa je izklopljen.
ˎˎ Ko preostala kapaciteta pomnilniške kartice, na katero 

se trenutno snema, znaša manj kot minuto, ter je v 
drugi reži vstavljena prazna pomnilniška kartica, se 
prikaže sporočilo »Will Switch Slots Soon«. Sporočilo 
izgine po preklopu med režama za pomnilniške 
kartice.
ˎˎ Preklopno snemanje morda ne bo delovalo, če 

začnete snemati, ko preostala kapaciteta pomnilniške 
kartice znaša manj kot minuto. Da bo preklopno 
snemanje potekalo pravilno, pred začetkom snemanja 
preverite, da preostala kapaciteta pomnilniške kartice 
znaša več kot minuto.
ˎˎ Videa, ki ga ustvarite s funkcijo preklopnega 

snemanja v videokameri, ni mogoče neprekinjeno 
predvajati na videokameri.
ˎˎ Za združitev videoposnetkov, ustvarjenih s funkcijo 

preklopnega snemanja, uporabite programsko 
opremo »Catalyst Browse«.

Nadzor zvoka

Zvok, ki ga snemate, lahko nadzirate z 
uporabo slušalk.
Priklop slušalk v vtičnico za slušalke 
(stran 5) vam omogoča, da nadzirate 
zvok, ki ga snemate. Zvok lahko nadzirate tudi 
med predvajanjem (stran 64) z uporabo 
vgrajenega zvočnika (stran 6) ali slušalk.
Nastavite lahko glasnost zvoka, ki ga 
nadzirate, s funkcijo Volume (stran 14) 
na zaslonu Audio Status ali Audio Output 
>Volume (stran 92) v meniju Audio 
glavnega menija.
Izberete lahko kanal, ki ga nadzirate, s 
funkcijo Monitor CH (stran 14) na zaslonu 
Audio Status ali Audio Output >Monitor CH 
(stran 91) v meniju Audio glavnega menija.

Določanje podatkov o času

Nastavitev časovne kode

Nastavite časovno kodo za snemanje s 
funkcijo Timecode (stran 85) v meniju TC/
Media glavnega menija.

Nastavitev uporabniških bitov

Posneti sliki lahko dodate 8-mestno 
šestnajstiško število kot uporabniške bite. 
Uporabniške bitne podatke lahko nastavite 
tudi trenutnemu času. Uporabo uporabniških 
bitov nastavite (stran 85) v meniju TC/
Media.

Prikaz podatkov o času

Nastavite prikaz časovne kode z uporabo 
funkcije TC Display (stran 85) >Display 
Select v meniju TC/Media.
S pritiskom na dodeljiv gumb (stran 48) 
z dodeljeno funkcijo DURATION/TC/U-BIT, 
preklopite med prikazom časovne kode, 
uporabniških bitov in trajanjem v sekvenci.

Preklop med vhodom/izhodom časovne 
kode

Med vhodom/izhodom časovne kode lahko 
preklopite z izbirnim stikalom TC IN/OUT 
(stran 4).
Za podrobnosti glejte razdelek page 107.
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Ogled posnetka (Rec Review)

Zadnji posneti videoposnetek si lahko 
ogledate na zaslonu (recording review).

[Opomba]
Funkcija ogleda posnetka ne deluje, če po snemanju 
posnetka spremenite video format.

Kako si ogledati posnetek

Najprej enemu od dodeljivih gumbov dodelite 
funkcijo Rec Review za ogled posnetka.
Ko je snemanje ustavljeno, pritisnite dodeljivi 
gumb (stran 48), ki ste mu dodelili funkcijo 
Rec Review za ogled posnetka. Začne se 
predvajanje zadnjega videoposnetka.
Videoposnetek se predvaja do konca, ogled 
posnetka se zaključi in videokamera se vrne v 
način STBY (stanje pripravljenosti).

Za zaustavitev ogleda posnetka

Pritisnite dodeljiv gumb, ki ste mu dodelili 
funkcijo Rec Review za ogled posnetka ali 
pritisnite gumb CANCEL/BACK.

Nastavitve ogleda posnetka

Začetek predvajanja pri ogledu posnetka lahko 
nastavite na eno od sledečih možnosti. To 
storite z nastavitvijo Rec Review (stran 93) v 
meniju Technical.
ˎˎ Predvajanje zadnjih 3 sekund videoposnetka
ˎˎ Predvajanje zadnjih 10 sekund 
videoposnetka
ˎˎ Predvajanje od začetka videoposnetka

[Nasvet]
Če si želite ogledati točno določen videoposnetek 
po tem, ko ste posneli več videoposnetkov, pritisnite 
tipko THUMBNAIL za prikaz zaslona sličic in izberite 
videoposnetek za začetek predvajanja.
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Zoom lahko prilagajate glede na razmere 
snemanja.

Ko je nameščen objektiv s samodejnim 
zoomom, lahko zoom prilagajate z ročico za 
zoom na držalu z daljinskim upravljalnikom ali 
ročaju. Hitrost zooma je odvisna od pritiska na 
ročico.
Videokamera je opremljena s funkcijo zooma, 
ki uporablja obdelavo signala slike, ki se 
imenuje Clear Image Zoom. Ko je vklopljena 
funkcija Clear Image Zoom, zoom podpirajo 
tudi objektivi s fiksno goriščno razdaljo. 
Uporablja se lahko tudi za večji razpon, ki je 
večji od optičnega razpona na objektivu s 
samodejnim zoomom.
Največje razmerje zooma s funkcijo Clear 
Image Zoom se razlikuje in je odvisno od 
ločljivosti snemanja.
ˎˎ Za ločljivost snemanja QFHD/4K: 1,5 ×
ˎˎ Za ločljivost snemanja v visoki ločljivosti: 2 ×

Izbiranje vrste zooma

Nastavite vrsto zooma z nastavitvijo Zoom 
>Zoom Type (stran 93) v meniju Technical 
glavnega menija.
Vrsta zooma bo odvisna od vrste 
nameščenega objektiva.

Nameščen 
objektiv

Nastavitev Zoom Type
Samo optični 
zoom

On (Clear 
Image Zoom)

Objektiv s 
fiksno goriščno 
razdaljo/
objektiv z 
ročnim 
zoomom

Upravljanje 
zooma z 
ročico ni 
podprto.

Funkcija Clear 
Image Zoom je 
podprta.

Nameščen 
objektiv

Nastavitev Zoom Type
Samo optični 
zoom

On (Clear 
Image Zoom)

Objektiv z 
zoomom 
Power

Optical zoom 
only

Optični zoom 
in funkcija 
Clear Image 
Zoom sta 
podprta.

[Opombe]
ˎˎ Funkcija Clear Image Zoom ni na voljo v naslednjih 

primerih.
–– Ko je nastavitev S&Q Motion >Frame Rate 

(stran 76) v meniju Shooting glavnega menija 
višja od 60 sličic na sekundo.

–– Ko je nastavitev Rec Format >Codec (stran 77) 
v meniju Project glavnega menija nastavljena na 
RAW ali na možnost, ki vključuje RAW.

ˎˎ Z izbirnim stikalom SERVO/MANUAL na objektivu 
ponastavite povečavo funkcije Clear Image Zoom na 
1×.
ˎˎ Med delovanjem funkcije Clear Image Zoom 

je območje ostrenja nastavljeno na Wide in je 
izklopljena funkcija samodejnega ostrenja z 
zaznavanjem obrazov/oči.

Nastavitev funkcije Handle Zoom

Nastavite nastavitev zooma na držalu s 
funkcijo Handle Zoom (stran 93) v meniju 
Technical glavnega menija.

Nastavitev smeri obračanja obroča 
za zoom

Na nekaterih objektivih E-mount lahko obrnete 
smer obračanja obroča za zoom.
Nastavite smer obračanja z nastavitvijo Lens 
> Zoom Ring Direction (stran 94) v meniju 
Technical glavnega menija.

Nastavitev zooma
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Prilagajanje ostrenja
Ostrenje lahko prilagajate samodejno ali ročno 
glede na razmere snemanja.

Ročno prilagajanje ostrenja 
(Ročno ostrenje)

Za ročno prilagajanje ostrenja, prestavite 
stikalo FOCUS (stran 4) v položaj »MAN«.
To vam omogoča ročno prilagajanje ostrenja 
glede na razmere snemanja.
Ročno ostrenje je primerno za naslednje tipe 
subjektov.
ˎˎ Subjekti na oddaljeni strani okna, ki je 
prekrito z vodnimi kapljicami
ˎˎ Subjekti z nizkim kontrastom glede na 
ozadje
ˎˎ Subjekti, ki so glede na bližnje subjekte bolj 
oddaljeni

[Nasvet]
V naslednjih primerih lahko uporabite tudi samodejno 
ostrenje, ko je ročna nastavitev glavna metoda 
upravljanja.
ˎˎ Ko je občutljivost samodejnega ostrenja pri prehodu 

med subjekti nastavljena na 1 (zaklenjena).
ˎˎ Ko je stikalo FOCUS nastavljeno v položaj »AF«.
ˎˎ Ko uporabljate obroč za ostrenje (AF Assist, 39).

Samodejno prilagajanje ostrenja 
(Samodejno ostrenje)

Videokamera uporablja samodejno ostrenje 
s faznim zaznavanjem za hitro ostrenje ter 
samodejno ostrenje z zaznavanjem kontrasta 
za visoko natančnost ostrenja.
Kombinacija teh dveh načinov omogoča 
samodejno ostrenje, ki je hitro in zelo 
natančno.
Za samodejno prilagajanje ostrenja prestavite 
stikalo FOCUS (stran 4) na videokameri 
v položaj »AUTO«. Če je objektiv opremljen s 
stikalom za izbiro načina ostrenja, prestavite 
stikalo v položaj »AF/MF« ali »AF«. Če je 
stikalo v položaju »Full MF« ali »MF«, ostrenja 
objektiva ni mogoče upravljati z videokamere 
(stran 23).

[Nasvet]
Ko je možnost Focus >AF Assist (stran 75) v meniju 
Shooting glavnega menija vklopljena, lahko med 
samodejnim ostrenjem še vedno tudi ročno prilagajate 
ostrenje z obročem za ostrenje na objektivu.

[Opombe]
ˎˎ Zahtevan je objektiv, ki podpira samodejno ostrenje.
ˎˎ Glede na razmere snemanja morda ne bo dosežena 

želena natančnost ostrenja.
ˎˎ Ostrenja ni mogoče prilagajati samodejno na 

objektivih serije A.

Nastavitev območja/položaja 
samodejnega ostrenja (Območje 
ostrenja)

Ciljno območje samodejnega ostrenja lahko 
nastavite prek možnosti Focus >Focus Area 
(stran 75) v meniju Shooting glavnega 
menija.

Flexible Spot:
Ostri na določeno mesto v sliki.
Ko je izbrana ta možnost, določite položaj z 
večfunkcijskim gumbom (stran 7).
Na osrednji položaj se lahko vrnete tako, da 
pritisnete in pridržite večfunkcijski gumb.

Zone:
Samodejno išče mesto ostrenja znotraj 
določenega območja.
Ko je izbrana ta možnost, določite položaj z 
večfunkcijskim gumbom (stran 7).
Na osrednji položaj se lahko vrnete tako, da 
pritisnete in pridržite večfunkcijski gumb.

Wide:
Med ostrenjem išče subjekt na širokem 
območju slike. Okvir ni prikazan.

[Nasvet]
Enako upravljanje je mogoče tudi z uporabo dodeljivega 
gumba (stran 48), ki mu dodelite možnost upravljanja 
z območjem ostrenja.
Okvir območja ostrenja lahko prikažete/skrijete z 
uporabo možnosti Display On/Off >Focus Area Indicator 
(stran 87) v meniju Monitoring glavnega menija.

[Opombe]
ˎˎ Okvir območja ostrenja ni skrit, ko uporabljate gumb 

DISPLAY.
ˎˎ Območje ostrenja je nastavljeno na Wide med 

delovanjem funkcije Clear Image Zoom.

Hitra sprememba območja ostrenja 
(Nastavitev ostrenja)

Položaj in velikost območja samodejnega 
ostrenja lahko hitro spremenite med samim 
snemanjem, če dodeljivemu gumbu dodelite 
možnost nastavitve ostrenja (stran 48).
Delovanje je odvisno od nastavitve območja 
ostrenja.

Ko je možnost Focus >Focus Area (stran 75) v 
meniju Shooting glavnega menija nastavljena 
na Flexible Spot ali Zone.
Mesto območja ostrenja lahko spremenite 
tako, da pritisnete dodeljiv gumb, ki ste mu 
dodelili funkcijo Focus Setting in uporabite 
večfunkcijski gumb (stran 7).
Medtem ko prilagajate mesto območja 
ostrenja, lahko tega vrnete v središče tako, da 
pritisnete večfunkcijski gumb.
Velikost območja ostrenja lahko spremenite 
tako, da pritisnete in zadržite dodeljiv gumb, ki 
ste mu dodelili nastavitev ostrenja.
Po spreminjanju velikosti nastavite mesto 
območja ostrenja tako, da pritisnete 
večfunkcijski gumb.
Ko ste zaključili, pritisnite dodeljiv gumb, ki ste 
mu dodelili nastavitev ostrenja, da se vrnete 
na izvorni zaslon.
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Ko je možnost Focus >Focus Area (stran 75) v 
meniju Shooting glavnega menija nastavljena 
na Wide.
Spremenite lahko samo velikost območja 
ostrenja, tako da pritisnete in zadržite dodeljiv 
gumb, ki ste mu dodelili nastavitev ostrenja. 
Mesto ostrenja lahko spremenite, če najprej 
spremenite tip ostrenja na Flexible Spot ali 
Zone.

[Nasveti]
ˎˎ Ko je možnost Focus >Push AF Mode (stran 75) 

v meniju Shooting glavnega menija nastavljena na 
Single-shot AF(AF-S) in je stikalo FOCUS (stran 4) 
v položaju MF, lahko spremenite mesto območja 
ostrenja Focus Area(AF-S) (stran 75).
ˎˎ Med uporabo funkcije Clear Image Zoom je nastavitev 

velikosti območja ostrenja izklopljena in se aktivira 
samodejno ostrenje s prioriteto na središčnem 
območju.
ˎˎ Okvir območja ostrenja je oranžne barve, ko je mesto 

območja ostrenja mogoče spreminjati.

Premikanje okvirja območja ostrenja z 
upravljanjem na dotik (dotaknite se 
območja ostrenja)

Mesto območja ostrenja lahko spremenite 
tako, da pritisnete dodeljiv gumb (stran 48) 
z dodeljeno funkcijo Focus Setting in 
spremenite prikaz območja ostrenja v oranžno 
barvo, nato pa ga premaknete z upravljanjem 
na dotik.
Tapnite zaslon, da premaknete območje 
ostrenja tako, da bo središče območje ostrenja 
na mestu, ki ste ga tapnili. Povlecite po 
zaslonu, da premaknete območje ostrenja na 
mesto, kamor povlečete prst (stran 10).

[Nasvet]
Upravljanje ostrenja z dotikom lahko vklopite/izklopite 
na zaslonu za snemanje z dodeljivim gumbom z 
dodeljeno funkcijo Focus Setting.

Tapnite poljubno mesto

Območje ostrenja se premakne tako, da je 
na sredini mesta, ki ste ga tapnili.

Povlecite po zaslonu, da premaknete območje 
ostrenja na mesto, kamor povlečete prst.

[Opombe]
ˎˎ Če tapnete mesto ali povlečete območje ostrenja na 

mesto zunaj območja nastavitve, bo območje ostrenja 
nastavljeno na vrhu/dnu/levem robu/desnem robu 
območja nastavitve.
ˎˎ Ta funkcija ni na voljo v naslednjih okoliščinah.

–– Ko je možnost Touch Operation (stran 93) v 
meniju Technical glavnega menija izklopljena.

–– Ko je območje ostrenja prikazano s sivo barvo ali 
pa sploh ni prikazano.

Nastavitev dejanja samodejnega 
ostrenja (hitrost prehoda samodejnega 
ostrenja, občutljivost samodejnega 
ostrenja pri prehodu med subjekti).

Hitrost prehoda samodejnega ostrenja
Nastavite lahko hitrost pogona ostrenja za 
primere, ko se subjekt spremeni. To omogoča 
možnost Focus >AF Transition Speed 
(stran 75) v meniju Shooting glavnega 
menija.
Ko se subjekt, na katerega naj bi ostrili, 
spremeni, vam izbrana nizka hitrost omogoča 
snemanje navdušujočih posnetkov.
Ko je izbrana visoka hitrost, ostrenje hitro 
preklopi med subjektoma. Subjekt, ki vstopi v 
sliko, je takoj izostren. S tem je ta nastavitev 
idealna za dokumentarno snemanje, ki 
zahteva hitro ostrenje.

Med spremembo:
1 (Počasi): Ostrenje deluje 
počasi
.
.
.
7 (Hitro): Ostrenje deluje hitro

Izostreno na oddaljeni subjekt

Izostreno na bližnji subjekt
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Občutljivost samodejnega ostrenja pri 
prehodu med subjekti
Občutljivost za prehajanje med subjekti lahko 
spremenite z možnostjo Focus >AF Subj. Shift 
Sens. (stran 75) v meniju Shooting glavnega 
menija.
Ko je izbrana nizka občutljivost, ostrenje ne 
preide takoj na drug subjekt, tudi če se drug 
subjekt giblje pred izostrenim subjektom. Ko je 
izbrana visoka občutljivost, ostrenje preide na 
subjekt, ki se giblje v ospredju.

[Nasvet]
Če je funkcija AF Speed/Sens. dodeljena dodeljivemu 
gumbu, so vrstice ravni za prilagajanje vrednosti ob 
vsakem pritisku gumba prikazane v naslednjem vrstnem 
redu. Tako lahko spremenite nastavitev hitrosti prehoda 
samodejnega ostrenja in nastavitev občutljivosti 
samodejnega ostrenja pri prehodu med subjekti.
Hitrost prehoda samodejnega ostrenja  Občutljivost 
samodejnega ostrenja pri prehodu med subjekti  Brez 
prikaza …

AF Subj. Shift Sens.: 1 (Zaklenjeno na) AF Subj. Shift Sens.: 5 (Odzivno)

Počasi spremenite izostritev na drug subjekt Hitro spremenite izostritev na drug subjekt

Ročno spreminjanje cilja ostrenja 
(AF Assist)

Ko je možnost Focus > AF Assist (stran 75) v 
meniju Shooting glavnega menija vklopljena, 
lahko med samodejnim ostrenjem še vedno 
tudi ročno prilagajate ostrenje z obročem za 
ostrenje na objektivu.
Ko prenehate uporabljati obroč za ostrenje, 
funkcija samodejnega ostrenja nadaljuje 
z izostritvijo subjekta, ki ste ga izostrili z 
obročem za ostrenje (stanje AF assist).
Po uporabi obroča za ostrenje je premik 
izostritve na drug subjekt nekoliko težji, ne 
glede na nastavitev Focus > AF Subj. Shift 
Sens. (stran 75) v meniju Shooting glavnega 
menija.
Stanje AF assist lahko izklopite na naslednji 
način.
ˎˎ Ko subjekt, ki ste ga izostrili z obročem za 
ostrenje, ni več viden.
ˎˎ Ko preklopite na ročno ostrenje.
ˎˎ Ko sistem registrira obraz.

[Nasveti]
ˎˎ Stanje AF assist lahko hitro izklopite z dodeljivim 

gumbom (stran 48) z dodeljeno funkcijo Push AF/
Push MF.
ˎˎ Z obročem za ostrenje počistite izbiro registriranih 

obrazov.
ˎˎ V načinu Face/Eye Only AF funkcija samodejnega 

ostrenja izostri obraz, ki je najbližje mestu ostrenja, ki 
ste ga nastavili z obročem za ostrenje.
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Začasna uporaba ročnega ostrenja 
(Push Manual Focus)

V načinu samodejnega ostrenja pritisnite 
gumb PUSH AUTO FOCUS (stran 4) za 
ročno ostrenje medtem, ko držite pritisnjen 
gumb.
Ostrenje se povrne na samodejno ostrenje, ko 
spustite gumb.
To vam omogoča, da začasno ustavite 
samodejno ostrenje in ročno ostrite, kar je 
uporabno v primerih, ko nekaj, kar ni subjekt 
snemanja, prečka sliko pred subjektom.

[Nasvet]
Enako delovanje omogoča tudi uporaba dodeljivega 
gumba (stran 48) z dodeljeno funkcijo Push AF/Push 
MF.

Začasna uporaba samodejnega 
ostrenja (Push Auto Focus)

Ko je možnost Focus >Push AF mode 
(stran 75) v meniju Shooting glavnega 
menija nastavljena na AF, pritisnite gumb 
PUSH AUTO FOCUS (stran 4), medtem ko 
ste v načinu ročnega ostrenja, da omogočite 
samodejno ostrenje, dokler je gumb pritisnjen.
Do ostrenja pride znotraj območja ostrenja, 
ki je nastavljeno z možnostjo Focus >Focus 
Area (stran 75) v meniju Shooting glavnega 
menija.
Ostrenje se povrne na ročno ostrenje, ko 
spustite gumb.
To je uporabno, kadar želite med ročnim 
ostrenjem počasi premakniti ostrenje z enega 
na drug subjekt.

[Nasvet]
Enako delovanje omogoča tudi uporaba dodeljivega 
gumba (stran 48) z dodeljeno funkcijo Push AF/Push 
MF.

[Opomba]
Funkcija Push Auto Focus ne deluje, če je objektiv 
nastavljen na ročno ostrenje.

Uporaba enkratnega 
samodejnega ostrenja (Push Auto 
Focus (AF-S))

Nastavite možnost Focus >Push AF Mode 
(stran 75) v meniju Shooting glavnega 
menija na Single-shot AF(AF-S). Nato nastavite 
območje ostrenja z možnostjo Focus >Focus 
Area(AF-S) (stran 75) v meniju Shooting 
glavnega menija.
V načinu ročnega ostrenja pritisnite gumb 
PUSH AUTO FOCUS za samodejno hitro 
izostritev. Ostrenje se ustavi takoj, ko spustite 
gumb.
Stanje ostrenja prikazuje indikator ostrenja.
ˎˎ Sveti: Izostritev je fiksirana na mesto 
ostrenja.
ˎˎ Utripa: Ni izostreno. Ker ostrenje ni 
samodejno, spremenite kompozicijo in 
nastavitve ostrenja, da dosežete izostritev.

Ostrenje se povrne na ročno ostrenje, ko 
spustite gumb.
Ta možnost je uporabna, ko želite hitro izostriti 
subjekt preden začnete snemati.

[Nasveti]
ˎˎ Enako delovanje omogoča tudi uporaba dodeljivega 

gumba (stran 48) z dodeljeno funkcijo Push AF/
Push MF.
ˎˎ Možnost Push AF Mode lahko dodelite tudi 

dodeljivemu gumbu (stran 48).
ˎˎ Dodeljivemu gumbu lahko dodelite tudi funkcijo 

Focus Area(AF-S) (stran 48).
ˎˎ Okvir območja ostrenja lahko prikažete/skrijete z 

uporabo možnosti Display On/Off > Focus Area Ind.
(AF-S) (stran 87) v meniju Monitoring glavnega 
menija.
ˎˎ Med povečavo ostrenja se ostrenje prilagodi, da 

ustreza mestu povečanega prikaza.

[Opombe]
ˎˎ Funkcija Push Auto Focus ne deluje, če je objektiv 

nastavljen na ročno ostrenje.
ˎˎ Okvir območja ostrenja ni skrit, ko uporabljate gumb 

DISPLAY.

Ostrenje z uporabo povečave 
ostrenja (Focus Magnifier)

Privzeta tovarniška nastavitev je, da je funkcija 
Focus Magnifier ×3/×6 dodeljena gumbu 
ASSIGN 4 na držalu z daljinskim upravljalnikom 
in gumbu ASSIGN 7 na ročaju (stran 48).
Pritisnite gumb ASSIGN 4 ali gumb ASSIGN 
7, da preklopite iskalo na zaslon povečave 
ostrenja, kjer je osrednji del zaslona povečan 
za približno trikrat. Pritisnite gumb še enkrat 
za še večjo, približno šestkratno povečavo. Ta 
funkcija je uporabna za preverjanje izostritve.
Za vrnitev na običajen zaslon ponovno 
pritisnite gumb.
Mesto, ki ga želite povečati, lahko med 
povečavo ostrenja premikate z večfunkcijskim 
gumbom (stran 7). S pritiskom 
večfunkcijskega gumba se vrnete na sredino 
slike.
Ko je med povečavo ostrenja uporabljena 
funkcija Push Auto Focus (AF), se ostrenje 
izvrši znotraj območja ostrenja, ki je 
nastavljeno z nastavitvijo Focus > Focus Area 
(stran 75) v meniju Shooting glavnega 
menija.
Če je med povečavo ostrenja uporabljena 
funkcija Push Auto Focus (AF-S), se izostritev 
prilagodi mestu povečave ostrenja.

[Opombe]
ˎˎ Posneta slika ali slika na izhodu SDI/HDMI se pri 

povečavi ostrenja ne poveča.
ˎˎ Med povečavo ostrenja so onemogočeni gumb MENU 

in druge operacije.
ˎˎ Ko ugasnete videokamero, se mesto povečave vrne 

na osrednji del zaslona.
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Ostrenje s funkcijo zaznavanja 
obrazov/oči (Face/Eye Detection AF)

Videokamera lahko zazna obraze in oči 
ljudi ter prilagodi izostritev obrazov in oči v 
območju ostrenja.
Ta funkcija je na voljo le v samodejnem načinu 
ostrenja in pri uporabi funkcije Push Auto 
Focus.
Ko videokamera zazna obraze, se prikažejo sivi 
okvirji zaznavanja obrazov/oči. Ko je mogoče 
samodejno ostrenje, okvirji postanejo beli. Ko 
videokamera zazna oči in prilagodi izostritev, 
se okvir zaznavanja obrazov/oči prikaže 
na očeh. Ko videokamera zazna več oseb, 
samodejno določi glavni subjekt.

[Nasveti]
ˎˎ Ko je območje ostrenja nastavljeno na Zone ali 

Flexible Spot in obrazi ali oči prekrivajo izbrano 
območje ostrenja, se barva okvirjev zaznavanja 
obrazov/oči spremeni v belo, videokamera pa izvede 
ostrenje teh obrazov/oči.
ˎˎ Ob uporabi funkcije Push Auto Focus (AF-S) se barva 

okvirjev zaznavanja obrazov/oči, ki so izostreni, 
spremeni v zeleno.

Nastavite samodejno ostrenje z zaznavanjem 
obrazov/oči z nastavitvijo Focus > Face/Eye 
Detection AF (stran 75) v meniju Shooting.

Face/Eye Only AF:
Videokamera zazna obraze/oči subjektov 
(ljudi) in izostri samo njihove obraze/
oči. Če videokamera ne zazna obraza/
oči, se samodejno ostrenje začasno ustavi 
(MF) in prikaže se ikona  (stran 11), ki 
označuje, da je način samodejnega ostrenja 
z zaznavanjem obrazov Face/Eye Only AF 
začasno ustavljen. Ta način je koristen takrat, 
ko želite samodejno izostriti samo obraze/oči.

Face/Eye Priority AF:
Videokamera zaznava obraze/oči subjektov 
(ljudi) in prednostno izostri obraze/oči. Če 
videokamera ne zazna obraza ali oči, izostri 
v načinu samodejnega ostrenja (privzeta 
nastavitev).

Off:
Funkcija samodejnega ostrenja z zaznavanjem 
obrazov/oči je onemogočena.
[Opombe]
ˎˎ Med uporabo funkcije Push Auto Focus, je način Face/

Eye Priority AF aktiviran, tudi če je trenutno izbran 
način Face/Eye Only AF.
ˎˎ Ko je stikalo FOCUS nastavljeno na MAN, je samodejno 

ostrenje z zaznavanjem obrazov/oči onemogočeno 
(razen med uporabo funkcije Push Auto Focus).

ˎˎ Če izklopite videokamero medtem, ko je izbran način 
Face/Eye Only AF, bo videokamera ob naslednjem vklopu 
samodejno preklopila v način Face/Eye Priority AF.
ˎˎ Med uporabo funkcije Clear Image Zoom 

videokamera ne podpira načina Face/Eye AF. Vklopi 
se običajno samodejno ostrenje.

Skrivanje okvirjev za zaznavanje 
obrazov/oči
Okvirje za zaznavanje obrazov/oči lahko 
prikažete/skrijete z možnostjo Display On/
Off > Face/Eye Detection Frame (stran 87) v 
meniju Monitoring glavnega menija.
[Opomba]
Zeleni okvirji za zaznavanje obrazov/oči so prikazani za 
obraze in oči, ki so izostreni z uporabo funkcije Push Auto 
Focus (AF-S), in niso skriti z uporabo gumba DISPLAY ali 
kadar je okvir zaznavanja obrazov/oči izklopljen.

Ostrenje na registrirani obraz
Med delovanjem samodejnega ostrenja z 
zaznavanjem obrazov/oči lahko registrirate 
obraz subjekta (osebe) za ostrenje tega obraza.
Registrirate lahko samo en obraz. Registriranje 
obraza prepiše trenutno registrirani obraz.
Ko je obraz registriran, se okvir za zaznavanje 
obrazov/oči spremeni v dvojni okvir (okvir 
registriranega obraza) in prikaže se ikona 
registriranega obraza  (stran 11).

V načinu samodejnega ostrenja z 
zaznavanjem obrazov/oči se glede na 
kombinacijo registriranega obraza in 
načina delovanja samodejnega ostrenja z 
zaznavanjem obrazov/oči, zgodi naslednje.

V načinu Face/Eye Priority AF:
Če videokamera zazna registrirani obraz, 
izostri ta obraz. Če videokamera ne zazna 
obraza, se vklopi samodejno ostrenje z 
zaznavanjem obrazov/oči.

V načinu Face/Eye Only AF:
Če videokamera zazna samo registrirani obraz, 
izostri ta obraz/oči. Če ne zazna registriranega 
obraza, se samodejno ostrenje začasno ustavi 
(MF) in prikaže se ikona  (stran 11), ki 
označuje, da je način samodejnega ostrenja z 
zaznavanjem obrazov/oči Face Only AF začasno 
ustavljen. Ta način je koristen takrat, ko želite 
samodejno ostriti samo registrirano osebo.

Nastavitev registriranega obraza
Z večfunkcijskim gumbom (stran 7) 
premaknite kazalec za izbiro obraza (oranžni 
podčrtaj) na obraz, ki ga želite registrirati, in 
nato pritisnite večfunkcijski gumb.

Drugi okvirji za zaznavanje obrazov/
oči (sivi)

Registriran 
okvir obraza 
(dvojni bel 
okvir)

Kazalec za izbiro obraza (oranžen)

Brisanje registriranega obraza
Z večfunkcijskim gumbom (stran 7) 
premaknite kazalec za izbiro obraza na 
okvir registriranega obraza, in nato pritisnite 
večfunkcijski gumb.
Registrirani obraz je izbrisan, okvir za 
zaznavanje obraza/oči postane enojni okvir in 
ikona registriranega obraza izgine.

Ko videokamera zazna obraze/oči in okvir 
registriranega obraza ni prikazan, prikazan pa 
je kazalec za izbiro obraza (oranžne barve), 
lahko izbrišete registrirani obraz tako, da 
dvakrat pritisnete večfunkcijski gumb.

[Opombe]
ˎˎ V stanju AF assist (stran 39) se izbira registriranega 

obraza izbriše.
ˎˎ Ko uporabljate funkcijo Clear Image Zoom, ne morete 

uporabljati samodejnega ostrenja z zaznavanjem 
obrazov/oči.
ˎˎ Videokamera obrazov/oči morda ne bo zaznala, kar 

je odvisno od snemalnega okolja, razmer subjekta ali 
nastavitev.
ˎˎ V nekaterih snemalnih okoljih morda ne boste 

mogli doseči pravega učinka. Zgodi tudi se lahko, 
da bo kakšen drug objekt prepoznan kot človeški 
obraz. V tem primeru izklopite samodejno ostrenje z 
zaznavanjem obrazov/oči.
ˎˎ Priporočamo, da registracijo obraza želene osebe 

izvedete pred snemanjem.
ˎˎ Registracija obraza morda ne bo uspešna, na kar 

lahko vplivajo stil pričeske, ličila ali če oseba ne gleda 
neposredno proti videokameri. V tem primeru se 
lahko okvir za zaznavanje obrazov/oči spremeni v 
dvojni okvir, vendar se ikona registriranega obraza ne 
prikaže in obraz ni registriran.
ˎˎ Če je bil obraz že registriran, priporočamo, da izbrišete 

obstoječi obraz in opravite novo registracijo obraza.

Preklapljanje samodejnega ostrenja z 
zaznavanjem obrazov/oči z uporabo 
dodeljivega gumba
Dodelite samodejno ostrenje z zaznavanjem 
obrazov/oči dodeljivemu gumbu 
(stran 48). Zdaj lahko z vsakim pritiskom 
na gumb preklapljate med načini delovanja 
samodejnega ostrenja z zaznavanjem 
obrazov/oči v naslednjem vrstnem redu: Face/
Eye Priority AF, Face/Eye Only AF in Off.

Nastavljanje z uporabo neposrednega 
menija
Delovanje samodejnega ostrenja z 
zaznavanjem obrazov/oči lahko nastavite tudi 
z uporabo neposrednega menija (stran 48).
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Prilagajanje svetlosti

B

C
D
E

F
H

I

A

Svetlost lahko prilagodite s prilagajanjem 
zaslonke, ojačitve in hitrosti zaklopa ter s 
prilagajanjem količine svetlobe z uporabo 
filtrov ND. Prilagoditve lahko opravite tudi 
samodejno.
Ciljno raven za samodejno prilagajanje 
svetlosti nastavite z možnostjo Auto Exposure 
(stran 73) > Level v meniju Shooting 
glavnega menija. Raven samodejne osvetlitve 
lahko dodelite tudi dodeljivemu gumbu ali 
dodeljivemu kolescu (stran 48).

[Opomba]
Ojačanja ne morete prilagajati v načinu Cine EI. Osnovna 
občutljivost je fiksna. Svetlosti ni mogoče samodejno 
prilagajati z uporabo hitrosti zaklopa. Podprta je 
samodejna prilagoditev svetlosti z uporabo zaslonke in 
filtra ND.

Izbira osnovne občutljivosti

Izbirate lahko med dvema tipoma osnovne 
občutljivosti.
V načinu Custom lahko nastavite osnovno 
občutljivost na High ali Low s funkcijo Base 
ISO/Sensitivity na zaslonu Main Status 
(stran 13) ali zaslonu Camera Status 
(stran 14) ali pa nastavite možnost ISO/
Gain/EI >Base Sensitivity (stran 72) v meniju 
Shooting glavnega menija.
V načinu Cine EI lahko nastavite osnovno 
občutljivost ISO na ISO 12800 ali ISO 800 
s funkcijo Base ISO/Sensitivity na zaslonu 
Main Status (stran 13) ali zaslonu Camera 
Status (stran 14) ali pa nastavite možnost 
ISO/Gain/EI >Base ISO (stran 72) v meniju 
Shooting glavnega menija.
Priporočamo, da izberete nastavitev Low ali 
ISO 800 v normalnih svetlobnih pogojih in 
nastavitev High ali ISO 12800 ob šibki svetlobi.

*	 Konfiguracija je mogoča tudi na zaslonu stanja.

[Nasvet]
Tudi funkcijo Base ISO/Sensitivity lahko dodelite 
dodeljivemu gumbu (stran 48).

Prilagajanje zaslonke

S prilagajanjem zaslonke lahko prilagodite 
svetlost.

Samodejno prilagajanje zaslonke

Ta funkcija prilagodi svetlost glede na subjekt. 
Zahtevan je objektiv, ki podpira samodejno 
zaslonko.

1	 Če je nameščen objektiv s stikalom Auto 
Iris, prestavite stikalo v položaj AUTO.

2	 Pritisnite in zadržite funkcijski gumb IRIS 
(E) za prikaz neposrednega menija 
(stran 48) in izberite možnost Auto.

	 [Nasvet]
Funkcijo samodejnega prilagajanja zaslonke 
Auto Iris lahko dodelite tudi dodeljivemu gumbu 
(stran 48).

	 [Opomba]
Zaslonke ni mogoče samodejno prilagajati na 
objektivih serije A.

Ročno prilagajanje zaslonke

1	 Pritisnite in zadržite funkcijski gumb IRIS 
(E) za prikaz neposrednega menija 
(stran 48) in izberite možnost Manual.

2	 Pritisnite funkcijski gumb IRIS (E), da je 
vrednost zaslonke prikazana na belem 
ozadju.

3	 Zavrtite večfunkcijsko kolesce, da 
prilagodite vrednost.

	 [Nasveti]
ˎˎ Večfunkcijsko kolesce lahko uporabljate tudi 

kot kolesce IRIS (stran 48) tako, da dodelite 
funkcijo IRIS večfunkcijskemu kolescu.
ˎˎ Funkcijo IRIS lahko dodelite tudi dodeljivemu 

kolescu (stran 48).

Začasno samodejno prilagajanje

Pritisnite dodeljiv gumb (stran 48), ki je 
dodeljen funkciji Push Auto Iris za začasno 
samodejno prilagajanje zaslonke, medtem ko 
je gumb pritisnjen.
Ko spustite gumb, se zaslonka vrne na prejšnjo 
nastavitev.

[Opomba]
Ko je stikalo samodejne prilagoditve zaslonke na 
objektivu nastavljeno na MANUAL, funkciji Auto Iris in 
Push Auto Iris na videokameri nimata učinka. Prav tako 
nima učinka ročno prilagajanje zaslonke na videokameri.

Prilagajanje ojačitve

V načinu Custom lahko prilagodite ojačitev, da 
prilagodite svetlost.

Samodejno prilagajanje ojačitve

Pritisnite funkcijski gumb ISO/GAIN (H) za 
prikaz neposrednega menija (stran 48) in 
izberite možnost Auto.

[Nasveti]
ˎˎ Isto lahko dosežete tako, da nastavite možnost Auto 

Exposure (stran 73) >AGC v meniju Shooting na On.
ˎˎ Samodejno prilagajanje ojačitve AGC lahko dodelite 

tudi dodeljivemu gumbu (stran 48).

Ročno prilagajanje ojačitve

Ojačitev lahko nadzorujete kadar želite 
prilagoditi osvetlitev med uporabo fiksne 
nastavitve zaslonke ali kadar želite preprečiti 
povečanje ojačitve zaradi funkcije AGC.

1	 Pritisnite in zadržite funkcijski gumb ISO/
GAIN (H) za prikaz neposrednega menija 
(stran 48) in izberite možnost Manual.

2	 Stikalo ISO/GAIN (I) nastavite na H, M ali L.

[Nasveti]
ˎˎ Funkcijo pritisk za AGC lahko dodelite dodeljivemu 

gumbu in začasno vklopite AGC tako, da pritisnete in 
zadržite gumb.
ˎˎ Prednastavljeno vrednost vsakega položaja 

stikala lahko spreminjate z možnostjo ISO / 
Gain<L>/<M>/<H> (stran 14) na zaslonu 
Camera Status ali z možnostjo ISO/Gain/EI >ISO/
Gain<H>/<M>/<L> (stran 72) v meniju Shooting 
glavnega menija.
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Upravljanje ojačitve (natančno 
prilagajanje)

1	 Pritisnite funkcijski gumb ISO/GAIN (H), da 
je vrednost ojačitve prikazana na belem 
ozadju.

2	 Zavrtite večfunkcijsko kolesce, da 
prilagodite vrednost.

[Nasvet]
Prednastavljeno vrednost ojačitve spremenite v skladu z 
nastavitvijo stikala ISO/GAIN (I).

Začasno upravljanje ojačitve (natančno 
prilagajanje)

Zavrtite dodeljivo kolesce (stran 48) z 
dodeljeno funkcijo ISO/Gain/EI, da prilagodite 
vrednost ojačitve, nastavljeno s stikalom ISO/
GAIN (I).
To je uporabno, kadar želite prilagoditi 
osvetlitev za eno stopnjo brez spreminjanja 
globinske ostrine.
Prilagojeno vrednost ojačitve prekličete s 
preklopom stikala ISO/GAIN (J), spremembo 
osnovne občutljivosti, vklopom funkcije AGC 
ali z izklopom videokamere.

[Nasveti]
ˎˎ To funkcijo lahko dodelite tudi večfunkcijskemu 

kolescu (stran 48).
ˎˎ Funkcijo pritisk za AGC lahko dodelite dodeljivemu 

gumbu in začasno vklopite AGC tako, da pritisnete in 
zadržite gumb.

Prilagajanje indeksa osvetlitve 
(Exposure Index)

V načinu Cine EI se domneva, da je video izhod 
z izklopljenim MLUT posnet kot glavni signal. 
S spreminjanjem svetlosti slike z vklopljenim 
MLUT, da ustreza vrednosti EI, lahko med 
snemanjem preverite rezultat prilagoditve 
občutljivosti osvetlitve za postprodukcijo.
Vrednost EI lahko spremenite tako, da stikalo 
ISO/GAIN (I) nastavite na H, M ali L.

[Nasvet]
Vrednost EI vsakega položaja stikala lahko spreminjate 
z možnostjo ISO/Gain/EI (stran 14) na zaslonu 
Camera Status ali z možnostjo ISO/Gain/EI >Exposure 
Index<H>/<M>/<L> (stran 72) v meniju Shooting 
glavnega menija.

Natančno prilagajanje indeksa osvetlitve

1	 Pritisnite funkcijski gumb ISO/GAIN (H), da 
je vrednost EI prikazana na belem ozadju.

2	 Zavrtite večfunkcijsko kolesce, da 
prilagodite vrednost.

[Nasvet]
Prednastavljeno vrednost EI spremenite v skladu z 
nastavitvijo stikala ISO/GAIN (I).

Prilagajanje zaklopa

S prilagajanjem zaklopa lahko prilagodite 
svetlost.

Samodejno prilagajanje zaklopa

Pritisnite in zadržite funkcijski gumb 
SHUTTER (F) za prikaz neposrednega menija 
(stran 48) in izberite možnost Auto za 
samodejno prilagoditev hitrosti zaklopa ali 
kota zaklopa glede na svetlost slike.

[Nasvet]
Isto lahko dosežete tako, da nastavite možnost Auto 
Exposure >Auto Shutter (stran 74) v meniju Shooting 
glavnega menija.

Ročno prilagajanje zaklopa

1	 Pritisnite in zadržite funkcijski gumb 
SHUTTER (F) za prikaz neposrednega 
menija (stran 48) in izberite možnost 
Speed ali Angle.

2	 Pritisnite funkcijski gumb SHUTTER (F), da 
se vrednost zaklopa prikaže na belem 
ozadju.

3	 Zavrtite večfunkcijsko kolesce, da 
prilagodite hitrost zaklopa.

[Nasveti]
ˎˎ Za nastavitev časa osvetlitve, ki se ujema z intervalom 

sličice, v koraku 1 izberite Off.
ˎˎ Nastavite lahko tudi kot in prilagodite frekvenco 

(stran 72).

Prilagajanje količine svetlobe 
(filter ND)

V razmerah, ko je svetlobe preveč, lahko 
primerno svetlost nastavite z uporabo filtra 
ND.
Videokamera ima dva načina filtra ND. Med 
njima lahko preklapljate s stikalom ND 
PRESET/VARIABLE.

Prilagajanje v prednastavljenem načinu

Prestavite stikalo (A) ND PRESET/VARIABLE v 
položaj PRESET in s smernima gumboma (B) 
ND FILTER POSITION izberite eno od sledečih 
nastavitev.
Clear: Brez filtra ND
1: Prepustnost svetlobe, nastavljena z 
možnostjo ND Filter >Preset1 (stran 72) v 
meniju Shooting glavnega menija.
2: Prepustnost svetlobe, nastavljena z 
možnostjo ND Filter >Preset2 (stran 72) v 
meniju Shooting glavnega menija.
3: Prepustnost svetlobe, nastavljena z 
možnostjo ND Filter >Preset3 (stran 72) v 
meniju Shooting glavnega menija.

Prilagajanje v variabilnem načinu

Prestavite stikalo (A) ND PRESET/VARIABLE v 
položaj VARIABLE. S smernima gumboma (B) 
ND FILTER POSITION izberite CLEAR ali On.

Samodejno prilagajanje količine svetlobe
Za vklop samodejnega prilagajanja osvetlitve 
z uporabo filtra ND nastavite možnost Auto ND 
Filter na On.

1	 Pritisnite gumb [+] izmed smernih 
gumbov ND FILTER POSITION (B) za vklop 
filtra ND.
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2	 Pritisnite in zadržite gumb (C) ND 
VARIABLE AUTO, dokler ni izbran način 
Auto.

Ročno prilagajanje količine svetlobe

1	 Pritisnite gumb [+] izmed smernih 
gumbov ND FILTER POSITION (B) za vklop 
filtra ND.

2	 Pritisnite in zadržite gumb (C) ND 
VARIABLE AUTO, dokler ni izbran način 
Manual.

3	 Zavrtite kolesce (D) ND VARIABLE in 
nastavite prepustnost filtra.

[Nasvet]
Funkcijo filtra ND lahko dodelite tudi dodeljivemu 
kolescu (stran 48).

Začasno samodejno prilagajanje
Funkcijo Push Auto ND lahko dodelite 
dodeljivemu gumbu (stran 48) in začasno 
vklopite filter ND tako, da pritisnete in zadržite 
gumb. Ko spustite gumb, se samodejni filter 
ND izklopi.
Pritisnite gumb [+] izmed smernih gumbov ND 
FILTER POSITION (B) za vklop filtra ND.

[Opomba]
Če filter ND med snemanjem preklopite v ali iz položaja 
CLEAR, se okvir filtra ND prikaže na sliki. Posname se tudi 
zvok, ki ga povzroči izklop/vklop filtra ND.

[Nasveti]
ˎˎ V položaj CLEAR lahko preklopite tako, da zavrtite 

kolesce ND VARIABLE (D) nižje od ND1/4. Če zavrtite 
kolesce višje od položaja CLEAR, nastavite filter na 
vrednost ND1/4. Takšno delovanje lahko onemogočite 
z uporabo možnosti ND Dial >CLEAR with Dial 
(stran 93) v meniju Technical glavnega menija.
ˎˎ Funkcijo ND Filter Position lahko tudi dodelite 

dodeljivemu gumbu (stran 48) in namesto, da za 
spremembo nastavitve uporabljate gumba navzgor/
navzdol ND FILTER POSITION, pritisnete ta gumb.  
Prednastavljeni način: Clear  Preset1  Preset2  
Preset3  Clear… 
Variabilni način: Clear  On  Clear …

ˎˎ Samodejni filter ND lahko dodelite dodeljivemu 
gumbu (stran 48) in s pritiskom nanj vklapljate in 
izklapljate samodejni filter ND.
ˎˎ Pri snemanju močno osvetljenih subjektov lahko 

preveliko zapiranje zaslonke privede do difrakcije 
in s tem zamegljenosti slike, kar ustvarja vtis slabe 
izostritve (tipičen pojav pri videokamerah). Ta učinek 
lahko zmanjšate in dobite boljše rezultate snemanja z 
uporabo filtra ND.
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Izberete lahko prilagoditveni način, ki ustreza 
razmeram snemanja.

ATW (Auto Tracing White Balance)

Ta funkcija samodejno prilagodi belino, tako 
da je ta ustrezna.
Ko se temperatura svetlobe spremeni, se 
belina samodejno prilagodi.
Pritisnite in zadržite funkcijski gumb WHT 
BAL (G) za prikaz neposrednega menija 
(stran 48) in izberite možnost ATW.
Izberete lahko hitrost prilagajanja (pet 
korakov) z uporabo možnosti White Setting 
> ATW Speed (stran 74) v meniju Shooting 
glavnega menija.

[Nasvet]
Trenutno nastavitev beline lahko zamrznete tako, 
da dodeljivemu gumbu dodelite funkcijo ATW Hold 
(stran 48) in pritisnete dodeljivi gumb za začasno 
prekinitev načina ATW.

[Opombe]
ˎˎ Funkcije ATW ni mogoče uporabljati v načinu Cine EI.
ˎˎ Glede na osvetlitev in razmere subjekta s funkcijo 

ATW morda ne bo mogoče nastaviti primerne barve.  
Primeri:
–– Kadar prevladuje ena barva subjekta, kot na primer 

pri nebu, morju, zemlji ali rožah.
–– Kadar je temperatura barve izjemno visoka ali 

izjemno nizka.
	 Če ne morete doseči želenega učinka, ker je hitrost 

samodejnega sledenja ATW prenizka ali zaradi drugih 
razlogov, zaženite samodejno nastavitev beline.

Ročno prilagajanje beline

1	 Ko je nastavitev beline nastavljena na 
način ATW, pritisnite in zadržite funkcijski 
gumb WHT BAL (G) za prikaz 
neposrednega menija (stran 48) in 
izberite možnost W:P, W:A, or W:B.

2	 S stikalom WHT BAL (J) izberite B, A ali 
PRESET.
B: Način pomnilnika B
A: Način pomnilnika A
PRESET: Prednastavljeni način

[Nasvet]
ATW lahko omogočite za pomnilnik B tako, da nastavite 
možnost White Setting > White Switch<B> (stran 74) v 
meniju Shooting glavnega menija na ATW.

Način Memory A/Memory B
Ta način prilagodi belino na nastavitev, ki je 
shranjena v pomnilniku A ali B.

Prednastavljeni način
Ta način prilagodi temperaturo barve na 
prednastavljeno vrednost (tovarniško privzeta 
vrednost je 3200 K).

Spreminjanje privzete prednastavljene 
vrednosti

V prednastavljenem načinu lahko neposredno 
spremenite obstoječo prednastavljeno 
vrednost.
Pritisnite in zadržite funkcijski gumb WHT BAL 
(G) in izberite eno od naslednjih možnosti v 
neposrednem meniju.
Način Custom:  3200K,  4300K, 

 5600K,  6300K
Način Cine EI:  3200K,  4300K,  5500K

[Nasvet]
Prednastavljeno izbiro beline lahko tudi dodelite 
dodeljivemu gumbu (stran 48) in nato pritisnete 
gumb za spremembo nastavitve.
Način Custom: 3200K  4300K  5600K  6300K  
 3200K…

Način Cine EI: 3200K  4300K  5500K  3200K…

Spreminjanje temperature barve

1	 Pritisnite funkcijski gumb WHT BAL (G), da 
se vrednost temperature barve prikaže na 
belem ozadju.

2	 Zavrtite večfunkcijsko kolesce, da 
prilagodite vrednost.

[Nasveti]
ˎˎ V prednastavljenem načinu lahko nastavljate vrednost 

v korakih po 100 K.
ˎˎ V pomnilniškem načinu lahko nastavljate vrednost 

v korakih po 20 K v razponu od 2000 K do 5600 K. 
Vrednosti nad 5600 K lahko nastavite v intervalih, 
ki so ustrezajo količini barvne spremembe (mired) 
od 5580 K do 5600K. Nastavite lahko tudi vrednost 
odtenka z uporabo možnosti White (stran 74) > Tint 
v meniju Shooting glavnega menija.

Potek samodejne nastavitve belin

Nastavitev beline, ki se shrani v načinu 
pomnilnika A/pomnilnika B, se opravi 
samodejno.

1	 Izberite pomnilniški način A ali 
pomnilniški način B.

2	 Položite bel list papirja (ali drug bel 
predmet) na mesto z enakim virom 
svetlobe in enakimi svetlobnimi 
razmerami, kot veljajo za subjekt. Nato z 
objektivom približajte papir, tako da 
zapolnjuje sliko na zaslonu.

3	 Prilagodite svetlost.
Prilagodite zaslonko z uporabo postopka, 
opisanega v razdelku »Ročno prilagajanje 
zaslonke« (stran 42).

4	 Pritisnite gumb WB SET (stran 4).
ˎˎ Če nastavitev beline opravljate v 
pomnilniškem načinu, se vrednost 
nastavitve shrani v pomnilnik (A ali B), 
izbran v 1. koraku.
ˎˎ Če nastavitev beline opravljate v 
načinu ATW, se po opravljeni nastavitvi 
videokamera vrne nazaj v način 
nastavljanja beline ATW.

[Opomba]
Če prilagoditev ni uspešna, se na zaslonu za približno 
tri sekunde prikaže sporočilo o napaki. Če se sporočilo 
o napaki prikaže vsakokrat tudi po več ponovljenih 
poskusih nastavitve beline, stopite v stik s servisnim 
predstavnikom podjetja Sony.

Prilagajanje za naravne barve (White Balance)
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Zvok, ki ga želite posneti, lahko izberete z 
uporabo vhodnih priključkov, stikal in kolesc 
na videokameri.

Zunanji vhodni avdio priključki in izbirna 
stikala

Priključek INPUT1 (stran 7)
Priključek INPUT2 (stran 7)
Večvmesniški nastavek (stran 7)
Stikalo INPUT1 (LINE/MIC/MIC+48 V) 
(stran 7)
Stikalo INPUT2 (LINE/MIC/MIC+48 V) 
(stran 7)

Stikala za nastavitev ravni zvoka

Stikalo CH1 (AUTO/MAN) (stran 6)
Stikalo CH2 (AUTO/MAN) (stran 6)
Kolesce AUDIO LEVEL (CH1) (stran 6)
Kolesce AUDIO LEVEL (CH2) (stran 6)

Zaslon stanja zvoka

Izbira vhodne avdio naprave

1	 Nastavite zvočni vhod z možnostjo CH1/
CH2/CH3/CH4 >Source (stran 14) na 
zaslonu Audio Status ali možnostjo Audio 
Input >CH1 Input Select na CH4 Input 
Select (stran 90) v meniju Audio 
glavnega menija.
Če uporabljate mikrofon, ki se namesti na 
večvmesniški nastavek, adapter XLR ali 
napravo UWP (brezžični mikrofon UHF), na 
enak način izberite SHOE CH1 ali SHOE 
CH2. Za podrobnosti o adapterju XLR, 
glejte razdelek »Dodajanje vhodnih avdio 
priključkov« (stran 47).

	 [Opombe]
ˎˎ Zvok se ne snema v načinu Interval Rec ali v 

načinu Slow & Quick Motion.
ˎˎ Videokamera ima vgrajen vokalni mikrofon za 

snemanje ambientalnega zvoka. Uporabite ga 
lahko za časovno sinhronizacijo z ostalo opremo. 
V takšnih primerih izberite možnost Internal MIC.
ˎˎ Ko pritrdite držalo, se za snemanje zvoka vklopi 

samo notranji mikrofon v držalu (stran 7). 
Ko držalo ni pritrjeno, lahko uporabite vokalni 
mikrofon (stran 6) za snemanje zvoka v 
okolici.
ˎˎ Ko sta možnosti CH1 Input Select in CH2 Input 

Select nastavljeni na Internal MIC, raven 
snemanja zvoka CH1 in CH2 prilagajate s 
kolescem AUDIO LEVEL(CH1) (stran 6). Ko sta 
možnosti CH3 Input Select in CH4 Input Select 
nastavljeni na Internal MIC, raven snemanja zvoka 
CH3 in CH4 prilagajate z možnostjo CH3 Input 
Level (stran 90).

2	 Izberite vhodni vir zvoka.
Nastavite stikali INPUT1/INPUT2 (LINE/
MIC/MIC+48V) tako, da nastavitve 
ustrezajo napravam, priklopljenim na 
priključka INPUT1/INPUT2.

Povezana naprava Položaj stikala
Zunanji vir zvoka (npr. 
mešalna miza)

LINE

Dinamični mikrofon, 
baterijski mikrofon

MIC

Mikrofon z +48 V 
fantomskim napajanjem

MIC+48V

ˎˎ Z izbiro MIC+48 V in priklopom 
mikrofona, ki ni združljiv z napetostjo 
+48 V, lahko poškodujete priključeno 
napravo. Pred priklopom naprave 
preverite nastavitev.
ˎˎ Če se želite izogniti šumu na priključku, 
na katerega ni priklopljena nobena 
naprava, nastavite ustrezno stikalo 
INPUT1/INPUT2 (LINE/MIC/MIC+48 V) na 
LINE.

Samodejno prilagajanje ravni 
zvoka pri snemanju

Za kanal, za katerega želite samodejno 
prilagajanje, nastavite stikalo CH1/CH2 (AUTO/
MAN) na AUTO.
Za CH3/CH4 nastavite uravnavanje ravni zvoka 
na zaslonu Audio Status (stran 14) ali pa 
nastavite možnost Audio Input >CH3 Level 
Control in CH4 Level Control v meniju Audio 
glavnega menija na Auto (stran 90).

Ročno prilagajanje ravni zvoka pri 
snemanju

Uporabite sledeč postopek za prilagoditev 
ravni zvoka za CH1/CH2.

1	 Za kanal, za katerega želite ročno 
prilagoditi raven zvoka, nastavite stikalo 
CH1/CH2 (AUTO/MAN) na MAN.

2	 Med snemanjem ali v stanju 
pripravljenosti zavrtite kolesce AUDIO 
LEVEL (CH1)/(CH2) ustreznega kanala in 
nastavite raven zvoka.
ˎˎ Za CH3/CH4 nastavite uravnavanje 
ravni zvoka z CH3/CH4 (stran 14) na 
zaslonu Audio Status ali pa nastavite 
možnost Audio Input >CH3 Level Control 
ali CH4 Level Control v meniju Audio 
glavnega menija na Manual, nato pa 
prilagodite raven snemanja zvoka z 
možnostjo CH3 Input Level ali CH4 Input 
Level.
ˎˎ Ravni zvoka za kanale CH1 do CH4 lahko 
nastavite skupinsko. Raven snemanja 
lahko nastavite z dodeljivim kolescem 
(stran 48), ki ste mu dodelili funkcijo 
Audio Input Level, zaslonom Audio 
Status ali z uporabo možnosti Audio 
Input >Audio Input Level v meniju Audio 
glavnega menija.

[Nasvet]
Zaslon Audio Status je priročen za preverjanje ravni 
vhodnega zvoka (stran 14).

[Opombe]
ˎˎ Nastavitev ravni zvoka je lahko onemogočena, kar je 

odvisno od kombinacije nastavitev v meniju Audio. Za 
podrobnosti glejte diagram na 124.
ˎˎ Videokamera podpira kombinacije različnih 

nastavitev. Za podrobnosti glejte diagram na 124.

Nastavitev zvoka, ki ga želite posneti
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Dodajanje vhodnih avdio 
priključkov

Na videokamero lahko z uporabo adapterja 
XLR XLR-K2M (ni priložen) ali adapterja XLR 
XLR-K3M (ni priložen) istočasno priklopite do 
štiri kanale zvočnih naprav XLR.
Namestite adapter XLR na večvmesniški 
nastavek in na zaslonu Audio Status 
(stran 14) nastavite možnost CH3 >Source 
na Shoe CH1 in CH4 >Source na Shoe CH2. Ali 
pa nastavite možnost Audio Input > CH3 Input 
Select na Shoe CH1 in CH4 Input Select na 
Shoe CH2 v meniju Audio glavnega menija.
Funkcije videokamere, ki se prekrivajo, 
bodo onemogočene za kanale, na katerih 
je kot vhod izbran adapter XLR. Za izvedbo 
prilagoditev uporabite stikala in kolesca na 
adapterju XLR.

[Opombe]
ˎˎ Videokamera podpira digitalni 2-kanalni zvočni 

vmesnik XLR-K3M.
ˎˎ Če sta možnosti Audio Input > CH3 Level in CH4 

Level v meniju Audio nastavljeni na Audio Input 
Level, bo možnost Audio Input Level na videokameri 
nastavljena tako, da bo ustrezala ravni, nastavljeni na 
adapterju XLR.  
Raven avdio vhoda je omogočena tudi, ko je stikalo 
adapterja XLR nastavljeno na AUTO.  
Ko je izbrana možnost »Through«, bo zvok posnet z 
ravnjo, ki je nastavljena na adapterju XLR (stran 125).



3 Snemanje48 SL

Uporabne funkcije

Upravljanje z neposrednim 
menijem

Stanje in nastavitve videokamere lahko 
preverite na zaslonu iskala in tam neposredno 
izbirate in spreminjate nastavitve.
Nastavite lahko naslednje elemente.
ˎˎ AF z zaznavanjem obrazov/oči
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position/Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ EI Gain Value
ˎˎ Auto Shutter
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1	 Pritisnite večfunkcijsko kolesce ali dodeljiv 
gumb z dodeljeno funkcijo neposrednega 
menija.
Z oranžnim kazalcem lahko izberete samo 
tiste možnosti, ki jih je mogoče nastavljati 
z uporabo neposrednega menija.

2	 Zavrtite večfunkcijsko kolesce, da 
premaknete kazalec na možnost v meniju, 
ki jo želite nastaviti in nato pritisnite 
večfunkcijsko kolesce.
Prikaže se meni ali izbrana možnost na 
belem ozadju.

3	 Zavrtite večfunkcijsko kolesce, da izberete 
nastavitev in nato pritisnite večfunkcijsko 
kolesce.
Meni ali belo ozadje izgine in nova 
nastavitev se prikaže z oranžnim 
kazalcem.
Za izhod iz neposrednega menija 
ponovno pritisnite dodeljiv gumb z 
dodeljeno funkcijo neposrednega menija 
ali počakajte 3 sekunde.

	 [Nasveti]
ˎˎ Neposredne nastavitve lahko nastavljate tudi 

tako, da pritisnete in zadržite vsakega od 
funkcijskih gumbov (stran 5).
ˎˎ Ko se na belem ozadju prikažejo možnosti, lahko 

uporabite večfunkcijsko kolesce kot dodeljivo 
kolesce.
ˎˎ Za izbiro možnosti lahko uporabite tudi 

večfunkcijski gumb (stran 9).

Dodeljivi gumbi/kolesca

Na videokameri je devet dodeljivih gumbov 
(6, 7, 9), ki jim lahko dodelite funkcije.
Funkcije lahko dodelite tudi večfunkcijskemu 
kolescu na videokameri (stran 5), 
dodeljivemu kolescu na ročaju (stran 7) 
in dodeljivemu kolescu na držalu z daljinskim 
upravljalnikom (stran 9).

Spreminjanje funkcije gumba

Uporabite možnost Assignable Button 
(stran 79) v meniju Project glavnega menija.
Dodeljene funkcije lahko vidite na zaslonu 
Assignable Button Status (stran 15).

Tovarniško privzeta dodelitev funkcij 
dodeljivim gumbom
Gumb 1	 S&Q Motion
Gumb 2	 AF Speed/Sens.
Gumb 3	 Focus Setting
Gumb 4	 Focus Magnifier x3/x6
Gumb 5	 Direct Menu
Gumb 6	 Off
Gumb 7	 Focus Magnifier x3/x6
Gumb 8	 Direct Menu
Gumb 9	 Video Signal Monitor
Gumb Focus Hold	 Focus Hold

Dodeljive funkcije
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ AF z zaznavanjem obrazov/oči
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot
ˎˎ Rec

ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Glasnost
ˎˎ Thumbnail (Sličica)
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ Meni User
ˎˎ Menu

Spreminjanje funkcije kolesca

Spremenite lahko funkcijo večfunkcijskega 
kolesca na videokameri, dodeljivega kolesca 
na držalu in dodeljivega kolesca na ročaju.

Funkcijo večfunkcijskega kolesca nastavite 
z uporabo možnosti Multi Function Dial 
(stran 81) >Default Function v meniju 
Project.
Tovarniško privzeta nastavitev je izklopljeno.



3 Snemanje: Uporabne funkcije49 SL

Funkcije, ki jih lahko dodelite večfunkcijskemu 
kolescu
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Opomba]
Nastavitev je onemogočena med prikazom menija.

Za dodeljivo kolesce uporabite možnost 
Assignable Dial (stran 81) v meniju Project 
glavnega menija.
Funkcija IRIS je tovarniško privzeto dodeljena 
vsem.

[Nasvet]
Dodeljivo kolesce RM-30BP (dodatna možnost) upošteva 
nastavitve kolesca na držalu/daljinskem upravljalniku.

Funkcije, ki so dodeljive dodeljivemu kolescu 
na ročaju
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

Funkcije, ki so dodeljive dodeljivemu kolescu 
na držalu
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

Dodeljene funkcije lahko vidite na zaslonu 
Assignable Button Status (stran 15).

Počasni in hitri posnetki

Ko je format snemanja (stran 77) nastavljen na sledeče vrednosti, lahko določite drugačne 
vrednosti za hitrost sličic pri snemanju in hitrost sličic pri predvajanju.

Format zapisovanja Hitrost sličic
Sistemska 
frekvenca

Način zajema 
slike

Kodek video format

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1-60

RAW & XAVC-I 3840×2160P 1-60

XAVC-I 4096×2160P 1-60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

XAVC-L 3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

S35 XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF XAVC-I 4096×2160P 1-60

Način hitrih in počasnih posnetkov lahko 
vklopite/izklopite s pritiskom dodeljivega 
gumba (stran 48) z dodeljeno funkcijo hitrih 
in počasnih posnetkov.
Hitrost sličic za snemanje lahko nastavite tako, 
da pritisnete in zadržite gumb.

[Opombe]
ˎˎ Hitrega in počasnega snemanja ne morete nastaviti 

med snemanjem, predvajanjem ali kadar je prikazan 
zaslon sličic.
ˎˎ V načinu hitrih in počasnih posnetkov ni podprto 

snemanje zvoka.
ˎˎ V načinu hitrih in počasnih posnetkov so 

onemogočene funkcije samodejnega ostrenja, 
samodejne zaslonke in samodejnega zaklopa. 
Funkcijo samodejnega ostrenja lahko uporabite, ko je 
hitrost sličic nastavljena na naslednje vrednosti.

Sistemska frekvenca Hitrost sličic

59,94/29,97/23,98 30, 60, 120, 240

50/25 25, 50, 100, 200

ˎˎ Podrobnosti o uporabi izhodnega formata RAW si 
oglejte v 55.

Video snemanje s prekinitvami 
(intervalno snemanje)

Funkcija intervalnega snemanja vam omogoča, 
da zajamete videoposnetek s časovnim 
preskokom na notranji pomnilnik videokamere. 
Ta funkcija predstavlja učinkovit način za 
snemanje počasi premikajočih se subjektov.
Ko začnete snemati, videokamera samodejno 
posname določeno število sličic na določen 
časovni interval.

Interval snemanja (dolžina intervala)

Število sličic v enem posnetku
(Število sličic)

Ko je intervalno snemanje vklopljeno, se pred 
začetkom snemanja samodejno vklopi video 
luč HVL-LBPC (možnost), kar vam omogoča, da 
posnamete video v stabilni svetlobi s stabilno 
temperaturo barve (funkcija predosvetlitve).
[Opombe]
ˎˎ Naenkrat lahko uporabljate samo eno funkcijo 

posebnega načina snemanja, kot je intervalno snemanje.
ˎˎ Če med intervalnim snemanjem vklopite drugo 

funkcijo posebnega načina snemanja, se intervalno 
snemanje samodejno izklopi.
ˎˎ Način intervalnega snemanja se samodejno izklopi, 

če spremenite sistemske nastavitve, kot je na primer 
video format.
ˎˎ Intervalnega snemanja ne morete nastaviti med 

snemanjem, predvajanjem ali kadar je prikazan zaslon 
sličic.
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Nastavitev intervalnega snemanja

Vklopite možnost Interval Rec (stran 78) 
>Setting v meniju Project glavnega menija 
in nastavite možnosti Number of Frames in 
Interval Time.
Če uporabljate video luč HVL-LBPC (možnost), 
nastavite časovni interval za vklop video luči 
pred začetkom snemanja. To storite z uporabo 
možnosti Interval Rec >Pre-Lighting v meniju 
Project, kot je zahtevano.

[Opombe]
ˎˎ Če želite vklopiti video luč pred začetkom snemanja, 

nastavite stikalo video luči na AUTO. Video luč se 
vklopi in izklopi samodejno glede na nastavitev 
možnosti Video Light Set (stran 94) v meniju 
Technical.
ˎˎ Če vklopite stikalo video luči, bo video luč vedno 

svetila (video luč se ne bo vklopila/izklopila 
samodejno).
ˎˎ Če je video luč nastavljena tako, da se izklopi za 5 

sekund ali manj, se ne bo izklopila.

Ko videokamero izklopite, se način 
intervalnega snemanja izklopi, medtem pa 
nastavljeno število sličic in časovni interval 
ter nastavitve predosvetlitve ostanejo 
shranjene. Tako vam jih naslednjič, ko snemate 
v intervalnem načinu snemanja, ni treba 
ponovno nastavljati.

Snemanje z uporabo funkcije 
intervalnega snemanja

Za začetek snemanja pritisnite gumb za 
snemanje START/STOP. V iskalu se izmenjaje 
prikazujeta oznaki »Int Rec« in »Int Stby«.
Če uporabljate funkcijo predosvetlitve, se pred 
začetkom snemanja vklopi video luč.

Zaustavitev snemanja

Ustavite snemanje.
Ko je snemanje zaključeno, se video posnetki, 
ki so se do tega trenutka shranili v pomnilnik, 
zapišejo na pomnilniški medij.

Izhod iz načina intervalnega snemanja

Naredite nekaj od sledečega.
ˎˎ Prestavite stikalo POWER v položaj za izklop.
ˎˎ Ko je videokamera v stanju pripravljenosti, 
nastavite možnost set Interval Rec >Setting 
v meniju Project na izklopljeno.

Način intervalnega snemanja ostane izklopljen 
tudi, ko ponovno zaženete videokamero.

Omejitve med snemanjem

ˎˎ Zvok se ne posname.
ˎˎ Ogled posnetka (Rec Review) ni mogoč.

Če med snemanjem izklopite 
videokamero

ˎˎ Če stikalo POWER na videokameri prestavite 
v položaj izklopljeno, videokamera še nekaj 
sekund dostopa do pomnilniškega medija, 
da nanj zapiše posnetke, ki so se do tistega 
trenutka shranili v notranji pomnilnik. Nato 
se samodejno izklopi.
ˎˎ Če pride do prekinitve napajanja zaradi 
odstranitve baterije, odklopa napajalnega 
kabla DC ali izklopa napajanja na omrežnem 
napajalniku, se video in zvočni posnetki, 
narejeni do tega trenutka, lahko izgubijo 
(največ 10 sekund). Menjavo baterije 
opravite pazljivo.

Sočasno snemanje na pomnilniški 
kartici A in B (2-slot Simul Rec)

Sočasno lahko snemate na obe pomnilniški 
kartici, A in B, če vklopite možnost Simul Rec 
(stran 14) na zaslonu Project status ali Simul 
Rec > Setting (stran 78) v meniju Project 
glavnega menija.

Video Signal Monitor

Nastavite lahko tip video signala za prikaz 
v iskalu - valovna oblika, vektorskop ali 
histogram. To storite z uporabo možnosti 
Display On/Off >Video Signal Monitor 
(stran 88) v meniju Monitoring.
Oranžna črta označuje nastavljeno vrednost 
na ravni Zebra.

Nadzorovanje ciljnega zaslona

V načinu Cine EI je podatek o nastavitvi 
barvnega prostora (stran 24) ali nastavitvi 
LUT (stran 76) prikazan v zgornjem desnem 
delu zaslona video signala, s čimer je označen 
cilj nadzorovanja.

Clip Flags

Zastavico posnetka OK lahko dodate posnetku, 
če pritisnete gumb Clip Flag (stran 5) in 
izberete možnost Add OK.
Zastavico posnetka lahko izbrišete tako, da 
dvakrat pritisnete gumb in izberete možnost 
Delete Clip Flag.

[Nasveti]
ˎˎ Za dodajanje zastavic posnetkov lahko uporabite 

tudi dodeljiv gumb, ki je dodeljen funkciji zastavice 
posnetka (stran 48).
ˎˎ Zastavico posnetka lahko dodate tudi z možnostjo Set 

Clip Flag (stran 92) v meniju Thumbnail glavnega 
menija (stran 65).
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Snemanje proxy
Ta funkcija vam omogoča, da hkrati 
posnamete podatke proxy z nizko ločljivostjo 
in videoposnetek z izvornimi podatki v visoki 
ločljivosti.

Za podrobnosti o podprtih pomnilniških karticah, 
formatiranju pomnilniških kartic in preverjanju preostale 
kapacitete glejte razdelek »Uporaba pomnilniških kartic« 
(stran 26).

Konfiguriranje pred snemanjem

1	 Vklopite možnost Proxy Rec (stran 14) 
na zaslonu Project ali možnost Proxy Rec > 
Setting (stran 78) v meniju Project 
glavnega menija.

2	 Vstavite pomnilniško kartico v režo za 
kartice CFexpress tipa A/SD (stran 7).
ˎˎ Pri karticah CFexpress mora biti nalepka 
na levi strani.
ˎˎ Pri karticah SD mora biti nalepka na 
desni strani, z zaobljenim vogalom na 
dnu.

[Opomba]
Funkcije Proxy Rec ne morete vklopiti hkrati s funkcijama 
S&Q Motion ali Interval Rec. Ko je snemanje proxy 
vklopljeno, se ti načini snemanja prisilno izklopijo.

Snemanje posnetka proxy

Pritisnite gumb za snemanje START/STOP, če 
želite začeti snemati po dokončanju potrebnih 
nastavitev za snemanje.

[Opombe]
ˎˎ Celovitost podatkov na kartici ne bo zagotovljena, 

če izklopite videokamero ali odstranite pomnilniško 
kartico medtem, ko je dostop do kartice še v teku. Vsi 
podatki, zapisani na kartici, se lahko zavržejo. Vedno 
se prepričajte, da je indikator dostopa do pomnilniške 
kartice izklopljen preden izklopite videokamero ali 
odstranite pomnilniško kartico.
ˎˎ Pazite, da pomnilniška kartica ne izskoči, ko jo vstavite 

ali odstranite.

Za izhod ustavite snemanje.

Nastavitev možnosti Audio 
Channel za proxy snemanje

Izberite možnost Proxy Rec > Audio Channel 
(stran 78) v meniju Project glavnega menija 
in nastavite avdio kanal za proxy zapisovanje 
podatkov.

O posneti datoteki

Končnica imena datoteke je ».mp4«.
Sočasno se posname tudi časovna koda.

Mesto shranjevanja posnete 
datoteke

Zapisana datoteka se shrani v naslednji 
imenik.

Zapisovalni medij Pot mape
SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

O imenu datoteke

Ime datoteke je sestavljeno iz imena posnetka, 
shranjenega na pomnilniško kartico, in 
pripone »S03«.
Za podrobnosti o imenih posnetkov glejte 
možnost Clip Name Format (stran 86) v 
meniju TC/Media glavnega menija.
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Snemanje s funkcijo Desired Look
Ko je videokamera v načinu Custom, lahko 
dodate prilagoditve parametrom black, matrix 
in drugim ter tako ustvarite »videz«, ki temelji 
na osnovnem videzu.

：

Videz

Matrix

Črn

Osnovni videz

Hitro lahko tudi izberete drugačen videz tako, 
da shranite različne kombinacije nastavitev v 
datotekah s prizorom.
V videokameri je privzeto na voljo šest 
prednastavljenih videzov.

Izbiranje videza

1	 Ko je prikazan zaslon za snemanje, 
pritisnite večfunkcijsko kolesce.

2	 Izberite ikono SCN.

3	 Pritisnite večfunkcijsko kolesce.

4	 V meniju izberite želeni videz in pritisnite 
večfunkcijsko kolesce.

[Nasveti]
ˎˎ Naslednje prednastavitve so tovarniško privzeto 

nastavljene.

Shooting Mode Custom
Target Display SDR(BT.709) HDR(HLG)
Scene file 1 S-Cinetone HLG Live

Scene file 2 Standard HLG Natural

Scene file 3 Fotografije (Not 
registered)

Scene file 4 ITU709 (Not 
registered)

Scene files  
5 to 16

(Not 
registered)

(Not 
registered)

ˎˎ Videz lahko izberete tudi z možnostjo Scene File 
(stran 13) na zaslonu Main Status ali z možnostjo 
Scene File > Recall (stran 83) in v meniju Paint/Look 
glavnega menija. Prednastavljen videz lahko prikličete 
tudi z možnostjo Scene File > Preset Recall.

Uvoz želenega osnovnega videza

Kot osnovni videz lahko tudi uvozite datoteko 
3D LUT, ki ste jo ustvarili v računalniku ali drugi 
napravi. Uvozite lahko največ 16 datotek.
ˎˎ Oblika zapisa datoteke: Datoteka CUBE 
(*.cube) za 17-točkovno ali 33-točkovno 
datoteko 3D LUT, ki ste jo ustvarili z 
možnostjo Catalyst Browse, RAW Viewer 
ali DaVinci Resolve* (avtorjev Blackmagic 
Design Pty. Ltd.).
*	 Preverjeno z Resolve V9.0, V10.0 in V11.0.

ˎˎ Input color space/Gamma: S-Gamut3.
Cine/S-Log3 or S-Gamut3/S-Log3

1	 V računalniku ali drugi napravi shranite 
datoteko 3D LUT v določeno mapo ali na 
zapisovalni medij.

Zapisovalni 
medij

Pot mape

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress 
Type A

/SONY/PRO/LUT/

2	 Vstavite zapisovalni medij, na katerem so 
shranjene datoteke 3D LUT, v režo za 
kartice CFexpress tipa A/SD (B).

3	 Izberite možnost Base Look > Import 
(stran 83) v meniju Paint/Look 
glavnega menija.

4	 Izberite ciljno mesto uvoza.

5	 Izberite datoteko 3D LUT, ki jo želite 
uvoziti.
Upoštevajte navodila na zaslonu. 
Videokamera obravnava datoteko 3D LUT 
kot osnovni videz.

6	 Izberite uvoženo datoteko 3D LUT z 
možnostjo Base Look > Select (stran 83) 
v meniju Paint/Look glavnega menija.

7	 Konfigurirajte možnost Base Look > Input 
and Output (stran 83) v meniju Paint/
Look glavnega menija, da se bo ujemala z 
lastnostmi uvožene datoteke 3D LUT.

Prilagajanje prešibki osvetlitvi

V primeru nagibanja k prešibki osvetlitvi, ko 
izberete samodejno osvetlitev ob uporabi 
uvoženega osnovnega videza, prilagodite 
možnost Base Look > AE Level Offset 
(stran 83) v meniju Paint/Look.

[Opombe]
ˎˎ Sam uvoz datoteke 3D LUT ne vpliva na sliko. Naložite 

uvoženo datoteko 3D LUT z možnostjo Base Look > 
Select (stran 83) v meniju Paint/Look glavnega 
menija.
ˎˎ Če vnos ni pravilno nastavljen, ne boste dobili 

ustreznega videza.
ˎˎ Nastavitve elementov menijev Input, Output in AE 

Level Offset se uporabijo pri osnovnem videzu, ki ste 
ga izbrali z možnostjo Select. Če uvozite več datotek 
3D LUT, izberite možnost Select za vsako datoteko 3D 
LUT in konfigurirajte Input, Output in AE Level Offset 
posamezno za vsako datoteko.
ˎˎ Konfigurirane nastavitve Input, Output in AE Level 

Offset se shranijo za vsako datoteko 3D LUT.
ˎˎ Izbirne možnosti osnovnega videza/LUT za uvožene 

datoteke 3D LUT so skupne načinom SDR(BT.709)/
HDR(HLG)/Cine EI, toda barvni prostor in pretvorba v 
gamo nista izvedena v skladu s temi načini.
ˎˎ Datoteke 3D LUT se ne izbrišejo, ko izberete možnost 

All Reset > Reset v meniju Maintenance.
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Prilagajanje videza

Videz lahko prilagajate glede na osnovni 
videz z uporabo elementa Matrix in drugih 
nastavitvenih elementov v meniju Paint/
Look glavnega menija. Podrobnosti vseh 
nastavitvenih elementov si oglejte v 83.
Videokamero priključite na televizor ali zaslon, 
nato pa med opazovanjem slike na televizorju 
ali zaslonu prilagodite kakovost slike.

[Opomba]
Ko uvozite datoteko 3D LUT in jo uporabite na sliki, ne 
boste dosegli želenega videza, ki je določen v datoteki 
3D LUT, če spremenite element Matrix in nastavitve, ki 
ne sodijo med nastavitve osnovnega videza v meniju 
Paint/Look. Vse prilagojene nastavitve lahko ponastavite 
z možnostjo Reset Paint Settings > Reset without Base 
Look (stran 83) v meniju Paint/Look glavnega menija.

Shranjevanje videza

Trenutni videz lahko shranite v notranji 
pomnilnik kot datoteko s prizorom z 
možnostjo Scene File > Store (stran 83) v 
meniju Paint/Look glavnega menija.
Hitro lahko shranite z operacijami v 
neposrednem meniju v zaslonu za snemanje.

[Opomba]
Če izberete drug videz, ne da bi shranili trenutni videz, 
bo trenutni videz zavržen.

[Nasvet]
Prednastavljene datoteke s prizori lahko prepišete.
Če želite obnoviti prednastavljeno datoteko s prizorom, 
naložite videz, ki ga želite obnoviti, z možnostjo Scene 
File >Preset Recall (stran 83) v meniju Paint/Look 
glavnega menija, nato pa shranite datoteko s prizorom z 
možnostjo Scene File > Store.

Brisanje shranjenega videza

Datoteko s prizorom, ki je shranjena v 
notranjem pomnilniku, lahko izbrišete z 
možnostjo Scene File > Delete (stran 83) v 
meniju Paint/Look glavnega menija.

[Nasvet]
Ko je izbrisana, ni več prikazana v neposrednem meniju.

Brisanje osnovnega videza

Uvoženo datoteko 3D LUT lahko izbrišete z 
možnostjo Base Look > Delete (stran 83) v 
meniju Paint/Look glavnega menija.
Vse uvožene datoteke 3D LUT lahko izbrišete z 
možnostjo Base Look > Delete All (stran 83) 
v meniju Paint/Look glavnega menija.

[Opombe]
ˎˎ Pred izbrisom preverite, da osnovni videz ni 

uporabljen v kateri koli datoteki s prizorom. Če 
izbrišete osnovni videz, ki je v uporabi, bo videz 
ustreznih datotek s prizori nepravilen.
ˎˎ Uvožene datoteke 3D LUT se ne izbrišejo, ko izberete 

možnost All Reset > Reset (stran 99) v meniju 
Maintenance glavnega menija.
ˎˎ Izbrisanega osnovnega videza ne morete več 

uporabiti kot datoteko LUT v načinu Cine EI 
(stran 54).
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Snemanje s prilagajanjem videza v postprodukciji
Če uporabite videokamero v načinu Cine EI 
in snemate enakomerne prehode iz temnih 
območij v svetla območja, lahko opravite 
natančne popravke, na primer lokalno 
obnovite prehode temnih in svetlih območij v 
postprodukciji.
Če posnete slike gledate na običajnem 
monitorju, bo skupni kontrast šibek, zato bodo 
popravki ostrenja in osvetlitve težavni.
Datoteko LUT lahko uporabite na cilju 
monitorja v videokameri, kar vam bo 
v pomoč pri različnih popravkih med 
snemanjem. Datoteko LUT lahko uporabite 
tudi pri predvajanju videoposnetkov, ko želite 
pregledati končni izdelek.
Datoteke LUT uporabljajo naslednji sistemi. 
Toda uporabite lahko samo eno datoteko LUT.
ˎˎ Izhod SDI in izhod HDMI
ˎˎ Iskalo in proxy slike, pretakanje
ˎˎ Videoposnetek, posnet na zapisovalni medij

Uporaba datoteke LUT na sliki v 
iskalu

1	 Pritisnite gumb MENU, da se prikaže 
zaslon Monitoring Status.

2	 Izberite stolpec Gamut/Gamma v vrstici 
VF.

3	 Izberite On ali Off.

[Opombe]
ˎˎ Nastavitev LUT On/Off pri VF se uporabi tudi na proxy 

datoteki in pretakanju videoposnetka.
ˎˎ Izboljšan prikaz game je na voljo med uporabo 

povečevala ostrenja.

[Nasveti]
ˎˎ Nastavite lahko tudi s funkcijo LUT On/Off > VF/Proxy/

Stream (stran 76) v meniju Shooting glavnega 
menija.
ˎˎ SDI/HDMI je mogoče nastaviti podobno kot VF.
ˎˎ Za videoposnetek na zapisovalnem mediju lahko 

nastavite z možnostjo LUT On/Off > Internal Rec 
(stran 76) v meniju Shooting glavnega menija.

Spreminjanje datoteke LUT

1	 Pritisnite gumb MENU, da se prikaže 
zaslon Monitoring Status.

2	 Izberite polje Base Look/LUT.

3	 Izberite datoteko LUT, ki jo želite uporabiti, 
s seznama osnovnih videzov.

[Nasveti]
ˎˎ Uvozite in uporabite lahko tudi datoteko 3D LUT. 

s709, 709(800%) ali S-Log3 lahko izberete za osnovni 
videz. Podrobnosti najdete v razdelkih »Uvoz 
želenega osnovnega videza« (stran 52) in »Brisanje 
osnovnega videza« (stran 53).
ˎˎ Osnovni videz lahko nastavite tudi s funkcijo Base 

Look > Select (stran 83) v meniju Paint/Look 
glavnega menija.

Spreminjanje porazdelitve temnih 
in svetlih območij na videoposnetku

Porazdelitev temnih in svetlih območij 
lahko spreminjate, če želite na primer dati 
prednost tonu temnih območij, in sicer tako, 
da spremenite nastavitev Exposure Index v 
osnovni občutljivosti.

1	 Uporaba datoteke LUT na sliki v iskalu 
(stran 54).

2	 Pritisnite gumb MENU, da se prikaže 
zaslon Camera Status.

3	 Nastavite polja L/M/H možnosti Exposure 
Index.
Posamezne nastavitve so dodeljene 
položajem L/M/H stikala ISO/GAIN 
(stran 5).

4	 Izberite vrednost Exposure Index, ki jo 
boste uporabili s stikalom ISO/GAIN.

5	 Ustrezno prilagodite osvetlitev slike v 
iskalu.

[Opomba]
Izboljšan prikaz game je na voljo med uporabo 
povečevala ostrenja. Nastavitev Exposure Index se ne 
uporablja pri izboljšanem prikazu game.

[Nasveti]
ˎˎ Osvetlitev lahko prilagodite tudi s funkcijo ISO/Gain/

EI > Exposure Index (stran 72) v meniju Shooting 
glavnega menija.
ˎˎ Druga številska vrednost nastavitve označuje, 

koliko korakov informacij o svetlobi je dodeljenih 
svetlim območjem (svetlost, večja kot pri 18 % sivini). 
Območja, ki so svetlejša od teh, so presvetljena.  
Primer: V »400EI/5.0E« je dodeljenih 5.0 korakov na 
svetli strani.
ˎˎ S tem si lahko med snemanjem tudi pomagate pri 

preverjanju odtenka temnih in svetlih območij.  
Če je na primer položaj M osnovna občutljivost, 
položaj L ima 2 koraka manj in položaj H 2 koraka 

več, lahko preverite s preklopom stikala ISO/GAIN. 
Po preverjanju osvetlitve se ne pozabite vrniti v 
položaj M.
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Posnamete lahko video signal RAW, ki gre iz 
priključka SDI OUT na videokameri v podprt 
zunanji snemalnik.

1	 Priključite zunanji snemalnik RAW v 
priključek SDI OUT na videokameri.

2	 Nastavite način snemanja na zaslonu 
Project status (stran 14) ali pa nastavite 
možnost Base Setting > Shooting Mode 
(stran 77) v meniju Project glavnega 
menija na Cine EI.

3	 Nastavite način skeniranja (samo FF) s 
funkcijo Imager Scan na zaslonu Project 
status ali pa nastavite možnost Rec 
Format > Imager Scan Mode (stran 77) 
v meniju Project glavnega menija.

4	 Nastavite kodek na zaslonu Project status 
ali pa nastavite možnost Rec Format > 
Codec (stran 77) v meniju Project 
glavnega menija na kodek, ki vključuje 
RAW.
Če izberete RAW & XAVC-I, boste sočasno 
posneli videoposnetek RAW na zunanji 
snemalnik RAW in na pomnilniške kartice 
v videokameri.

5	 Nastavite ločljivost na zaslonu Project ali 
pa nastavite možnost Rec Format > RAW 
Output Format (stran 77) v meniju 
Project glavnega menija.

6	 Preverite, ali je zunanji snemalnik 
vklopljen, nato pa pritisnite gumb za 
snemanje START/STOP na videokameri.

	 [Opomba]
Ko se snemanje z zunanjim snemalnikom začne, 
ne da bi uporabili gumb za snemanje START/STOP 
na videokameri, videoposnetki ne bodo ustrezno 
posneti.

Podprti izhodni formati RAW so prikazani 
spodaj.

Sistemska 
frekvenca

Kodek RAW Output 
Format

59,94/
50/
29,97/
25/
23,98

RAW 4096×2160

3840×2160

RAW & XAVC-I 4096×2160

3840×2160

24 RAW 4096×2160

RAW & XAVC-I 4096×2160

Indikator stanja snemanja

Ko je vklopljena nastavitev Display On/Off 
(stran 87) > RAW Output Control Status v 
meniju Monitoring glavnega menija, stanje 
snemanja RAW označuje ikona, ki je prikazana 
na zaslonu iskala.

[Opomba]
Nadzorni signal snemanja pride iz priključka SDI OUT 
na videokameri, stanja zunanjega snemalnika pa ni 
mogoče pridobiti. Zato lahko videokamera daje znak, 
da snemanje videoposnetka RAW poteka, medtem ko 
zunanji snemalnik v resnici ne bo snemal. Pravilno stanje 
si oglejte prek indikatorja na zunanjem snemalniku.

[Nasvet]
Prikazana je tudi vrednost nastavitve izhodnega formata 
RAW.

Snemanje počasnih in hitrih 
posnetkov

Če je nastavitev S&Q Motion > Setting v meniju 
Shooting vklopljena, bo videoposnetek RAW 
posnet v načinu Slow & Quick Motion.
Podrobnosti o podprtih hitrostih sličic za 
snemanje si oglejte v razdelku 49.

Snemanje videoposnetka RAW
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Povezovanje z ostalimi napravami prek povezave LAN
Videokamero lahko prek povezave LAN 
povežete s pametnimi telefoni, tabličnimi 
računalniki in drugimi napravami.
Vzpostavitev povezave LAN med videokamero 
in drugo napravo omogoči sledeče z uporabo 
aplikacije »Content Browser Mobile«.
ˎˎ Daljinsko upravljanje prek povezave LAN 
Videokamero lahko upravljate s pametnim 
telefonom, tabličnim računalnikom ali 
računalnikom, ki je na videokamero 
priklopljen prek povezave LAN.
ˎˎ Prenos datotek prek povezave LAN 
Prek povezave LAN lahko v strežnik 
prenesete datoteko proxy (v nizki ločljivosti) 
ali originalno datoteko (v visoki ločljivosti), 
ki je zapisana na pomnilniški kartici v 
videokameri.
ˎˎ Nadzor videa prek povezave LAN 
Ustvarite lahko video podatkovni tok (H.264) 
s kamere ali predvajate video s kamere 
in nadzorujete video z uporabo aplikacije 
»Content Browser Mobile« na napravi, ki je 
povezana prek povezave LAN.

Aplikacija »Content Browser Mobile«

Z aplikacijo »Content Browser Mobile« 
lahko daljinsko upravljate z videokamero in 
spreminjate nastavitve videokamere prek 
zaslona druge naprave ter nadzorujete video, 
ki ga snema videokamera.

Za podrobnosti o aplikaciji »Content Browser Mobile« se 
obrnite na prodajnega ali servisnega predstavnika podjetja 
Sony.

Nastavitev uporabniškega imena 
in gesla

Za uporabo omrežne funkcije nastavite 
uporabniško ime in geslo videokamere.

1	 Nastavite Access Authentication > User 
Name (stran 95) v meniju Network 
glavnega menija.

2	 Nastavite Access Authentication > 
Password (stran 95) v meniju Network 
glavnega menija.

Povezovanje z uporabo načina 
dostopovne točke za brezžični LAN

Videokamera deluje kot dostopovna točka 
in se poveže z drugo napravo prek brezžične 
povezave LAN.

Pametni telefon/tablični računalnik

Vzpostavljanje povezave z napravo, 
združljivo s funkcijo NFC, z enim dotikom

Naprave, ki podpirajo NFC, lahko povežete 
(povezava z enim dotikom) z uporabo funkcije 
NFC.

1	 Odprite nastavitve [Settings] na napravi, 
izberite več [More] in postavite kljukico v 
polje za vklop funkcije NFC.

2	 Vklopite videokamero.

3	 Aktivirajte funkcijo NFC.
Za aktiviranje načina povezave NFC 
pritisnite in zadržite (za 3 sekunde) 
dodeljiv gumb z dodeljeno funkcijo NFC 
ali izberite možnost Wireless LAN >NFC v 
meniju Network.
Funkcija NFC je na voljo samo takrat, ko je 
na zaslonu prikazana ikona .

4	 Z napravo se dotaknite videokamere.
Naprava se poveže z videokamero in 
zažene se aplikacija »Content Browser 
Mobile«.

	 [Opombe]
ˎˎ Pred tem onemogočite način mirovanja in 

zaklep zaslona.
ˎˎ Z napravo se dotaknite videokamere in jo držite 

pri miru, dokler se ne zažene aplikacija »Content 
Browser Mobile« (1 do 2 sekundi).
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Povezovanje z napravo, združljivo z WPS

Naprave, ki podpirajo WPS, lahko povežete z 
uporabo funkcije WPS.

1	 Izberite možnost Wireless LAN > Setting > 
Access Point Mode v meniju Network 
glavnega menija.

2	 Izberite možnost Wireless LAN > WPS > 
Execute v meniju Network celovitega 
menija.

3	 Odprite nastavitve omrežja na napravi ali 
nastavitve za Wi-Fi na napravi in vklopite 
Wi-Fi.

4	 S seznama omrežij Wi-Fi v napravi izberite 
SSID videokamere. Nato v možnostih na 
napravi pritisnite gumb WPS za 
vzpostavitev povezave.

	 [Opombe]
ˎˎ Način uporabe se med različnimi napravami 

razlikuje.
ˎˎ Za SSID in geslo videokamere si oglejte AP Mode 

Settings > Camera SSID & Password (stran 97) 
v meniju Network glavnega menija.

5	 Povežite z uporabo aplikacije Content 
Browser Mobile.

Povezovanje z vnosom SSID-ja in gesla 
na napravi
Videokamero lahko povežete z napravo 
tako, da na napravi vnesete SSID in geslo 
videokamere.

1	 Izberite možnost Wireless LAN > Setting > 
Access Point Mode v meniju Network 
glavnega menija.

2	 Odprite nastavitve omrežja na napravi ali 
nastavitve za Wi-Fi na napravi in vklopite 
Wi-Fi.

3	 Povežite napravo na videokamero tako, da 
s seznama brezžičnih omrežij na napravi 
izberete SSID videokamere in vnesete 
geslo.
Za SSID in geslo videokamere uporabite 
možnost AP Mode Settings >Camera SSID 
& Password (stran 97) v meniju 
Network.

	 [Opomba]
Način uporabe se med različnimi napravami 
razlikuje.

4	 Povežite z uporabo aplikacije Content 
Browser Mobile.

Povezovanje z uporabo načina 
Wireless LAN Station

Videokamera se kot odjemalec poveže na 
obstoječo dostopovno točko brezžičnega 
LAN-a. Videokamera in naprava se povežeta 
prek dostopovne točke.
Zadnjih 10 povezanih dostopovnih točk je 
prikazanih v zgodovini.
Zgodovina povezav je shranjena v datoteki 
ALL. Gesla za dostop se ne shranijo. Ko 
naložite datoteko ALL, je ob naslednjem 
povezovanju potreben vnos gesla.

Pametni telefon/ 
tablični računalnik

Dostopovna točka

računalnik

Povezovanje na dostopovno točko z 
uporabo funkcije WPS

Če je dostopovna točka združljiva s funkcijo 
WPS, lahko videokamero povežete na 
dostopovno točko z nekaj enostavnimi 
nastavitvami.

1	 Vklopite dostopovno točko.

2	 Vklopite videokamero.

3	 Izberite možnost Wireless LAN > Setting > 
Station Mode v meniju Network glavnega 
menija.

4	 Izberite možnost ST Mode Settings > 
Camera Remote Control (stran 95) > 
Enable v meniju Network glavnega 
menija.

5	 Izberite možnost Wireless LAN > WPS > 
Execute v meniju Network glavnega 
menija.

6	 Pritisnite gumb WPS na dostopovni točki.
Za podrobnosti o delovanju gumba WPS 
glejte navodila za uporabo dostopovne 
točke.
Ko je povezava uspešno vzpostavljena, 
indikator stanja omrežja na zaslonu iskala 
prikazuje jakost 1 ali višjo.

	 [Opomba]
Če povezava ne uspe, ponovite navedene korake 
od 1. koraka.

7	 Povežite napravo na dostopovno točko.
Za podrobnosti o povezovanju glejte 
navodila za uporabo naprave.

8	 Povežite z uporabo aplikacije Content 
Browser Mobile.
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Povezovanje na dostopovno točko z 
uporabo samodejnega zaznavanja 
omrežja ali ročno

Povezavo na želeno dostopovno točko lahko 
nastavite v glavnega meniju.
Povezavo na želeno dostopovno točko lahko 
nastavite z uporabo funkcije samodejnega 
zaznavanja omrežja.

Povezovanje z uporabo funkcije samodejnega 
zaznavanja omrežja

1	 Opravite korake od 1 do 3 v razdelku 
»Povezovanje na dostopovno točko z 
uporabo funkcije WPS« (stran 57).

2	 Izberite možnost ST Mode Settings > Scan 
Networks (stran 96) > Execute v meniju 
Network glavnega menija.
Videokamera zažene zaznavanje ciljev 
povezovanja.
Najdeni možni cilji se prikažejo na 
seznamu.

3	 Izberite cilj s seznama.
Pojavi se zaslon s podrobnostmi omrežja 
(dostopovne točke). Izbrana povezava je 
prikazana v SSID-ju.

4	 Izberite geslo in nastavite geslo na 
zaslonu za vnos gesla.
Izbira SSID-ja v zgodovini povezav 
samodejno prilagodi nastavitve, vključno 
z geslom.
Vnesite geslo, da se vrnete na zaslon s 
podrobnostmi o omrežju (dostopovni 
točki).

5	 Prilagodite naslednje nastavitve povezave.
ˎˎ DHCP 
Določite nastavitve DHCP.  
Ko je DHCP vklopljen, se videokameri 
samodejno dodeli naslov IP.  
Če želite naslov IP videokamere določiti 
ročno, izklopite DHCP.
ˎˎ IP Address 
Vnesite IP naslov enote.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.
ˎˎ Subnet Mask 
Vnesite masko podomrežja enote.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.
ˎˎ Gateway 
Vnesite prehod za dostopovno točko.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.
ˎˎ DNS Auto 
Nastavite, ali naj se DNS pridobi 
samodejno.  
Ko je samodejni DNS vklopljen, se naslov 
strežnika DNS pridobi samodejno. Ta 
nastavitev je na voljo samo, če je DHCP 
vklopljen.
ˎˎ Primary DNS Server 
Vnesite primarni strežnik DNS za 
dostopovno točko.  
Ta nastavitev je na voljo samo, če je 
samodejni DNS izklopljen.
ˎˎ Secondary DNS Server 
Vnesite sekundarni strežnik DNS za 
dostopovno točko.  
Ta nastavitev je na voljo samo, če je 
samodejni DNS izklopljen.

6	 Ko zaključite, izberite možnost Connect za 
vzpostavitev povezave na dostopovno 
točko.

Ročno povezovanje

1	 Opravite korake od 1 do 3 v razdelku 
»Povezovanje na dostopovno točko z 
uporabo funkcije WPS« (stran 57).

2	 Izberite možnost ST Mode Settings > 
Manual Register (stran 96) > Execute v 
meniju Network glavnega menija.
Za trenutek se prikaže zaslon s 
podrobnostmi o omrežju (dostopovni 
točki).

3	 Prilagodite naslednje nastavitve povezave.
ˎˎ SSID 
Vnesite SSID za povezavo na 
dostopovno točko.
ˎˎ Security 
Izberite način šifriranja.
ˎˎ Password 
Vnesite geslo za povezavo na 
dostopovno točko.
ˎˎ DHCP 
Določite nastavitve DHCP.  
Ko je DHCP vklopljen, se videokameri 
samodejno dodeli naslov IP.  
Če želite naslov IP videokamere določiti 
ročno, izklopite DHCP.
ˎˎ IP Address 
Vnesite IP naslov enote.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.
ˎˎ Subnet Mask 
Vnesite masko podomrežja enote.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.
ˎˎ Gateway 
Vnesite naslov prehoda.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.

ˎˎ DNS Auto 
Nastavite, ali naj se DNS pridobi 
samodejno.  
Ko je samodejni DNS vklopljen, se naslov 
strežnika DNS pridobi samodejno. Ta 
nastavitev je na voljo samo, če je DHCP 
vklopljen.
ˎˎ Primary DNS Server 
Vnesite naslov primarnega strežnika 
DNS.  
Ta nastavitev je na voljo samo, če je 
samodejni DNS izklopljen.
ˎˎ Secondary DNS Server 
Vnesite naslov sekundarnega strežnika 
DNS.  
Ta nastavitev je na voljo samo, če je 
samodejni DNS izklopljen.

4	 Ko zaključite, izberite možnost Connect za 
vzpostavitev povezave na dostopovno 
točko.



4 Omrežne funkcije: Povezovanje z ostalimi napravami prek povezave LAN59 SL

Povezovanje z napravo s kablom 
LAN

Z napravo se lahko povežete tako, da s kablom 
LAN povežete priključek žičnega omrežja LAN 
na adapterju žičnega omrežja LAN (dodatna 
možnost), ki je povezan s priključkom USB-C 
(stran 7) videokamere, z usmerjevalnikom 
omrežja Wi-Fi (dodatna možnost).

Pametni telefon/tablični računalnik

Usmerjevalnik Wi-Fi

Povezovanje s kablom LAN in nastavitve 
žične povezave LAN

1	 S kablom LAN povežite priključek žičnega 
omrežja LAN na adapterju žičnega 
omrežja LAN z usmerjevalnikom omrežja 
Wi-Fi.

2	 Vklopite videokamero.

3	 Vklopite možnost Wired LAN > Setting 
(stran 97) v meniju Network glavnega 
menija.

4	 Določite nastavitve povezave z uporabo 
možnosti Wired LAN >Detail Settings 
(stran 97) v meniju Network.
ˎˎ DHCP 
Določite nastavitve DHCP.  
Ko je DHCP vklopljen, se videokameri 
samodejno dodeli naslov IP.  
Če želite naslov IP videokamere določiti 
ročno, izklopite DHCP.
ˎˎ IP Address 
Vnesite IP naslov enote.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.
ˎˎ Subnet Mask 
Vnesite masko podomrežja enote.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.
ˎˎ Gateway 
Vnesite naslov prehoda.  
Ta možnost je na voljo samo, če je DHCP 
izklopljen.
ˎˎ DNS Auto 
Nastavite, ali naj se DNS pridobi 
samodejno.  
Ko je samodejni DNS vklopljen, se naslov 
strežnika DNS pridobi samodejno. Ta 
nastavitev je na voljo samo, če je DHCP 
vklopljen.

ˎˎ Primary DNS Server 
Vnesite naslov primarnega strežnika 
DNS.  
Ta nastavitev je na voljo samo, če je 
samodejni DNS izklopljen.
ˎˎ Secondary DNS Server 
Vnesite naslov sekundarnega strežnika 
DNS.  
Ta nastavitev je na voljo samo, če je 
samodejni DNS izklopljen.

5	 Ko ste zaključili, izberite možnost Set, da 
shranite nastavitve.

[Opombe]
ˎˎ Po spreminjanju nastavitev povezave vedno izberite 

možnost Set. Če ne izberete možnosti Set, se 
nastavitve ne uporabijo.
ˎˎ Uporabite adapter žičnega omrežja LAN s priključkom 

USB tipa C. Priporočamo uporabo adapterja, ki je 
združljiv z gigabitnim ethernetom. Ne zagotavljamo, 
da bo deloval z vsemi napravami.
ˎˎ Od modela adapterja žičnega omrežja LAN (dodatna 

možnost) je odvisno, ali vpliva na vgrajeno funkcijo 
komunikacije prek omrežja Wi-Fi.
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Videokamero lahko povežete z internetom 
prek povezave USB, žičnega omrežja LAN ali 
brezžičnega omrežja LAN.

Povezava prek USB

Enoto lahko s pametnim telefonom povežete s 
kablom USB, nato pa jo povežete z internetom 
prek pametnega telefona.

Konfiguracija komunikacije s pametnim 
telefonom

Omogočite komunikacijsko povezavo v 
pametnem telefonu.
Za podrobnosti glejte navodila za uporabo 
pametnega telefona.

Priključitev pametnega telefona na 
videokamero

Kabel USB povežite s priključkom USB-C 
(stran 7) videokamere, nato pa povežite 
pametni telefon.

[Opombe]
ˎˎ Pametni telefon priključite/odstranite, ko je 

videokamera izklopljena.
ˎˎ Povezave USB ne morete uporabiti, če je pametni 

telefon priključen prek zvezdišča USB.
ˎˎ Povezave USB ne morete uporabiti, če je računalnik 

priključen na priključek USB/multi (stran 7).

Vzpostavljanje povezave z omrežjem

1	 Vklopite videokamero.

2	 Vklopite možnost Modem > Setting 
(stran 97) v meniju Network glavnega 
menija.

Omogočanje delovanja v pametnem 
telefonu

Če želite videokamero upravljati na daljavo 
prek aplikacije Content Browser Mobile v 
pametnem telefonu, omogočite možnost 
Modem > Camera Remote Control (stran 95) 
v meniju Network glavnega menija.

Povezovanje z uporabo načina 
Wireless LAN Station

Videokamero lahko v načinu Wi-Fi station 
povežete z internetom prek usmerjevalnika 
omrežja Wi-Fi ali prek povezave z drugo 
napravo.

Pametni telefon/
tablični računalnik

Usmerjevalnik Wi-Fi

računalnik

Internet

Pametni 
telefon/
tablični 
računalnik

Internet

Povežite z usmerjevalnikom omrežja Wi-
Fi ali napravo, kot je opisano v razdelku 
»Povezovanje z uporabo načina Wireless LAN 
Station« (stran 57).

Povezovanje s kablom LAN

Z internetom se lahko povežete tako, da s 
kablom LAN povežete priključek žičnega 
omrežja LAN na adapterju žičnega omrežja 
LAN (dodatna možnost), ki je povezan s 
priključkom USB-C (stran 7) videokamere, 
z usmerjevalnikom omrežja Wi-Fi (dodatna 
možnost).

Pametni telefon/
tablični računalnik

računalnik

Usmerjevalnik Wi-Fi

Internet

Povežite z usmerjevalnikom omrežja Wi-Fi, kot 
je opisano v razdelku »Povezovanje z napravo 
s kablom LAN« (stran 59).

[Opombe]
ˎˎ Adapterja žičnega omrežja LAN s priključkom USB 

(dodatna možnost) ne morete uporabiti, če je računalnik 
priključen na priključek USB/multi (stran 7).
ˎˎ Od modela adapterja žičnega omrežja LAN (dodatna 

možnost) je odvisno, ali vpliva na vgrajeno funkcijo 
komunikacije prek omrežja Wi-Fi.

Povezovanje z internetom
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Nalaganje datotek
Datoteko proxy ali originalno datoteko, ki 
je posneta z videokamero, lahko naložite v 
strežnik na internetu ali v strežnik v lokalnem 
omrežju prek pametnega telefona ali 
dostopovne točke.

Priprave

Vzpostavljanje povezave z omrežjem

Povežite videokamero z internetom ali 
lokalnim omrežjem, kot je opisano v razdelkih 
»Povezovanje z internetom« (stran 60) 
in »Povezovanje z ostalimi napravami prek 
povezave LAN« (stran 56).

Registriranje cilja za prenos datoteke

Strežnik za nalaganje datoteke lahko 
registrirate vnaprej.

1	 Izberite možnost File Transfer > Server 
Settings1 (ali Server Settings2, Server 
Settings3) v meniju Network glavnega 
menija.
Pojavi se zaslon za nastavitev cilja 
prenosa.

2	 Nastavite vse elemente na zaslonu za 
nastavitev cilja prenosa.
Display Name
Vnesite ime strežnika, ki bo prikazano na 
seznamu ciljev prenosa.
Service
Prikaže tip strežnika.
»FTP«: Strežnik FTP
Host Name
Vnesite naslov strežnika.
Port
Vnesite številko vrat strežnika, s katerim 
želite vzpostaviti povezavo.

User Name
Vnesite uporabniško ime.
Password
Vnesite geslo.
Passive Mode
Vklopite/izklopite pasivni način.
Destination Directory
Vnesite ime mape na ciljnem strežniku.

	 [Opombe]
ˎˎ Simbol »« med urejanjem označuje znake, ki 

jih ni mogoče spremeniti. Pri urejanju imena 
mape, ki vsebuje te znake, ni mogoče zagotoviti 
pravilnega delovanja.  
Če želite urediti, izbrišite vse znake in ponovno 
vnesite vrednost.
ˎˎ Če so znaki, ki so neveljavni na ciljnem strežniku, 

vneseni v ciljno mapo, bodo datoteke prenesene 
v uporabnikovo domačo mapo. Neveljavni znaki 
se razlikujejo glede na strežnik.

Using Secure Protocol
Nastavite, če želite izvesti varen prenos 
FTP.
Root Certificate
Naložite/izbrišite potrdilo.
ˎˎ Load 
Za uvoz potrdila CA v koraku 3 izberite 
Set.

*	 Potrdilo, ki ga želite naložiti, mora biti v formatu 
PEM z imenom datoteke »certification.pem« in 
mora biti zapisano v korenski mapi pomnilniške 
kartice, ki je vstavljena v režo za kartice CFexpress 
tipa A/SD (B).

ˎˎ Clear 
Za brisanje potrdila CA v 3. koraku 3 
izberite možnost Set.
ˎˎ None 
Potrdilo se ne naloži in ne izbriše.

	 [Opombe]
ˎˎ Pred uvozom potrdila CA nastavite uro 

videokamere na pravilen čas.
ˎˎ Ko snemate v formatu XAVC-I 4096×2160P/ 

3840×2160P 59,94/50P, ni mogoče izbrati 
možnosti Load.
ˎˎ V stanju nizke napetosti ni mogoče izbrati 

možnosti Load/Clear za potrdilo CA.

Root Certificate Status
Prikaže stanje nalaganja potrdila.
Ponastavitev
Ponastavite nastavitve Server Settings na 
privzete vrednosti.

3	 Ko ste zaključili, izberite možnost Set, da 
shranite nastavitve.
Po spreminjanju nastavitev vedno izberite 
možnost Set. Če ne izberete možnosti Set, 
se nastavitve ne uporabijo.

Izbira datoteke in nalaganje

Za prenos v strežnik lahko izberete datoteke 
proxy ali izvirne datoteke, zapisane na 
pomnilniških karticah.

Nalaganje datoteke proxy na 
pomnilniški kartici z zaslona sličic

1	 Povežite videokamero in napravo z 
uporabo povezave LAN (stran 56).

2	 Izberite možnost Transfer Clip (Proxy) > 
Select Clip v meniju Thumbnail glvnega 
menija.
Na zaslonu se namesto glavnega menija 
prikaže meni sličic.
Posnetke lahko prenesete z zaslona sličic 
ali zaslona sličic filtriranih posnetkov.

3	 Izberite posnetek, ki ga želite prenesti, in 
nato pritisnite gumb MENU.
Prikaže se potrditveni zaslon prenosa.

4	 Izberite Execute.
Datoteka proxy, ki ustreza izbrani datoteki, 
se registrira za opravilo prenosa in prenos 
se začne.
Ko se opravilo prenosa uspešno registrira, 
se prikaže zaslon z rezultatom prenosa.

5	 Izberite OK.

Nalaganje vseh datotek
V 2. koraku izberite možnost Select All Clips 
namesto Select Clip za prenos datotek proxy, 
ki ustrezajo vsem datotekam.

[Opomba]
Prenesti je mogoče do 200 datotek.
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Nalaganje izvirne datoteke na 
pomnilniški kartici z zaslona sličic

1	 Povežite videokamero in napravo z 
uporabo povezave LAN (stran 56).

2	 Izberite možnost Transfer Clip > Select Clip 
v meniju Thumbnail glavnega menija.
Na zaslonu se namesto glavnega menija 
prikaže meni sličic.
Posnetke lahko prenesete z zaslona sličic 
ali zaslona sličic filtriranih posnetkov.

3	 Izberite posnetek, ki ga želite prenesti, in 
nato pritisnite gumb MENU.
Prikaže se potrditveni zaslon prenosa.

4	 Izberite Execute.
Izbrana datoteka se registrira kot opravilo 
prenosa in nalaganje se začne.
Ko se opravilo prenosa uspešno registrira, 
se prikaže zaslon z rezultatom prenosa.

5	 Izberite OK.

Nalaganje vseh datotek
Za prenos vseh datotek v 2. koraku namesto 
možnosti Select Clip izberite možnost All Clips.

[Opomba]
Prenesti je mogoče do 200 datotek.

Preverjanje prenosa datotek

Stanje prenosa datotek lahko preverite tako, 
da izberete možnost File Transfer > View Job 
List (stran 97) v meniju Network glavnega 
menija.
Stanje prenosa datotek lahko preverite tudi na 
zaslonu aplikacije Content Browser Mobile.

[Nasvet]
Če je možnost File Transfer >Auto Upload (Proxy) 
(stran 97) v meniju Network glavnega menija 
vklopljena in je vzpostavljena omrežna povezava, se 
datoteke proxy po zaključku zapisovanja samodejno 
prenesejo v strežnik, določen z uporabo možnosti 
Default Upload Server (stran 97).

[Opombe]
ˎˎ Registrirati je mogoče do 200 opravil prenosa.
ˎˎ Ko videokamero izklopite, se seznam opravil ohrani. 

Podatki o trenutnem napredku za zadnjih 10 minut 
se lahko izgubijo, če odstranite baterijo ali izklopite 
videokamero, ne da bi stikalo POWER najprej 
prestavili v položaj STANDBY.
ˎˎ Opravila, ki jih dodate, ko je napetost baterije že nizka, 

se ne shranijo na seznam opravil.
ˎˎ Če pride med prenosom datotek do napake, se 

prenos posnetka z enakim imenom, kot ga ima 
preneseni posnetek, morda ne bo začel znova. To je 
odvisno od nastavitev in stanja ciljnega strežnika. 
V tem primeru preverite nastavitve in stanje ciljnega 
strežnika prenosa.

Nalaganje z uporabo Secure FTP

Datoteke naložite prek šifrirane povezave s 
ciljnim strežnikom, tako da uporabite FTPS v 
načinu Explicit (FTPES).

Nastavitev varnega prenosa FTP

Za varen prenos FTP na ciljnem strežniku 
vklopite uporabo varnega protokola in uvozite 
certifikat.
Za podrobnosti o konfiguraciji glejte razdelek 
»Registriranje cilja za prenos datoteke« 
(stran 61).
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Zaslon sličic
Ko pritisnete gumb THUMBNAIL (stran 5), se posnetki, ki so posneti na pomnilniško kartico, prikažejo kot sličice na zaslonu.
Na zaslonu sličic lahko izberete posnetek in zaženete njegovo predvajanje. Predvajana slika je lahko prikazana v iskalu in na zunanjem zaslonu.
Ponovni pritisk gumba THUMBNAIL zapre zaslon sličic in na zaslon vrne sliko kamere.

[Opomba]
Na zaslonu sličic so prikazani samo posnetki, posneti v trenutno izbranem formatu snemanja. Če posnetek, ki ste ga pričakovali, ni prikazan, preverite format snemanja. Na to bodite posebej pozorni pred formatiranjem (inicializiranjem) 
pomnilniških medijev.

Postavitev zaslona

Podatki o posnetku, na katerega je usmerjen kazalec, so prikazani na dnu zaslona.

4 5

6

3

1

2

Indikator trenutno izbrane pomnilniške kartice
(Če je kartica zaščitena, je prikazana ikona ključavnice.)

Kazalec (rumene barve)

Številka posnetka/skupno število posnetkov

1.	 Sličica (slika kazala)
Prikaže sliko kazala posnetka. Ko je posnetek 
posnet, se njegova prva sličica samodejno 
nastavi kot slika kazala.
Podatki o posnetku/sličici so prikazani 
pod sličico. Z možnostjo Customize View 
(stran 92) > Thumbnail Caption v meniju 
Thumbnail glavnega menija lahko spremenite 
prikazane informacije.

2.	 Ime posnetka
Prikaže ime izbranega posnetka.

3.	 Video format snemanja
Prikaže datotečni format izbranega posnetka.

4.	 Posebni podatki o snemanju
Prikaže način snemanja, a samo, če je bil 
posnetek posnet s posebnim načinom 
snemanja.
Hitrost sličic počasnih in hitrih posnetkov je 
prikazana na desni strani.

5.	 Trajanje posnetka

6.	 Datum, ko je bil posnetek ustvarjen
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Predvajanje posnetkov

Predvajanje posnetih posnetkov

Posnete posnetke lahko predvajate, ko je 
videokamera v načinu stanja pripravljenosti za 
snemanje (Stby).

1	 Vstavite pomnilniško kartico, ki jo želite 
predvajati.

2	 Pritisnite gumb THUMBNAIL.

3	 Z večfunkcijskim gumbom (stran 7) ali 
večfunkcijskim kolescem (stran 5) 
premaknite kazalec na sličico posnetka, ki 
ga želite predvajati.

4	 Pritisnite gumb za potrditev na 
večfunkcijskem gumbu ali večfunkcijsko 
kolesce.
Predvajanje se začne od začetka 
izbranega posnetka.

Predvajanje lahko nadzorujete s pritiski na 
sledeče gumbe.
Pritisnite gumb za potrditev na 

večfunkcijskem gumbu ali večfunkcijsko 
kolesce: 
Premor predvajanja.  
Pritisnite ponovno za vrnitev v običajno 
predvajanje.

Pritisnite levo/desno stran večfunkcijskega 
gumba: 
Skok na začetek posnetka/začetek 
naslednjega posnetka.

Pritisnite in zadržite levo/desno stran 
večfunkcijskega gumba: 
Hitro premikanje nazaj/naprej.  
Ko spustite gumb, se predvajanje vrne na 
normalno.

Gumb CANCEL/BACK: 
Ustavi predvajanje in vrne videokamero v 
način pripravljenosti za snemanje.

[Opombe]
ˎˎ Na ločnici med posnetkoma se lahko pojavi začasna 

prekinitev slike ali ustavljena slika. Med tem časom ne 
morete uporabljati videokamere.
ˎˎ Ko izberete posnetek s seznama sličic in ga začnete 

predvajati, se lahko na začetku posnetka pojavi 
začasna prekinitev slike. Če si želite ogledati začetek 
posnetka brez prekinitve, preklopite videokamero v 
način predvajanja, prekinite predvajanje, z levo stranjo 
večfunkcijskega gumba se vrnite na začetek posnetka 
in znova začnite predvajati.
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Na zaslonu s sličicami lahko v meniju 
Thumbnail glavnega menija upravljate s 
posnetki ali si ogledate lastnosti posnetkov.
Meni Thumbnail (stran 92) se prikaže, 
ko pritisnete gumb MENU in ga zadržite ter 
izberete možnost Thumbnail.

Uporaba menija Thumbnail

Z večfunkcijskim gumbom (stran 7) ali 
večfunkcijskim kolescem (stran 5) izberite 
funkcijo, nato pritisnite gumb za potrditev 
na večfunkcijskem gumbu ali večfunkcijsko 
kolesce.
Za vrnitev na prejšnji zaslon pritisnite gumb 
CANCEL/BACK (stran 5).

[Opomba]
Nekaterih elementov ni mogoče izbrati, kar je odvisno 
od stanja, ko je bil meni prikazan.

Elementi menija za upravljanje s 
posnetki

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

Za podrobnosti o elementih menija za 
upravljanje s posnetki glejte meni Thumbnail 
(stran 92).

Prikaz lastnosti posnetka

Za prikaz zaslona lastnosti posnetka izberite 
možnost Display Clip Properties (stran 92) v 
meniju Thumbnail.

Dodajanje zastavic posnetkov

Posnetkom lahko dodate zastavice (oznake 
OK, NG ali KP), če želite filtrirati prikaz 
posnetkov glede na zastavice posnetkov.
Izberite sličico za posnetek, ki mu želite 
dodati zastavico posnetka, nato pa izberite 
zastavico posnetka z možnostjo Set Clip Flag 
(stran 92) v meniju Thumbnail glavnega 
menija.

Setting Dodana zastavica posnetka
Add OK OK (Uspešno)

Add NG NG

Add KEEP KP

[Nasveti]
ˎˎ Za dodajanje zastavic posnetkov lahko uporabite 

tudi dodeljiv gumb, ki je dodeljen funkciji zastavice 
posnetka (stran 48).
ˎˎ Sličici izbranega posnetka lahko dodate zastavico 

posnetka OK (stran 50) tako, da pritisnete gumb 
Clip Flag (stran 5).

Prikaz zaslona sličic filtriranih posnetkov

V meniju Thumbnail glavnega menija izberite 
možnost Filter Clips (stran 92), nato pa 
izberite vrsto zastavice posnetka, če želite, 
da se prikažejo samo posnetki z določeno 
zastavico.
Za prikaz vseh posnetkov izberite možnost All.

[Nasvet]
Med filtri lahko preklapljate tudi v sekvenci z gumbom 
DISPLAY.

Brisanje posnetkov

Izbrišete lahko posnetke s pomnilniških kartic.
V meniju Thumbnail glavnega menija izberite 
možnost Delete Clip > Select Clip ali All Clips.
Select Clip: 

Izbriše izbrani posnetek. Izberete lahko več 
posnetkov.

All Clips: 
Izbriše vse prikazane posnetke.

Spreminjanje podatkov, prikazanih na 
zaslonu sličic

Spremenite lahko podatke o posnetku/sličici, 
ki so prikazani pod sličico.
V meniju Thumbnail glavnega menija izberite 
možnost Customize View > Thumbnail 
Caption, nato pa izberite informacije, ki naj se 
prikažejo.
Date Time: 

Prikaže datum in čas, ko je bil posnetek 
ustvarjen in nazadnje spremenjen.

Time Code: 
Prikaže časovno kodo.

Trajanje: 
Prikaže trajanje posnetka.

Sequential Number: 
Prikaže sekvenčno številko vsake sličice.

Upravljanje s posnetki
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Konfiguracija in hierarhija glavnega menija
Pritisnite in pridržite gumb MENU za prikaz 
glavnega menija v iskalu, da nastavite 
različne elemente za snemanje, zapisovanje 
in predvajanje (meni je lahko prikazan tudi na 
zunanjem monitorju). Glavni meni sestavljajo 
naslednji meniji.

Konfiguracija menijev

Meni User
Vsebuje elemente, ki jih nastavi uporabnik 
v meniju Edit User.

Meni Edit User
Vsebuje elemente menija za urejanje 
menija User.

Meni Shooting
Vsebuje nastavitve povezane s 
snemanjem.

Meni Project
Vsebuje osnovne nastavitve projekta.

Meni Paint/Look
Vsebuje nastavitve, povezane s 
kakovostjo slike.

Meni TC/Media
Vsebuje nastavitve, povezane s časovnimi 
kodami in pomnilniškimi mediji.

Meni Monitoring
Vsebuje nastavitve, povezane z video 
izhodom in prikazom iskala.

Meni Audio
Vsebuje nastavitve, povezane z zvokom.

Meni Thumbnail
Vsebuje nastavitve, povezane s prikazom 
sličic.

Meni Technical
Vsebuje nastavitve za tehnične elemente.

Meni Network
Vsebuje nastavitve, povezane z omrežji.

Meni Maintenance
Vsebuje nastavitve naprave, kot sta ura in 
jezik.

Hierarhija glavnega menija

User 
(tovarniške 
nastavitve)

Base Setting
Focus
S&Q Motion
LUT On/Off
Simul Rec
Proxy Rec
Interval Rec
Assignable Button
Assignable Dial
Multi Function Dial
All File
Clip Name Format
Format Media
VF Setting
Zebra
Zoom
Menu Settings

Meni Edit User Add Item
Customize Reset

Shooting ISO/Gain/EI
ND Filter
Shutter
Auto Exposure
White
White Setting
Offset White
Focus
S&Q Motion
LUT On/Off
Noise Suppression
Flicker Reduce
SteadyShot

Project Base Setting
Rec Format
Cine EI Setting
Simul Rec
Proxy Rec
Interval Rec
SDI/HDMI Rec Control
Assignable Button
Assignable Dial
Multi Function Dial
User File
All File

Paint/Look Scene File
Base Look
Reset Paint Settings
Black
Knee
Detail
Matrix
Multi Matrix

TC/Media Timecode
TC Display
Users Bit
HDMI TC Out
Clip Name Format
Update Media
Format Media

Monitoring Output On/Off
Output Format
Output Display
Display On/Off
Marker
VF Setting
Gamma Display Assist
Peaking
Zebra

Avdio Audio Input
Avdio izhod

Thumbnail Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Delete Clip
Transfer Clip
Transfer Clip (Proxy)
Filter Clips
Customize View

Technical Color Bars
ND Dial
Tally
HOLD Switch Setting
Touch Operation
Rec Review
Zoom
Handle Zoom
Menu Settings
Fan Control
Lens
Video Light Set
APR
Camera Battery Alarm
Camera DC IN Alarm

Network Access Authentication
Wireless LAN
AP Mode Settings
ST Mode Settings
Wired LAN
Modem
File Transfer
Network Reset
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Maintenance Language
Clock Set
All Reset
Hours Meter
Version
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Funkcije glavnega menija
Pritisnite in pridržite gumb MENU za prikaz 
glavnega menija v iskalu, da nastavite 
podrobne nastavitve (meni je lahko prikazan 
tudi na zunanjem monitorju).

Upravljanje menija

Gumb MENU (stran 5)
Za prikaz glavnega menija ga pritisnite in 
pridržite. Ko je glavni meni prikazan, ga 
znova pritisnite, da ga skrijete.

Večfunkcijski gumb (8-smerna D-ploščica in 
gumbi za potrditev) (stran 7)

Pritisnite gumbe D-ploščice, da 
premaknete kazalec navzgor/navzdol/v 
levo/v desno, da izberete elemente ali 
nastavitve menija.
Pritisnite gumb za potrditev na 
večfunkcijskem gumbu, da potrdite 
izbrani element.

Večfunkcijsko kolesce (stran 5)
Zavrtite večfunkcijsko kolesce, da 
premaknete kazalnik gor/dol, da izberete 
element menija ali nastavitev.
Pritisnite večfunkcijsko kolesce za 
potrditev izbire izbranega elementa.

Gumb CANCEL/BACK (stran 5)
Pritisnite za vrnitev v prejšnji meni. 
Nedokončana sprememba je preklicana.

[Opombe]
ˎˎ Glavnega menija ne morete uporabljati v načinu 

povečevalnika za ostrenje (stran 40).
ˎˎ Nekaterih elementov ni mogoče izbrati, kar je odvisno 

od stanja, ko je bil meni prikazan.

Nastavljanje elementov menija

Uporabite gumbe D-ploščice ali obrnite 
večfunkcijsko kolesce, da premaknete kazalec 
na element menija, ki ga želite nastaviti. Nato 
pritisnite gumb za potrditev ali večfunkcijsko 
kolesce, da izberete element.
ˎˎ Območje za izbor elementov menija prikaže 
do osem vrstic. Če vseh razpoložljivih 
možnosti za element ni mogoče prikazati 
hkrati, se s kazalcem pomaknite po zaslonu 
navzgor/navzdol.
ˎˎ Območje nastavitev se ne prikaže pri 
podelementih z velikim razponom 
nastavitev (na primer –99 do +99). Trenutna 
nastavitev je poudarjena, s čimer je 
označena vrednost, ki jo lahko spremenite.
ˎˎ Izbira možnosti [Execute] za funkcijo bo 
izvršila ustrezno funkcijo.
ˎˎ Izbira elementa, ki zahteva potrditev 
pred izvršitvijo, bo začasno skrila meni in 
prikazala potrditveno sporočilo. Preverite 
sporočilo in izberite ali želite izvršiti ali 
preklicati funkcijo.

Vnos niza znakov

Ko izberete element, kot je ime datoteke, ki 
zahteva vnos znakov, se pojavi zaslon za vnos 
znakov.

1

2 3

1	 Pritisnite gumbe D-ploščice ali obrnite 
večfunkcijsko kolesce, da izberete tip 
znaka, in nato potrdite nastavitev.
ABC: Veliki abecedni znaki
abc: Mali abecedni znaki
123: Številčni znaki
!#$: Posebni znaki

2	 Izberite znak s seznama izbranega tipa 
znakov, nato potrdite vnos.
Kazalec se premakne na naslednje polje.

Space: Vstavi presledek na položaju 
kazalca.

/: Spremeni položaj kazalca.
BS: Izbriše znak na levi strani kazalca 

(funkcija backspace).

3	 Ko ste končali, izberite [Done] in potrdite 
vnos.
Niz znakov je potrjen in zaslon za vnos 
znakov izgine.

Zaklepanje in odklepanje menija

Glavni meni lahko zaklenete tako, da je 
prikazan samo meni User.
V tem stanju ne morete spreminjati nastavitev 
z zasloni stanja.

Zaklepanje menija

1	 Pritisnite in pridržite večfunkcijsko kolesce 
in pritisnite ter pridržite gumb MENU.

2	 V meniju Technical izberite Menu Settings 
>User Menu with Lock.

	 [Opomba]
Ko pritisnete in pridržite samo gumb MENU za 
prikaz normalnega glavnega menija, je pod 
možnostjo Menu Settings v meniju Technical 
prikazana možnost User Menu Only. Za prikaz 
menija User Menu with Lock pritisnite in pridržite 
večfunkcijsko kolesce ter pritisnite in pridržite gumb 
MENU.

3	 Nastavite na On in pritisnite gumb za 
potrditev ali večfunkcijsko kolesce.
Zaslon v iskalu preklopi na zaslon za vnos 
številskega gesla.

4	 Vnesite poljubno številko.
Vnesite 4-mestno številko v razponu od 
0000 do 9999. Privzeta vrednost je 0000.
Vnesite številko in pritisnite gumb za 
potrditev ali večfunkcijsko kolesce, da 
premaknete kazalec na naslednjo številko.
Ko ste vnesli vse številke, premaknite 
kazalec na SET.

5	 Pritisnite gumb za potrditev ali 
večfunkcijsko kolesce.
Vnos se shrani.
Prikaže se potrditveno sporočilo in zaslon 
preklopi na prikaz menija User menu.
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Odklepanje menija

1	 Pritisnite in pridržite večfunkcijsko kolesce 
in pritisnite ter pridržite gumb MENU.

2	 V meniju User izberite Menu Settings 
>User Menu with Lock.

	 [Opomba]
Ko pritisnete in pridržite samo gumb MENU za 
prikaz normalnega glavnega menija, je pod 
možnostjo Menu Settings v meniju Technical 
prikazana možnost User Menu Only. Za prikaz 
menija User Menu with Lock pritisnite in pridržite 
večfunkcijsko kolesce ter pritisnite in pridržite 
gumb MENU.

3	 Nastavite na Off in pritisnite gumb za 
potrditev ali večfunkcijsko kolesce.
Zaslon v iskalu preklopi na zaslon za vnos 
številskega gesla.

4	 Vnesite številsko geslo, da odklenete 
meni.
Vnesite številko in pritisnite gumb za 
potrditev ali večfunkcijsko kolesce, da 
premaknete kazalec na naslednjo številko.
Ko ste vnesli vse številke, premaknite 
kazalec na SET.

5	 Pritisnite gumb za potrditev ali 
večfunkcijsko kolesce.
Vnos se shrani.
Če vneseno številsko geslo ustreza 
številskemu geslu, ki je bilo uporabljeno 
za zaklepanje menija, se ta odklene in 
prikaže.

[Opombe]
ˎˎ Če vneseno številsko geslo ne ustreza številskemu 

geslu, ki je bilo uporabljeno za zaklepanje menija, se 
ta ne odklene.
ˎˎ Priporočljivo je, da si številsko geslo zapišete za 

primer, če bi ga pozabili. Še pozabite številsko geslo, 
se obrnite na servisnega predstavnika podjetja Sony.

ˎˎ Če je meni zaklenjen brez registracije elementov 
glavnega menija z naslednje tabele v meniju User, teh 
funkcij ni mogoče dodeliti dodeljivim gumbom.
ˎˎ Če so te funkcije že bile dodeljene dodeljivim 

gumbom, se dodeljiva nastavitev na silo onemogoči 
na točki, ko je meni zaklenjen.

Element glavnega 
menija

Izbira dodeljivega 
gumba

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI> 
Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Technical >Rec Review 
>Setting

Rec Review

Element glavnega 
menija

Izbira dodeljivega 
gumba

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Glasnost

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User Meni User
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Meni User
Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.

User
Element Opis
Base Setting Project >element Base Setting

Focus Shooting >element Focus

S&Q Motion Shooting >element S&Q Motion

LUT On/Off Shooting >LUT On/Off item

Simul Rec Project >element Simul Rec

Proxy Rec Project >element Proxy Rec

Interval Rec Project >Interval Rec item

Assignable Button Project >element Assignable Button

Assignable Dial Project >element Assignable Dial

Multi Function Dial Project >element Multi Function Dial

All File Project >element All File

Clip Name Format TC/Media >element Clip Name Format

Format Media TC/Media >element Format Media

VF Setting Monitoring >element VF Setting

Zebra Monitoring >Zebra item

Zoom Technical >Zoom item

Menu Settings Technical >element Menu Settings

Meni Edit User Prikaže zaslon menija Edit User.

[Opomba]
Elemente menija lahko dodajate in odstranjujete z uporabo menija Edit User v meniju User. Nastaviti je mogoče do 
20 elementov.
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Meni Edit User
Ko je v meniju User izbran meni Edit User, je slednji prikazan na vrhnji ravni.

Edit User
Element Nastavitev podelementa Opis
Add Item
Dodaj element meniju 
User

Meniju User doda element menija.

Customize Reset
Ponastavi elemente v 
meniju User

Elemente menija, registrirane v 
meniju User, ponastavi na privzete 
tovarniške nastavitve.

Element menija izbran 
med urejanjem

Delete Izbriše registriran meni iz menija 
User.

Move Prerazporedi registrirane elemente 
menija v meniju User.

Edit Sub Item Uredi (registracija/brisanje) 
registrirane podelemente menija v 
meniju User.
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Meni Shooting
Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Shooting >ISO/Gain/EI
Nastavi ojačanje.

Element Nastavitev podelementa Opis
Mode ISO/dB Izbere način nastavitve ojačanja.

ISO/Gain<H> Za podrobnosti o nastavitvah glejte razdelek »ISO/
Gain Settings and Default Values« (stran 100).

Nastavi privzeto vrednost ojačitve 
<H>.

ISO/Gain<M> Za podrobnosti o nastavitvah glejte razdelek »ISO/
Gain Settings and Default Values« (stran 100).

Nastavi privzeto vrednost ojačitve 
<M>.

ISO/Gain<L> Za podrobnosti o nastavitvah glejte razdelek »ISO/
Gain Settings and Default Values« (stran 100).

Nastavi privzeto vrednost ojačitve 
<L>.

Exposure 
Index<H>

Ko je možnost Base ISO nastavljena na ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Ko je možnost Base ISO nastavljena na ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Nastavi indeksno vrednost 
osvetlitve <H>.
Na voljo samo v načinu Cine EI.

Shooting >ISO/Gain/EI
Nastavi ojačanje.

Element Nastavitev podelementa Opis
Exposure 
Index<M>

(Enake nastavitve kot Exposure Index<H>)
Ko je možnost Base ISO nastavljena na ISO 800:

1000EI / 6.3E
Ko je možnost Base ISO nastavljena na ISO 12800:

16000EI / 6.3E

Nastavi indeksno vrednost 
osvetlitve <M>.

Exposure 
Index<L>

(Enake nastavitve kot Exposure Index<H>)
Ko je možnost Base ISO nastavljena na ISO 800:

800EI / 6.0E
Ko je možnost Base ISO nastavljena na ISO 12800:

12800EI / 6.0E

Nastavi indeksno vrednost 
osvetlitve <L>.

Shockless 
Gain

On / Off Vklopi/izklopi funkcijo shockless 
gain.

Base 
Sensitivity

High / Low Nastavi osnovno občutljivost za 
način SDR/HDR.

Base ISO ISO 12800 / ISO 800 Nastavi osnovno občutljivost ISO 
za način Cine EI.

Shooting >ND Filter
Nastavi prednastavljene vrednosti za filter ND.

Element Nastavitev podelementa Opis

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Nastavi prednastavljeno vrednost 1 za 
filter ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Nastavi prednastavljeno vrednost 2 za 
filter ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Nastavi prednastavljeno vrednost 3 za 
filter ND.

Shooting >Shutter
Prilagodi nastavitve za pogoj delovanja elektronskega zaklopa.

Element Nastavitev podelementa Opis

Mode Speed / Angle Izbere način delovanja elektronskega 
zaklopa.
Uporablja se za jasno snemanje hitro 
premikajočih se subjektov. Izbere način 
za nastavitev hitrosti zaklopa v sekundah 
(Speed) ali v obliki kota zaklopa (Angle).

Shutter 
Speed  
On/Off

On / Off Nastavi ali naj čas osvetlitve ob izbranem 
načinu Speed sledi vrednosti Shutter 
Speed, ali pa je nastavljen za polno 
osvetlitev.
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Shooting >Shutter
Prilagodi nastavitve za pogoj delovanja elektronskega zaklopa.

Element Nastavitev podelementa Opis

Shutter 
Speed

64F do 1/8000
Razpoložljive nastavitve se lahko 
razlikujejo glede na frekvenco sličic 
izbranega video formata.
59,94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29,97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Nastavi hitrost zaklopa, ko je možnost 
Mode nastavljena na Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360,0° / 300,0° /  
270,0° / 240,0° / 216,0° / 210,0° /  
180,0° / 172,8° / 150,0° / 144,0° /  
120,0° / 90,0° / 86,4° / 72,0° / 45,0° / 
30,0° / 22,5° / 11,25° / 5,6°

Nastavi kot zaklopa, ko je možnost Mode 
nastavljena na Angle.

ECS On/Off On / Off Vklopi/izklopi funkcijo Extended Clear 
Scan.

Shooting >Shutter
Prilagodi nastavitve za pogoj delovanja elektronskega zaklopa.

Element Nastavitev podelementa Opis

ECS 
Frequency

23,99 do 8000
Razpoložljive nastavitve se lahko 
razlikujejo glede na frekvenco sličic 
izbranega video formata.
Privzete vrednosti so prikazane spodaj.
59,94P: 60,00
50P: 50,00
29,97P: 30,00
23,98P: 23,99
25P: 25,02
24P: 24,02

Nastavi frekvenco ECS, ko je možnost 
Mode nastavljena na ECS.

Shooting >Auto Exposure
Nastavi prilagoditev samodejne osvetlitve.

Element Nastavitev podelementa Opis

Level +3,0 / +2,75 / +2,5 / +2,25 / +2,0 / +1,75 / 
+1,5 / +1,25 / +1,0 / +0,75 / +0,5 / +0,25 / 
±0 / –0,25 / –0,5 / –0,75 / –1,0 / –1,25 / 
–1,5 / –1,75 / –2,0 / –2,25 / –2,5 / –2,75 / 
–3,0

Nastavi raven svetlosti za samodejno 
zaznano osvetlitev.

Mode Backlight / Standard / Spotlight Nastavi način delovanja prilagoditve 
samodejne osvetlitve.
Backlight: 

Način Backlight (način za zmanjšano 
temnost subjekta, ko je osvetljen iz 
ozadja)

Standard: 
Način Standard

Spotlight: 
Način Spotlight (način za zmanjšano 
prežganost bele barve, ko je subjekt 
osvetljen s točkovnim virom svetlobe)

Speed –99 do +99 (±0) Nastavi hitrost prilagoditve za 
prilagoditev samodejne osvetlitve.

AGC On / Off Vklopi/izklopi funkcijo AGC (auto gain 
control).

AGC Limit Za podrobnosti o nastavitvah glejte 
razdelek »AGC Limit Settings and Default 
Values« (stran 102).

Nastavi največje ojačanje funkcije AGC.

AGC Point F2.8 / F4 / F5.6 Nastavi vrednost zaslonke, kjer se začne 
delovanje AGC, ko je vklopljena funkcija 
AGC.
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Shooting >Auto Exposure
Nastavi prilagoditev samodejne osvetlitve.

Element Nastavitev podelementa Opis

Auto Shutter On / Off Vklopi/izklopi kontrolno funkcijo 
samodejnega zaklopa.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Nastavi najkrajši čas zaklopa pri funkciji 
samodejnega zaklopa.

A.SHT Point F5.6 / F8 / F11 / F16 Nastavi vrednost zaslonke, kjer se začne 
delovanje samodejnega zaklopa.

Clip High 
light

On / Off Vklopi/izklopi funkcijo, ki ignorira 
najsvetlejše dele, da omogoči manj 
izrazito reakcijo na visoko osvetljenost.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Nastavi razpon merjenja za samodejno 
prilagajanje osvetlitve glede na svetlost 
subjekta. (Ni na voljo pri ročnem 
prilagajanju osvetlitve)

Detect 
Window 
Indication

On / Off Vklopi/izklopi indikacijo merjenja ravni 
osvetljenosti.

Custom 
Width

40 do 999 (500) Nastavi širino razpona merjenja svetlobe.

Custom 
Height

70 do 999 (500) Nastavi višino razpona merjenja svetlobe.

Custom H 
Position

–479 do +479 (±0) Nastavi vodoravni položaj razpona 
merjenja svetlobe.

Custom V 
Position

–464 do +464 (±0) Nastavi navpični položaj razpona 
merjenja svetlobe.

Shooting >White
Prilagodi nastavitve beline.

Element Nastavitev podelementa Opis

Preset White 2000 K do 15000 K (3200K) Nastavi privzeto vrednost beline.

Color Temp 
<A>

2000 K do 15000 K (3200K) Nastavi temperaturo barve za belino, 
shranjeno v pomnilniku A.

[Opomba]
Ker je temperatura barve med delovanjem R/B 
Gain pri 2000 K in 15000 K prežgana, morda 
ne bo mogoče prikazati pravilne vrednosti 
temperature barve za vrednost R/B Gain.

Shooting >White
Prilagodi nastavitve beline.

Element Nastavitev podelementa Opis

Tint<A> –99 do +99 (±0) Nastavi odtenek za belino, shranjeno v 
pomnilniku A.

[Opomba]
Ker je odtenek med delovanjem R/B Gain pri 
vrednosti +99 prežgan, morda ne bo mogoče 
prikazati pravilne vrednosti odtenka za 
vrednost R/B Gain.

R Gain <A> –99,0 do +99,0 (±0,0) Nastavi vrednost ojačitve R za belino, 
shranjeno v pomnilniku A.

B Gain <A> –99,0 do +99,0 (±0,0) Nastavi vrednost ojačitve B za belino, 
shranjeno v pomnilniku A.

Color Temp 
<B>

2000 K do 15000 K (3200K) Nastavi temperaturo barve za belino, 
shranjeno v pomnilniku B.

[Opomba]
Ker je temperatura barve med delovanjem R/B 
Gain pri 2000 K in 15000 K prežgana, morda 
ne bo mogoče prikazati pravilne vrednosti 
temperature barve za vrednost R/B Gain.

Tint<B> –99 do +99 (±0) Nastavi odtenek za belino, shranjeno v 
pomnilniku B.

[Opomba]
Ker je odtenek med delovanjem R/B Gain pri 
vrednosti +99 prežgan, morda ne bo mogoče 
prikazati pravilne vrednosti odtenka za 
vrednost R/B Gain.

R Gain <B> –99,0 do +99,0 (±0,0) Nastavi vrednost ojačitve R za belino, 
shranjeno v pomnilniku B.

B Gain <B> –99,0 do +99,0 (±0,0) Nastavi vrednost ojačitve B za belino, 
shranjeno v pomnilniku B.

Shooting >White Setting
Prilagodi nastavitve beline.

Element Nastavitev podelementa Opis

Shockless 
White

Off / 1 / 2 / 3 Nastavi hitrost odziva beline pri 
preklapljanju med načini beline.
Off: Preklop se zgodi takoj.
1 do 3: Višja kot je številka, počasnejši je 

preklop.

ATW Speed 1 / 2 / 3 / 4 / 5 Nastavi hitrost odziva v načinu ATW.
1: Najvišja hitrost odziva

White 
Switch<B>

Memory / ATW Izbere način prilagoditve beline, ki je izbran, 
ko je stikalo WHT BAL nastavljeno na B.
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Shooting >White Setting
Prilagodi nastavitve beline.

Element Nastavitev podelementa Opis

Filter White 
Memory

On / Off Vklopi/izklopi funkcijo, ki nastavi pomnilnik 
območja beline za vsak filter ND.
Sveti: Nastavi pomnilnik beline za vsak 

filter ND.

	 [Nasvet]
V prednastavljenem načinu so štiri 
nastavitve (CLEAR / 1 / 2 / 3). V variabilnem 
načinu sta dve nastavitvi (CLEAR / On).

Off: Nastavi pomnilnik beline, skupen 
vsem filtrom ND.

Shooting >Offset White
Prilagodi nastavitve odmika beline.

Element Nastavitev podelementa Opis

Offset White 
<A>

On / Off Nastavi, ali naj se doda (On) ali ne doda 
(Off) vrednost odmika belini v 
pomnilniku A.

Offset Color 
Temp<A>

–99 do +99 (±0) Nastavi odmik temperature barve, ki bo 
dodan belini v pomnilniku A, ko je 
možnost Offset White <A> nastavljena 
na On.

Offset 
Tint<A>

–99 do +99 (±0) Nastavi odmik vrednosti odtenka, ki bo 
dodan belini v pomnilniku A, ko je 
možnost Offset White <A> nastavljena 
na On.

Offset White 
<B>

On / Off Nastavi, ali naj se doda (On) ali ne doda 
(Off) vrednost odmika belini v 
pomnilniku B.

Offset Color 
Temp<B>

–99 do +99 (±0) Nastavi odmik temperature barve, ki bo 
dodan belini v pomnilniku B, ko je 
možnost Offset White <B> nastavljena 
na On.

Offset 
Tint<B>

–99 do +99 (±0) Nastavi odmik vrednosti odtenka, ki bo 
dodan belini v pomnilniku B, ko je 
možnost Offset White <B> nastavljena 
na On.

Offset White 
<ATW>

On / Off Nastavi, ali naj se doda (On) ali ne doda 
(Off) vrednost odmika belini ATW.

Offset Color 
Temp<ATW>

–99 do +99 (±0) Nastavi odmik temperature barve, ki bo 
dodan belini ATW, ko je možnost Offset 
White <ATW> nastavljena na On.

Shooting >Offset White
Prilagodi nastavitve odmika beline.

Element Nastavitev podelementa Opis

Offset 
Tint<ATW>

–99 do +99 (±0) Nastavi odmik vrednosti odtenka, ki bo 
dodan belini ATW, ko je možnost Offset 
White <ATW> nastavljena na On.

Shooting >Focus
Prilagodi nastavitve ostrenja.

Element Nastavitev podelementa Opis

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Nastavi hitrost pogona ostrenja za 
primere, ko se med samodejnim 
ostrenjem spremeni subjekt.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Nastavi občutljivost za spreminjanje 
ostrine subjekta med samodejnim 
ostrenjem.

Focus Area Wide / Zone / Flexible Spot Nastavi ciljno območje za samodejno 
ostrenje in samodejno ostrenje s 
pritiskom (AF) (stran 37).
Wide: 

Med ostrenjem išče subjekt na 
širokem območju slike.

Zone: 
Samodejno išče točko ostrenja 
znotraj določenega območja.

Flexible Spot: 
Ostri na določeno mesto v sliki.

Focus Area 
(AF-S)

Flexible Spot Nastavi ciljno območje ostrenja za 
samodejno ostrenje s pritiskom (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Omogoči/onemogoči samodejno 
ostrenje z zaznavanjem obrazov.

Push AF 
Mode

AF / Single-shot AF(AF-S) Nastavi način pritiska za samodejno 
ostrenje.

AF Assist On / Off Ko je možnost nastavljena na On, vam 
omogoča, da začasno preglasite 
samodejno ostrenje in ostrite ročno.
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Shooting >S&Q Motion
Prilagodi nastavitve načina za počasne in hitre posnetke (stran 49).

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi način za počasne in hitre 
posnetke.
Ko je možnost nastavljena na On, sta 
sledeči funkciji onemogočeni.

ˎˎ Samodejna zaslonka
ˎˎ Samodejno ostrenje

Frame Rate Od 1 do 60 sličic na sekundo / 100 sličic na 
sekundo / 120 sličic na sekundo / 150 sličic 
na sekundo / 180 sličic na sekundo / 
200 sličic na sekundo / 240 sličic na 
sekundo

Nastavi hitrost sličic za počasne in hitre 
posnetke.

[Opomba]
Razpoložljive nastavitve se lahko razlikujejo 
glede na sistemsko frekvenco, kodek in video 
format.

Shooting >LUT On/Off
Nastavi nastavitve LUT.

Element Nastavitev podelementa Opis

SDI/HDMI MLUT On / MLUT Off Izbere, ali dodati LUT monitorja 
izhodnemu video signalu SDI in HDMI.

VF/Proxy/
Stream

MLUT On / MLUT Off Izbere, ali dodati LUT monitorja iskalu, 
proxyju in pretakati izhodni video signal.

Internal Rec MLUT On / MLUT Off Izbere, ali dodati LUT monitorja 
notranjemu videoposnetku.

Shooting >Noise Suppression
Prilagodi nastavitve zmanjševanja šuma.

[Nasvet]
Nastavitvi Setting(Custom) in Level(Custom) sta vidni v nastavitvi Target Display (stran 104).

Element Nastavitev podelementa Opis

Setting 
(Custom)

On / Off Vklopi/izklopi funkcijo zmanjševanja 
šuma v načinu Custom.

Level 
(Custom)

Low / Mid / High Nastavi raven zmanjševanja šuma v 
načinu Custom.

Setting 
(Cine EI)

On / Off Vklopi/izklopi funkcijo zmanjševanja 
šuma v načinu Cine EI.

Shooting >Noise Suppression
Prilagodi nastavitve zmanjševanja šuma.

[Nasvet]
Nastavitvi Setting(Custom) in Level(Custom) sta vidni v nastavitvi Target Display (stran 104).

Element Nastavitev podelementa Opis

Level 
(Cine EI)

Low / Mid / High Nastavi raven zmanjševanja šuma v 
načinu Cine EI.

Shooting >Flicker Reduce
Prilagodi nastavitve popravljanja migetanja.

Element Nastavitev podelementa Opis

Mode Auto / On / Off Nastavi način popravljanja migetanja.

Frequency 50Hz / 60Hz Nastavi frekvenco vira napajanja 
razsvetljave, ki povzroča migetanje.

Shooting >SteadyShot
Prilagodi nastavitve stabilizacije slike.

Element Nastavitev podelementa Opis

Setting Active / Standard / Off Nastavi funkcijo stabilizatorja slike.

[Opomba]
Možnost je omogočena, ko je nameščen 
združljiv objektiv.
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Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Project >Base Setting
Prilagodi osnovne nastavitve.

Element Nastavitev podelementa Opis

Shooting 
Mode

Custom / Cine EI Nastavi način snemanja (stran 24).

Target 
Display

SDR(BT.709) / HDR(HLG) Nastavi barvni prostor posnetka/izhoda v 
načinu Cine EI.

Project >Rec Format
Prilagodi nastavitve formata snemanja.

Element Nastavitev podelementa Opis

Frequency 59,94 / 50 / 29,97 / 25 / 24 / 23,98 Izbere sistemsko frekvenco.

Imager Scan 
Mode

FF / S35 Nastavi kombinacijo metode branja s 
slikovnega senzorja (vse točke/
združevanje točk) in nastavitve velikosti 
slike s slikovnega senzorja.

Kodek RAW / RAW & XAVC-I / XAVC-I / XAVC-L Nastavi način snemanja/predvajanja.

RAW Output 
Format

Razpoložljive nastavitve se razlikujejo 
glede na frekvenco in nastavitve kodeka.

Nastavi format zapisovanja za zunanji 
snemalnik RAW.

[Opomba]
Ko je možnost Codec nastavljena na RAW 
& XAVC-I, nastavitev Video Format zamenja 
povezavo z nastavitvijo RAW Output Format.

Frekvenca Kodek Možnosti izbire

59,94/
50/
29,97/
25/
23,98

RAW 4096×2160

3840×2160

RAW & 
XAVC-I

4096×2160

3840×2160

24 RAW 4096×2160

RAW & 
XAVC-I

4096×2160

Project >Rec Format
Prilagodi nastavitve formata snemanja.

Element Nastavitev podelementa Opis

Video format Razpoložljive nastavitve se razlikujejo 
glede na frekvenco in nastavitve kodeka.

Nastavi format snemanja.

Frekvenca Kodek Možnosti izbire

59,94 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

29,97 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Meni Project
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Project >Rec Format
Prilagodi nastavitve formata snemanja.

Element Nastavitev podelementa Opis

Video format 25 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

23,98 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW –

RAW & 
XAVC-I

4096×2160P

XAVC-I 4096×2160P

Project >Cine EI Setting
Prilagodi nastavitve načina Cine EI.

Element Nastavitev podelementa Opis

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Nastavi barvni prostor v načinu Cine EI.
S-Gamut3/SLog3: 

Nastavi barvni prostor v načinu Cine 
EI na S-Gamut3.

S-Gamut3.Cine/SLog3: 
Nastavi barvni prostor v načinu Cine 
EI na S-Gamut3.Cine.

Project >Simul Rec
Prilagodi nastavitve načina sočasnega snemanja (stran 50).

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi funkcijo sočasnega 
snemanja in nastavi ciljni pomnilniški 
medij za snemanje.

Project >Proxy Rec
Prilagodi nastavitve načina snemanja proxy.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi način snemanja proxy.

Audio 
Channel

CH1/CH2 / CH3/CH4 Izbere avdio kanal za snemanje podatkov 
proxy.

Project >Interval Rec
Prilagodi nastavitve načina intervalnega snemanja (stran 49).

Element Nastavitev podelementa Opis

Setting On / Off Vklop/izklop načina intervalnega 
snemanja. (Vklop tega načina bo izklopil 
vse ostale posebne načine.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (ur)

Nastavi interval med snemanji v načinu 
snemanja Interval Rec (ko je možnost 
Interval Rec nastavljena na On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Razpoložljive nastavitve se lahko 
razlikujejo glede na frekvenco sličic 
izbranega video formata.
59.94P/50P: 

2frames / 6frames / 12frames
29,97P/25P/24P/23,98P: 

1frame / 3frames / 6frames / 9frames

Nastavi število sličic, ki se posnamejo v 
enem posnetku v načinu snemanja 
Interval Rec (ko je možnost Interval Rec 
nastavljena na On).

Pre-Lighting Off / 2sec / 5sec / 10sec Nastavi koliko sekund pred začetkom 
snemanja v načinu IntervalRec se vklopi 
video luč.

[Nasvet]
Na voljo samo z uporabo video luči HVL-LBPC 
(možnost).
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Project >SDI/HDMI Rec Control
Prilagodi nastavitve upravljanja snemanja SDI/HDMI.

Element Nastavitev podelementa Opis

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Nastavi upravljanje začetka/zaustavitve 
snemanja na zunanji napravi prek 
izhodnega signala SDI/HDMI.
Off: 

Ne uporabljajte daljinskega 
upravljalnika.

SDI/HDMI Remote I/F: 
Upravljanje začetka/zaustavitve 
snemanja na povezani zunanji 
napravi, ko v videokameri ni 
vstavljenega pomnilniškega medija. 
S pomnilniškim medijem v 
videokameri ni sinhronizirano na 
sličico natančno.

Parallel Rec: 
Upravljanje začetka/zaustavitve 
snemanja na povezani zunanji 
napravi, ko je v videokameri vstavljen 
pomnilniški medij. S pomnilniškim 
medijem v videokameri je 
sinhronizirano na sličico natančno.

[Opomba]
Za upravljanje z izhodnim signalom HDMI 
vklopite možnost HDMI TC Out > Setting 
(stran 85) v meniju TC/Media glavnega 
menija.

Project >Assignable Button
Dodeljivim gumbom nastavi dodeljive funkcije.

Element Nastavitev podelementa Opis

<1> do <9>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / 
AGC / Push AGC / ND Filter 
Position / Auto ND Filter / Push 
Auto ND / Auto Iris / Push Auto 
Iris / Auto Shutter / Auto 
Exposure Level / Backlight / 
Spotlight / Preset White 
Select / ATW / ATW Hold / AF 
Speed/Sens. / Focus Setting / 
Focus Area / Focus Area(AF-S) / 
Face/Eye Detection AF / Push 
AF Mode / Push AF/Push MF / 
Focus Hold / Focus Magnifier 
x3/x6 / Focus Magnifier x3 / 
Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / 
Rec Review / Clip Flag OK / Clip 
Flag NG / Clip Flag Keep / Color 
Bars / Tally [Front] / DURATION/
TC/U-BIT / Display / Lens Info / 
Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma 
Display Assist / Peaking / 
Zebra / Volume / Thumbnail / 
Touch Operation / Handle 
Zoom / NFC / Auto Upload 
(Proxy) / Direct Menu / User 
Menu / Menu

Dodeli funkcije dodeljivim gumbom.
Base ISO/Sensitivity: 

Preklopi osnovno občutljivost slikovnega 
senzorja.

AGC: 
Vklopi/izklopi funkcijo AGC.

Push AGC: 
Omogoči funkcijo AGC med pritiskom gumba.

ND Filter Position: 
Preklopi filtre ND.

Auto ND Filter: 
Vklopi/izklopi funkcijo samodejnega filtra ND.

Push Auto ND: 
Omogoči funkcijo samodejnega filtra ND med 
pritiskom gumba.

Auto Iris: 
Vklopi/izklopi funkcijo zaslonke.

Push Auto Iris: 
Omogoči funkcijo samodejne zaslonke med 
pritiskom gumba.

Auto Shutter: 
Vklopi/izklopi funkcijo samodejnega zaklopa.

Auto Exposure Level: 
Prikaže/zapusti neposredni meni Auto Exposure 
Level.

Backlight: 
Preklopi med možnostma Backlight in Standard.

Spotlight: 
Preklopi med možnostma Spotlight in Standard.

Preset White Select: 
Preklopi privzeto vrednost beline.

ATW: 
Vklopi/izklopi funkcijo ATW.

ATW Hold: 
Začasno ustavi delovanje funkcije ATW.
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Project >Assignable Button
Dodeljivim gumbom nastavi dodeljive funkcije.

Element Nastavitev podelementa Opis

<1> do <9>, 
Focus Hold 
Button

AF Speed/Sens.: 
Preklopi nastavitev hitrosti prehoda 
samodejnega ostrenja in nastavitev občutljivosti 
samodejnega ostrenja pri prehodu med subjekti.

Focus Setting: 
Nastavi območje ostrenja.

Focus Area: 
Nastavi območje ostrenja za samodejno ostrenje 
in samodejno ostrenje s pritiskom.

Focus Area(AF-S): 
Nastavi območje ostrenja za samodejno ostrenje 
s pritiskom (AF-S).

Face/Eye Detection AF: 
Preklopi med nastavitvami samodejnega 
ostrenja z zaznavanjem obrazov/oči.

Push AF Mode: 
Preklopi nastavitev načina Push AF.

Push AF/Push MF: 
V načinu ročnega ostrenja med pritiskom gumba 
aktivira samodejno ostrenje. 
V načinu samodejnega ostrenja med pritiskom 
gumba aktivira ročno ostrenje.

Focus Hold: 
V načinu samodejnega ostrenja se med 
pritiskom gumba izostritev ne spreminja.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Vklopi/izklopi funkcijo povečevalnika za ostrenje.
S&Q Motion: 

Vklopi/izklopi način za počasne in hitre 
posnetke. 
Ob pritisku in pridržanju nastavi hitrost sličic pri 
snemanju.

SteadyShot: 
Preklopi med možnostmi Active, Standard in Off.

Rec: 
Začne/zaustavi snemanje.

Rec Review: 
Vklop/izklopi funkcijo Rec Review.

Project >Assignable Button
Dodeljivim gumbom nastavi dodeljive funkcije.

Element Nastavitev podelementa Opis

<1> do <9>, 
Focus Hold 
Button

Clip Flag OK: 
Izvede funkcijo Add OK. 
Pritisnite dvakrat za izvedbo ukaza Delete Clip 
Flag.

Clip Flag NG: 
Izvede funkcijo Add NG. 
Pritisnite dvakrat za izvedbo ukaza Delete Clip 
Flag.

Clip Flag Keep: 
Izvede funkcijo Add Keep. 
Pritisnite dvakrat za izvedbo ukaza Delete Clip 
Flag.

Color Bars: 
Vklopi/izklopi barvne vrstice.

Tally [Front]: 
Vklopi/izklopi funkcijo svetenja/utripanja 
indikatorja snemanja.

DURATION/TC/U-BIT: 
Preklopi med možnostmi Time Code, User Bit in 
Duration.

Zaslon: 
Vklopi/izklopi indikatorje na zaslonu.

Lens Info: 
Preklopi indikator globinske ostrine.

Video Signal Monitor: 
Preklopi monitor video signala (kot je monitor 
valovne oblike).

Marker: 
Vklopi/izklopi funkcijo označbe.

VF Adjust: 
Prikaže črte za prilagajanje svetlosti zaslona 
iskala.

VF Mode: 
Preklopi med barvnim in črno-belim prikazom 
slike na zaslonu iskala.

Gamma Display Assist: 
Preklopi funkcijo pomoči za gammo zaslona.

Peaking: 
Vklopi/izklopi funkcijo peaking.
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Project >Assignable Button
Dodeljivim gumbom nastavi dodeljive funkcije.

Element Nastavitev podelementa Opis

<1> do <9>, 
Focus Hold 
Button

Zebra: 
Vklopi/izklopi funkcijo Zebra.

Volume: 
Prilagodi izhodno raven zvoka monitorja na 
priključek za slušalke in vgrajen zvočnik.

Thumbnail: 
Prikaže/zapusti zaslon sličic.

Touch Operation: 
Vklopi/izklopi upravljanje na dotik.

Handle Zoom: 
Preklopi delovanje zooma na držalu.

NFC: 
Izvede funkcijo NFC.

Auto Upload (Proxy): 
Vklopi/izklopi samodejni prenos datoteke proxy.

Direct Menu: 
Prikaže/zapusti neposredni meni.

User Menu: 
Prikaže/zapusti meni User.

Menu: 
Prikaže/zapre glavni meni.

Project >Assignable Dial
Nastavi dodelitve funkcij dodeljivemu kolescu in nastavi smer vrtenja.

Element Nastavitev podelementa Opis

Kolesce na 
držalu/
daljinskem 
upravljalniku

Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level

Dodeli funkcije dodeljivemu kolescu.
ISO/Gain/EI: 

Prilagodi ojačanje ali EI.
ND Filter: 

Prilagodi filter ND.
IRIS: 

Prilagodi zaslonko.
Auto Exposure Level: 

Prilagodi raven samodejne osvetlitve.
Audio Input Level: 

Prilagodi glasnost snemanja zvoka.

Smer kolesca 
na držalu

Normal / Opposite Nastavi smer vrtenja dodeljivega kolesca.
Normal: Vrtenje v normalni smeri.
Opposite: Vrtenje v nasprotni smeri.

Project >Assignable Dial
Nastavi dodelitve funkcij dodeljivemu kolescu in nastavi smer vrtenja.

Element Nastavitev podelementa Opis

Kolesce na 
ročaju

Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level / Multi 
Function Dial

Dodeli funkcije dodeljivemu kolescu na 
ročaju.
ISO/Gain/EI: 

Prilagodi ojačanje ali EI.
ND Filter: 

Prilagodi filter ND.
IRIS: 

Prilagodi zaslonko.
Auto Exposure Level: 

Prilagodi raven samodejne osvetlitve.
Audio Input Level: 

Prilagodi glasnost snemanja zvoka.
Večfunkcijsko kolesce: 

Deluje kot večfunkcijsko kolesce.

Smer kolesca 
na ročaju

Normal / Opposite Nastavi smer vrtenja dodeljivega kolesca 
na ročaju.
Normal: Vrtenje v normalni smeri.
Opposite: Vrtenje v nasprotni smeri.

Project >Multi Function Dial
Dodeli funkcije večfunkcijskemu kolescu.

Element Nastavitev podelementa Opis

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Večfunkcijskemu kolescu dodeli privzeto 
funkcijo.
IRIS: 

Prilagodi zaslonko.
ISO/Gain/EI: 

Prilagodi ojačanje ali EI.
Auto Exposure Level: 

Prilagodi raven samodejne osvetlitve.
Audio Input Level: 

Prilagodi glasnost snemanja zvoka.
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Project >User File
Prilagodi nastavitve, povezane z upravljanjem uporabniške datoteke.

Element Nastavitev podelementa Opis

Load 
Media(B)

Execute/Cancel Naloži nastavitve uporabniške datoteke s 
pomnilniške kartice, ki je vstavljena v režo 
za kartice CFexpress tipa A/SD (B).
Execute: Izvedite funkcijo.

Save 
Media(B)

Execute/Cancel Shrani nastavitve uporabniške datoteke 
na pomnilniško kartico, ki je vstavljena v 
režo za kartice CFexpress tipa A/SD (B).
Execute: Izvedite funkcijo.

File ID Prikaže zaslon za prikaz/urejanje ID-ja 
datoteke uporabniških datotek.

Load 
Customize 
Data

On / Off Nastavi, ali naj se naložijo prilagojeni 
podatki menija User, ko je izveden ukaz 
Load Media(B).

Load White 
Data

On / Off Nastavi, ali naj se naložijo podatki o 
nastavitvi belin, ko je izveden ukaz Load 
Media(B).

Project >All File
Prilagodi nastavitve, povezane z datotekami ALL.

Element Nastavitev podelementa Opis

Load 
Media(B)

Execute/Cancel Naloži datoteko ALL.
Execute: Izvedite funkcijo.

Save 
Media(B)

Execute/Cancel Shrani datoteko ALL.
Execute: Izvedite funkcijo.

File ID Datoteki dodeli ime.

Load Network 
Data

On / Off Nastavi, ali naj se naložijo informacije o 
nastavitvah menija Network, ko je 
izveden ukaz Load Media(B).
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Meni Paint/Look
Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Paint/Look >Scene File
Prilagodi nastavitve, povezane s scenskimi datotekami.

Element Nastavitev podelementa Opis

Recall Naloži datoteko s prizorom, ki je 
shranjena v notranjem pomnilniku, in 
uporabi nastavitve kot nastavitve 
kakovosti trenutne slike.

Store Shrani stanje kakovosti trenutne slike kot 
datoteko s prizorom v notranji pomnilnik.

Brisanje Izbriše datoteko s prizorom iz notranjega 
pomnilnika.

Preset Recall Ko je nastavitev Shooting Mode 
nastavljena na Custom in je nastavitev 
Target Display nastavljena na SDR(BT.709):

S-Cinetone / Standard / Still / ITU709
Ko je nastavitev Shooting Mode 
nastavljena na Custom in je nastavitev 
Target Display nastavljena na HDR(HLG):

HLG Live / HLG Natural

Uporabi nastavitve kakovosti 
prednastavljene slike (zapisljive) kot 
nastavitve kakovosti trenutne slike.

Paint/Look >Base Look
Nastavi nastavitve, ki so povezane z osnovnim videzom.

Element Nastavitev podelementa Opis

Select Ko je nastavitev Shooting Mode 
nastavljena na Custom in je nastavitev 
Target Display nastavljena na SDR(BT.709):

S-Cinetone / Standard / Still / 
ITU709 / User1 to User16

Ko je nastavitev Shooting Mode 
nastavljena na Custom in je nastavitev 
Target Display nastavljena na HDR(HLG):

HLG Live / HLG Natural / User1 to 
User16

Ko je nastavitev Shooting Mode 
nastavljena na Cine EI:

s709 / 709(800) / S-Log3 / User1 to 
User16

Izbere osnovni videz.

Brisanje Izbriše izbrani osnovni videz.

Delete All Izbriše vse osnovne videze.

Import Naloži datoteko z osnovnim videzom z 
zapisovalnega medija.

Paint/Look >Base Look
Nastavi nastavitve, ki so povezane z osnovnim videzom.

Element Nastavitev podelementa Opis

Vhod S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Nastavi vhodno barvno lestvico za 
izbrani osnovni videz.

Izhod BT.709 / HLG Nastavi izhodno barvno lestvico za 
izbrani osnovni videz.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Nastavi referenčno vrednost osvetlitve 
za izbrani osnovni videz.

Paint/Look > Reset Paint Settings
Ponastavi nastavitve menija Paint/Look z izjemo osnovnega videza.

Element Nastavitev podelementa Opis

Reset 
without Base 
Look

Execute/Cancel Ponastavi nastavitve menija Paint/Look z 
izjemo osnovnega videza.
Execute: Izvedite funkcijo.

Paint/Look > Black
Prilagodi nastavitve črnine.

Element Nastavitev podelementa Opis

Master Black –99,0 do +99,0 (±0,0) Nastavi raven master črnine.

R Black –99,0 do +99,0 (±0,0) Nastavi raven črnine R.

B Black –99,0 do +99,0 (±0,0) Nastavi raven črnine B.

Paint/Look >Knee
Prilagodi nastavitve popravkov kolena.

Element Nastavitev podelementa Opis

Setting Ko je možnost Target Display nastavljena 
na SDR(BT.709):

On / Off / ---
Ko je možnost Target Display nastavljena 
na HDR(HLG):

On / Off / ---

Vklopi/izklopi funkcijo popravkov kolena.

Auto Knee Ko je možnost Target Display nastavljena 
na SDR(BT.709):

On / Off / ---
Ko je možnost Target Display nastavljena 
na HDR(HLG):

On / Off / ---

Vklopi/izklopi funkcijo samodejnih 
popravkov kolena.

Point 75 % do 109 % (90 %) Nastavi točko kolena.

Slope –99 do +99 (±0) Nastavi naklon kolena.
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Paint/Look > Detail
Nastavi nastavitve prilagajanja podrobnosti.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi funkcijo podrobnosti.

Level -7 do +7 (±0) Nastavi raven podrobnosti.

Manual 
Setting

On / Off / --- Vklopi/izklopi funkcijo ročne nastavitve 
podrobnosti.

V/H Balance -2 do +2 (±0) Nastavi razmerje med navpičnimi (V) in 
vodoravnimi (H) podrobnostmi za ročno 
nastavitev podrobnosti.

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Nastavi razmerje med črnimi (B) 
podrobnostmi za slabo osvetljena 
območja in belimi (W) podrobnosti za 
močno osvetljena območja za ročno 
nastavitev podrobnosti.

Limit 0 to 7 Nastavi raven omejitve podrobnosti za 
ročno nastavitev podrobnosti.

Crispening 0 to 7 Nastavi raven izrazitosti barve za ročno 
nastavitev podrobnosti.

High Light 
Detail

0 to 4 Nastavi raven podrobnosti močno 
osvetljenih območij za ročno nastavitev 
podrobnosti.

Paint/Look > Matrix
Prilagodi nastavitve popravkov matrice.

Element Nastavitev podelementa Opis

User Matrix On / Off Vklopi/izklopi funkcijo popravkov 
uporabniške matrice.

User Matrix 
Level

–99 do +99 (±0) Prilagodi nasičenost barv celotne slike.

User Matrix 
Phase

–99 do +99 (±0) Prilagodi ton barv (fazo) celotne slike.

User Matrix 
R-G

–99 do +99 (±0) Nastavi uporabniško določeno 
uporabniško matrico R-G.

User Matrix 
R-B

–99 do +99 (±0) Nastavi uporabniško določeno 
uporabniško matrico R-B.

User Matrix 
G-R

–99 do +99 (±0) Nastavi uporabniško določeno 
uporabniško matrico G-R.

User Matrix 
G-B

–99 do +99 (±0) Nastavi uporabniško določeno 
uporabniško matrico G-B.

User Matrix 
B-R

–99 do +99 (±0) Nastavi uporabniško določeno 
uporabniško matrico B-R.

Paint/Look > Matrix
Prilagodi nastavitve popravkov matrice.

Element Nastavitev podelementa Opis

User Matrix 
B-G

–99 do +99 (±0) Nastavi uporabniško določeno 
uporabniško matrico B-G.

Paint/Look > Multi Matrix
Prilagodi nastavitve popravkov multi matrice.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi funkcijo popravkov multi 
matrice.

Ponastavitev Execute/Cancel Ponastavi odtenek in nasičenost za vsako 
osno barvo na privzete vrednosti.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Izbere os.

Hue –99 do +99 (±0) Nastavi odtenek barve, uporabljene za 
popravke multi matrice.

Saturation –99 do +99 (±0) Nastavi nasičenost barve, uporabljene za 
popravke multi matrice.
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Meni TC/Media
Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

TC/Media >Timecode
Prilagodi nastavitve časovne kode.

Element Nastavitev podelementa Opis

Mode Preset / Regen / Clock Nastavi način, kako teče časovna koda.
Preset: 

Teči začne od prednastavljene 
vrednosti.

Regen: 
Teči začne od časovne kode na 
zaključku prejšnjega posnetka.

Clock: 
Kot časovno kodo uporabi notranjo 
uro.

Run Rec Run / Free Run Rec Run: Teče samo med snemanjem.
Free Run: Teče vedno ne glede na 

delovanje videokamere.

Setting Časovno kodo nastavi na poljubno 
vrednost.
SET: Nastavite vrednost.

Ponastavitev Execute/Cancel Ponastavi časovno kodo na 00:00:00:00.
Execute: Izvedite funkcijo.

TC Format DF / NDF Nastavi format časovne kode.
DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display
Prilagodi nastavitve prikaza podatkov o času.

Element Nastavitev podelementa Opis

Display Select Timecode / Users Bit / Duration Switches the time data display.

TC/Media >Users Bit
Prilagodi nastavitve povezane z uporabniškimi biti.

Element Nastavitev podelementa Opis

Mode Fix / Time Nastavi način uporabniških bitov.
Fix: V uporabniških bitih uporabi 

poljubno fiksno vrednost.
Time: V uporabniških bitih uporabi 

trenuten čas.

Setting Uporabniške bite nastavi na poljubno 
vrednost.

TC/Media >HDMI TC Out
Prilagodi nastavitve povezane z izhodom časovne kode ob uporabi izhoda HDMI.

Element Nastavitev podelementa Opis

Setting On / Off Nastavi, ali naj se pošilja časovna koda na 
naprave za druge namene z uporabo 
izhoda HDMI.
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TC/Media >Clip Name Format
Prilagodi nastavitve povezane s poimenovanjem in brisanjem posnetkov.

Element Nastavitev podelementa Opis

Title Prefix nnn_ (nnn so zadnje 3 številke serijske 
številke)
(Največ 7-številčni zaslon)

Nastavi naslovni del (4 do 46 znakov) 
imena posnetka.
Odpre zaslon za vnos niza znakov.

Struktura zaslona za vnos niza znakov
Območje za izbiro znakov (3 vrstice): 

Izbere znake, ki bodo vstavljeni na 
položaju kazalca v območju Title 
Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Območje delovanja kazalca (1 vrstica): 
Space: Na položaju kazalca vstavi 
presledek.  
: Premakne kazalec na levo.  
: Premakne kazalec na desno.  
BS: Izbriše znak levo od kazalca.

Območje Title Prefix (1 vrstica): 
Območje za vnos naslova.

Za nastavitev naslova
1	 V območju za izbiro znakov z 

večfunkcijskim gumbom (stran 7) 
izberite znak, ki ga želite vstaviti na 
mesto kazalca v območju Title Prefix, 
in pritisnite gumb za potrditev na 
večfunkcijskem gumbu. (Vstavi se 
izbrani znak in kazalec se premakne v 
desno.)

2	 Za nastavitev naslova ponovite 1. 
korak. (Uporabite BS kot je 
zahtevano.)

3	 Ko nastavite naslov, izberite možnost 
Done, da zaprete zaslon za vnos 
znakov.

Number Set 0001 do 9999 Imenu posnetka nastavi 4-mestno 
številčno pripono.

TC/Media >Update Media
Na pomnilniških karticah posodobi datoteko za upravljanje.

Element Nastavitev podelementa Opis

Media(A) Execute/Cancel Posodobi datoteko za upravljanje na 
pomnilniški kartici v reži A.
Execute: Izvedite funkcijo.

Media(B) Execute/Cancel Posodobi datoteko za upravljanje na 
pomnilniški kartici v reži B.
Execute: Izvedite funkcijo.

TC/Media >Format Media
Inicializira pomnilniške kartice.

Element Nastavitev podelementa Opis

Media(A) Full Format / Quick Format / Cancel Formatira pomnilniško kartico v reži A.

Media(B) Full Format / Quick Format / Cancel Formatira pomnilniško kartico v reži B.
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Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Monitoring >Output On/Off
Prilagodi nastavitve video izhoda.

Element Nastavitev podelementa Opis

SDI On / Off Vklopi/izklopi izhod SDI.

HDMI On / Off Vklopi/izklopi izhod HDMI.

Monitoring >Output Format
Prilagodi nastavitve izhodnega formata.

Element Nastavitev podelementa Opis

SDI Za podrobnosti o nastavitvah glejte 
razdelek »Izhodni formati in omejitve« 
(stran 110).

Nastavi izhodno ločljivost izhodov SDI in 
HDMI.HDMI

Monitoring >Output Display
Prilagodi nastavitve izhodnega signala.

Element Nastavitev podelementa Opis

SDI On / Off Prikaže, ali so meni in podatki o stanju 
dodani izhodnemu signalu SDI.

HDMI On / Off Prikaže, ali so meni in podatki o stanju 
dodani izhodnemu signalu HDMI.

Monitoring >Display On/Off
Prilagodi nastavitve elementov zaslona.

Element Nastavitev podelementa Opis

Network 
Status

On / Off Izbere elemente za prikaz v iskalu.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off

Base Look/
LUT

On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Meni Monitoring
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Monitoring >Display On/Off
Prilagodi nastavitve elementov zaslona.

Element Nastavitev podelementa Opis

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Zaklop On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Prilagodi nastavitve prikaza označb.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi prikaz vseh označb.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Izbere označevalno barvo označbe.

Center 
Marker

1 / 2 / 3 / 4 / Off Izbere osrednjo označbo.

Safety Zone On / Off Vklopi/izklopi označbo varnega območja.

Safety Area 80% / 90% / 92.5% / 95% Izbere velikost označbe varnega območja 
(kot odstotek velikosti celotne slike).

Aspect 
Marker

Line / Mask / Off Izbere tip označbe razmerja.

Aspect Mask 0 do 15 (12) Nastavi raven video signala izven 
označbe.

Aspect Safety 
Zone

On / Off Vklopi/izklopi označbo razmerja varnega 
območja.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Izbere velikost označbe razmerja varnega 
območja (kot odstotek velikosti celotne 
slike).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Nastavi način pri prikazu označbe 
razmerja.

Custom 
Aspect Ratio

Enter arbitrary value (01.00:01.00) Nastavi razmerje med stranicami na 
poljubno vrednost.

[Opomba]
Ta nastavitev je mogoča, ko je nastavitev 
Aspect Select nastavljena na Custom.

Guide Frame On / Off Vklopi/izklopi prikaz vodilnega okvirja.

100% Marker On / Off Vklopi/izklopi 100 % označbo.

User Box On / Off Vklopi/izklopi prikaz označbe 
uporabniškega pravokotnika.

User Box 
Width

3 do 479 (240) Nastavi širino označbe uporabniškega 
pravokotnika (razdaljo od sredine do 
levega in desnega roba).

User Box 
Height

3 do 269 (135) Nastavi višino označbe uporabniškega 
pravokotnika (razdaljo od sredine do 
zgornjega in spodnjega roba).

User Box H 
Position

–476 do +476 (0) Nastavi vodoravni položaj središča 
označbe uporabniškega pravokotnika.

User Box V 
Position

–266 do +266 (0) Nastavi navpični položaj središča 
označbe uporabniškega pravokotnika.
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Monitoring >VF Setting
Prilagodi nastavitve iskala.

Element Nastavitev podelementa Opis

Brightness 1 to 15 (8) Prilagodi svetlost slike v iskalu.

Color Mode Color/B&W Izbere način prikaza iskala v načinu E-E/
snemanje.

Monitoring >Gamma Display Assist
Prilagodi nastavitve pomoči za gammo zaslona.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi funkcijo za izboljšan prikaz 
game v načinu Custom, ko je možnost 
Target Display nastavljena na HDR(HLG).

Monitoring >Peaking
Prilagodi nastavitve za funkcijo Peaking.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi funkcijo peaking.

Peaking Level High / Mid / Low Nastavi raven signala barvnega peakinga.

Color B&W / Red / Yellow / Blue Izbere barvo signala barvnega peakinga.

Monitoring >Zebra
Prilagodi nastavitve vzorca zebra.

Element Nastavitev podelementa Opis

Setting Off / Zebra1 / Zebra2 Izbere tip vzorca zebra (Off, Zebra 1, Zebra 
2).

Zebra1 Level 0 % do 109 % (70 %) Nastavi raven prikaza za Zebra 1.

Zebra1 
Aperture 
Level

2 % do 20 % (10%) Nastavi raven odprtosti za Zebra 1.

Zebra2 Level 0 % do 109 % (100 %) Nastavi raven prikaza za Zebra 2.



6. Prikaz in nastavitve menijev90 SL

Meni Audio
Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).
Glejte »Sheme delovanja« (stran 124).

Audio >Audio Input
Prilagodi nastavitve avdio vhoda.

Element Nastavitev podelementa Opis

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Preklopi vhodni vir za snemanje na 
kanalu 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Preklopi vhodni vir za snemanje na 
kanalu 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Preklopi vhodni vir za snemanje na 
kanalu 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Preklopi vhodni vir za snemanje na 
kanalu 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Nastavi referenčno raven snemanja za 
mikrofonski vhod XLR na vhodu INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Nastavi referenčno raven snemanja za 
mikrofonski vhod XLR na vhodu INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Nastavi referenčno raven vhoda, ko je 
stikalo INPUT1/INPUT2 nastavljeno na 
LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Nastavi raven snemanja 1 kHz 
referenčnega tonskega signala.

CH1 Wind 
Filter

On / Off Omogoči/onemogoči zmanjševanje 
šuma vetra na kanalu 1.

CH2 Wind 
Filter

On / Off Omogoči/onemogoči zmanjševanje 
šuma vetra na kanalu 2.

CH3 Wind 
Filter

On / Off Omogoči/onemogoči zmanjševanje 
šuma vetra na kanalu 3.

CH4 Wind 
Filter

On / Off Omogoči/onemogoči zmanjševanje 
šuma vetra na kanalu 4.

CH3 Level 
Control

Auto / Manual Nastavi samodejno ali ročno prilagajanje 
ravni avdio vhoda na kanalu 3.

[Opomba]
Če sta tako možnost CH3 Input Select kot 
možnost CH4 Input Select nastavljeni na 
Internal MIC, se CH4 v povezavi s to nastavitvijo 
preklopi na automatic/manual.

Audio >Audio Input
Prilagodi nastavitve avdio vhoda.

Element Nastavitev podelementa Opis

CH4 Level 
Control

Auto / Manual Nastavi samodejno ali ročno prilagajanje 
ravni avdio vhoda na kanalu 4.

[Opomba]
Če sta tako možnost CH3 Input Select kot 
možnost CH4 Input Select nastavljena na 
Internal MIC, se CH4 v povezavi z nastavitvijo 
CH3 Level Control preklopi na automatic/
manual.

CH3 Input 
Level

0 to 99 (49) Nastavi vhodno raven za snemanje na 
kanalu 3.

CH4 Input 
Level

0 to 99 (49) Nastavi vhodno raven za snemanje na 
kanalu 4.

Audio Input 
Level

0 do 99 Nastavi raven avdio vhoda.
Glede na nastavitve možnosti CH1 Level 
do CH4 Level, se lahko uporabi kot glavna 
nastavitev glasnosti.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Izbere lastnosti omejevalnika za velike 
vhodne signale, ko ročno nastavljate 
raven avdio vhoda.

CH1&2 AGC 
Mode

Mono / Stereo Nastavi samodejni način prilagajanja 
ravni za kanal 1 in kanal 2. Pri nastavitvi 
Stereo je AGC povezan med kanaloma.

CH3&4 AGC 
Mode

Mono / Stereo Nastavi samodejni način prilagajanja 
ravni za kanal 3 in kanal 4. Pri nastavitvi 
Stereo je AGC povezan med kanaloma.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Izbere lastnosti AGC-ja.

1kHz Tone on 
Color Bars

On / Off Vklopi/izklopi 1 kHz referenčni tonski 
signal ob prikazu barvnih vrstic.

[Opomba]
Ko je možnost nastavljena na On, je 1 kHz 
referenčni tonski signal nastavljen za snemanje 
na kanalu 3 in kanalu 4, tudi če sta možnosti 
CH3 Input Select in CH4 Input Select nastavljeni 
na Off.
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Audio >Audio Input
Prilagodi nastavitve avdio vhoda.

Element Nastavitev podelementa Opis

CH1 Level Vhod brez adapterja XLR
Audio Input Level / Side / Level+Side

Vhod z adapterjem XLR (stran 47)
Audio Input Level / Through

Nastavi kombinacijo prilagoditev ravni 
avdio vhoda, omogočenih za kanal 1.

[Opomba]
»Side« se nanaša na kolesce AUDIO LEVEL (CH1) 
na stranskem delu videokamere. Ko je izbrana 
možnost Level+Side, je raven snemanja zvoka 
določena s kombinacijo nastavitev Audio Input 
Level in nastavitev kolesca (stran 124).

CH2 Level Vhod brez adapterja XLR
Audio Input Level / Side / Level+Side

Vhod z adapterjem XLR (stran 47)
Audio Input Level / Through

Nastavi kombinacijo prilagoditev ravni 
avdio vhoda, omogočenih za kanal 2.

[Opomba]
»Side« se nanaša na kolesce AUDIO LEVEL 
(CH2) na stranskem delu videokamere. Ko je 
izbrana možnost Level+Side, je raven snemanja 
zvoka določena s kombinacijo nastavitev Audio 
Input Level in nastavitev kolesca (stran 124).

CH3 Level Vhod brez adapterja XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Vhod z adapterjem XLR (stran 47)
Audio Input Level / Through

Nastavi kombinacijo prilagoditev ravni 
avdio vhoda, omogočenih za kanal 3.

CH4 Level Vhod brez adapterja XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Vhod z adapterjem XLR (stran 47)
Audio Input Level / Through

Nastavi kombinacijo prilagoditev ravni 
avdio vhoda, omogočenih za kanal 4.

Audio >Audio Output
Prilagodi nastavitve avdio izhoda.

Element Nastavitev podelementa Opis

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Izbere izhod avdio kanala na priključek za 
slušalke in vgrajen zvočnik.

[Opomba]
Če je avdio za več kanalov nastavljen na 
sočasni izhod, se izhodna raven vsakega kanala 
na izhodu zmanjša, da se prepreči kliping.

Glasnost 0 to 50 Prilagodi izhodno raven zvoka monitorja 
na priključek za slušalke in vgrajen 
zvočnik.

Headphone 
Out

Mono / Stereo Izbere, ali je izhod na priključku za 
slušalke mono (Mono) ali stereo (Stereo).

Alarm Level 0 do 7 (4) Nastavi glasnost alarma.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Nastavi kombinacijo avdio kanalov na 
izhodu HDMI.
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Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Thumbnail (Sličica)

Element Nastavitev podelementa Opis

Display Clip 
Properties

Prikaže zaslon z lastnostmi posnetka.

Thumbnail > Set Clip Flag
Prilagodi nastavitve zastavice posnetka.

Element Nastavitev podelementa Opis

Add OK Doda zastavico OK.

Add NG Doda zastavico NG.

Add KEEP Doda zastavico Keep.

Delete Clip 
Flag

Izbriše vse zastavice.

Thumbnail >Lock/Unlock Clip
Prilagodi nastavitve zaščite posnetka.

Element Nastavitev podelementa Opis

Select Clip Izbere in zaklene/odklene posnetek.

Lock All Clips Zaklene vse posnetke.

Unlock All 
Clips

Odklene vse posnetke.

Thumbnail >Delete Clip
Izbriše posnetke.

Element Nastavitev podelementa Opis

Select Clip Izbriše izbrani posnetek.

All Clips Izbriše vse posnetke.

Thumbnail >Transfer Clip
Prenese posnetke.

[Opomba]
Možnosti Transfer Clip ni mogoče konfigurirati, ko možnost Access Authentication > Password v meniju Network 
ni določena.

Element Nastavitev podelementa Opis

Select Clip Prenese izbrane posnetke.

All Clips Prenese vse posnetke.

[Opomba]
Prenesti je mogoče do 200 posnetkov.

Thumbnail >Transfer Clip (Proxy)
Prenese posnetke proxy.

[Opomba]
Možnosti Transfer Clip (Proxy) ni mogoče konfigurirati, ko možnost Access Authentication > Password v meniju 
Network ni določena.

Element Nastavitev podelementa Opis

Select Clip Prenese posnetke proxy, ki ustrezajo 
izbranim posnetkom.

All Clips Prenese posnetke proxy, ki ustrezajo 
vsem posnetkom.

[Opomba]
Prenesti je mogoče do 200 posnetkov.

Thumbnail >Filter Clips
Prilagodi nastavitve posnetkov za prikaz.

Element Nastavitev podelementa Opis

OK (Uspešno) Prikaže samo posnetke, ki imajo zastavico 
OK.

NG Prikaže samo posnetke, ki imajo zastavico 
NG.

KEEP Prikaže samo posnetke, ki imajo 
zastavico Keep.

None Prikaže samo posnetke, ki nimajo 
zastavice.

Vse Prikaže vse posnetke ne glede na 
zastavice.

Thumbnail >Customize View
Preklopi pogled zaslona sličic.

Element Nastavitev podelementa Opis

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Preklopi podatke, prikazane pod 
sličicami.

Meni Thumbnail
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Meni Technical
Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Technical >Color Bars
Prilagodi nastavitve barvnih vrstic.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi barvne vrstice.

Tip ARIB / 100% / 75% / SMPTE Izbere tip barvne vrstice.

Technical >ND Dial
Prilagodi nastavitve, povezane z delovanjem kolesca ND VARIABLE.

Element Nastavitev podelementa Opis

CLEAR with 
Dial

On / Off Nastavi, ali naj bo omogočeno 
preklapljanje stanja ND (CLEAR  On) z 
uporabo kolesca ND VARIABLE.

Technical >Tally
Prilagodi nastavitve indikatorja snemanja.

Element Nastavitev podelementa Opis

Spredaj On / Off Vklopi/izklopi sprednji (Front) indikator 
snemanja.

Zadaj On / Off Vklopi/izklopi zadnji (Rear) indikator 
snemanja.

Technical >HOLD Switch Setting
Prilagodi nastavitve stikala zadržanja.

Element Nastavitev podelementa Opis

with Rec 
Button

On / Off Nastavi, ali naj se zaklene delovanje 
gumba za snemanje START/STOP.

with Hand 
Grip Remote

On / Off Nastavi, ali naj se zaklene delovanje 
držala z daljinskim upravljalnikom.

Technical >Touch Operation
Nastavi nastavitve, ki so povezane z upravljanjem na dotik.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi upravljanje na dotik.

Technical >Rec Review
Prilagodi nastavitve ogleda posnetka.

Element Nastavitev podelementa Opis

Setting 3sec / 10sec / Clip Izbere čas predvajanja pravkar posnetih 
posnetkov za funkcijo ogleda posnetka.

Technical >Zoom
Nastavi nastavitve zooma.

Element Nastavitev podelementa Opis

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Nastavi vrsto zooma.
Optical Zoom Only: 

Optični zoom prilagajate z 
upravljanjem objektiva.

On(Clear Image Zoom): 
Elektronski zoom z minimalnim ali 
ničnim poslabšanjem kakovosti slike.

Technical >Handle Zoom
Prilagodi nastavitve zooma na držalu.

Element Nastavitev podelementa Opis

Setting Off / Low / High / Variable Nastavi hitrost zooma na držalu.

Visok 1 do 8 (8) Nastavi hitrost zooma na ročici za zoom 
na držalu, ko je izbrana visoka (High) 
hitrost zooma na držalu.

Nizek 1 do 8 (3) Nastavi hitrost zooma na ročici za zoom 
na držalu, ko je izbrana nizka (Low) 
hitrost zooma na držalu.

[Opomba]
Ko je hitrost zooma nastavljena na nizko 
vrednost, lahko pride do neenakomernega 
zoomiranja.

Technical >Menu Settings
Prilagodi nastavitve v povezavi z menijem.

Element Nastavitev podelementa Opis

User Menu 
Only

On / Off Nastavi, ali naj bo prikazan samo meni 
User (On) ali seznam menijev (Off), ko 
videokamera prikazuje meni.

User Menu 
with Lock

On / Off Nastavi, ali naj se prikaz menija zaklene 
in prikazuje samo meni User.

[Opomba]
Ta element ni prikazan v normalnem delovanju 
prikaza menija. Za podrobnosti o delovanju 
prikaza menija glejte 68.
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Technical >Fan Control
Prilagodi nastavitve upravljanja ventilatorja.

Element Nastavitev podelementa Opis

Setting Auto / Minimum / Off in Rec Nastavi način upravljanja ventilatorja 
videokamere.

[Opomba]
Tudi če je izbrana možnost Off in Rec, bo 
ventilator deloval, če notranja temperatura 
videokamere preseže določeno vrednost.

Technical >Lens
Prilagodi nastavitve povezane z objektivi.

Element Nastavitev podelementa Opis

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Nastavi smer delovanja obroča za zoom.

[Opomba]
Omogočeno samo pri uporabi objektiva serije 
E, ki podpira preklop smeri obroča za zoom.

Shading 
Compensation

Auto / Off Vklopi/izklopi samodejno kompenzacijo 
senčenja.

Chroma 
Aberration 
Comp.

Auto / Off Vklopi/izklopi samodejno kompenzacijo 
kromatske aberacije.

Distortion 
Comp.

Auto / Off Vklopi/izklopi samodejno kompenzacijo 
popačenja.

Distance 
Display

Meter / Feet Nastavi mersko enoto za prikaz podatkov 
o objektivu in položaju ostrenja.

Zoom 
Position 
Display

Focal Length / Number / Bar Nastavi format prikaza položaja zooma.

Technical >Video Light Set
Nastavi način osvetljevanja video luči. Na voljo samo z uporabo video luči HVL-LBPC (možnost).

Element Nastavitev podelementa Opis

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Nastavi način osvetljevanja za video luč, 
nameščeno na večvmesniški nastavek.
Power Link: 

Video luč se vklopi/izklopi, ko 
vklopite/izklopite videokamero.

Rec Link: 
Video luč se vklop/izklopi, ko 
videokamera začne/prekine s snemanjem.

Rec Link + Stby: 
Video luč se vklopi/gre v stanje 
pripravljenosti, ko videokamera 
začne/prekine s snemanjem.

Technical >APR
Izvede funkcijo APR.

Element Nastavitev podelementa Opis

APR Execute/Cancel Zažene APR (Automatic Pixel Restoration) 
za samodejno prilagoditev slikovnega 
senzorja.
Execute: Izvedite funkcijo.

[Opomba]
Pred zagonom funkcije APR vedno namestite 
pokrovček objektiva.

Technical >Camera Battery Alarm
Prilagodi nastavitve opozorila za izpraznjeno baterijo.

Element Nastavitev podelementa Opis

Low Battery 5% / 10% / 15% / … / 45% / 50% Nastavi preostalo napolnjenost baterije, 
pri kateri se prikaže opozorilo za nizko 
napetost baterije (v korakih po 5 %).

Battery 
Empty

3 % do 7 % Nastavi preostalo napolnjenost baterije, 
pri kateri se prikaže opozorilo za 
izpraznjeno baterijo.

Technical >Camera DC IN Alarm
Prilagodi nastavitve opozoril za vhodno napetost.

Element Nastavitev podelementa Opis

DC Low 
Voltage1

16,0 V do 19,0 V (16,5 V) Nastavi napetost, pri kateri se prikaže 
opozorilo za nizko vhodno napetost.

DC Low 
Voltage2

15,5 V do 18,5 V Nastavi napetost, pri kateri se prikaže 
opozorilo za prenizko vhodno napetost.
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Meni Network
Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Network >Access Authentication
Prilagodi nastavitve, povezane z avtentikacijo.

Element Nastavitev podelementa Opis

User Name Nastavi uporabniško ime za avtentikacijo 
dostopa.

Password Nastavi geslo za avtentikacijo dostopa.

Network >Wireless LAN
Prilagodi nastavitve povezane z brezžičnimi povezavami LAN.

Element Nastavitev podelementa Opis

Setting Access Point Mode / Station Mode / Off Izbere način delovanja brezžične 
povezave LAN.

WPS Execute/Cancel Vzpostavi povezavo z uporabo WPS 
(Wi-Fi Protected Setup).
Execute: Izvedite funkcijo.

NFC Execute/Cancel Vzpostavi povezavo z uporabo NFC (Near 
Field Communication).
Execute: Izvedite funkcijo.

MAC Address Prikaže naslov MAC brezžičnega 
vmesnika LAN v videokameri.

Network >AP Mode Settings
Prilagodi nastavitve povezane s povezavami v načinu dostopovne točke.

Element Nastavitev podelementa Opis

Channel Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Nastavi kanal brezžične povezave LAN.
Auto(5GHz) je na voljo samo pri modelu 
ILME‑FX6V/VK.

Camera SSID 
& Password

Prikaže SSID in geslo videokamere.

Regenerate 
Password

Execute/Cancel Ustvari novo geslo.
Execute: Izvedite funkcijo.

IP Address Prikaže naslov IP videokamere v načinu 
dostopovne točke.

Subnet Mask Prikaže masko podomrežja videokamere 
v načinu dostopovne točke.

Network >ST Mode Settings
Prilagodi nastavitve povezane s povezavami načina postaje.

Element Nastavitev podelementa Opis

Camera 
Remote 
Control

Enable / Disable Nastavi, ali naj bo omogočeno daljinsko 
upravljanje z naprave, povezane z 
videokamero prek brezžične povezave 
LAN v načinu postaje.

Connected 
Network

Prikaže povezano brezžično omrežje LAN 
(dostopovna točka).

SSID Prikaže SSID dostopovne točke za 
povezavo.

Varnost Prikaže tip varnosti dostopovne točke za 
povezavo.

Password Prikaže geslo dostopovne točke za 
povezavo.
Ko je možnost Security nastavljena na 

WEP ali WPA: *******
Ko je možnost Security nastavljena na 

None: (prazno)

DHCP Prikaže, ali je možnost DHCP vklopljena/
izklopljena.

IP Address Prikaže naslov IP videokamere, ko je 
možnost DHCP nastavljena na Off.

Subnet Mask Prikaže masko podomrežja videokamere, 
ko je možnost DHCP nastavljena na Off.

Gateway Prikaže privzeti prehod videokamere, ko 
je možnost DHCP nastavljena na Off.

DNS Auto Prikaže, ali je pridobivanje DNS 
vklopljeno/izklopljeno.

Primary DNS Server Prikaže primarni strežnik DNS 
videokamere, ko je možnost DNS Auto 
nastavljena na Off.

Secondary DNS Server Prikaže sekundarni strežnik DNS 
videokamere, ko je možnost DNS Auto 
nastavljena na Off.
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Network >ST Mode Settings
Prilagodi nastavitve povezane s povezavami načina postaje.

Element Nastavitev podelementa Opis

Scan 
Networks

Zazna brezžična omrežja LAN 
(dostopovne točke) in prikaže njihov 
seznam.
Izberite cilj s seznama za povezavo.

SSID Prikaže SSID dostopovne točke za 
povezavo.

Varnost Prikaže tip varnosti dostopovne točke za 
povezavo.

Password Vnesite geslo dostopovne točke za 
povezavo.

DHCP 
On / Off

Vklopi/izklopi DHCP.

IP Address Vnesite naslov IP videokamere, ko je 
možnost DHCP nastavljena na Off.

Subnet Mask Vnesite masko podomrežja videokamere, 
ko je možnost DHCP nastavljena na Off.

Gateway Vnesite privzeti prehod videokamere, ko 
je možnost DHCP nastavljena na Off.

DNS Auto 
On / Off

Vklopi/izklopi samodejno pridobivanje 
DNS.

Primary DNS Server Vnesite primarni strežnik DNS 
videokamere, ko je možnost DNS Auto 
nastavljena na Off.

Secondary DNS Server Vnesite sekundarni strežnik DNS 
videokamere, ko je možnost DNS Auto 
nastavljena na Off.

Network >ST Mode Settings
Prilagodi nastavitve povezane s povezavami načina postaje.

Element Nastavitev podelementa Opis

Manual 
Register

Registrira nastavitve ročne povezave na 
dostopovno točko.

SSID Vnesite SSID dostopovne točke za 
povezavo.

Security 
None / WEP / WPA

Nastavite tip varnosti dostopovne točke 
za povezavo. Če je tip varnosti 
dostopovne točke WPA ali WPA2, izberite 
WPA.

Password Vnesite geslo dostopovne točke za 
povezavo.

DHCP 
On / Off

Vklopi/izklopi DHCP.

IP Address Vnesite naslov IP videokamere, ko je 
možnost DHCP nastavljena na Off.

Subnet Mask Vnesite masko podomrežja videokamere, 
ko je možnost DHCP nastavljena na Off.

Gateway Vnesite privzeti prehod videokamere, ko 
je možnost DHCP nastavljena na Off.

DNS Auto 
On / Off

Vklopi/izklopi samodejno pridobivanje 
DNS.

Primary DNS Server Vnesite primarni strežnik DNS, ko je 
možnost DNS Auto nastavljena na Off.

Secondary DNS Server Vnesite sekundarni strežnik DNS, ko je 
možnost DNS Auto nastavljena na Off.
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Network >Wired LAN
Prilagodi nastavitve povezane z žično povezavo LAN.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi funkcijo žične povezave 
LAN.

Camera 
Remote 
Control

Enable / Disable Nastavi, ali naj bo omogočeno daljinsko 
upravljanje z naprave, povezane z 
videokamero prek žične povezave LAN.

Detail 
Settings

Nastavi lastnosti žične povezave LAN.

DHCP 
On / Off

Vklopi/izklopi DHCP.

IP Address Vnesite naslov IP videokamere, ko je 
možnost DHCP nastavljena na Off.

Subnet Mask Vnesite masko podomrežja videokamere, 
ko je možnost DHCP nastavljena na Off.

Gateway Vnesite privzeti prehod videokamere, ko 
je možnost DHCP nastavljena na Off.

DNS Auto 
On / Off

Vklopi/izklopi samodejno pridobivanje 
DNS.

Primary DNS Server Vnesite primarni strežnik DNS, ko je 
možnost DNS Auto nastavljena na Off.

Secondary DNS Server Vnesite sekundarni strežnik DNS, ko je 
možnost DNS Auto nastavljena na Off.

Network >Modem
Nastavi nastavitve, ki so povezane s povezavo USB.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi povezavo s pametnim 
telefonom.

Camera 
Remote 
Control

Enable / Disable Omogočitev povezave za dostop s 
pametnim telefonom prek aplikacije 
Content Browser Mobile.

Device Name Prikaže ime naprave pametnega telefona.

IP Address Prikaže naslov IP pametnega telefona.

Subnet Mask Prikaže masko podomrežja pametnega 
telefona.

Network >File Transfer
Prilagodi nastavitve povezane s prenosi datotek.

Element Nastavitev podelementa Opis

Auto Upload 
(Proxy)

On / Off Vklopi/izklopi samodejni prenos datoteke 
proxy.

Default 
Upload 
Server

Izbere strežnik za nalaganje datotek. 
Tukaj izbran strežnik postane cilj za 
samodejno nalaganje datotek proxy in 
cilj za nalaganje datotek z zaslona sličic.
Prikaže prikazno ime, ki je nastavljeno v 
nastavitvah Server Settings 1 to 3.

Clear 
Completed 
Jobs

Execute/Cancel S seznama izbriše zaključene prenose.
Execute: Izvedite funkcijo.

Clear All Jobs Execute/Cancel S seznama izbriše vse prenose.
Execute: Izvedite funkcijo.

View Job List Prikaže seznam prenosov.
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Network >File Transfer
Prilagodi nastavitve povezane s prenosi datotek.

Element Nastavitev podelementa Opis

Server 
Settings1

Display Name Nastavi prikazno ime, prikazano v meniju 
za nastavitev cilja prenosa.

Service 
FTP

Prikaže tip strežnika.

Host Name Nastavi ime gostitelja ciljnega strežnika 
za prenos.

Port (1 do 65535 (21)) Nastavi številko vrat ciljnega strežnika za 
prenos.

User Name Nastavi uporabniško ime za avtentikacijo 
povezave ciljnega strežnika za prenos.

Password Nastavi avtentikacijsko geslo povezave 
ciljnega strežnika za prenos.

Passive Mode 
On / Off

Vklopi/izklopi način PASV.

Destination Directory Vnesite ime ciljne mape za prenos.

Using Secure Protocol 
On / Off

Nastavi, ali naj se uporabi (On) ali ne 
uporabi (Off) varen prenos FTP (FTPS 
Explicit Mode: FTPES).

Root Certificate 
Load / Clear / None

Naloži korenski certifikat za varen prenos 
FTP in izbriše nastavitve.

Root Certificate Status 
Loaded / No Certificate

Prikaže stanje nalaganja korenskega 
certifikata za varen prenos FTP.

Reset 
Execute/Cancel

Ponastavi nastavitve Server Settings na 
privzete vrednosti.
Execute: Izvedite funkcijo.

Server 
Settings2

Enako kot Server Settings1.

Server 
Settings3

Enako kot Server Settings1.

Network >Network Reset
Ponastavi nastavitve omrežja.

Element Nastavitev podelementa Opis

Ponastavitev Execute/Cancel Ponastavi nastavitve omrežja.
Execute: Izvedite funkcijo.
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Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Maintenance >Language
Nastavi jezik prikaza.

Element Nastavitev podelementa Opis

Select Nastavi jezik prikaza.
SET: Nastavite jezik.

Maintenance >Clock Set
Prilagodi nastavitve notranje ure.

Element Nastavitev podelementa Opis

Time Zone UTC – 12:00 do UTC + 14:00 Nastavi razliko do časa UTC v korakih po 
30 minut.

Date Mode YYMMDD / MMDDYY / DDMMYY Izbere format prikaza datuma.
YYMMDD: Leto, mesec, dan
MMDDYY: Mesec, dan, leto
DDMMYY: Dan, mesec, leto

12H/24H 12H / 24H Izbere format prikaza ure.
12H: 12-urni način
24H: 24-urni način

Datum Nastavi trenutni datum.
SET: Nastavite vrednost.

Time Nastavi trenutni čas.
SET: Nastavite vrednost.

Maintenance >All Reset
Ponastavi nastavitve na tovarniško privzete.

Element Nastavitev podelementa Opis

Reset Execute/Cancel Ponastavi vse nastavitve na tovarniško 
privzete vrednosti.
Execute: Izvedite funkcijo.

[Opomba]
Datoteka 3D LUT, uvožena s funkcijo Base Look 
>Import (stran 83) v meniju Paint/Look, 
je izbrisana. Če želite izbrisati vse uvožene 
datoteke 3D LUT, izberite nastavitev Base Look 
> Delete All v meniju Paint/Look (stran 83).

Reset without 
Network

Execute/Cancel Ponastavi nastavitve menija, razen 
nastavitev menija Network, na privzeto 
tovarniško stanje.

Maintenance >Hours Meter
Prikaže akumulirani čas delovanja.

Element Nastavitev podelementa Opis

Hours 
(System)

Prikaže akumulirane ure uporabe 
(ponastavitev ni mogoča).

Hours (Reset) Prikaže akumulirane ure uporabe 
(ponastavitev je mogoča).

Ponastavitev Execute/Cancel Ponastavi prikaz Hours (Reset) na 0.
Execute: Izvedite funkcijo.

Maintenance >Version
Prikaže podatke o različici.

Element Nastavitev podelementa Opis

Version 
Number

Vx.xx Prikaže različico programske opreme 
videokamere.

Version Up Execute/Cancel Posodobi videokamero.*

Execute: Izvedite funkcijo.
*	 Ta funkcija posodobi programsko opremo 

videokamere.

Lens Version 
Number

Vxx Prikaže številko različice programske 
opreme objektiva serije E.

Meni Maintenance



6. Prikaz in nastavitve menijev100 SL

Shooting Menu Settings and Default Values

ISO/Gain Settings and Default Values

Razpon nastavitev ISO/Gain (stran 72) in privzetih vrednosti se razlikuje glede na nastavitve Mode, Target Display, Base Look >Select in Base Sensitivity. Razpoložljive možnosti so označene s sivo 
barvo.

Ko je nastavitev Mode nastavljena na ISO

Target Display SDR(BT.709) HDR(HLG) SDR(BT.709) in HDR(HLG) common
Base Look > Select S-Cinetone / Standard / ITU709 / Still HLG Live / HLG Natural User1 to User16
Base Sensitivity Nizek Visok Nizek Visok Nizek Visok
ISO 320 ISO/Gain<L> default
ISO 400
ISO 500
ISO 640 ISO/Gain<M> default
ISO 800 ISO/Gain<L> default ISO/Gain<L> default
ISO 1000
ISO 1250 ISO/Gain<H> default
ISO 1600 ISO/Gain<M> default ISO/Gain<M> default
ISO 2000
ISO 2500
ISO 3200 ISO/Gain<H> default ISO/Gain<H> default
ISO 4000
ISO 5000 ISO/Gain<L> default
ISO 6400
ISO 8000
ISO 10000 ISO/Gain<M> default
ISO 12800 ISO/Gain<L> default ISO/Gain<L> default
ISO 16000
ISO 20000 ISO/Gain<H> default
ISO 25600 ISO/Gain<M> default ISO/Gain<M> default
ISO 32000
ISO 40000
ISO 51200 ISO/Gain<H> default ISO/Gain<H> default
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ko je možnost Mode nastavljena na dB

Območje nastavitev
–3dB
–2dB
–1dB
0dB ISO/Gain<L> default
1dB
2dB
3dB
4dB
5dB
6dB ISO/Gain<M> default
7dB
8dB
9dB
10dB
11dB
12dB ISO/Gain<H> default
13dB
14dB
15dB
16dB
17dB
18dB
19dB
20 dB
21dB
22dB
23dB
24dB
25dB
26dB
27dB
28dB
29dB
30dB
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AGC Limit Settings and Default Values

Območje nastavitev AGC Limit (stran 73) in privzetih vrednosti se razlikuje glede na nastavitve Mode, Target Display, Base Look >Select in Base Sensitivity. Razpoložljive možnosti so označene s 
sivo barvo.

Ko je nastavitev Mode nastavljena na ISO

Target Display SDR(BT.709) HDR(HLG) HDR(HLG) SDR(BT.709) in HDR(HLG) common
Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live HLG Natural User1 to User16
Base Sensitivity Nizek Visok Nizek Visok Nizek Visok Nizek Visok
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000 Privzeta
ISO 2500
ISO 3200
ISO 4000
ISO 5000 Privzeta Privzeta Privzeta
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000 Privzeta
ISO 40000
ISO 51200
ISO 64000
ISO 80000 Privzeta Privzeta Privzeta
ISO 102400
ISO 128000
ISO 160000

ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ko je možnost Mode nastavljena na dB

Območje nastavitev
3dB
6dB
9dB
12dB
15dB Privzeta
18dB
21dB
24dB
27dB
30dB
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Image Quality Settings Saved for Each Shooting Mode
Elementi trenutnega stanje konfiguracije, ki so povezani s kakovostjo slike, se shranijo za vsakega od naslednjih snemalnih načinov (stran 24). Ko spremenite snemalni način, se ustrezne 
nastavitve, ki so shranjene, uporabijo za ciljni snemalni način.
ˎˎ Custom mode SDR(BT.709)
ˎˎ Custom mode HDR(HLG)
ˎˎ Način Cine EI

Konfiguracijski elementi, ki so povezani s kakovostjo slike in so shranjeni za vsak snemalni način, so prikazani spodaj.
Da: Element je shranjen.
Ne: Element ni shranjen.

Konfiguracijski element Način zajemanja posnetkov
Način Custom Način Cine EI
SDR(BT.709) HDR(HLG)

Meni Shooting ISO/Gain/EI ISO/Gain Da1) Ne

Indeks osvetlitve Ne Da

Base Sensitivity Da Ne

Base ISO Ne Da

Bel Preset White Da Da

Drugo Da

White Setting Da

Offset White Da Ne

LUT On/Off Ne Da

Noise Suppression Setting(Custom) Da Da Ne

Level(Custom) Da Da Ne

Setting(Cine EI) Ne Da

Level(Cine EI) Ne Da

Meni Paint/Look Base Look izberite Da Da Da

Input2) Da

Output2) Da

AE Level Offset2) Da

Črn Da Da Ne

Knee Auto Knee Da Ne Ne

Drugo Da Da Ne

Detail Da Da Ne

Matrix Da Da Ne

Multi Matrix Da Da Ne
1)	 Ločene nastavitve občutljivosti ISO so shranjene za način Custom SDR(BT.709) in HDR(HLG).
2)	Nastavitve se shranijo za vsak osnovni videz in niso odvisne od snemalnega načina.
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Konfiguracijski podatki

Nastavitve glavnega menija lahko shranite 
na pomnilniško kartico, ki je vstavljena v 
režo za kartice CFexpress tipa A/SD (B). To 
vam omogoča, da hitro prikličete primerne 
nastavitve menija za trenutno situacijo.
Konfiguracijski podatki so shranjeni v sledečih 
kategorijah.

Uporabniške datoteke
Uporabniške datoteke hranijo elemente 
nastavitev in podatke prilagodljivega menija 
User.
Na pomnilniško kartico lahko shranite do 64 
datotek.
Z nalaganjem te datoteke v pomnilnik 
videokamere lahko prilagodite nastavitev 
menija User.

VSE datoteke (vse nastavitve)
Datoteke ALL hranijo konfiguracijske podatke 
vseh menijev. Na pomnilniško kartico lahko 
shranite do 64 datotek.

[Opomba]
Podatki, specifični za napravo (senčenje, izhodne ravni 
in ostali podatki, ki zahtevajo prilagoditev za specifično 
napravo), se ne shranijo.

Shranjevanje datoteke User File/
ALL File

1	 Vstavite pomnilniško kartico v režo za 
kartice CFexpress tipa A/SD (B) 
(stran 6).
ˎˎ Pri karticah CFexpress mora biti nalepka 
na levi strani.
ˎˎ Pri karticah SD mora biti nalepka na 
desni strani, z zaobljenim vogalom na 
dnu.

2	 Za uporabniško datoteko izberite možnost 
User File > Save Media(B) (stran 82) > 
Execute v meniju Project glavnega menija.
Za datoteko ALL izberite možnost All File > 
Save Media(B) (stran 82) > Execute v 
meniju Project glavnega menija.
Pojavi se ciljni zaslon za shranitev 
datoteke.

3	 Izberite vrstico »No File« na ciljnem 
zaslonu za shranitev datoteke.
Izbira vrstice z vnosom File ID bo prepisala 
izbrano datoteko.
File ID se generira samodejno, a ga lahko 
spremenite.

4	 Izberite ukaz Execute na potrditvenem 
zaslonu.

Nalaganje datoteke User File/
ALL file

1	 Vstavite pomnilniško kartico, na kateri je 
shranjena datoteka, v režo za kartice 
CFexpress tipa A/SD (B) (stran 6).
ˎˎ Pri karticah CFexpress mora biti nalepka 
na levi strani.
ˎˎ Pri karticah SD mora biti nalepka na 
desni strani, z zaobljenim vogalom na 
dnu.

2	 Za uporabniško datoteko izberite možnost 
User File > Load Media(B) (stran 82) > 
Execute v meniju Project glavnega menija.
Za datoteko ALL izberite možnost All File > 
Load Media(B) (stran 82) > Execute v 
meniju Project glavnega menija.
Pojavi se zaslon s seznamom datotek.

3	 Izberite datoteko za nalaganje.
Prikaže se potrditveni zaslon.

4	 Izberite Execute.

[Opombe]
ˎˎ Enota se po nalaganju konfiguracijskih podatkov 

samodejno znova zažene.
ˎˎ Ko je možnost All File > Load Network Data v meniju 

Project glavnega menija izklopljena, so naložene vse 
nastavitve v datoteki ALL, razen nastavitev menija 
Network.

Spreminjanje ID-ja datoteke

1	 Za uporabniško datoteko izberite User File 
> File ID (stran 82) v meniju Project 
glavnega menija.
Za datoteko ALL izberite možnost All File > 
File ID (stran 82) v meniju Project 
glavnega menija.
Pojavi se zaslon za urejanje File ID-ja.

2	 Izberite znak z večfunkcijskim gumbom 
(stran 7) ali z večfunkcijskim kolescem 
(stran 5), nato pa pritisnite gumb za 
potrditev na večfunkcijskem gumbu ali 
večfunkcijsko kolesce.

3	 Po potrebi ponovite 2. korak.

4	 Ko ste zaključili z vnašanjem znakov, 
izberite Done.

Shranjevanje in nalaganje konfiguracijskih podatkov
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Povezovanje zunanjih monitorjev in snemalnih naprav
Za prikaz snemane/predvajane slike na 
zunanjem monitorju izberite izhodni signal 
videokamere in uporabite primeren kabel za 
monitor, ki ga želite priklopiti.
Priklopite lahko tudi snemalne naprave, 
kot je VTR, in posnamete izhodni signal iz 
videokamere.
Iste podatke, ki so vidni v iskalu, kot so 
podatki o stanju in menijih, lahko prikažete 
na zunanjem monitorju. Vklopite prikaz 
informacij (stran 14) na zaslonu Monitoring 
Status ali prikaz na zaslonu (stran 87) v 
meniju Monitoring glavnega menija v skladu s 
signalom, ki je poslan v monitor.

Priključek SDI OUT (tip BNC)

V meniju Monitoring (stran 87) izberite 
nastavitev on/off in izhodni format.
Za povezavo uporabite komercialno dostopen 
koaksialni kabel z upornostjo 75 Ω.

[Opomba]
Pred vklopom naprav preverite, da je povezava med 
videokamero in zunanjo napravo ozemljena.

(Priporočljivo je, da videokamero in zunanjo 
napravo vklopite po tem, ko ste ju povezali s 
koaksialnim kablom z upornostjo 75 Ω.)
Če morate zunanjo napravo priklopiti na 
videokamero, ko je videokamera vklopljena, 
priklopite koaksialni kabel z upornostjo 75 
Ω najprej na zunanjo napravo in nato na 
videokamero.

Za sočasen začetek snemanja na 
videokameri in zunanji napravi

Ob omogočenem izhodu signala SDI nastavite 
možnost SDI/HDMI Rec Control (stran 79) > 
Setting v meniju Project glavnega menija na 
SDI/HDMI Remote I/F ali Parallel Rec. S tem 
boste omogočili prenos sprožilnega signala 
REC v zunanjo napravo, povezano na priključek 
SDI OUT. S tem boste snemanje na zunanji 
napravi sinhronizirali z videokamero.

[Opombe]
ˎˎ Če povezana zunanja naprava ne podpira sprožilnega 

signala REC, je na ta način ne morete upravljati.
ˎˎ Če pomnilniški medij ni vstavljen, se na izhod pošilja 

samo sprožilni signal REC.

Priključek HDMI OUT 
(priključek tipa A)

V meniju Monitoring (stran 87) glavnega 
menija izberite nastavitev On/Off izhoda in 
izhodni format.

Za sočasen začetek snemanja na 
videokameri in zunanji napravi

Ob omogočenem izhodu signala HDMI 
vklopite TC Out > Setting (stran 85) v meniju 
TC/Media glavnega menija in nastavite SDI/
HDMI Rec Control > Setting (stran 79) v 
meniju Project na SDI/HDMI Remote I/F ali 
Parallel Rec. S tem boste omogočili prenos 
sprožilnega signala REC na zunanjo napravo, 
povezano na priključek HDMI OUT. S tem boste 
snemanje na zunanji napravi sinhronizirali z 
videokamero.
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Sinhronizacija časovnih kod
Časovno kodo enote lahko sinhronizirate z 
drugimi napravami.

Zaklep časovne kode na ostale 
naprave

Enoto, ki dovaja časovno kodo, nastavite tako, 
da časovna koda na izhodu neprestano teče 
(kot na primer Free Run ali Clock).

1	 Nastavite možnost Timecode (stran 85) 
v meniju TC/Media glavnega menija na 
naslednji način.
Mode: Preset
Run: Free Run

2	 Pritisnite dodeljiv gumb (stran 48) z 
dodeljeno funkcijo DURATION/TC/U-BIT, 
da se na zaslonu prikaže časovna koda.

3	 Preverite, da je izbirno stikalo TC IN/OUT 
(stran 4) v položaju IN. Nato pošljite 
referenčno časovno kodo za sinhronizacijo 
sistemske frekvence videokamere v 
priključek TC IN/TC OUT.

Generator časovne kode v videokameri se 
zaklene z referenčno časovno kodo in na 
zaslonu se pojavi »EXT-LK«.
Ko mine približno deset sekund od zaklepa 
časovne kode, ostane časovna koda 
zaklenjena na zunanjo časovno kodo tudi, 
če odklopite vir zunanje referenčne časovne 
kode.

[Opombe]
ˎˎ Ob uporabi zaklepa na zunanjo časovno kodo se 

časovna koda videokamere takoj zaklene na zunanjo 
časovno kodo. Na območju za prikaz podatkov se 
pojavi vrednost zunanje časovne kode. Kljub temu ne 
začnite takoj snemati. Počakajte nekaj sekund, da se 
generator časovne kode pred snemanjem stabilizira.
ˎˎ Če frekvenca referenčne časovne kode in frekvenca 

sličic na videokameri nista enaki, ne more priti do 
zaklepa in videokamera ne bo delovala pravilno. 
Če pride do tega, se časovna koda ne bo uspešno 
zaklenila na zunanjo časovno kodo.
ˎˎ Časovna koda se lahko v primerjavi z referenčno 

časovno kodo zamakne za eno sličico na uro.

Za sprostitev zunanjega zaklepa

Spremenite nastavitev Timecode v meniju 
TC/Media glavnega menija ali izklopite 
videokamero.
Zunanja sinhronizacija se sprosti tudi v 
primeru, če spremenite sistemsko frekvenco 
ali če začnete snemati v posebnem načinu 
snemanja (počasni in hitri posnetki ali 
intervalno snemanje).

Sinhronizacija časovne kode 
druge naprave s časovno kodo 
videokamere

Enoto, ki dovaja časovno kodo, nastavite tako, 
da časovna koda na izhodu neprestano teče 
(kot na primer Free Run ali Clock).

1	 Nastavite časovno kodo videokamere z 
uporabo možnosti Timecode (stran 85) 
v meniju TC/Media glavnega menija.

2	 Preverite, da je izbirno stikalo TC IN/OUT 
(stran 4) v položaju OUT. Nato 
povežite priključek TC IN/TC OUT z 
vhodnim priključkom časovne kode na 
napravi, ki jo želite sinhronizirati.
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Upravljanje/urejanje posnetkov z računalnikom

Povezovanje s kablom USB

Uporaba bralnika kartic (možnost)
Povežite bralnik kartic CFexpress ali bralnik 
kartic SD z računalnikom prek kabla USB 
in vstavite pomnilniško kartico v režo 
bralnika kartic. Računalnik pomnilniško 
kartico prepozna kot razširitveni pogon. Na 
podprtih računalnikih lahko z visoko hitrostjo 
uvozite posnetke tako, da uporabite način 
videokamere masovno shranjevanje.

Uporaba načina masovnega 
shranjevanja

[Opomba]
Načina masovnega shranjevanja ni mogoče uporabiti, 
ko je vklopljena možnost Modem > Setting v meniju 
Network glavnega menija ali ko je vklopljena možnost 
Wired LAN > Setting v meniju Network. Izklopite obe 
možnosti.

Povežite videokamero s kablom USB in 
vstavite pomnilniško kartico v režo A ali B. 
Računalnik pomnilniško kartico prepozna kot 
razširitveni pogon.

1	 Povežite priključek USB-C (stran 7) ali 
priključek USB/multi (stran 7) z 
računalnikom prek kabla USB.

2	 Stikalo POWER na videokameri prestavite 
v položaj ON.
Na zaslonu se pojavi sporočilo, ki vas 
vpraša ali želite omogočiti povezavo USB.

	 [Opomba]
Potrditveno sporočilo povezave USB se ne 
prikaže v času, ko je prikazano drugo potrditveno 
sporočilo ali sporočilo o napredku, na primer med 
formatiranjem ali obnavljanjem pomnilniške kartice.
Potrditveno sporočilo se prikaže, ko se formatiranje 
ali obnavljanje zaključi. Potrditveno sporočilo se 
tudi ne prikaže, ko je prikazan zaslon lastnosti 
posnetka. Sporočilo se prikaže, ko se procesiranje 
zaključi ali, ko se vrnete na zaslon sličic.

3	 Zavrtite večfunkcijsko kolesce, da izberete 
Execute.

4	 V operacijskem sistemu Windows v oknu 
»Moj računalnik« preverite, da je kartica 
dodana kot odstranljiv disk.
V računalniku Mac preverite, da je na 
namizju ustvarjena mapa z imenom 
»NO NAME« ali »Untitled« (z možnostjo 
urejanja).

[Opombe]
ˎˎ Ne izvajajte naslednjih opravil, če indikator dostopa 

sveti v rdeči barvi.
–– Izklop napajanja ali odklop napajalnega kabla
–– Odstranjevanje pomnilniške kartice
–– Odklop kabla USB

ˎˎ Pravilno delovanje z vsemi računalniki ni 
zagotovljeno.

Uporaba nelinearnega sistema za 
urejanje

Pri nelinearnem sistemu za urejanje mora 
programska oprema za urejanje (možnost) 
podpirati formate, v katerih snema 
videokamera.
Uporabite namensko uporabniško programsko 
opremo, da posnetke, ki jih želite urediti, pred 
tem shranite na trdi disk računalnika.



109 SL 8. Dodatek

Previdnostni ukrepi
Kondenzacija

Če enoto prenesete s hladnega na toplo 
mesto ali če se temperatura okolice nenadoma 
zviša, se lahko na zunanji površini enote in/
ali znotraj enote ustvari vlaga. Temu pravimo 
kondenzacija. Če pride do kondenzacije, 
izklopite enoto in pred ponovno uporabo 
počakajte, da se kondenzacija posuši. Ko je 
prisotna kondenzacija, lahko uporaba enote 
poškoduje enoto.

O zaslonih LCD

Zaslon LCD, nameščen na to enoto, je izdelan z 
visoko natančno tehnologijo. To mu zagotavlja 
razmerje delujočih točk, ki znaša najmanj 
99,99 %. Obstaja lahko zelo majhen delež 
točk, ki so »zataknjene«, tako da so vedno 
izklopljene (črne), vedno vklopljene (rdeče, 
zelene ali modre) ali utripajo. Poleg tega se 
zaradi fizičnih lastnosti zaslona s tekočimi 
kristali take »zataknjene« slikovne točke v 
daljšem obdobju uporabe lahko pojavijo same 
od sebe. Te težave ne pomenijo, da gre za 
okvaro. Upoštevajte, da takšne težave nimajo 
učinka na posnete podatke.

Pojavi slikovnega senzorja CMOS 
kamere

[Opomba]
Sledeči pojavi, ki se lahko pojavijo na slikah, so značilni 
za slikovne senzorje. V teh primerih ne gre za okvaro.

Beli madeži
Čeprav so slikovni senzorji izdelani z visoko 
natančnimi tehnologijami, se lahko v redkih 
primerih na zaslonu pojavijo beli madeži, ki jih 
povzročijo kozmični žarki ipd.
To je povezano z načinom delovanja slikovnih 
senzorjev in ne predstavlja okvare.

Bele madeže je mogoče opaziti predvsem v 
naslednjih primerih:
ˎˎ Pri delovanju pri visoki delovni temperaturi
ˎˎ Kadar povečate ojačitev (občutljivost)

Migetanje
Pri snemanju s svetlobo fluorescenčnih luči, 
natrijevih svetilk, živosrebrnih svetilk ali svetilk 
LED se lahko pojavi utripanje zaslona ali 
nepravilne barve.

Deli, ki so potrošni material

ˎˎ Ventilator in baterija sta potrošni material, ki 
zahteva občasno zamenjavo.  
Pri uporabi pri sobni temperaturi bo 
običajen cikel zamenjave znašal približno 
5 let. Cikel zamenjave predstavlja splošno 
vodilo in ne pomeni, da je takšna tudi 
zagotovljena življenjska doba teh delov. Za 
podrobnosti o menjavi delov se obrnite na 
prodajalca.
ˎˎ Pričakovana življenjska doba omrežnega 
napajalnika in elektrolitskega kondenzatorja 
znaša približno 5 let pri normalnih 
temperaturah in normalnem času uporabe 
(8 ur na dan; 25 dni na mesec). Če uporaba 
presega zgoraj navedeno normalno 
uporabo, se lahko pričakovana življenjska 
doba ustrezno zmanjša.
ˎˎ Priključek za baterijo na tej enoti (priključek 
za pakete baterij in omrežne napajalnike) je 
potrošni material.  
Napajanje enote morda ne bo pravilno, če 
so kontakti priključka za baterijo zviti ali 
deformirani zaradi udarcev ali tresljajev 
ali če zaradi dolgotrajnejše uporabe na 
prostem korodirajo.  
Priporočamo vam periodične preglede 
enote, da zagotovite njeno pravilno 
delovanje in podaljšajte njeno življenjsko 
dobo. Za več informacij o pregledih se 
obrnite na prodajnega ali servisnega 
predstavnika podjetja Sony.

Vgrajena akumulatorska baterija

Videokamera ima vgrajeno akumulatorsko 
baterijo za shranjevanje datuma, časa in ostalih 
nastavitev, tudi ko je videokamera izklopljena. 
Vgrajena akumulatorska baterija se napolni, ko 
preteče 24 ur od priklopa na omrežno napajanje 
ali priklopa polno napolnjenega paketa baterij, 
ne glede na to, ali je videokamera vklopljena 
ali izklopljena. Akumulatorska baterija se 
popolnoma izprazni v približno 2 mesecih, če 
videokamera v tem času ni priklopljena na 
omrežno napajanje in nima nameščenega 
paketa baterij. Videokamero uporabljajte 
po tem, ko ste napolnili baterijo. Tudi če 
akumulatorska baterija ni napolnjena, delovanje 
videokamere ne bo prizadeto, razen če boste 
potrebovali snemanje datuma.

Lokacije uporabe in shranjevanja
Shranjujte na ravnem, prezračevanem mestu.
Izogibajte se uporabi in shranjevanju enote na 
sledečih mestih.
ˎˎ Na čezmerni vročini ali mrazu (temperaturni 
razpon za delovanje: 0 °C do 40 °C (od 32 °F 
do 104 °F)) 
Ne pozabite, da lahko poleti v toplejših 
podnebnih pasovih temperatura v 
avtomobilu z zaprtimi stekli zlahka preseže 
50 °C (122 °F).
ˎˎ Na vlažnih ali prašnih lokacijah Na lokacijah, 
kjer bi bila enota lahko izpostavljena dežju
ˎˎ Na lokacijah, ki so izpostavljene močnim 
vibracijam
ˎˎ V bližini močnih magnetnih polj
ˎˎ Blizu radijskih ali TV oddajnikov, ki ustvarjajo 
močna elektromagnetna polja.
ˎˎ Dalj časa na neposredni sončni svetlobi ali 
blizu grelnih teles

Opomba glede laserskih žarkov
Laserski žarki lahko poškodujejo slikovni 
senzor CMOS. Če snemate prizor, ki vključuje 
laserski žarek, bodite pozorni, da laserski žarek 

ni usmerjen v objektiv enote. Poleg tega lahko 
laserski žarki visoke moči na medicinskih ali 
drugih napravah povzročijo poškodbe z odbito 
ali razpršeno svetlobo.

Za preprečitev elektromagnetnih motenj 
s strani prenosnih komunikacijskih 
naprav

Uporaba prenosnih telefonov in drugih 
komunikacijskih naprav v bližini kamere lahko 
povzroči nepravilno delovanje ter motnje 
avdio in video signalov. Priporočljivo je, da 
so prenosne komunikacijske naprave v bližini 
videokamere izklopljene.

Varnostni ukrepi

ˎˎ DRUŽBA SONY NI ODGOVORNA ZA 
NIKAKRŠNO ŠKODO, KI JE POSLEDICA 
NEUPOŠTEVANJA USTREZNIH VARNOSTNIH 
UKREPOV NA PRENOSNIH NAPRAVAH, ZA 
NEIZOGIBNO RAZKRITJE PODATKOV, KI JE 
POSLEDICA SPECIFIKACIJ PRENOSA, ALI ZA 
KAKRŠNEKOLI VARNOSTNE TEŽAVE.
ˎˎ Odvisno od okolja uporabe bodo morda 
nepooblaščene tretje osebe v omrežju lahko 
dostopale do enote. Pri povezovanju enote 
v omrežje se prepričajte, da je omrežje 
ustrezno zavarovano.
ˎˎ Vsebino komunikacij lahko nevede 
prestrežejo neavtorizirane tretje osebe, ki se 
nahajajo v bližini signalov. Pri komunikacijah 
prek brezžičnega omrežja LAN uporabite 
ustrezne varnostne ukrepe, da zaščitite 
vsebino komunikacij.
ˎˎ Ko izdelek povežete z omrežjem, ga 
povežite prek sistema z zaščitno funkcijo, 
kot je na primer usmerjevalnik ali požarni 
zid. Če ga povežete brez zaščite, lahko pride 
do težav z varnostjo.
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Tovarniško privzete nastavitve so prikazane s krepko pisavo (na primer 1920×1080P (Level A)).

[Opombe]
ˎˎ Ločljivost izhodnega formata je omejena z nastavitvijo Rec Format > Frequency, Video Format in Codec v meniju 

Project glavnega menija (stran 77).
ˎˎ Ločljivost izhodnega formata je omejena s kombinacijo hitrosti sličic S&Q. Izhod HDMI se spremeni v Full HD, če so 

izpolnjeni vsi pogoji v glavnem meniju.
–– Nastavitev Rec Format > Video Format je nastavljena na 4096×2160 ali 3840×2160 v meniju Project.
–– Ko je nastavitev S&Q Motion >Setting v meniju Shooting vklopljena.
–– Nastavitev S&Q Motion > Frame Rate v meniju Shooting je višja od 60 sličic na sekundo.
–– Nastavitev Rec Format > Codec v meniju Project je nastavljena na RAW ali RAW & XAVC-I ali pa je nastavitev 

Output On/Off >SDI v meniju Monitoring vklopljena.
ˎˎ Ko je izhod HDMI nastavljen na 4096×2160P ali 3840×2160P, se izhod HDMI spremeni v 1920×1080P, če so zgornji 

pogoji izpolnjeni. Ko se to zgodi, sta možnosti izbire izhoda HDMI 4096×2160P in 3840×2160P za nastavitev Output 
Format >SDI/HDMI (stran 87) v meniju Monitoring zasenčeni in ju ni mogoče izbrati.
ˎˎ Na izhodu ni predvajane slike, če je ločljivost video izhoda višja od ločljivosti slike.

Izhodni formati priključkov SDI OUT/HDMI OUT

Sistemska 
frekvenca 
(Rec Format 
>Frequency v 
meniju Project)

Video format 
(Rec Format 
>Video Format v 
meniju Project)

Stanje izhodnega 
formata RAW
(Rec Format 
>Codec v meniju 
Project)

Izhodni format (Output Format v 
meniju Monitoring)

SDI HDMI

59,94/50 4096×2160 Z izhodnim 
formatom RAW

– 4096×2160P

1920×1080P

1920×1080i

3840×2160P

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i

Sistemska 
frekvenca 
(Rec Format 
>Frequency v 
meniju Project)

Video format 
(Rec Format 
>Video Format v 
meniju Project)

Stanje izhodnega 
formata RAW
(Rec Format 
>Codec v meniju 
Project)

Izhodni format (Output Format v 
meniju Monitoring)

SDI HDMI

Brez izhodnega 
formata RAW

4096×2160P 4096×2160P

1920×1080P

1920×1080i

3840×2160P 3840×2160P

1920×1080P

1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

3840×2160 Z izhodnim 
formatom RAW

– 3840×2160P

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i

Brez izhodnega 
formata RAW

3840×2160P 3840×2160P

1920×1080P

1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

Izhodni formati in omejitve
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Sistemska 
frekvenca 
(Rec Format 
>Frequency v 
meniju Project)

Video format 
(Rec Format 
>Video Format v 
meniju Project)

Stanje izhodnega 
formata RAW
(Rec Format 
>Codec v meniju 
Project)

Izhodni format (Output Format v 
meniju Monitoring)

SDI HDMI

1920×1080 Brez izhodnega 
formata RAW

1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

– 59,94: 720×480P
50: 720×576P

29,97/25 4096×2160 Z izhodnim 
formatom RAW

– 4096×2160P

1920×1080P

3840×2160P

1920×1080P

1920×1080P

1920×1080i

Brez izhodnega 
formata RAW

4096×2160P 4096×2160P

1920×1080P

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

3840×2160 Z izhodnim 
formatom RAW

– 3840×2160P

1920×1080P

1920×1080P

1920×1080i

Brez izhodnega 
formata RAW

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

1920×1080 Brez izhodnega 
formata RAW

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

Sistemska 
frekvenca 
(Rec Format 
>Frequency v 
meniju Project)

Video format 
(Rec Format 
>Video Format v 
meniju Project)

Stanje izhodnega 
formata RAW
(Rec Format 
>Codec v meniju 
Project)

Izhodni format (Output Format v 
meniju Monitoring)

SDI HDMI

24 4096×2160 Z izhodnim 
formatom RAW

– 4096×2160P

1920×1080P

Brez izhodnega 
formata RAW

4096×2160P 4096×2160P

1920×1080P 1920×1080P

23,98 4096×2160 Z izhodnim 
formatom RAW

– 4096×2160P

1920×1080P

3840×2160P

1920×1080P

1920×1080P

Brez izhodnega 
formata RAW

4096×2160P 4096×2160P

1920×1080P

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

3840×2160 Z izhodnim 
formatom RAW

– 3840×2160P

1920×1080P

1920×1080P

Brez izhodnega 
formata RAW

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080 Brez izhodnega 
formata RAW

1920×1080P 1920×1080P
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Napajanje

Težava Vzrok Rešitev
Videokamera se ne vklopi. Ni nameščenega paketa 

baterij in ni napajanja na 
priključku DC IN.

Namestite paket baterij (stran 17) ali 
priklopite omrežno napajanje prek 
omrežnega napajalnika (stran 18).

Paket baterij je popolnoma 
izpraznjen.

Paket baterij zamenjajte s povsem 
napolnjenim (stran 17).

Med delovanjem se prekine 
napajanje.

Paket baterij se je izpraznil. Paket baterij zamenjajte s povsem 
napolnjenim (stran 17).

Paket baterij se zelo hitro 
izprazni.

Temperatura okolice je zelo 
nizka.

To se zgodi zaradi lastnosti baterij in ne 
predstavlja okvare.

Paket baterij ni dovolj 
napolnjen.

Paket baterij napolnite (stran 17).
Če se paket baterij hitro izprazni tudi, ko 
ga popolnoma napolnite, je morda 
dosegel konec svoje življenjske dobe. 
Zamenjajte jo z novo.

Snemanje/predvajanje

Težava Vzrok Rešitev
Snemanje se s pritiskom 
gumba za snemanje START/
STOP ne začne.

Pomnilniška kartica je polna. Zamenjajte pomnilniško kartico z drugo, 
na kateri je dovolj prostora.

Pomnilniško kartico je treba 
obnoviti.

Obnovite pomnilniško kartico 
(stran 33).

Ni mogoče snemati zvoka. Kolesca AUDIO LEVEL (CH1/
CH2) so nastavljena na 
najnižjo raven.

Prilagodite ravni snemanja zvoka s 
kolesci AUDIO LEVEL (CH1/CH2) 
(stran 46).

Posneti zvok je popačen. Raven zvoka je previsoka. Prilagodite ravni snemanja zvoka s 
kolesci AUDIO LEVEL (CH1/CH2) 
(stran 46).

Posneti zvok ima visoko 
raven šuma.

Raven zvoka je prenizka. Prilagodite ravni snemanja zvoka s 
kolesci AUDIO LEVEL (CH1/CH2) 
(stran 46).
Ko je izbran zunanji mikrofon, 
prilagodite tudi nastavitev INPUT MIC 
Reference v razdelku Audio Input v 
meniju Audio (stran 90).

Težava Vzrok Rešitev
Posnetkov ni mogoče 
predvajati.

Posnetek se ureja. Posnetkov ni mogoče predvajati, če ste 
spremenili imena datotek ali map ali če 
je posnetek v uporabi na računalniku. 
Ne gre za okvaro.

Posnetek se snema na drugi 
napravi.

Posnetkov, posnetih na drugih 
napravah, včasih ni možno prikazati ali 
pa so prikazani v nepravilni velikosti. Ne 
gre za okvaro.

Zunanje naprave

Težava Rešitev
Računalnik ne prepozna 
videokamere.

Odklopite kabel USB z računalnika in ga ponovno zanesljivo 
priklopite.

Odklopite kabel USB z računalnika, ponovno zaženite računalnik in 
ponovno sledite korakom v pravilnem vrstnem redu.

Povežite računalnik in videokamero tako, da vstavite kabel USB v 
priključek USB-C ali priključek USB/multi.

Posnetkov ni mogoče naložiti na 
računalnik.

Odklopite kabel USB z računalnika, znova zaženite računalnik in ga 
nato ponovno priklopite.

Za nalaganje posnetkov na vaš računalnik mora biti nameščena 
uporabniška programska oprema (stran 108).

Odpravljanje težav
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Brezžična povezava LAN

[Opomba]
Ovire in elektromagnetne motnje med videokamero in dostopovno točko za brezžični LAN ali terminalno napravo ter 
lastnosti okolja (na primer material, iz katerega so izdelani zidovi) lahko skrajšajo doseg povezave ali celo preprečijo 
povezavo. Če opazite te težave, premaknite videokamero na novo lokacijo in preverite stanje povezave/komunikacije 
ali premaknite videokamero in dostopovno točko/terminalno napravo bliže drugo drugi.

Težava Rešitev

Terminalna naprava ne more 
dostopati do videokamere.

ˎˎ Preverite brezžično povezavo LAN (naslov IP itd.).
ˎˎ Nastavitve za komunikacijo med dostopovno točko in 
odjemalcem so morda neveljavne. Za podrobnosti glejte 
navodila za uporabo dostopovne točke.

Ne morete se prijaviti v 
videokamero.

Preverite nastavljeno uporabniško ime in geslo.

Internetna povezava

Težava Rešitev

Datotek ni mogoče naložiti. Uporabniško ime in geslo strežnika morda nista pravilna.
Vnesite pravilno uporabniško ime in geslo.

Nalaganje datoteke ni na voljo. Stanje signala je morda šibko.
Premaknite se na drugo lokacijo in poskusite znova.

Pri uporabi filtra ND

Težava Rešitev
Filter ND se ne premakne. Po sledečem postopku lahko filter ročno premaknete v položaj 

Clear.

1	 Stikalo POWER na videokameri prestavite v položaj za izklop.

2	 Odstranite okrogel pokrovček na spodnji strani.

3	 V odprtino vstavite izvijač in ga zavrtite v nasprotni smeri urinega kazalca.
ˎˎ Z vrtenjem v nasprotni smeri urinega kazalca se filter ND premakne v položaj Clear. 
Nadaljujte z vrtenjem, dokler ne dosežete položaja Clear.
ˎˎ Uporabite izvijač s premerom ø 2,4 mm ali manjšim. Globina vstavitve izvijača znaša 
približno 3,0 cm (1 3/16 palca).

Odprtina za izvijač
(z odstranjenim pokrovčkom)

4	 Nastavite stikalo ND PRESET/VARIABLE (stran 5) v položaj PRESET in nastavite smerna 
gumba ND FILTER POSITION (stran 5) v položaj CLEAR.

[Opombe]
ˎˎ Zgoraj opisanega postopka ne izvajajte med normalnim delovanjem. Ta postopek uporabite samo, če se filter ND 

noče premakniti. Filter ND se lahko poškoduje, če ta postopek izvedete med normalnim delovanjem.
ˎˎ Po izvedbi zgoraj opisanega postopka se obrnite na servisni center podjetja Sony, kjer bodo popravili videokamero.
ˎˎ Snemanje je mogoče, tudi če se po izvedbi zgoraj opisanega postopka še vedno prikazuje sporočilo o napaki.
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Če se na videokameri pojavi opozorilo ali pride do dogodka, ki zahteva potrditev, se v iskalu 
prikaže sporočilo, indikator snemanja začne utripati in predvaja se opozorilni zvok.
Opozorilni zvok se predvaja iz slušalk, povezanih na priključek za slušalke.

Sporočila o napakah

Če se pojavi sledeče, bo videokamera prenehala delovati.

Sporočilo v iskalu Opozorilni 
zvok

Indikator 
snemanja

Vzrok in odprava

Koda napake E + neprekinjeno Hitro utripa Označuje neobičajno delovanje videokamere. 
Snemanje se ustavi, tudi če je v iskalu prikazan 
simbol REC .
Izklopite videokamero in preverite morebitne 
težave s povezanimi napravami, kabli in 
pomnilniškimi mediji. Če je po ponovnem vklopu 
videokamere napaka še vedno prisotna, se 
obrnite na servisnega predstavnika podjetja Sony.
(Če se videokamera ne izklopi, ko ste stikalo 
POWER prestavili v položaj OFF, odstranite 
baterijo ali odklopite omrežno napajanje.)
Glede na stanje videokamere se morda ne bo 
izpisalo sporočilo o napaki ali predvajal 
opozorilni zvok.

Opozorilna sporočila

Če se pojavi sledeče, sledite spodnjim navodilom.

Sporočilo v iskalu Opozorilni 
zvok

Indikator 
snemanja

Vzrok in odprava

Battery Near End V presledkih Utripa Preostala napolnjenost paketa baterij je nizka.
Čim prej napolnite.

Battery End neprekinjeno Hitro utripa Paket baterij je prazen. Snemanje je 
onemogočeno.
Prekinite uporabo in zamenjajte paket baterij.

Temperature High V presledkih Utripa Notranja temperatura je visoka.
Izklopite videokamero in pred ponovno uporabo 
počakajte, da se ohladi.

Sporočilo v iskalu Opozorilni 
zvok

Indikator 
snemanja

Vzrok in odprava

Media Temperature 
High

V presledkih Utripa Temperatura kartice CFexpress je visoka.
Zamenjajte kartico ali počakajte, da se ohladi, 
preden jo znova uporabite.

Voltage Low V presledkih Utripa Napetost omrežnega napajanja je nizka (level 1). 
Preverite vir napajanja.

Insufficient Voltage neprekinjeno Hitro utripa Napetost omrežnega napajanja je prenizka 
(level 2). Snemanje je onemogočeno.
Priklopite drug vir napajanja.

Media Near Full V presledkih Utripa Zmanjkuje preostalega prostora na pomnilniški 
kartici.
Čim prej zamenjajte.

Media Full neprekinjeno Hitro utripa Posnetkov ni mogoče posneti ali kopirati, saj ni 
več prostora na pomnilniški kartici.
Takoj zamenjajte.

Clips Near Full V presledkih Utripa Število dodatnih posnetkov, ki jih je mogoče 
posneti na pomnilniško kartico, se zmanjšuje.
Čim prej zamenjajte.

Clips Full neprekinjeno Hitro utripa Doseženo je bilo največje število posnetkov, ki jih 
je mogoče posneti na pomnilniško kartico.
Snemanje ali kopiranje novih posnetkov ni 
mogoče. Takoj zamenjajte.

Last Clip Recording V presledkih Utripa Posnetek, ki se trenutno snema, je zadnji 
posnetek, ki ga je mogoče posneti, saj je bilo 
doseženo največje število posnetkov.
Pripravite novo pomnilniško kartico.

Media(A)1) Life Near 
End

V presledkih Utripa Pomnilniška kartica se približuje koncu svoje 
življenjske dobe. Čim prej zamenjajte.

Media(A)1) Life End neprekinjeno Hitro utripa Pomnilniška kartica je dosegla konec svoje 
življenjske dobe. Takoj zamenjajte.

Media(A)1) Near Full V presledkih Utripa Pri uporabi funkcije Simul Rec

Media(A)1) Full neprekinjeno Hitro utripa Pri uporabi funkcije Simul Rec

Media(A)1) Clips Near 
Full

V presledkih Utripa Pri uporabi funkcije Simul Rec

Media(A)1) Clips Full neprekinjeno Hitro utripa Pri uporabi funkcije Simul Rec

Media(A)1) Last Clip 
Rec

V presledkih Utripa Pri uporabi funkcije Simul Rec

1)	 Za kartico v reži B je prikazano »(B)«.

Sporočila o napakah/opozorilna sporočila
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Previdnostna sporočila in sporočila o delovanju

Sledeča previdnostna sporočila in sporočila o delovanju se lahko pojavijo sredi zaslona. Za 
razrešitev težave sledite spodnjim navodilom.

Sporočilo na zaslonu Vzrok in odprava

Battery Error
Please Change Battery

Zaznana je bila napaka paketa baterij.
Zamenjajte z normalnim paketom baterij.

Backup Battery End
Please Change

Preostala napolnjenost pomožne baterije je nezadostna.
Napolnite pomožno baterijo.

Unknown Media (A) 1)

Please Change
Vstavljena je bila pomnilniška kartica, ki vsebuje particije ali 
pomnilniška kartica, ki vsebuje več posnetkov, kot jih lahko 
obravnava videokamera.
Kartice ni mogoče uporabljati v videokameri in jo je treba 
zamenjati.

Cannot Use Media (A) 1)

Unsupported File System
Vstavljena je bila neformatirana kartica ali kartica, ki uporablja 
drugačen datotečni sistem.
Kartice ni mogoče uporabljati v videokameri in jo je treba 
zamenjati ali formatirati z videokamero.

Media Error
Media (A) 1) Needs to be Restored

Na pomnilniški kartici je prišlo do napake in jo je treba 
obnoviti.
Pomnilniško kartico obnovite.

Media Error
Cannot Record to Media (A) 1)

Pomnilniška kartica je morda poškodovana in je ni več 
mogoče uporabljati za snemanje.
Predvajanje je mogoče, zato je priporočljivo, da naredite 
kopijo in zamenjate pomnilniško kartico.

Media Error
Cannot Use Media (A) 1)

Pomnilniška kartica je morda poškodovana in je ni več 
mogoče uporabljati za snemanje ali predvajanje.
Kartice ni mogoče uporabljati v videokameri in jo je treba 
zamenjati.

Media (A) 1) Error
Recording Halted
Playback Halted

Snemanje in predvajanje sta bila ustavljena, ker je med 
uporabo pomnilniške kartice prišlo do napake.
Če težave ne morete odpraviti, pomnilniško kartico 
zamenjajte.

Media Reached Rewriting Limit
Change Media (A) 1)

Pomnilniška kartica je dosegla konec svoje življenjske dobe.
Naredite varnostno kopijo in takoj zamenjajte kartico. Če 
nadaljujete z uporabo kartice, snemanje ali predvajanje morda 
ne bo mogoče.
Za podrobnosti glejte navodila za uporabo pomnilniške 
kartice.

Navedeni naslov ni veljaven. Navedeni naslov ni veljaven.
Preverite, ali je nastavitev pravilna.

Sporočilo na zaslonu Vzrok in odprava

Cannot Use Specified Port Number Navedena številka vrat ni veljavna.
Preverite, ali je nastavitev pravilna.

Fan Stopped Vgrajeni ventilator se je ustavil.
Izogibajte se uporabi pri visokih temperaturah, odklopite 
napajanje in stopite v stik s servisnim predstavnikom podjetja 
Sony.

Lens I/F Error(xx:xx) Ob namestitvi objektiva serije E je bila zaznana napaka v 
komunikaciji objektiva I/F.
Preverite stanje povezave z objektivom serije E.
Če je težava prisotna še naprej, se obrnite na servisnega 
predstavnika podjetja Sony in mu sporočite kodo napake (pet 
znakov v oklepaju).

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Zaznan je bil nezdružljiv dodatek.
Edini dodatek Multi Terminal, ki ga enota podpira, je priloženo 
držalo z daljinskim upravljalnikom.

Failed (Neuspešno) Ta napaka se lahko pojavi, če ni mogoče pridobiti naslova, ko 
je DHCP nastavljen na On.
Preverite nastavitve strežnika DHCP.

Cannot add auto upload job of Proxy 
file because maximum number of 
upload jobs was reached.

Doseženo je bilo največje število prenosov.
Izbrišite neželene prenose. Morda je tudi napačno nastavljen 
cilj samodejnega nalaganja datotek proxy. Preverite, ali je 
nastavitev pravilna.

<SSID>Not found. Omrežja (dostopovne točke) z navedenim imenom <SSID> ni 
bilo mogoče najti.
Preverite, ali je nastavitev pravilna.

<SSID>Authentication Failed Avtentikacija povezave v omrežje (na dostopovno točko) z 
navedenim imenom <SSID> je spodletela.
Preverite, ali so geslo in ostale nastavitve pravilni.

An IP address conflict has occurred. 
Please check the network settings.

Obstaja spor med omrežnimi naslovi brezžičnega omrežja 
LAN, žičnega omrežja LAN ali povezave USB.
Ročno spremenite naslov ali spremenite nastavitve 
omrežnega usmerjevalnika.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

Naslov IP načina dostopovne točke za brezžično omrežje LAN 
je bil spremenjen zaradi spora med omrežnimi naslovi načina 
dostopovne točke brezžičnega omrežja LAN, žičnega omrežja 
LAN ali povezave USB.
Preverite nastavitev naslova IP.

1)	 Za kartico v reži B je prikazano »(B)«.
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Elementi, konfigurirani v glavnem meniju

Da: Element je shranjen.
Ne: Element ni shranjen.
–: Ni shranjen (začasna nastavitev)

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Shooting ISO/Gain/EI Mode Da Ne

ISO/Gain<H> Da Ne

ISO/Gain<M> Da Ne

ISO/Gain<L> Da Ne

Exposure Index<H> Da Ne

Exposure Index<M> Da Ne

Exposure Index<L> Da Ne

Shockless Gain Da Ne

Base Sensitivity Da Ne

Base ISO Da Ne

ND Filter Preset1 Da Ne

Preset2 Da Ne

Preset3 Da Ne

Zaklop Mode Da Ne

Shutter Speed On/Off Da Ne

Shutter Speed Da Ne

Shutter Angle Da Ne

ECS On/Off Da Ne

ECS Frequency Da Ne

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Shooting Auto Exposure Level Da Ne

Mode Da Ne

Speed Da Ne

AGC Da Ne

AGC Limit Da Ne

AGC Point Da Ne

Auto Shutter Da Ne

A.SHT Limit Da Ne

A.SHT Point Da Ne

Clip High light Da Ne

Detect Window Da Ne

Detect Window Indication Da Ne

Custom Width Da Ne

Custom Height Da Ne

Custom H Position Da Ne

Custom V Position Da Ne

Bel Preset White Da Ne

Color Temp <A> Da Ne

Tint<A> Da Ne

R Gain <A> Da Ne

B Gain <A> Da Ne

Color Temp <B> Da Ne

Tint<B> Da Ne

R Gain <B> Da Ne

B Gain <B> Da Ne

White Setting Shockless White Da Ne

ATW Speed Da Ne

White Switch<B> Da Ne

Filter White Memory Da Ne

Elementi, shranjeni v datotekah
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Shooting Offset White Offset White <A> Da Ne

Offset Color Temp<A> Da Ne

Offset Tint<A> Da Ne

Offset White <B> Da Ne

Offset Color Temp<B> Da Ne

Offset Tint<B> Da Ne

Offset White<ATW> Da Ne

Offset Color Temp<ATW> Da Ne

Offset Tint<ATW> Da Ne

Focus AF Transition Speed Da Ne

AF Subj. Shift Sens. Da Ne

Focus Area Da Ne

Focus Area (AF-S) Da Ne

AF z zaznavanjem obrazov/oči Da Ne

Push AF Mode Da Ne

AF Assist Da Ne

S&Q Motion Setting Da Ne

Frame Rate Da Ne

LUT On/Off SDI/HDMI Da Ne

VF/Proxy/Stream Da Ne

Internal Rec Da Ne

Noise Suppression Setting(Custom) Da Ne

Level(Custom) Da Ne

Setting(Cine EI) Da –

Level(Cine EI) Da –

Flicker Reduce Mode Da Ne

Frekvenca Da Ne

SteadyShot Setting Da Ne

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Project Base Setting Shooting Mode Da –

Target Display Da –

Rec Format Frekvenca Da Ne

Imager Scan Mode Da Ne

Kodek Da Ne

Izhodni format RAW Da Ne

Video Format Da Ne

Cine EI Setting Color Gamut Da –

Simul Rec Setting Da Ne

Proxy Rec Setting Da Ne

Audio Channel Da Ne

Interval Rec Setting Ne Ne

Interval Time Da Ne

Number of Frames Da Ne

Pre-Lighting Da Ne

SDI/HDMI Rec Control Setting Da Ne

Assignable Button <1> Da Ne

<2> Da Ne

<3> Da Ne

<4> Da Ne

<5> Da Ne

<6> Da Ne

<7> Da Ne

<8> Da Ne

<9> Da Ne

Focus Hold Button Da Ne

Assignable Dial Kolesce na držalu/daljinskem 
upravljalniku

Da Ne

Smer kolesca na držalu Da Ne

Kolesce na ročaju Da Ne

Smer kolesca na ročaju Da Ne

Multi Function Dial Default Function Da Ne
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Project User File Load Media(B) – –

Save Media(B) – –

File ID Ne Ne

Load Customize Data Da Ne

Load White Data Da Ne

All File Load Media(B) – –

Save Media(B) – –

File ID Da Ne

Load Network Data Ne Ne

Paint/Look Scene File Recall – –

Shranjevanje – –

Delete – –

Preset Recall – –

Base Look izberite Da Da

Delete – –

Delete All – –

Import – –

Vhod Da Da

Izhod Da Da

AE Level Offset Da Da

Reset Paint Settings Ponastavitev brez Base Look – –

Črn Master Black Da Da

R Black Da Da

B Black Da Da

Knee Setting Da Da

Auto Knee Da Da

Point Da Da

Slope Da Da

Detail Setting Da Da

Level Da Da

Manual Setting Da Da

V/H Balance Da Da

B/W Balance Da Da

Limit Da Da

Crispening Da Da

High Light Detail Da Da

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Paint/Look Matrix User Matrix Da Da

User Matrix Level Da Da

User Matrix Phase Da Da

User Matrix R-G Da Da

User Matrix R-B Da Da

User Matrix G-R Da Da

User Matrix G-B Da Da

User Matrix B-R Da Da

User Matrix B-G Da Da

Multi Matrix Setting Da Da

Ponastavitev – –

Axis Ne Da

Hue Da Da

Saturation Da Da

TC/Media Timecode Mode Da Ne

Run Da Ne

Setting Ne Ne

Ponastavitev – –

TC Format Da Ne

TC Display Display Select Da Ne

Users Bit Mode Da Ne

Setting Ne Ne

HDMI TC Out Setting Da Ne

Clip Name Format Title Prefix Da Ne

Number Set Ne Ne

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Monitoring Output On/Off SDI Da Ne

HDMI Da Ne

Output Format SDI Da Ne

HDMI Da Ne

Output Display SDI Da Ne

HDMI Da Ne
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Monitoring Display On/Off Network Status Da Ne

File Transfer Status Da Ne

Rec/Play Status Da Ne

RAW Output Control Status Da Ne

Tally Da Ne

Battery Remain Da Ne

Focus Mode Da Ne

Focus Position Da Ne

Focus Area Indicator Da Ne

Focus Area Ind.(AF-S) Da Ne

Face/Eye Detection Frame Da Ne

Lens Info Da Ne

Imager Scan Mode Da Ne

Rec Format Da Ne

Frame Rate Da Ne

Zoom Position Da Ne

UWP RF Level Da Ne

SteadyShot Da Ne

Base Look/LUT Da Ne

SDI/HDMI Rec Control Da Ne

Gamma Display Assist Da Ne

Proxy Status Da Ne

Base ISO/Sensitivity Da Ne

Media Status Da Ne

Video Signal Monitor Da Ne

Clip Name Da Ne

White Balance Da Ne

Scene File Da Ne

Focus Indicator Da Ne

Auto Exposure Mode Da Ne

Auto Exposure Level Da Ne

Timecode Da Ne

ND Filter Da Ne

Iris Da Ne

ISO/Gain/EI Da Ne

Zaklop Da Ne

Level Gauge Da Ne

Audio Level Meter Da Ne

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Monitoring Display On/Off Video Level Warning Da Ne

Clip Number Da Ne

Notice Message Da Ne

Marker Setting Da Ne

Color Da Ne

Center Marker Da Ne

Safety Zone Da Ne

Safety Area Da Ne

Aspect Marker Da Ne

Aspect Mask Da Ne

Aspect Safety Zone Da Ne

Aspect Safety Area Da Ne

Aspect Select Da Ne

Custom Aspect Ratio Da Ne

Guide Frame Da Ne

100% Marker Da Ne

User Box Da Ne

User Box Width Da Ne

User Box Height Da Ne

User Box H Position Da Ne

User Box V Position Da Ne

VF Setting osvetlitev Da Ne

Color Mode Da Ne

Gamma Display Assist Setting Da Ne

Peaking Setting Da Ne

Peaking Level Da Ne

Color Da Ne

Zebra Setting Da Ne

Zebra1 Level Da Ne

Zebra1 Aperture Level Da Ne

Zebra2 Level Da Ne
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Avdio Audio Input CH1 Input Select Da Ne

CH2 Input Select Da Ne

CH3 Input Select Da Ne

CH4 Input Select Da Ne

INPUT1 MIC Reference Da Ne

INPUT2 MIC Reference Da Ne

Line Input Reference Da Ne

Reference Level Da Ne

CH1 Wind Filter Da Ne

CH2 Wind Filter Da Ne

CH3 Wind Filter Da Ne

CH4 Wind Filter Da Ne

CH3 Level Control Da Ne

CH4 Level Control Da Ne

CH3 Input Level Da Ne

CH4 Input Level Da Ne

Audio Input Level Da Ne

Limiter Mode Da Ne

CH1&2 AGC Mode Da Ne

CH3&4 AGC Mode Da Ne

AGC Spec Da Ne

1kHz Tone on Color Bars Da Ne

CH1 Level Da Ne

CH2 Level Da Ne

CH3 Level Da Ne

CH4 Level Da Ne

Avdio izhod Monitor CH Da Ne

Volume Ne Ne

Headphone Out Da Ne

Alarm Level Da Ne

HDMI Output CH Da Ne

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Da –

Technical Color Bars Setting Ne Ne

Tip Da Ne

ND Dial CLEAR with Dial Da Ne

Tally Front Da Ne

Rear Da Ne

HOLD Switch Setting with Rec Button Da Ne

with Hand Grip Remote Da Ne

Touch Operation Setting Da Ne

Rec Review Setting Da Ne

Zoom Zoom Type Da Ne

Handle Zoom Setting Da Ne

High Da Ne

Low Da Ne

Menu Settings User Menu Only Da Ne

User Menu with Lock Ne Ne

Fan Control Setting Da Ne
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Technical Lens Zoom Ring Direction Da Ne

Shading Compensation Da Ne

Chroma Aberration Comp. Da Ne

Distortion Comp. Da Ne

Distance Display Da Ne

Zoom Position Display Da Ne

Video Light Set Video Light Set Da Ne

APR APR – –

Camera Battery Alarm Low Battery Da Ne

Battery Empty Da Ne

Camera DC IN Alarm DC Low Voltage1 Da Ne

DC Low Voltage2 Da Ne

Network Access Authentication User Name Ne Ne

Password Ne Ne

Wireless LAN Setting Da Ne

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Da Ne

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Omrežje ST Mode Settings Camera Remote Control Da Ne

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Ne Ne

DHCP Da Ne

IP Address Da Ne

Subnet Mask Da Ne

Gateway Da Ne

DNS Auto Da Ne

Primary DNS Server Da Ne

Secondary DNS Server Da Ne

Manual Register

SSID Da Ne

Security Da Ne

Password Ne Ne

DHCP Da Ne

IP Address Da Ne

Subnet Mask Da Ne

Gateway Da Ne

DNS Auto Da Ne

Primary DNS Server Da Ne

Secondary DNS Server Da Ne
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Network Wired LAN Setting Da Ne

Camera Remote Control Da Ne

Detail Settings

DHCP Da Ne

IP Address Da Ne

Subnet Mask Da Ne

Gateway Da Ne

DNS Auto Da Ne

Primary DNS Server Da Ne

Secondary DNS Server Da Ne

Modem Setting Da Ne

Camera Remote Control Da Ne

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload (Proxy) Da Ne

Default Upload Server Da Ne

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Da Ne

Service Da Ne

Host Name Da Ne

Port Da Ne

User Name Ne Ne

Password Ne Ne

Passive Mode Da Ne

Destination Directory Da Ne

Using Secure Protocol Da Ne

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Maintenance Language Select Da Ne

Clock Set Time Zone Da Ne

Date Mode Da Ne

12H/24H Da Ne

Datum Ne Ne

Time Ne Ne

All Reset Reset – –

Reset without Network – –

Hours Meter Hours (System) – –

Hours (Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Elementi, konfigurirani z dodeljivimi gumbi

Da: Element je shranjen.
Ne: Element ni shranjen.
–: Ni shranjen (začasna nastavitev)

Izbira dodeljivega gumba All File Scene File
ND Filter Position Da Ne

Auto Iris Da Ne

ATW Da Ne

Focus Setting Da Ne

Display Da –

VF Adjust Da –

Elementi, konfigurirani z dodeljivim kolescem

Da: Element je shranjen.
Ne: Element ni shranjen.
–: Ni shranjen (začasna nastavitev)

Izbira dodeljivega kolesca All File Scene File
IRIS Da Ne

ND Filter Da Ne

Audio Input Level Da Ne
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Glejte povezane elemente v razdelkih »Nastavitev zvoka, ki ga želite posneti« (stran 46) in »Face/Eye Detection AF« (stran 69).

Avdio vhod (CH1 in CH2)

Na naslednji sliki je prikazana shema delovanja z nameščenim ročajem.

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Nastavljeno na Manual, ko vhodni zvok prihaja iz adapterja XLR.

Sheme delovanja
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Avdio vhod (CH3 in CH4)

Na naslednji sliki je prikazana shema delovanja z nameščenim ročajem.

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ~ 99

CH4

[CH4 Input Level]
0 ~ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Nastavljeno na Manual, ko vhodni zvok prihaja iz adapterja XLR.
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Avdio izhod

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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Programsko opremo objektiva serije E lahko 
posodobite prek videokamere.
Na spletni strani za objektive poglejte, katere 
objektive je mogoče posodobiti in katera je 
ustrezna programska oprema.

Preverjanje različice

1	 Na videokamero namestite objektiv 
serije E (stran 22).

2	 Izberite možnost Version v meniju 
Maintenance glavnega menija, da 
prikažete oznako različice objektiva Lens 
Version Number (stran 99).
Oznaka različice programske opreme 
objektiva serije E je prikazana ob strani.

Posodabljanje programske 
opreme

Videokamero nastavite v način masovnega 
shranjevanja (stran 108).
Programsko opremo posodobite po postopku, 
ki je priložen programski opremi za objektiv.

Posodabljanje programske opreme objektiva serije E
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Licenca MPEG-4 Visual Patent 
Portfolio

TA IZDELEK JE LICENCIRAN V OKVIRU 
LICENCE PORTFELJA ZA PATENT AVC ZA 
OSEBNO UPORABO POTROŠNIKA ALI DRUGE 
UPORABE, PRI KATERIH POTROŠNIK NE PREJME 
FINANČNEGA NADOMESTILA ZA
(i)	 KODIRANJE VIDEOVSEBIN V SKLADU S 

STANDARDOM MPEG-4 VISUAL (»MPEG-4 
VIDEO«) IN/ALI

(ii)	ODKODIRANJE VIDEOVSEBIN MPEG-4, KI JIH 
JE POTROŠNIK KODIRAL V OKVIRU OSEBNE 
IN NEKOMERCIALNE DEJAVNOSTI IN/ALI 
PRIDOBIL OD PONUDNIKA VIDEOVSEBIN, 
LICENCIRANEGA S STRANI MPEG LA ZA 
DISTRIBUCIJO VIDEOVSEBIN MPEG-4.

LICENCA SE NE DODELJUJE IN NI NAMENJENA 
ZA KAKRŠNO KOLI DRUGO UPORABO. 
DODATNE INFORMACIJE, VKLJUČNO Z 
INFORMACIJAMI GLEDE UPORABE V 
REKLAMNE, INTERNE IN KOMERCIALNE 
NAMENE IN GLEDE PRIDOBITVE LICENC, SO 
NA VOLJO PRI DRUŽBI MPEG LA, LLC. OBIŠČITE 
HTTP://WWW.MPEGLA.COM

Uporaba programske opreme pod 
licenco GPL/LGPL

Ta izdelek uporablja programsko opremo, za 
katero velja licenca GPL/LGPL. To pomeni, 
da imate pravico do dostopa, spreminjanja 
in nadaljnje distribucije izvorne kode za to 
programsko opremo, in sicer v skladu s pogoji 
licence GPL/LGPL.
Izvorna koda je na voljo na spletu. Uporabite 
sledeč naslov URL in sledite navodilom za 
prenos.

http://www.sony.net/Products/Linux/
common/search.html

Želimo, da se v zvezi z vsebino izvorne kode 
ne obračate na nas.

Licence (v angleščini) so shranjene v 
notranjem pomnilniku izdelka.
Vzpostavite povezavo za količinsko 
shranjevanje med izdelkom in računalnikom za 
branje licenc v mapi »PMHOME« – »LICENSE«.

Če uporabljate računalnik Mac, mapa 
»PMHOME« - »LICENSE« morda ne bo 
dostopna.
Za ogled datotek uporabite računalnik, ki ni 
Mac, ali obiščite ta naslov URL.
https://oss.sony.net/License/ILME-FX6/

LICENČNA POGODBA ZA 
KONČNEGA UPORABNIKA

POMEMBNO: 
PRED UPORABO PROGRAMSKE OPREME, KI JO VSEBUJE 
VIDEOKAMERA S POMNILNIKOM SSD, PROSIMO, 
POZORNO PREBERITE TO POGODBO ZA KONČNEGA 
UPORABNIKA (»EULA«). Z UPORABO PROGRAMSKE 
OPREME SPREJEMATE DOLOČILA TE POGODBE EULA. ČE 
NE SPREJMETE DOLOČIL TE POGODBE EULA, NE SMETE 
UPORABLJATI TE PROGRAMSKE OPREME.

Ta pogodba EULA je pravna pogodba med vami in 
družbo Sony Corporation (»SONY«). Ta pogodba EULA 
določa vaše pravice in obveznosti v povezavi s 
programsko opremo družbe SONY in/ali drugih 
povezanih izdajateljev licenc (vključno s podružnicami 
družbe SONY) in njihovih podružnic (s skupnim imenom 
»DRUGI DOBAVITELJI«), ki jo vsebuje brezžični adapter, 
skupaj vsemi posodobitvami/nadgraditvami, ki jih 
zagotavlja družba SONY, vso tiskano, spletno ali 
elektronsko dokumentacijo za tako programsko opremo 
in vsemi podatkovnimi datotekami, ustvarjenimi z 
uporabo take programske opreme (s skupnim imenom 
»PROGRAMSKA OPREMA«).

Ne glede na navedeno se za vso programsko opremo v 
PROGRAMSKI OPREMI, ki ima ločeno licenčno pogodbo za 
končnega uporabnika (vključno z, vendar ne omejeno na 
GNU General Public License in Lesser/Library General Public 
License), namesto določil te pogodbe EULA uporablja 
takšna ločena veljavna licenčna pogodba za končnega 
uporabnika v obsegu, ki ga zahteva taka ločena licenčna 
pogodba za končnega uporabnika (»IZVZETA PROGRAMSKA 
OPREMA«).

LICENCA ZA PROGRAMSKO OPREMO
Družba SONY vam odobri licenco za uporabo (in vam ne 
prodaja) PROGRAMSKE OPREME. PROGRAMSKA OPREMA je 
zaščitena z zakoni in mednarodnimi pogodbami o avtorskih 
pravicah in drugih pravicah intelektualne lastnine.

AVTORSKE PRAVICE
Vsi pravice in pravni naslovi v povezavi s PROGRAMSKO 
OPREMO (vključno z, vendar ne omejeno na kakršne koli 
slike, fotografije, animacijo, videoposnetke, glasbo, besedilo 
in »programčke«) so last družbe SONY ali enega ali več 
DRUGIH DOBAVITELJEV.

ODOBRITEV LICENCE
SONY vam podeljuje omejeno licenco za uporabo 
PROGRAMSKE OPREME samo v povezavi z brezžičnim 
adapterjem in samo za vašo individualno uporabo. Družba 
SONY in DRUGI DOBAVITELJI si izrecno pridržujejo vse 
pravice, pravne naslove in interese (vključno z vsemi 
pravicami intelektualne lastnine, vendar ne omejeno nanje) 
v povezavi s PROGRAMSKO OPREMO, ki vam jih ta pogodba 
EULA izrecno ne podeljuje.

ZAHTEVE IN OMEJITVE
Kopiranje, objavljanje, prilagajanje, nadaljnja distribucija, 
poskusi pridobitve izvorne kode, spreminjanje, obratni 
inženiring, povratno prevajanje ali obratno zbiranje katere 
koli PROGRAMSKE OPREME, v celoti ali njenih delov, ali 
izpeljave iz ali od PROGRAMSKE OPREME niso dovoljeni, 
razen če PROGRAMSKA OPREMA namerno olajša take 
izpeljave. Spreminjanje ali poseganje v kakršne koli 
funkcionalnosti za upravljanje digitalnih pravic 
PROGRAMSKE OPREME ni dovoljeno. Ni dovoljeno obiti, 
spremeniti, onesposobiti ali zaobiti katere koli funkcije ali 
zaščite PROGRAMSKE OPREME ali katerih koli mehanizmov, 
ki so povezani z delovanjem PROGRAMSKE OPREME. Ni 
dovoljeno razdvojiti katerih koli individualnih komponent 

PROGRAMSKE OPREME za uporabo z več kot enim 
brezžičnim adapterjem, razen z izrecnim dovoljenjem 
družbe SONY. Odstranjevanje, spreminjanje, prekrivanje ali 
uničenje katerih koli blagovnih znamk ali obvestil na 
PROGRAMSKI OPREMI ni dovoljeno. Skupna raba, 
distribucija, najem, zakup, podlicenciranje, dodeljevanje, 
prenos ali prodaja PROGRAMSKE OPREME ni dovoljena. 
Programska oprema, omrežne storitve ali drugi izdelki, 
razen PROGRAMSKE OPREME, od katerih je odvisno 
delovanje PROGRAMSKE OPREME, je lahko prekinjeno ali 
ukinjeno po presoji dobaviteljev (dobaviteljev programske 
opreme, storitev ali družbe SONY). Družba SONY in takšni 
dobavitelji ne jamčijo, da bodo PROGRAMSKA OPREMA, 
omrežne storitve, vsebina ali drugi izdelki še naprej na voljo 
ali da bodo delovali brez prekinitev ali sprememb. 

IZVZETA PROGRAMSKA OPREMA IN 
ODPRTOKODNE KOMPONENTE
Ne glede na navedeno omejeno podeljeno licenco se 
strinjate, da lahko PROGRAMSKA OPREMA vključuje 
IZVZETO PROGRAMSKO OPREMO. Določena IZVZETA 
PROGRAMSKA OPREMA je lahko zajeta z licencami 
odprtokodne programske opreme (»odprtokodne 
komponente«), kar pomeni vse licence za programsko 
opremo, ki jih je kot odprtokodne licence potrdila 
organizacija Open Source Initiative, ali kakršne koli 
vsebinsko podobne licence, vključno z licencami, vendar ne 
omejeno nanje, pri katerih mora kot pogoj za distribucijo 
programske opreme, licencirane v okviru takšne licence, 
distributer omogočiti dostop do izvorne kode programske 
opreme. Če je potrebno razkritje, obiščite www.sony.com/
linux ali drugo s strani družbe SONY določeno spletno 
mesto za seznam veljavnih ODPRTOKODNIH KOMPONENT, 
občasno vključenih v PROGRAMSKO OPREMO, in veljavne 
pogoje, ki urejajo njeno uporabo. Te pogoje lahko zadevne 
tretje osebe kadar koli spremenijo, in sicer brez 
odgovornosti do vas. V obsegu, ki ga zahtevajo licence, ki 
zajemajo IZVZETO PROGRAMSKO OPREMO, bodo pogoji 
takšnih licenc veljali namesto pogojev te pogodbe EULA. V 
kolikor pogoji licenc, ki veljajo za IZVZETO PROGRAMSKO 
OPREMO, prepovedujejo kakršne koli omejitve v tej pogodbi 
EULA v zvezi s tako IZVZETO PROGRAMSKO OPREMO, te 
omejitve ne bodo veljale za tako IZVZETO PROGRAMSKO 
OPREMO. V kolikor mora družba SONY v skladu s pogoji 
licenc, ki veljajo za odprtokodne komponente, podati 
ponudbo za prikaz izvorne kode v zvezi s PROGRAMSKO 
OPREMO, je taka ponudba s tem podana. 

Licence

http://www.sony.net/Products/Linux/common/search.html
http://www.sony.net/Products/Linux/common/search.html
http://https://oss.sony.net/License/ILME-FX6/
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UPORABA PROGRAMSKE OPREME Z 
AVTORSKO ZAŠČITENIMI MATERIALI
PROGRAMSKO OPREMO boste morda lahko uporabili za 
ogledovanje, shranjevanje obdelovanje in/ali uporabo 
vsebine, ki ste jo ustvarili sami ali pa so jo ustvarile druge 
osebe. Taka vsebina je morda zaščitena na podlagi zakonov 
o avtorskih pravicah, zakonov o drugih pravicah intelektualne 
lastnine in/ali sporazumov. Soglašate, da boste 
PROGRAMSKO OPREMO uporabljali samo v skladu z vsemi 
takimi zakoni in sporazumi, ki veljajo za takšne vsebine. 
Priznavate in se strinjate, da lahko SONY sprejme ustrezne 
ukrepe za zaščito avtorskih pravic vsebin, ki so shranjene, 
obdelane ali uporabljene s PROGRAMSKO OPREMO. Taki 
ukrepi vključujejo, vendar niso omejeni na štetje pogostosti 
izdelave varnostnih kopij in obnavljanja prek določenih 
funkcij PROGRAMSKE OPREME, zavrnitev vaše zahteve za 
obnovitev podatkov in prekinitev te pogodbe EULA v primeru 
nezakonite uporabe PROGRAMSKE OPREME. 

VSEBINSKA STORITEV 
UPOŠTEVAJTE, DA JE PROGRAMSKA OPREMA LAHKO 
ZASNOVANA ZA UPORABO Z VSEBINO, KI JE NA VOLJO PREK 
ENE ALI VEČ VSEBINSKIH STORITEV (»VSEBINSKA 
STORITEV«). UPORABA STORITVE IN TE VSEBINE JE V 
SKLADU Z DOLOČILI STORITVE ZA TO VSEBINSKO STORITEV. 
ČE ZAVRNETE TA DOLOČILA, BO VAŠA UPORABA TE 
PROGRAMSKE OPREME OMEJENA. Priznavate in se strinjate, 
da nekatero vsebino in storitve, ki so na voljo prek 
PROGRAMSKE OPREME, lahko zagotovijo tretje stranke, nad 
katerimi SONY nima nadzora. UPORABA VSEBINSKE 
STORITVE ZAHTEVA INTERNETNO POVEZAVO. VSEBINSKA 
STORITEV JE LAHKO KADAR KOLI PREKINJENA.

INTERNETNA POVEZLJIVOST IN STORITVE 
TRETJIH STRANK
Priznavate in se strinjate, da je lahko za dostop do nekaterih 
funkcij PROGRAMSKE OPREME potrebna internetna 
povezava, za katero ste odgovorni sami. Poleg tega ste sami 
odgovorni za plačilo vseh pristojbin tretjim strankam, 
povezanih z vašo internetno povezavo, vključno z, vendar 
ne omejeno na ponudnika internetnih storitev ali stroške 
časa predvajanja. Delovanje PROGRAMSKE OPREME je lahko 
omejeno ali onemogočeno, kar je odvisno od zmogljivosti, 
pasovne širine ali tehničnih omejitev vaše internetne 
povezave in storitve. Zagotavljanje, kakovost in varnost take 
internetne povezave je izključna odgovornost tretje stranke, 
ki ponuja tako storitev. 

IZVOZ IN DRUGI PREDPISI
Soglašate, da boste upoštevali vse veljavne omejitve in 
predpise v zvezi z uvozom in ponovnim uvozom na 
območju ali državi, v katerih prebivate, in da ne boste 
prenesli ali dovolili prenosa PROGRAMSKE OPREME v 
prepovedane države ali ravnali kako drugače v nasprotju s 
temi omejitvami ali predpisi.

UPORABA Z VISOKIM TVEGANJEM
PROGRAMSKA OPREMA ni brez napak in ni zasnovana, 
izdelana ali namenjena za uporabo ali nadaljnjo prodajo kot 
oprema za nadzor v nevarnih okoljih, v katerih se zahteva 
visoka zanesljivost (na primer v jedrskih elektrarnah ter 
zrakoplovnih in komunikacijskih sistemih, pri nadzoru 
zračnega prometa, upravljanju medicinskih naprav za 
ohranjanje življenja ali v vojaških kompleksih z orožjem) in v 
katerih lahko okvara pri delovanju PROGRAMSKE OPREME 
povzroči smrt, telesne poškodbe ali resno fizično ali okoljsko 
škodo (»UPORABA Z VISOKIM TVEGANJEM«). Družba SONY, 
vsi DRUGI DOBAVITELJI in vse podružnice se izrecno 
odpovedujejo kakršnim koli izrecnim ali naznačenim 
jamstvom, dolžnostim ali pogojem za primernost opreme 
za UPORABO Z VISOKIM TVEGANJEM.

IZKLJUČITEV JAMSTVA ZA PROGRAMSKO 
OPREMO
Soglašate in se strinjate, da PROGRAMSKO OPREMO 
uporabljate na lastno odgovornost in da ste odgovorni za 
uporabo PROGRAMSKE OPREME. PROGRAMSKA OPREMA je 
na voljo »takšna, kot je«, brez kakršnih koli jamstev, 
dolžnosti ali pogojev.

Družba SONY in vsi DRUGI DOBAVITELJI (za namene tega 
razdelka so poimenovani s skupnim imenom »SONY«) 
IZRECNO ZAVRAČAJO VSA JAMSTVA, DOLŽNOSTI ALI 
POGOJE, IZRECNE ALI NAZNAČENE, VKLJUČNO Z, VENDAR 
NE OMEJENO NA NAZNAČENA JAMSTVA O PRIMERNOSTI ZA 
PRODAJO IN DOLOČEN NAMEN TER NEKRŠITVI. DRUŽBA 
SONY NE JAMČI ALI ZAGOTAVLJA KAKRŠNIH KOLI POGOJEV 
ALI NAVEDB (A) DA BODO FUNKCIJE KATERE KOLI 
PROGRAMSKE OPREME IZPOLNILE VAŠE ZAHTEVE ALI DA 
BODO POSODOBLJENE, (B) DA BO DELOVANJE KATERE KOLI 
PROGRAMSKE OPREME PRAVILNO ALI BREZ NAPAK ALI DA 
BODO KATERE KOLI NAPAKE ODPRAVLJENE, (C) DA 
PROGRAMSKA OPREMA NE BO POŠKODOVALA KATERE KOLI 
DRUGE PROGRAMSKE ALI STROJNE OPREME ALI PODATKOV, 
(D) DA BO KATERA KOLI PROGRAMSKA OPREMA, OMREŽNA 

STORITEV (VKLJUČNO Z INTERNETOM) ALI IZDELEK (RAZEN 
PROGRAMSKE OPREME), NA KATEREM TEMELJI DELOVANJE 
PROGRAMSKE OPREME, NA VOLJO ŠE NAPREJ, 
NEPREKINJENO ALI NESPREMENJENO IN (E) V POVEZAVI Z 
UPORABO ALI REZULTATI UPORABE PROGRAMSKE OPREME 
V SMISLU NJENE PRAVILNOSTI, NATANČNOSTI, 
ZANESLJIVOSTI ALI DRUGAČE. 

NOBENE INFORMACIJE ALI NASVETI PODJETJA SONY ALI 
NJEGOVIH POOBLAŠČENIH PREDSTAVNIKOV V USTNI ALI 
PISNI OBLIKI NE POMENIJO JAMSTVA, DOLŽNOSTI ALI 
POGOJA ALI NA KAKRŠEN KOLI NAČIN POVEČUJEJO OBSEG 
TEGA JAMSTVA. ČE JE PROGRAMSKA OPREMA OKVARJENA, 
PREVZEMATE CELOTNE STROŠKE VSEH POTREBNIH 
SERVISOV ALI POPRAVIL. NEKATERE PRAVNE UREDITVE NE 
DOVOLJUJEJO IZKLJUČITVE NAZNAČENIH JAMSTEV, ZATO TE 
IZKLJUČITVE MORDA NE VELJAJO ZA VAS.

OMEJITEV ODGOVORNOSTI
DRUŽBA SONY IN VSI DRUGI DOBAVITELJI (za namene tega 
razdelka so poimenovani s skupnim imenom »SONY«) NISO 
ODGOVORNI ZA KAKRŠNO KOLI NAKLJUČNO ALI 
POSLEDIČNO ŠKODO ZARADI KRŠITVE IZRECNEGA ALI 
NAZNAČENEGA JAMSTVA, KRŠITVE POGODBE, 
MALOMARNOSTI, OBJEKTIVNE ODGOVORNOSTI ALI NA 
PODLAGI DRUGEGA PRAVNEGA NAČELA, POVEZANEGA S 
PROGRAMSKO OPREMO, VKLJUČNO Z, VENDAR NE 
OMEJENO NA ŠKODO, KI NASTANE ZARADI IZGUBE 
DOBIČKA, IZGUBO PRIHODKOV, IZGUBO PODATKOV, IZGUBO 
UPORABE PROGRAMSKE OPREME ALI KATERE KOLI 
POVEZANE STROJNE OPREME, ČASA IZPADA IN 
UPORABNIKOVEGA ČASA, ČEPRAV SO BILI OBVEŠČENI O 
MOŽNOSTI NASTANKA TAKŠNE ŠKODE. VSAKA IN VSE 
SKUPNE ODGOVORNOSTI V OKVIRU DOLOČIL TE POGODBE 
EULA JE V VSAKEM PRIMERU OMEJENA NA DEJANSKI 
ZNESEK, PLAČAN ZA IZDELEK. NEKATERE PRAVNE UREDITVE 
NE DOVOLJUJEJO IZKLJUČITVE ALI OMEJITVE NAKLJUČNE 
ALI POSLEDIČNE ŠKODE, ZATO ZGORAJ NAVEDENE 
IZKLJUČITVE ALI OMEJITVE MORDA NE VELJAJO ZA VAS.

SOGLASJE ZA UPORABO NEOSEBNIH 
PODATKOV, PODATKOV O LOKACIJI, VARNOSTI 
PODATKOV
Soglašate in se strinjate, da družba SONY in njene 
podružnice, partnerji in agenti lahko berejo, zbirajo, 
prenašajo, obdelujejo in shranjujejo nekatere podatke, 
zbrane s pomočjo PROGRAMSKE OPREME, vključno z, a ne 

omejeno na informacije o (i) PROGRAMSKI OPREMI in (ii) 
programskih aplikacijah, vsebini in perifernih napravah, ki 
komunicirajo z vašim brezžičnim adapterjem in 
PROGRAMSKO OPREMO (»Informacije«). Informacije 
zajemajo, vendar niso omejene na: (1) edinstvene 
identifikatorje, vezane na vaš brezžični adapter in njegove 
komponente; (2) delovanje brezžičnega adapterja, 
PROGRAMSKE OPREME in njihovih komponent; (3) 
konfiguracije vašega brezžičnega adapterja, PROGRAMSKE 
OPREME in programskih aplikacij, vsebin in perifernih 
naprav, ki komunicirajo z brezžičnim adapterjem in 
PROGRAMSKO OPREMO; (4) uporabo in frekvenco uporabe 
funkcij (x) PROGRAMSKE OPREME in (y) programskih 
aplikacij, vsebin in perifernih naprav, ki komunicirajo s 
PROGRAMSKO OPREMO; in (5) lokacijskih podatkov, kot je 
označeno spodaj. Družba SONY in njene podružnice, 
partnerji in agenti lahko uporabljajo in razkrivajo 
informacije v skladu z veljavno zakonodajo, da bi izboljšali 
svoje izdelke in storitve ali vam zagotovili produkte in 
storitve. Taka uporaba zajema, vendar ni omejena na: (a) 
upravljanje funkcionalnosti PROGRAMSKE OPREME, (b) 
izboljšanje, servisiranje, posodabljanje ali nadgradnjo 
PROGRAMSKE OPREME, (c) izboljšanje in razvijanje sedanjih 
in prihodnjih izdelkov in storitev družbe SONY in drugih 
strank, (d) zagotavljanje informacij o izdelkih in storitvah, ki 
jih ponujajo družba SONY in druge stranke, (e) skladnost z 
veljavnimi zakoni ali predpisi in (f) v obsegu, v katerem je na 
razpolago, zagotavljanje lokacijske storitve družbe SONY in 
drugih strank, kot je navedeno spodaj. Poleg tega si družba 
SONY pridržuje pravico do uporabe informacij za svojo 
zaščito in zaščito tretjih strank pred nezakonitim, kazenskim 
ali škodljivim ravnanjem.

Nekatere storitve, ki so na voljo prek PROGRAMSKE 
OPREME, se lahko zanašajo na lokacijske informacije, med 
drugim na geografsko lokacijo brezžičnega adapterja. 
Soglašate, da za namen zagotavljanja takih storitev družba 
SONY, DRUGI DOBAVITELJI ali njihovi partnerji lahko zbirajo, 
arhivirajo, obdelujejo in uporabljajo take lokacijske podatke 
in da takšne storitve ureja pravilnik o zasebnosti družbe 
SONY ali tretjih oseb. Preglejte pravilnik o varovanju 
zasebnosti, ki velja za te storitve, in sprejemate te 
dejavnosti. 

Družba SONY, njene podružnice, partnerji in agenti ne bodo 
namenoma uporabljali informacij za osebno identifikacijo 
lastnika ali uporabnika PROGRAMSKE OPREME brez vaše 
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vednosti ali soglasja. Vsaka uporaba informacij bo v skladu 
s pravilniki o varstvu zasebnosti družbe SONY ali tretjih 
oseb. 

Za informacije o sedanjem pravilniku o varstvu zasebnosti 
družbe SONY uporabite kontaktni naslov vsakega območja 
ali države. Za pravilnike o varstvu zasebnosti v zvezi z 
osebnimi in drugimi podatki, ki jih posredujete, ko 
uporabljate ali dostopate do programske opreme ali storitev 
tretjih strank, se obrnite na te tretje stranke. 

Podatki bodo morda obdelani, hranjeni ali preneseni v 
družbo SONY, njene podružnice ali agente, ki se nahajajo v 
državah zunaj države vašega stalnega prebivališča. 
Varovanje podatkov in zakoni o zasebnosti podatkov v 
nekaterih državah morda ne nudijo enake ravni zaščite kot 
država vašega stalnega prebivališča in morda boste imeli v 
teh državah manj zakonskih pravic v zvezi z obdelavo, 
hranjenem in pošiljanjem podatkov. Družba SONY se bo v 
okviru razumnih prizadevanj trudila sprejeti ustrezne 
tehnične in organizacijske ukrepe, da prepreči nepooblaščen 
dostop do informacij ali njihovo razkritje, vendar ne jamči, 
da bo odpravila vsa tveganja zlorabe takšnih informacij.

FUNKCIJA SAMODEJNE POSODOBITVE
Družba SONY ali DRUGI DOBAVITELJI občasno samodejno 
posodobijo ali kako drugače spremenijo PROGRAMSKO 
OPREMO, vključno za, vendar ne omejeno na namene 
izboljšanja varnostnih funkcij, odpravljanje napak in 
izboljšanje funkcij v času, ko ste povezani s strežniki družbe 
SONY ali strežniki tretjih strank ali drugače. Te posodobitve 
ali spremembe lahko izbrišejo ali spremenijo naravo funkcij 
ali drugih vidikov PROGRAMSKE OPREME, vključno s 
funkcijami, ki jih potrebujete, vendar ne omejeno nanje. 
Potrjujete in se strinjate, da se lahko takšne dejavnosti 
zgodijo po lastni presoji družbe SONY in da družba lahko 
pogojuje nadaljnjo uporabo PROGRAMSKE OPREME s 
popolno namestitvijo ali sprejetjem teh posodobitev ali 
sprememb. Za namene te pogodbe EULA se šteje, da so 
kakršne koli posodobitve/spremembe sestavni del 
PROGRAMSKE OPREME. S sprejetjem te pogodbe EULA 
soglašate s takimi posodobitvami/spremembami.

CELOTNA POGODBA, ODPOVEDNA KLAVZULA, 
LOČITVENA KLAVZULA
Ta pogodba EULA in pravilnik o zasebnosti družbe SONY, 
kakor je oboje občasno spremenjeno, skupaj predstavljata 
celotno pogodbo med vami in družbo SONY v zvezi s 
PROGRAMSKO OPREMO. Neuspeh družbe SONY pri izvedbi 
ali uveljavitvi kakršne koli pravice ali določila te pogodbe 
EULA ne pomeni opustitve takšne pravice ali določila. Če je 
katerikoli del te pogodbe EULA neveljaven, nezakonit ali 
neizvršljiv, se ta določba izvrši do največje mogoče mere, da 
se ohrani namen te pogodbe EULA, drugi deli pa ostanejo v 
polni veljavi.

ZAKONODAJA IN PRISTOJNOST
Konvencija Združenih narodov o pogodbah o mednarodni 
prodaji blaga ne velja za to pogodbo EULA. To pogodbo 
EULA ureja in uveljavlja japonska zakonodaja, razen 
kolizijskih določb. Za kakršne koli spore, ki bi nastali na 
podlagi te pogodbe EULA, je pristojno okrožno sodišče v 
Tokiu na Japonskem. Stranki soglašata s krajem in 
pristojnostjo teh sodišč.

PRAVIČNA PRAVNA SREDSTVA
Ne glede na vsebino te pogodbe EULA soglašate in se 
strinjate, da bo vsaka kršitev ali nespoštovanje te pogodbe 
EULA z vaše strani povzročilo nepopravljivo škodo družbi 
SONY, za katero denarna odškodnina ne bo zadoščala, in 
soglašate, da družba SONY pridobi kakršen koli ukrep 
pravnega varstva s prepovedjo in pravičnim nadomestilom, 
za katerega meni, da je nujen ali primeren glede na 
okoliščine. Družba SONY lahko sprejme tudi kakršne koli 
pravne in tehnične ukrepe za preprečevanje kršitev te 
pogodbe EULA ali njeno uveljavljanje, vključno z, vendar ne 
omejeno na takojšnje prenehanje uporabe PROGRAMSKE 
OPREME z vaše strani, če družba SONY po lastni presoji 
meni, da kršite ali nameravate kršiti to pogodbo EULA. Ti 
ukrepi so dodatni k drugim pravnim sredstvom, s katerimi 
družba SONY razpolaga v skladu z zakonom, kapitalom ali 
na podlagi pogodbe.

ODPOVED
V primeru kršitve katerih koli določil te pogodbe EULA lahko 
družba SONY brez poseganja v katere koli druge pravice to 
pogodbo prekine. V primeru take odpovedi morate: (i) 
prenehati uporabljati PROGRAMSKO OPREMO in uničiti vse 
njene kopije; (ii) upoštevati zahteve v razdelku z naslovom 
»Odgovornosti, povezane z vašim računom«.

SPREMEMBE
DRUŽBA SONY SI PRIDRŽUJE PRAVICO, DA SPREMENI 
KATERI KOLI POGOJ TE POGODBE EULA PO LASTNI PRESOJI, 
TAKO DA OBJAVI OBVESTILO NA DOLOČENEM SPLETNEM 
MESTU, Z E-POŠTNIM OBVESTILOM, POSLANIM NA VAŠ 
NASLOV, Z OBVESTILOM KOT DELOM POSTOPKA 
NADGRADNJE/POSODOBITVE ALI NA KATERI KOLI DRUG 
PRAVNO DOPUSTEN NAČIN OBVEŠČANJA. Če se ne strinjate 
s spremembo, se čim prej obrnite na družbo SONY za 
navodila. Nadaljnja uporaba PROGRAMSKE OPREME po 
datumu uveljavitve takšnega obvestila pomeni, da se 
strinjate s spremembo.

UPRAVIČENE TRETJE STRANKE
Vsak DRUG DOBAVITELJ je izrecna upravičena tretja stranka 
vsake določbe te pogodbe EULA v zvezi z njegovo 
PROGRAMSKO OPREMO in ima pravico uveljavljati 
pogodbene določbe. 

Če imate kakršno koli vprašanje v zvezi s to pogodbo EULA, 
se lahko pisno obrnete na družbo SONY na veljaven 
kontaktni naslov vsake regije ali države.

Copyright © 2012 Sony Corporation.

Licence za odprtokodno 
programsko opremo

Ta izdelek uporablja odprtokodno programsko 
opremo na temelju licenčnih pogodb med 
družbo Sony in imetniki avtorskih pravic za 
programsko opremo.
Za izpolnitev zahtev imetnikov avtorskih 
pravic na programski opremi, je družba Sony 
zavezana, da vas obvesti o vsebini teh licenc.
Licence (v angleščini) so shranjene v 
notranjem pomnilniku izdelka.
Vzpostavite povezavo za količinsko 
shranjevanje med izdelkom in računalnikom za 
branje licenc v mapi »PMHOME« – »LICENSE«.

Če uporabljate računalnik Mac, mapa 
»PMHOME« - »LICENSE« morda ne bo 
dostopna.
Za ogled datotek uporabite računalnik, ki ni 
Mac, ali obiščite ta naslov URL.
https://oss.sony.net/License/ILME-FX6/

https://oss.sony.net/License/ILME-FX6/
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Splošno

Teža
	 Približno 890 g (1 lb 15 oz) (samo glavno 

ohišje)
	 Približno 2,59 kg (5 lb 11 oz) (vključno z 

objektivom SEL24105G, senčilom 
objektiva, baterijo (BP‑U35), 
iskalom, ročajem, držalom)

Mere
	 Glejte razdelek 133.
Napajanje
	 19,5 V DC (18,0 V do 20,5 V)
Poraba energije
	 Pribl. 18,0 W (ohišje, objektiv, snemanje 

XAVC-I QFHD 59,94P, iskalo 
vklopljeno, brez priklopljenih 
zunanjih naprav)

	 Pribl. 36,0 W (ohišje, objektiv, snemanje 
XAVC-I QFHD 59,94P (S&Q 
120 sličic na sekundo), iskalo 
vklopljeno, HDMI, SDI, s 
priključeno zunanjo napravo)

Delovna temperatura
	 od 0 do 40 °C
Temperatura shranjevanja
	 od –20 do +60 °C
Neprekinjen čas delovanja
	 Približno 105 minut (z uporabo BP-U35) 

(ohišje, objektiv, snemanje XAVC-I 
QFHD 59,94P, iskalo vklopljeno, 
brez priklopljenih zunanjih 
naprav)

Format snemanja (video)
	 XAVC Intra
		  Način XAVC-I 4K/QFHD: 

CBG, 600 Mb/s (največja) bitna 
hitrost, MPEG-4 AVC/H.264

		  Način XAVC-I HD: 
CBG, 223 Mb/s (največja) bitna 
hitrost, MPEG-4 AVC/H.264

	 XAVC Long
		  Način XAVC-L QFHD: 

VBR, 150 Mb/s (največja) bitna 
hitrost, MPEG-4 H.264/AVC

		  Način XAVC-L HD 50: 
VBR, 50 Mb/s (največja) bitna 
hitrost, MPEG-4 H.264/AVC

		  Način XAVC-L HD 35: 
VBR, 35 Mb/s (največja) bitna 
hitrost, MPEG-4 H.264/AVC

Format snemanja (zvok)
	 LPCM, 24-bitni, 48 kHz, 4-kanalni
Hitrost sličic pri snemanju
	 XAVC Intra
		  Način XAVC-I 4K: 

4096×2160/59,94P, 50P, 29,97P, 
25P, 24P, 23,98P

		  Način XAVC-I QFHD: 
3840×2160/59,94P, 50P, 29,97P, 
25P, 23,98P

		  Način XAVC-I HD: 
1920×1080/59,94P, 50P, 29,97P, 
25P, 23,98P

	 XAVC Long
		  Način XAVC-L QFHD: 

3840×2160/59,94P, 50P, 29,97P, 
25P, 23,98P

		  Način XAVC-L HD 50: 
1920×1080/59,94P, 50P, 29,97P, 
25P, 23,98P

		  Način XAVC-L HD 35: 
1920×1080/59,94P, 50P, 29,97P, 
25P, 23,98P

Čas snemanja/predvajanja
	 XAVC Intra
		  Način XAVC-I QFHD:
			   59,94P
			   Približno 30 minut 

(z uporabo CEA-G160T)

		  Način XAVC-I HD:
			   59,94P
			   Približno 78 minut 

(z uporabo CEA-G160T)
	 XAVC Long
		  Način XAVC-L QFHD:
			   59,94P
			   Približno 115 minut 

(z uporabo CEA-G160T)
		  Način XAVC-L HD 50:
			   59,94P
			   Približno 155 minut 

(z uporabo CEA-G80T)
		  Način XAVC-L HD 35:
			   59,94P
			   Približno 210 minut 

(z uporabo CEA-G80T)

[Opomba]
Čas snemanja/predvajanja se lahko razlikuje glede na 
razmere uporabe in lastnosti pomnilnika. Časi snemanja 
in predvajanja so navedeni za neprekinjeno snemanje 
enega posnetka. Dejanski časi so lahko krajši, odvisno 
od števila posnetih posnetkov.

Področje kamere

Slikovna naprava (tip)
	 35 mm slikovni senzor CMOS polnega 

formata z enim čipom
Število slikovnih pik
	 12,9 M (skupaj)
	 10,2 M (efektivno)
Samodejno ostrenje
	 Metoda zaznavanja: Fazno zaznavanje/

zaznavanje kontrasta

Notranji filtri ND
	 CLEAR: OFF
	 1: 1/4ND
	 2: 1/16ND
	 3: 1/64ND
	 Linearno spremenljivi ND: 1/4ND do 1/128ND
Občutljivost ISO
	 ISO 800/12800 (način Cine EI, svetlobni 

vir D55)
Nastavek za objektiv
	 Serija E
Razpon
	 15+ stopenj
Shutter speed (Hitrost zaklopa)
	 Od 64F do 1/8000 s (23,98P)
Kot zaklopa
	 Od 5,6° do 360°, od 2 do 64 sličic
Počasni in hitri posnetki
	 XAVC QFHD: Od 1 do 120 sličic na sekundo
	 XAVC HD: Od 1 do 240 sličic na sekundo
	 XAVC 4K: Od 1 do 60 sličic na sekundo
	 XAVC HD (S35): Od 1 do 120 sličic na sekundo
White balance (Nastavitev beline)
	 2000 K do 15000 K
Ojačitev
	 Od –3 dB do +30 dB (v korakih po 1 dB)
Osnovni videz
	 S-Cinetone, Standard, Still, ITU709, s709, 

709 (800 %), S-Log3, HLG Live, 
HLG Natural

Specifikacije
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Področje zvoka

Podprta frekvenca vzorčenja

	 48 kHz

Kvantizacija

	 24-bitna

Frekvenčni odziv

	 Način MIC vhoda XLR: 20 Hz do 20 kHz  

(±3 dB ali manj)

	 Način LINE vhoda XLR: 20 Hz do 20 kHz  

(±3 dB ali manj)

Dynamic range (Dinamični razpon)

	 Način MIC vhoda XLR: 80 dB (tipično)

	 Način LINE vhoda XLR: 90 dB (tipično)

Popačenje

	 Način MIC vhoda XLR: 0,08 % ali nižje (raven 

vhoda –40 dBu)

	 Način LINE vhoda XLR: 0,08 % ali nižje (raven 

vhoda +14 dBu)

Vgrajeni zvočnik

	 Mono

Notranji mikrofon 

	 Mono

Notranji mikrofon v držalu

	 Vsesmerni stereo elektretni kondenzatorski 

mikrofon

[Opomba]
Ko pritrdite držalo, se vklopi samo interni mikrofon v 
držalu.

Področje vhodov/izhodov

Vhodni priključki
INPUT 1/2:

	 Tip XLR, 3-pinski, ženski

	 LINE/MIC/MIC+48V preklopno

	 MIC: Referenca –30 dBu do –80 dBu

TC IN:

	 Tip BNC

Izhodni priključki
SDI OUT:

	 Tip BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI

Slušalke (stereo mini vtič):

	 –16 dBu (referenčna raven izhoda, največja 

glasnost monitorja, 16 Ω breme)

HDMI:

	 Tip A, 19-pinski

TC OUT:

	 Tip BNC

Drugo
DC IN:

	 Skladno s standardom EIAJ, 18 V do 20,5 V DC

Večnamenski nastavek:

	 Namenski (21-pinski)

REMOTE:

	 2,5 mm 3-polni, tip sub-mini

Priključek držala z daljinskim upravljalnikom:

	 4-polni stereo mini vtič 3,5 mm (priložen 

priključek za držalo z daljinskim 

upravljalnikom)

USB-C:

	 USB 3.2 Gen 1

USB/multi:

	 Skladen s standardom USB 2.0, tip micro B za 

količinsko shranjevanje (1)

VF:

	 Namenski (40-pinski)

Področje zaslona

Iskalo (LCD)
Velikost zaslona

	 8,8 cm (3,5 palca) po diagonali

Razmerje stranic

	 16:9

Število slikovnih pik

	 1280 (V) × 720 (N)

Področje rež za kartice

Reža za kartico A/SD tipa CFexpress (2)

Brezžični LAN

Podprti standardi

	 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

	 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Frekvenčni pas

	 2,4 GHz

	 5 GHz (samo ILME-FX6V/VK)

Podprti varnostni protokoli

	 WEP/WPA-PSK/WPA2-PSK

Način povezave

	 Wi-Fi Protected Setup™ (WPS)/ročno

Način dostopa

	 infrastrukturni način

Polnilnik baterij (BC-CU1)

Teža

	 Pribl. 60 g (2,1 oz)

Mere

	 Pribl. 57 × 26 × 101 mm  

(2 1/4 × 1 1/16 × 4 palcev)  

(širina/višina/globina)

Vhod

	 19,5 V DC, 26 W

Izhod

	 16,4 V DC, 1,4 A

Delovna temperatura

	 od 0 do 40 °C

Temperatura shranjevanja

	 od –20 do +60 °C

Priložena dodatna oprema

Omrežni napajalnik (1)

Napajalni kabel (1) 

Polnilnik baterij (1) 

Paket baterij (1)

Držalo (1)

LCD-zaslon (1)

Kabel USB-C (1)

Daljinski upravljalnik za držalo (1)

Senčilo za LCD (1)

Nastavek za opremo brez napajanja (1) 

(nastavek brez napajanja (1), vzmet nastavka (1), 

vijaki (4))

Pokrovček nastavka za objektiv (1)

Zaščitni pokrovček priključka držala (1)

Pred uporabo tega izdelka (1)

Garancijska knjižica (1)

Oblika in tehnični podatki se lahko spremenijo 
brez obvestila.
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Opombi
ˎˎ Vedno naredite testni posnetek in se 
prepričajte, da je bil uspešno posnet. 
DRUŽBA SONY NI ODGOVORNA ZA 
NIKAKRŠNO ŠKODO, MED DRUGIM ZA 
NADOMESTILO ALI POVRAČILO IZGUBE 
SEDANJEGA ALI PRIČAKOVANEGA 
DOBIČKA ZARADI NAPAKE TE ENOTE ALI 
SNEMALNEGA MEDIJA ALI KATEREGAKOLI 
MEDIJA ALI POMNILNIŠKEGA SISTEMA 
KATEREKOLI VRSTE ZA SNEMANJE KAKRŠNE 
KOLI VSEBINE.
ˎˎ Pred uporabo enote vedno preverite, 
ali deluje pravilno. DRUŽBA SONY NI 
ODGOVORNA ZA NIKAKRŠNO ŠKODO, MED 
DRUGIM ZA NADOMESTILO ALI POVRAČILO 
IZGUBE SEDANJEGA ALI PRIČAKOVANEGA 
DOBIČKA ZARADI NAPAKE TE ENOTE, TAKO 
V GARANCIJSKEM ROKU KOT PO POTEKU 
GARANCIJE ALI ZARADI KAKRŠNEGA KOLI 
DRUGEGA RAZLOGA.
ˎˎ DRUŽBA SONY NI ODGOVORNA ZA 
KAKRŠNEKOLI ZAHTEVKE UPORABNIKOV TE 
ENOTE ALI TRETJIH OSEB.
ˎˎ DRUŽBA SONY NI ODGOVORNA ZA 
IZGUBO, POPRAVILO ALI REPRODUKCIJO 
PODATKOV, POSNETIH NA NOTRANJI 
POMNILNIŠKI SISTEM, SNEMALNE MEDIJE 
ALI KATEREKOLI DRUGE MEDIJE ALI 
POMNILNIŠKE SISTEME.
ˎˎ DRUŽBA SONY NI ODGOVORNA ZA 
PREKINITEV ALI KONČANJE KATERIHKOLI 
STORITEV, VEZANIH NA TO ENOTO, KI BI 
BILE POSLEDICA KAKRŠNIHKOLI OKOLIŠČIN.

Zunanje dimenzije

Enota: mm (palci)

UNC 1/4-20

UNC 3/8-16

228 (9)

2-UNC 1/4-20

UNC 1/4-20

143 (5 3/4)

UNC 1/4-20

116  
(4 5/8)

8-UNC 1/4-20

114 (4 1/2)
60  
(2 3/8)

258 (10 1/4)

2-UNC 1/4-20

153 (6 1/8)

28 (1 1/8)

25 (1)

25 (1)
25 (1)

25 (1)

Dimenzije so približne vrednosti.
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Blagovne znamke

ˎˎ  je blagovna znamka družbe Sony 
Corporation.
ˎˎ XAVC in  sta zaščiteni blagovni znamki 
podjetja Sony Corporation.
ˎˎ Izraza HDMI in večpredstavnostni vmesnik 
visoke ločljivosti HDMI ter logotip HDMI 
so blagovne znamke ali zaščitene 
blagovne znamke družbe HDMI Licensing 
Administrator, Inc. v ZDA in drugih državah.
ˎˎ Microsoft in Windows sta blagovni znamki 
ali zaščiteni blagovni znamki družbe 
Microsoft Corporation v ZDA in/ali drugih 
državah.
ˎˎ Mac in MacOS sta zaščiteni blagovni znamki 
družbe Apple Inc. v ZDA in drugih državah.
ˎˎ »Catalyst Browse«, »Content Browser 
Mobile« in logotip »Content Browser Mobile« 
so blagovne znamke ali zaščitene blagovne 
znamke družbe Sony Corporation.
ˎˎ iOS je zaščitena blagovna znamka oziroma 
blagovna znamka podjetja Cisco Systems, 
Inc. in/ali njegovih podružnic v ZDA in 
določenih drugih državah.
ˎˎ Android in Google Play sta blagovni znamki 
družbe Google Inc.
ˎˎ Wi-Fi, logotip Wi-Fi in Wi-Fi PROTECTED 
SETUP so blagovne znamke ali zaščitene 
blagovne znamke združenja Wi-Fi Alliance.
ˎˎ Oznaka N je blagovna znamka ali 
registrirana blagovna znamka družbe NFC 
Forum, Inc. v ZDA in v drugih državah.
ˎˎ Logotip SDXC je blagovna znamka podjetja 
SD-3C, LLC.
ˎˎ Logotipa CFexpress in CFexpress Type A 
sta blagovni znamki zveze CompactFlash 
Association.

Vsa druga imena podjetij in izdelkov so 
zaščitene blagovne znamke ali blagovne 
znamke njihovih lastnikov. Elementi, ki so 
blagovna znamka, v tem dokumentu niso 
označeni s simbolom ™ ali ®.
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